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Safety  
This recorder is compliant with the requirements of EN61010-1, UL 61010C-1 & CSA C22.2 No. 24-93. If 
the equipment is used in a manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired. The manufacturer is not liable for any damages incurred to 
equipment/personal during installation or use of equipment as explained in this document. User must 
acquire sufficient knowledge & skills prior to using equipment in the application and follow all the local 
standards & regulations to meet safety requirements. 
 
Warning Symbol 
 This document contains notices that you should observe to ensure your safety, as well as to protect the 
product and connected equipment. These notices are highlighted in the manual by a warning triangle and 
are marked as follows. 
 

  The danger symbol indicates that death or severe personal injury may result if proper precautions are 
not taken. Do not proceed beyond a Warning symbol until the indicated conditions are fully understood and 
met. 
 Before connecting the power cord, ensure that the power supply voltage matches the voltage rating for the 
instrument. 
 

   Make sure to connect the protective grounding to prevent electric shock before turning ON the power. 
Never cut off the internal or external protective grounding wire or disconnect the wiring of the protective 
grounding terminal. Doing so will pose a potential shock hazard. Do not operate the instrument when the 
protective grounding or the fuse might be defective. Also, make sure to check them before the operation. 
 

 Do not operate the instrument in the presence of flammable liquids or vapours. Operation of any 
electrical instrument in such an environment constitutes a safety hazard. 

 Some areas inside the instrument have high voltages. Do not remove the cover if the power 
supply is connected. The cover should be removed by our qualified personnel only. 

 Using the instrument in a manner not specified in this manual can damage the instrument’s 
protection 

 Keep signal and supply voltage wiring separated from one another. If this is impractical, use 
shielded cables for signal wiring.  Double insulation should be used for signal wiring when the 
recorder is used with hazardous voltage. 

 Do not use the recorder where there is high vibration or a high magnetic field. This could cause 
damage or an error of measurement. 

 All maintenance or repairs should be carried out with power disconnected to avoid personal 
injury or damage to the unit. 

 In areas with conductive pollution, adequate ventilation, filtering and sealing must be installed. 
 When cleaning the recorder, handle it carefully and use a soft dry cloth. Avoid the use of 

abrasives, or any sharp or hard objects which would damage the display. 
 Do not operate the recorder if any part has been removed or disassembled.  Consult your 

nearest dealer at once. 
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 Static Electricity:  
Appropriate precautions must be taken when handling the recorder. The circuit board 
components are susceptible to damage caused by electrostatic discharge. Take static electricity 
precautions while handling and inserting USB memory into the recorder.  
 

Preface 
 Original equipment manufacturer reserves the right to change information available in this document 
without notice. The manufacturer is not liable for any damages incurred to equipment/personal during 
installation or use of equipment as explained in this document. User must acquire sufficient knowledge & 
skills prior to using equipment in the application and follow all the local standards & regulations to meet 
safety requirements. 
 
Copyright 
The documentation and the software included with this product are copyrighted in 2025 by the manufacturer. 
All rights are reserved. The manufacturer reserves the right to make improvements in the products 
described in this manual at any time without notice.  
 No part of this manual may be reproduced/copied/translated or transmitted in any form or by any means 
without the prior written permission of the manufacturer. The information we supply is believed to be 
accurate and reliable as of this printing. However, we assume no responsibility for its use. 
 
For any repair or maintenance needs, please contact us. 
 
Brainchild Electronic Co.,Ltd. 
Tel : 886-2-27861299 
 

 

Protective Earth 
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1. Introduction 

1.1 Introduction 

 The new generation PR series paperless recorder has many outstanding features to meet the industry 
requirements. 
  

1.2 Features 

1.2.1 Hardware  

 The PR series hardware has the following unique features. 
 Available in three display sizes 4.3”, 5.6” and 12.1”  
 PR10, with a 4.3” display, with 3 or 6 universal analog inputs and 24 Optional External Channels 
 PR20, with a 5.6” display, with 6, 12, 18 or 24 universal analog inputs and 48 Optional External 

Channels 
 PR30, with a 12.1” display, with 6, 12, 18, 24, 30, 36, 42 or 48 universal analog inputs and 96 

Optional External Channels 
 High-resolution TFT Colour LCD display with Touch screen  
 100-millisecond sampling rate and data logging 
 PID Process Control card (PC201) to control the process. 
 High accuracy 24-bit A-D Analog Input  
 16-bit D-A Analog Output 
 Pulse input through Digital input, maximum 100 Hz. 
 I/O cards (AI, AO, DI, and DO) for easy expansion. 
 On-board SD card slot for external storage. 
 Two USB Host Ports for external storage and printer connectivity 
 Ethernet as standard with optional RS-232 or RS422/RS485 communication 
 IP65 water-resistant (Non-UL Certify, Self-Declaration of Conformity) 

          
 
 
 
 
 
 
 
 
 
 
 
 
 

PR10                            PR20                                      PR30 
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1.2.2 Firmware 

 The PR series recorder has 4 different versions of firmware for the user to select as per the application 
requirement. 

1. Standard Firmware 
2. Plus 1 Firmware 
3. Plus 2 Firmware 
4. Plus 3 Firmware 

1.2.3 PC Software 

 The PR series has the below user-friendly software for configuration, analysis, data acquisition and custom 
display 

1. Free Basic Software Historical Viewer for configuration and analysis 
2. Extensive Software Data Acquisition Studio for configuration, analysis and data acquisition on 

PC. 
3. Panel Studio Software for Custom display 

1.2.4 Firmware and Software Features 

 The below are the unique features of the PR series different firmware. 
 Circular Chart in PR30 
 Panel Studio Software for editing and customizing display pages. 
 Display values in Digital, Trend, Bar graph and mix format. 
 Real-time and Historical Trends 
 Real-time and Historical Alarms 
 Event management, Jobs linked with events 
 Reports (Daily, Weekly and Monthly) 
 Timers, Counters, Totalizers, Math channels  
 FDA 21 CFR part 11 compliance 
 Customized messages for alarms 
 Alarms by email directly from the paperless recorder 
 Batch control, log data in batches 
 100 milliseconds data logging and historical data archival tools 
 Display pages rotation 
 Start/Stop data logging functions which can be linked with real-time clock or events  
 Search data with reference Time, Period, Tag, Event, Alarm, Remark, Handwrite 
 Export data to Excel and database format (*.csv only) 
 Web-server 
 Handwriting function in historical data 
 PID control with Profile function  
 Multiple Languages for users to select 
 Data logging by value change or time base  
 Dynamic Data Exchange via PC software 
 On-Field Calibration 
 Direct Printer Connectivity with PDF Printer included 
 USB Bar-code Reader Connectivity for Data Entry 
 USB Keyboard and Mouse Connectivity 
 Clock Synchronization via Internet 
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1-1 Historical Viewer Software  

 

 
 

1-2 Configuration Viewer Software in Historical Viewer Software 
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1-3 Real-Time Viewer in Data Acquisition Studio Software 

 

 
 

1-4 Panel Studio Software for Custom Display 
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1-5 Circular Chart in PR30 

1.3 Comparison of PR Series Recorders 

 The below table shows the differences between different models of PR series recorder. 
 

 
Description 
 

PR10 PR20 PR30 

Display Size 4.3” 5.6” 12.1” 

Analog Inputs (Maximum) 6 24 48 

Analog Outputs (Maximum) 6 6 12 

Digital Inputs (Maximum) 24 24 24 

Relay Outputs (Maximum) 24 24 24 

PID Process Control Card 
(Non-UL Certify, Self-Declaration of Conformity) 

4 4 8 

Math Channels (Maximum) 15 40 60 

External Channels (Other devices via Modbus) 24 48 96 

Total Pages 8 20 21 

Pens/Page (Maximum) 6 6 10 

Batches (Maximum) 1 1 1 

Timers (Maximum) 6 20 48 
 

1-6 Comparison of PR10, PR20 and PR30 
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1.4 Expandable Input and Output Cards 

There are 4 rear expansion slots in PR10 and PR20 and 16 rear expansion slots in PR30 available for 
expansion with the following plug and play I/O Cards.  
 

1.4.1 Analog Input Cards (part number AI203 & AI206 & AI306) 

These AI cards are used for 3 or 6-channel analog inputs.  Each input is isolated from each other to avoid 
noise and to ensure stable measurement.  
 
New modifications since V2.0 (2507)  
 Add function:  

AI306 has been added as a basic feature   
AMS2750 compliance with the accuracy of +/- 0.6 °C, it only supports PR10 and PR20. 

 

AI206 
6-channel AI (6 analog inputs) 

 

 
AI203 

3-channel AI (3 anlalog inputs) 
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AI306 

6-channel AI (6 analog inputs) 

 
 

1.4.2 Relay Output Card (RO206) 

 Each card includes 6 relay outputs. The relay contacts are rated 1 Amp/240 VAC. 
 

RO206 
6 relay outputs 
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1.4.3 Digital Input Card (DI206) 

Each card includes 6 channels. Logic Low: -5V minimum, 0.8V maximum, Logic High: 3.5V minimum, 24V 
maximum 
 

DI206 
6 DI (6 digital inputs) 

 
 

1.4.4 Combination Relay Output and Digital Input Card (RD233) 

 Each Card includes 3 Digital Inputs and 3 Relay Outputs. For Digital Inputs, Logic Low: -5V minimum, 0.8V 
maximum, Logic High: -3.5V minimum, 24V maximum.  
For Relay Outputs, the Contacts are rated 1 Amp/240 VAC 
 

RD233 
3 relays + 3DI 
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1.4.5 Analog Output Cards (AO206) 

 Each card includes 6 channels. They are used for 4-20mA, 0-20mA current output, 0-5V, 1-5V, 0-10VDC 
voltage output. 
 

AO206 
6 AO (6 analog outputs) 

 
 

Note 1: To insert/ remove the IO card from the device, please turn off the power first. 
Note 2: When using thermocouple inputs, warm up the device for one hour before operation 
Note 3: The PR30 analog input AI2XX card can only be inserted into slots 1~8 to operate properly. 

Other cards can be placed into any slot 1~18. 
Note 4: Only the PR30 supports circular chart diagram function.  

 

1.4.6 PID Process Control Card (PC201) 

 Each card includes one single loop PID process control function with ramp and soak profile segment. 
 
 

PC201 
Single loop process control 
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1.5 Communication 

 The standard communication interface is Ethernet with protocol IEEE 802.3 – 10/100 Base T.  Other 
options are RS-232 / RS-422 / RS-485. Details are explained in Chapter 2.4.8 - RS-232, RS-422, RS-485 
wiring. 

1.6 External Storage Media 

 The recorder has 256MB internal memory to store the data. There are two types of External storage media 
available for the recorder to dump the stored data from internal memory. They are SD card and USB. Only 
one storage media can be used at a time in the recorder. 
 If the recorder is used with 6-channel inputs, the below chart shows the maximum no of days historical 
data can be stored based on available memory. 
 

SD card 
16GB 32GB 

Log speed 

1 second 15, 808 days 31,616 days 

10 seconds 158,032 days 316,064 days 

120 seconds 1,896,304 days 3,792,608 days 

 
* The above is an approximation, each record of data uses 2 or 4 bytes of memory depending on the data 

type.  
For ex:  Selected data size = 2 bytes 
 If the Log Speed (the recording speed of measured data) is set to the speed at 1 second per data, then for 
six channels, a 16GB SD Card will last approximately 15, 808 days [16GB / (2 bytes x 24 hours x 60 
minutes x 60 seconds x 6 Channels].   
 
 The following formula is to calculate how many days a USB disk can do saving before it is full. 
 No of days = (The capacity of SD card memory x Log Speed) / (2 x # of hours per day x 60 x 60 x Number 
of channels) 
 
If the user is using USB to dump the data then it is necessary to insert USB memory back to recorder after 
loading recorded data onto PC. Otherwise, the dumping process will fail and the oldest data will be deleted 
once the internal memory is full. The recorder will do automatic dumping process when the internal memory 
is occupied by 96% to ensure the device can continue to record. 
 
Auto data cleaning: When external memory SD or USB not being installed, the memory less than 5% 
remaining, the recorder will do automatic cleaning process to clear the memory from the device. During the 
cleaning process, memory percentage keeps slowly increasing.  
Auto data dumping: When external memory SD or USB being installed into the device, the memory less 
than 5% remaining, the recorder will do automatic dumping process to transfer the memory to external 
storage. During the dumping process, memory percentage keeps slowly increasing. 
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 Go to Home > Menu  > Alarm, MemoryFull: The Alarm list will show “MemoryFull” 
 Go to Menu  > Realtime, Auto Data Clearing/ Dumping: The recorder will start automatic clearing/ 

dumping processing 
 Go to Menu  > Event, AutoClear/ AutoDump: After deleting memory, there will be AutoClear or 

AutoDump message on the event list. 
 

 
PR10-Memory Full 
 

 
PR30-Memory Full 
 

 
Auto data dumping to SD 
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Auto data clearing w/o external storage 
 

 
AutoClear type displayed under Event  
 

 
AutoDump type displayed under Event  
 
New modifications since V1.60: 
○ Add function: A new mechanism for making the free space of the external storage >= 512MB by 

automatically clearing the oldest data is added. 
 
 

1.7 Smart Mechanism 

 The recorded data is stored in the manufacturer’s special binary format. It is not possible to manipulate or 
modify the recorded data. This feature fully guarantees the security of the data. 
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1.8   Ordering Code 

1.8.1 PR10 Ordering Code 

 PR1003 (3 Analog Inputs)   
                 Other Inputs and Outputs 
       0:   none 
        6:   3 relays + 3 DI 
PR1006 (6 Analog Inputs)  
                Other Inputs and Outputs 
        0:   none 
      1:   6 relays 
    3:   6DI 
      6:   3 relays + 3 DI 
     7:   6 relays + 6 DI 
Power  
       A: 90-250 VAC, 50/60 Hz 
       D: 11-36 VDC 
Communication 

       0:  standard Ethernet interface 
       1:  Ethernet + RS-232 
       2:  Ethernet + RS-422/485 
Firmware 
       0:  Standard Version with Mathematic Functions 
       1: Plus Version 1 with external channels, batch & FDA 21 CFR part 11 and  
           EMS/ optional Multi Power Transduer 
       2: Plus Version 2 with editable custom display and Panel Studio software,  

w/o EMS  
       3: Plus Version 3- includes Plus Version 1+2 above,  

EMS/ optional Multi Power Transduer      
PC Software 
       1: Free Basic Software of Historical Viewer and Configuration 
       2: Extensive software Data Acquisition Studio                                                                                                         
          (Real-Time Viewer + Historical Viewer + Configuration) 
Mounting types, Power Cord & Switch  
       0: panel mount, no power cord, no power switch 
       1: panel mount, no power cord, power switch 
       2: portable, UL & CSA power cord, power switch 
       3: portable, VDE power cord, power switch 
       4: portable, SAA power cord, power switch 
       5: portable, BS power cord, power switch 
       6: portable, no power cord, power switch 
       7: Panel mount, UL & CSA power cord, power switch 
       8: Panel mount, VDE power cord, power switch 
       9: Panel mount, SAA power cord, power switch 
       A: Panel mount, BS power cord, power switch     
Special options  
       00: none 
       S1: 16G SD card 
       S2: 32G SD card 
    
 

Note: 
       DI- Digital Input 
       PID Process Control card can be purchased separately. 



 
 

 
 

Page 27 of 550 

 

1.8.2 PR20 Ordering Code 

PR2003 (3 Analog Inputs)    
   Other Inputs and Outputs 
     0:   none 
      6:   3 relays + 3 DI 

   C:   3 relays + 3 DI + 6 AO 

PR2006 (6 Analog Inputs)  
 Other Inputs and Outputs 

0: none           1:  6 Relays 
    3:  6 DI           5:  6 AO 

6:  3 relays + 3 DI                                                  Special options 
7:  6 relays + 6 DI                                                                                                                               (Select from the option 
A:  6 relays + 6 AO                                                                                                                                  in the next page) 
B:  6 DI + 6 AO                                  
C:   3 relays + 3 DI + 6 AO 
D:  6 relays + 6 DI + 6 AO 

PR2009 / PR2012 (9 / 12 Analog Inputs)             
 Other Inputs and Outputs                      

0:  none           1:  6 Relays          
           2:  12 Relays   3:  6 DI 

4:  12 DI           5:  6 AO                                                                                         
6:  3 relays + 3 DI                                                                        
7:  6 relays + 6 DI 
8:  9 relays + 3 DI 
9:  3 relays + 9 DI 
A:  6 relays + 6 AO 
B:  6 DI + 6 AO 
C:  3 relays + 3 DI + 6 AO 

PR2015 / PR2018 (15 / 18 Analog Inputs)  
  Other Inputs and Outputs 

0:  none    1:  6 Relays 
     3:  6 DI      5:  6 AO  

6:  3 relays + 3 DI 
PR2021 / PR2024 (21 / 24 Analog Inputs)  
 Other Inputs and Outputs 
        0:  none 
Power  
       A: 90-250 VAC, 50/60 Hz 
       D: 11-36 VDC 
Communication 

       0:  standard Ethernet interface 
       1:  Ethernet + RS-232 
       2:  Ethernet + RS-422/485 
Firmware 
       0:  Standard Version with Mathematic Functions 
       1: Plus Version 1 with external channels, batch & FDA 21 CFR part 11 and   
           EMS/ optional Multi Power Transduer 
       2: Plus Version 2 with editable custom display and Panel Studio software,  

w/o EMS  
       3: Plus Version 3- includes Plus Version 1+2 above,  

EMS/ optional Multi Power Transduer     
PC Software 
       1: Free Basic Software of Historical Viewer and Configuration 
       2: Extensive software Data Acquisition Studio                                                                                                         
          (Real-Time Viewer + Historical Viewer + Configuration) 
Mounting types, Power Cord & Switch  
       0: panel mount, no power cord, no power switch 
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       1: panel mount, no power cord, power switch 
       2: portable, UL & CSA power cord, power switch 
       3: portable, VDE power cord, power switch 
       4: portable, SAA power cord, power switch 
       5: portable, BS power cord, power switch 
  Special options  
       00: none 
       S1: 16G SD card 
       S2: 32G SD card  
       A0: AI206 upgrade to AI306  
       A1: AI206 upgrade to AI306 + 16G SD card 
       A2: AI206 upgrade to AI306 + 32G SD card  
       *AI306L Non-UL Certify, Self-Declaration of Conformity  
        
 
Note: 
       DI- Digital Input 
       AO- Analog Output 
       PID Process Control card can be purchased separately 
       Process control card cannot be chosen together with  
       5: 6AO,  
       A: 6 relays + 6AO 
       B: 6DI +6AO 
       C: 3 relays + 3DI + 6AO 
       D: 6 relays + 6DI + 6AO  
       Nor with 24 analog inputs 
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1.8.3 PR30 Ordering Code 

PR3006 (6 Analog Inputs)   - 
PR3012 (12 Analog Inputs) 
PR3018 (18 Analog Inputs)             
PR3024 (24 Analog Inputs)  
PR3030 (30 Analog Inputs)  
PR3036 (36 Analog Inputs)  
PR3042 (42 Analog Inputs)  
PR3048 (48 Analog Inputs)  
  

Relay 
       0:  none 
       1:  6 Relays 
       2:  12 Relays 
       3:  18 Relays 
       4:  24 Relays 

Digital Inputs  
      0:  none 
       1:  6 Channels 
       2:  12 Channels 
       3:  18 Channels 
Analog Outputs  
       0:  none 
       1: 6 Channels 
       2: 12 Channels 
Power  
       A: 90-250 VAC, 50/60 Hz 
       D: 11-36 VDC (UL Certification Not available) 
Communication 

       0:  standard Ethernet interface 
       1:  Ethernet + RS-232 
       2:  Ethernet + RS-422/485 
Firmware 
       0:  Standard Version with Mathematic Functions 
       1: Plus Version 1 with external channels, batch & FDA 21 CFR part 11,   

EMS/ optional Multi Power Transduer 
       2: Plus Version 2 with editable custom display and Panel Studio software, w/o EMS  
       3: Plus Version 3- includes Plus Version 1+2 above, EMS/ optional Multi Power Transduer      
PC Software 
       1: Free Basic Software of Historical Viewer and Configuration 
       2: Extensive software Data Acquisition Studio                                                                                                         
          (Real-Time Viewer + Historical Viewer + Configuration) 
Mounting types, Power Cord & Switch  
       0: panel mount, no power cord, no power switch 
       1: panel mount, no power cord, power switch 
       2: portable, UL & CSA power cord, power switch 
       3: portable, VDE power cord, power switch 
       4: portable, SAA power cord, power switch 
       5: portable, BS power cord, power switch 
       6: portable, no power cord, power switch 
       7: Panel mount, UL & CSA power cord, power switch 
       8: Panel mount, VDE power cord, power switch 
       9: Panel mount, SAA power cord, power switch 
       A: Panel mount, BS power cord, power switch     
Special options  
       00: none                             A0: AI206 upgrade to AI306 
       S1: 16G SD card                A1: AI206 upgrade to AI306 + 16G SD card 
       S2: 32G SD card                A2: AI206 upgrade to AI306 + 32G SD card 

*AI306: Non-UL Certify, Self-Declaration of Conformity 
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1.8.4 PID Process Control Card PC201 Ordering Code 

                              PC201- 
 
 
Output 1 
    0: None 
    1: Relay 2A/240VAC 
    2: Pulse voltage to drive SSR, 5V/30mA 
    3: Isolated 4-20mA/0-20mA (OM95-3) 
    4: Isolated 1-5V/0-5V (OM95-4) 
    5: Isolated 0-10V (OM95-5) 
    6: Triac output 1A/240VAC, SSR 
    C: Pulse voltage to drive SSR, 14V/40mA (OM94-7) 
Output 2 
    0: None 
    1: Relay 2A/240VAC 
    2: Pulse voltage to drive SSR, 5V/30mA 
    3: Isolated 4-20mA/0-20mA (OM95-3) 
    4: Isolated 1-5V/0-5V (OM95-4) 
    5: Isolated 0-10V (OM95-5) 
    6: Triac output 1A/240VAC, SSR 
    7: Isolated 20VDC/25mA power supply (DC94-1) 
    8: Isolated 12VDC/40mA power supply (DC94-2) 
    9: Isolated 5VDC/80mA power supply (DC94-3) 
    C: Pulse voltage to drive SSR, 14V/40mA (OM94-7) 
Alarm 1 
   0: None 
   1: Form C relay 2A/240VAC 
Alarm 2 
   0: None 
   1: Form A relay 2A/240VAC 
 

**Non-UL Certify, Self-Declaration of Conformity 
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1.8.5 Accessories 

 

Part no Description 

AI203 3-channel analog input card (TC, RTD, mA, V, mV) 

AI206 6-channel analog input card (TC, RTD, mA, V, mV) 

AI306 
6-channel analog input card (TC, RTD, mA, V, mV) 
*Non-UL Certify, Self-Declaration of Conformity 

PC201 
PID process control card 
*Non-UL Certify, Self-Declaration of Conformity 

RO206 6-channel relay output card 

DI206 6-channel digital input card 

RD233 3-channel relay output and 3-channel digital input card 

AO206 6-channel analog output card 

IF232 RS-232 communication module for PR10 and PR20 

IF485 RS-422/485 communication module for PR10 and PR20 

IF232A RS-232 communication module for PR30 

IF485A RS-422/485 communication module for PR30 

PM201 
90-250VAC 47-63Hz panel mount power supply board without power switch for  PR10 and 
PR20 

PM202 90-250VAC 47-63Hz panel mount power supply board with power switch For PR10 and PR20 

PM203 90-250VAC 47-63Hz portable power supply board with a power switch for PR10 and PR20 

PM211 11-36VDC panel mount power supply board without power switch for PR10 and  PR20 

PM212 11-36VDC panel mount power supply board with a power switch for PR10 and PR20  

PM213 11-36VDC portable power supply board with a power switch for PR10 and PR20 

PM301 90-250VAC 47-63Hz panel mount power supply board without power Switch for  PR30 

PM302 90-250VAC 47-63Hz panel mount power supply board with power switch For PR30 

PM303 90-250VAC 47-63Hz portable power supply board with a power switch for PR30  

PM311 11-36VDC panel mount power supply board without power switch for PR30 

PM312 11-36VDC panel mount power supply board with a power switch for PR30 

PM313 11-36VDC portable power supply board with a power switch for PR30  
 

1-1 Accessories Ordering Code 

Note: 
 The rear slots of the recorder will accept certain Input or output cards only in any combination 

based on the selected model.  
 The basic PC software is supplied free with the recorder.  There is an additional charge for the 

extensive Data Acquisition Software and communication ports of RS-232/422/485. 
 The Ordering Code for various standard model Recorders with an AC supply and without any 

additional options are as follows: 
PR1003- 0A001000 
PR2003- 0A001000 
PR3006- 000A001000 

 
 New modifications since V2.0 (2507)  
 Add function:  

AI306 has been added as a basic feature   
AMS2750 compliance with the accuracy of +/- 0.6 °C, it only supports PR10 and PR20. 
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1.9 Specifications 

1.9.1 General Specifications 

 PR10 PR20 PR30 

Number of Analog Input  3,6 3,6,12,18,24 6,12,18,24,30,36,42,48 

Input Signals 

Thermocouples: J, K, T, E, B, R, S, N, L, U, P, W5, W3, LR, A1, A2, A3, M 
RTD: PT50, PT100, PT200, PT500, PT1000(α=0.00385), PT50, 
PT100(α=0.00391), JPT50, JPT100, JPT200, JPT500, JPT1000(α=0.003916), 
Cu10(α=0.00427), Cu50, Cu100(α=0.00426, 0.00428), Ni100, Ni200, Ni500, 
Ni1000(α=0.00617), Current(mA), Voltage (Volts, mV) 

Fastest Sampling rate 100msec/dot, Default setting: 1sec/dot 

Calibration Correction On-site Calibration possible or using Offset and Gain for correction 

Power 
90-250VAC, 47-63Hz, 52VA, 26W 
maximum 
11-36VDC, 26VA, 26W maximum 

90-250VAC, 47-63Hz, 110VA, 62W 
maximum, 
11-36VDC, 62VA, 62W maximum (UL 
Certification Not available) 
 

Display Size 4.3” 5.6” 12.1” 

Display Type 65K Colour, TFT Touch Screen 

Display Resolution 480 x 272 640 x 480 1024 x 768 

Backlight LED 

Display MTBF @25°C  20000 Hours 60000 Hours 

CPU  ARM Cortex-A8, 1GHz 

Internal Memory 256MB 

External Storage Max. Up to 32GB SD Card or USB Disk 

SD Card Slot Standard one slot at Front 

USB Slot Standard one USB slot in front and one USB slot in the rear  

Pulse Input Optional DI card support pulse Input up to 100Hz 

PID Process Control 
PID, Ramp & Dwell 
**Non-UL Certify, Self-Declaration of Conformity 

Math Channel Available by Standard version 

External Channel, 
Batch, Custom Display, 
FDA 21 CFR Part 11 

Available by plus versions 

Multilingual 

Convenient for local users by offering languages in Brazil Portuguese, Chinese 
(Simplified, Traditional), Czech, Danish, Dutch, English, French, German, Greek, 
Italian, Japanese, Korean, Polish, Portuguese, Russian, Spanish, Swedish, Thai, 
Turkish. Other Languages are negotiable. 

Screen saver, Email Available by Standard version 

Ethernet 
Standard Ethernet Port. Modbus TCP/IP (Server by default, Client available with 
plus 1 version) 

RS-232/422/485 
Optional RS232 or Optional RS422/485. Modbus RTU (Slave by default, Master 
available with plus 1 version) 

PC Software 
Standard: Historical Viewer + Configuration 
Optional: Extensive Software Data Acquisition Studio for real-time monitoring 
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1.9.2 Analog Input Specifications (AI203, AI206 & AI306) 

Channels: AI203 ~ 3 channels, AI206/AI306 ~ 6 channels 
Resolution: 24 bits  
Sampling Rate: 10 times/ second (100milliseconds) 
Maximum Rating:  

 RTD input ±20V 
 Thermocouple and Voltage input ± 50V 
 mA input ±10V 

Temperature Effect:  
 ±0.1uV ±15PPM of reading for all inputs except mA 
 ±30PPM of reading for mA input  

Sensor Lead Resistance Effect:  
 Thermocouple: 0.32PPM of reading/Ω 
 3-wire RTD: 2.6˚C/Ω of resistance difference of two leads (Based on °C measurement    

temperature for PT100)       
 2-wire RTD: 2.6˚C/Ω of resistance sum of two leads (Based on °C measurement temperature  

for PT100) 
Burn-out Current: 10uA  
Common Mode Rejection Ratio (CMRR): 120dB 
Normal Mode Rejection Ratio (NMRR): 55dB  
Isolation Breakdown Voltage between channels: 1500VAC min.  
Sensor Break Detection:   

 Sensor opened for TC, RTD and mV inputs 
 Below 1 mA for 4-20mA input 
 Below 0.25V for 1-5V inputs 
 Not available for other inputs 

 

Sensor Break Responding Time:  
 Within 1 seconds for TC, RTD and mV inputs 
 0.1 second for 4-20 mA and 1-5V inputs 

 

 New modifications since V2.0 (2507)  
 Add function:  

AI306 has been added as a basic feature   
AMS2750 compliance with the accuracy of +/- 0.6 °C, it only supports PR10 and PR20. 
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Input Characteristics: 

Type Range Accuracy at 25 ˚C 
Input 
Impedance 

J -120 ~ 1000 ˚C (-184 ~ 1832 ˚F) ±1 ˚C 3.12MΩ 

K -200 ~ 1370 ˚C (-328 ~ 2498 ˚F) ±1 ˚C 3.12MΩ 

T -250 ~ 400˚C (-418 ~ 752˚F) ±1 ˚C 3.12MΩ 

E -100 ~ 800 ˚C (-148 ~ 1472 ˚F) ±1 ˚C 3.12MΩ 

B 0 ~ 1820 ˚C (32 ~ 3308 ˚F) ±2˚C (200 ~ 1820˚C) 3.12MΩ 

R 0 ~ 1760 ˚C (32 ~ 3200 ˚F) ±2 ˚C 3.12MΩ 

S 0 ~ 1760 ˚C (32 ~ 3200 ˚F) ±2 ˚C 3.12MΩ 

N -250 ~ 1300 ˚C (-418 ~ 2372 ˚F) ±1 ˚C 3.12MΩ 

L -200 ~ 900 ˚C (-328 ~ 1652 ˚F) ±1 ˚C 3.12MΩ 

U -200 ~ 600˚C (-328 ~ 1112 ˚F) ±1 ˚C 3.12MΩ 

P 0 ~ 1395 ˚C (32~2543 ˚F) ±1 ˚C 3.12MΩ 

W5 or C 0 ~ 2315 ˚C (32 ~ 4199˚F) ±1 ˚C 3.12MΩ 

W3 0 ~ 2315˚C (32 ~ 4199 ˚F) ±1 ˚C 3.12MΩ 

LR -200 ~ 800 ˚C (-328 ~ 1472 ˚F) ±1 ˚C 3.12MΩ 

A1 0 ~ 2500 ˚C (-32 ~ 4532 ˚F) ±1 ˚C 3.12MΩ 

A2 0 ~ 1800 ˚C (-32 ~ 3272 ˚F) ±1 ˚C 3.12MΩ 

A3 0 ~ 1800 ˚C (-32 ~ 3272 ˚F) ±1 ˚C 3.12MΩ 

M -200 ~ 100 ˚C (-328 ~ 212 ˚F) ±1 ˚C 3.12MΩ 

PT50  
(α = 0.00385) 

-200 ~ 850 ˚C (-328 ~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

PT100  
(α = 0.00385) 

-200 ~ 850 ˚C (-328~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

PT200  
(α = 0.00385) 

-200 ~ 850 ˚C (-328 ~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

PT500  
(α = 0.00385) 

-200 ~ 850 ˚C (-328 ~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

PT1000  
(α = 0.00385) 

-200 ~ 350 ˚C (-328 ~ 662 ˚F) ±0.4 ˚C 2.0KΩ 

PT50  
(α = 0.00391) 

-200 ~ 850 ˚C (-328 ~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

PT100  
(α = 0.00391) 

-200 ~ 850 ˚C (-328 ~ 1562 ˚F) ±0.4 ˚C 2.0KΩ 

JPT50  
(α = 0.003916) 

-200 ~ 600 ˚C (-328 ~ 1112 ˚F) ±0.4 ˚C 2.0KΩ 

JPT100  
(α = 0.003916) 

-200 ~ 600 ˚C (-328 ~ 1112 ˚F) ±0.4 ˚C 2.0KΩ 

JPT200  
(α = 0.003916) 

-200 ~ 600 ˚C (-328 ~ 1112 ˚F) ±0.4 ˚C 2.0KΩ 

JPT500  
(α = 0.003916) 

-200 ~ 600 ˚C (-328 ~ 1112 ˚F) ±0.4 ˚C 2.0KΩ 

JPT1000  
(α = 0.003916) 

-200 ~350 ˚C (-328 ~ 662 ˚F) ±0.4 ˚C 2.0KΩ 

Cu10  
(α = 0.00427) 

-200 ~ 260 ˚C (-328 ~500 ˚F) ±0.1 ˚C 2.0KΩ 
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Type Range Accuracy at 25 ˚C 
Input 
Impedance 

Cu50  
(α = 0.00426) 

-50 ~ 200 ˚C (-58 ~392 ˚F) ±0.4 ˚C 2.0KΩ 

Cu100  
(α = 0.00426) 

-50 ~ 200 ˚C (-58 ~392 ˚F) ±0.4 ˚C 2.0KΩ 

Ni100  
(α = 0.00617) 

-60 ~ 180 ˚C (-76 ~356 ˚F) ±0.4 ˚C 2.0KΩ 

Ni200  
(α = 0.00617) 

-60 ~ 180 ˚C (-76 ~356 ˚F) ±0.4 ˚C 2.0KΩ 

Ni500  
(α = 0.00617) 

-60 ~ 180 ˚C (-76 ~356 ˚F) ±0.4 ˚C 2.0KΩ 

Ni1000  
(α = 0.00617) 

-60 ~ 180 ˚C (-76 ~356 ˚F) ±0.4 ˚C 2.0KΩ 

±20mA -26 ~ 26mA ±0.05% 75Ω 

±60mV -122 ~ 122mV ±0.05% 3.12MΩ 

±200mV -243 ~ 243mV ±0.05% 3.12MΩ 

±1V -1.58 ~ 1.58mV ±0.05% 3.12MΩ 

±2V -3.16 ~ 3.16mV ±0.05% 3.12MΩ 

±6V -6.32 ~ 6.32V ±0.05% 3.12MΩ 

±20V -25.3 ~ 25.3V ±0.05% 3.12MΩ 

±50V -50.6 ~ 50.6V ±0.05% 3.12MΩ 

0.4 ~ 2V -3.16 ~ 3.16V ±0.05% 3.12MΩ 

1 ~ 5V -6.32 ~ 6.32V ±0.05% 3.12MΩ 
 
 

*Note: 
The ranges above do not represent the operating range of the AI card sensor of the PR machine, rather 
referring to the range within which the sensor guarantees accuracy. Values outside the ranges might be 
inaccurate. 
 

 

Notes 
1  When measuring the T/C temperature, please use standardized T/C cable with Fluke 7526A and 

Evolution Model 525B calibrators. The results of temperature measurement might be inaccurate if use 
the different T/C cable/wire or different calibrators. 

2  When power on the PR for the first time, please wait to warm up at least 1 hour before measurement for 
machinery reaching its operating temperature. If turn off the PR, please must wait for more than 30 
minutes to cool down before operation again. When after 30-minute cooling down and restart the PR unit, 
please wait for 1 hour for warming up before any tasks of operation and measurement; otherwise the 
measured value may be inaccurate. 

3  If there is any error in the temperature measurement of analog input cards (AI20X/ AI30X), please 
manually calibrate the temperature in the PR unit or send it back to the original factory for calibration. 
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1.9.3 Digital Input Specifications (DI206 & RD233) 

Channels:  
 DI206: 6 Channels per card,  
 RD233: 3 Channels per card  
Logic Low: -5V minimum, 0.8V maximum 
Logic High: 3.5V minimum, 24V maximum  
External pull-down Resistance: 1KΩ maximum  
External pull-up Resistance: 1.5MΩ minimum  
 

1.9.4 Relay Output Specifications (RO206 & RD206) 

Channels:  
 RO206: 6 Channels per card, 
  RD233: 3 Channels per card  
Contact Form: N.O. & N.C. (Form C)   
Relay Rating: 1A/240 VAC  
 

1.9.5 Analog Output Specifications (AO206) 

Channels: 6 Channels per card 
Output signal: 4-20mA, 0-20mA, 0-5V, 1-5V, 0-10V 
Resolution: 16 bits 
Accuracy: ±0.05% of Span ±0.0025% /˚C 
Load Resistance: 0-500Ω (current), 10KΩ minimum (voltage) 
Output Regulation: 0.01% for full load change 
Output Setting Time: 0.1 second (stable to 99.9%) 
Isolation Breakdown Voltage: 1500VAC at 50/60Hz for 1 minute 
Integral Linearity Error: ±0.005% of Span 
Temperature Effect: ±0.0025% of Span /˚C  
 

Note:   
 There are DIP switches available on the AO card to select the output type and the default setting is SET to 
Voltage output. For Current (mA) Output, SET 1to 5 (ON) and 6 to 8 (OFF). For more details refer to 
Chapter 5.1.4 
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1.9.6 PID Process Control Card Specifications 

1.9.6.1 Input1 

Resolution: 18 bits 
Sampling Rate: 5 times / second 
Maximum Rating: -2 VDC minimum, 12 VDC maximum (1 minute for mA input) 
Temperature Effect: 1.5uV/°C for all inputs except mA input, ±3.0uV/°C for mA input 
Sensor Lead Resistance Effect: 

 Thermocouple: 0.2uV/Ω 
 3-wire RTD: 2.6°C/Ω of resistance difference of two leads 
 2-wire RTD: 2.6° C/Ω of resistance sum of two leads 

Burn-out Current: 200nA 
Common Mode Rejection Ratio (CMRR): 120dB 
Normal Mode Rejection Ratio (NMRR): 55dB 
Sensor Break Detection:  

 Sensor Open for Thermocouple, RTD and mV inputs 
 Sensor short for RTD input 
 Below 1 mA for 4-20 mA input 
 Below 0.25V for 1 - 5 V input 
 Not available for other inputs. 

Sensor Break Responding Time: 
 Within 4 seconds for TC, RTD and mV inputs 
 0.1 second for 4-20 mA and 1 - 5 V inputs 

 
Input 1 Characteristics: 

Type Range Accuracy @ 25°C 
Input 
Impedance 

J -120°C to 1000°C (-184°F to 1832°F) ±2°C 2.2 MΩ 

K -200°C to 1370°C ( -328°F to 2498°F) ±2°C 2.2 MΩ 

T -250°C to 400°C ( -418°F to 752°F) ±2°C 2.2 MΩ 

E -100°C to 800°C ( -148°F to 1472°F) ±2°C 2.2 MΩ 

B 0°C to 1800°C (32°F to 3200°F) ±2°C (200°C to 1800° C) 2.2 MΩ 

R 0°C to 1760°C (32°F to 3200°F) ±2°C 2.2 MΩ 

S 0°C to 1760°C (32°F to 3200°F) ±2°C 2.2 MΩ 

N -250°C to 1300°C (-418°F to 2372°F) ±2°C 2.2 MΩ 

L -200°C to 900°C (-328°F to 1652°F) ±2°C 2.2 MΩ 

PT100(DIN) -210°C to 700°C (-346°F to 1292°F) ±0.4°C 1.3KΩ 

PT100(JIS) -200°C to 600°C (-328°F to 1112°F) ±0.4°C 1.3Ω 

mV -8mV to 70mV ±0.05% 2.2 MΩ 

mA -3mA to 27mA ±0.05% 70.5Ω 

V -1.3V to 11.5V ±0.05% 302KΩ 
 

*Note: 
The ranges above do not represent the operating range of the AI card sensor of the PR machine, rather 
referring to the range within which the sensor guarantees accuracy. Values outside the ranges might be 
inaccurate. 
 



 
 

 
 

Page 38 of 550 

Notes 
1  When measuring the T/C temperature, please use standardized T/C cable with Fluke 7526A and 

Evolution Model 525B calibrators. The results of temperature measurement might be inaccurate if use 
the different T/C cable/wire or different calibrators. 

2  When power on the PR for the first time, please wait to warm up at least 1 hour before measurement for 
machinery reaching its operating temperature. If turn off the PR, please must wait for more than 30 
minutes to cool down before operation again. When after 30-minute cooling down and restart the PR unit, 
please wait for 1 hour for warming up before any tasks of operation and measurement; otherwise the 
measured value may be inaccurate. 

3  If there is any error in the temperature measurement of analog input cards (AI20X/AI30X), please 
manually calibrate the temperature in the PR unit or send it back to the original factory for calibration. 

 

**Non-UL Certify, Self-Declaration of Conformity 
 

1.9.6.2 Input2 

Resolution: 18 bits 
Sampling Rate: 5 times / second 
Maximum Rating: -2 VDC minimum, 12 VDC maximum (1 minute for mA input) 
Temperature Effect: 1.5uV/°C for all inputs except mA input, ±3.0uV/°C for mA input 
Common Mode Rejection Ratio (CMRR): 120dB 
Normal Mode Rejection Ratio (NMRR): 55dB 
Sensor Break Detection: 

 Below 1 mA for 4-20 mA input 
 Below 0.25V for 1 - 5 V input 
 Not available for other inputs 

Sensor Break Responding Time: 0.5 Seconds 
Input 2 Characteristics: 

Type Range Accuracy @ 25°C Input Impedance 

CT94-1 0.0 to 50.0 A ±2% of Reading ±0.2A 302KΩ 

mA -3mA to 27mA ±0.05% 70.5Ω+(0.8V/Input Current) 

V -1.3V to 11.5V ±0.05% 302KΩ 

 

1.9.6.3 Input3 (Event Input) 

Logic Low: -10V minimum, 0.8V maximum 
Logic high: 2V minimum, 10V maximum 
External pull-down Resistance: 400 KΩ maximum 
External pull-up Resistance: 1.5 MΩ minimum 
Functions:  
 Select second setpoint and/or PID, reset alarm 1 and/or alarm 2, Disable output 1 and/or output 2, 

Remote lockout. 
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1.9.6.4 Output1/ Output2 

1. Relay Rating: 
1A/240 VAC 

2. Pulsed Voltage:  
Source Voltage 5V, current limiting resistance 66Ω 

3. Linear Output:  
   Resolution: 15 bits 
   Output Regulation: 0.01 % for full load change 
   Output Settling Time: 0.1 sec. (stable to 99.9 %) 
   Isolation Breakdown Voltage: 1000 VAC 
   Temperature Effect: ±0.0025 % of SPAN /°C 

 

1.9.6.5 Input3 (Event Input) 

Logic Low: -10V minimum, 0.8V maximum 
Logic high: 2V minimum, 10V maximum 
External pull-down Resistance: 400 KΩ maximum 
External pull-up Resistance: 1.5 MΩ minimum 
Functions:  
 Select second setpoint and/or PID, reset alarm 1 and/or alarm 2, Disable output 1 and/or output 2, 

Remote lockout. 

1.9.6.6 Output1/ Output2 

1. Relay Rating: 
1A/240 VAC, life cycles 200,000 for Resistive load 

2. Pulsed Voltage:  
Source Voltage 5V, current limiting resistance 66Ω 

3. Linear Output:  
  Resolution: 15 bits 
  Output Regulation: 0.01 % for full load change 
  Output Settling Time: 0.1 sec. (stable to 99.9 %) 
  Isolation Breakdown Voltage: 1000 VAC 
  Temperature Effect: ±0.0025 % of SPAN /°C 
 
Linear Output Characteristics: 

Type Zero Tolerance Span Tolerance Load Capacity 

4 to 20mA 3.8-4 mA 20-21 mA 500 Ω max 

0 to 20mA 0 mA 20-21 mA 500 Ω max 

0 to 5V 0 V 5 -5.25 V 10KΩ min 

1 to 5V 0.95 to 1V 5 -5.25 V 10KΩ min 

0 to 10V 0 V 10 - 10.5 V 10KΩ min 
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1. Triac (SSR) Output: 

   Rating: 1A / 240 VAC 
Inrush Current: 20A for 1 cycle 
Min. Load Current: 50 mA RMS 
Max. Off-state Leakage: 3 mA RMS 
Max. On-state Voltage: 1.5 V RMS 
Insulation Resistance: 1000 MΩ minimum at 500 VDC 
Dielectric Strength: 2500 VAC for 1 minute 

 SSR Output Characteristics: 

Type Tolerance 
MaximumOutput 

Current 
Ripple 

Voltage 
Isolation 
Barrier 

20V ±0.5 V 25 mA 0.2 Vp-p 500 VAC 

12V ±0.3 V 40 mA 0.1 Vp-p 500 VAC 

5V ±0.15 V 80 mA 0.05 Vp-p 500 VAC 

 

1.9.6.7 Alarm 1/ Alarm 2 

Alarm 1 Relay: Form C, Max. Rating 2A/240VAC, life cycles 200,000 for resistive load 
Alarm 2 Relay: Form C, Max. Rating 2A/240VAC, life cycles 200,000 for resistive load 
Alarm Mode: Normal, Latching, Hold, Latching / Hold 
Dwell Timer: 0 - 6553.5 minutes 
 

Alarm Functions: 
   Dwell timer, Deviation High / Low Alarm, Deviation Band High / Low Alarm, PV1 High / Low 

Alarm, PV2 High / Low Alarm, PV1 or PV2 High / Low Alarm, PV1-PV2 High / Low Alarm, Loop 
Break Alarm, Sensor Break Alarm 

1.9.6.8 Control Mode 

Output 1: Reverse (heating) or direct (cooling) action 
Output 2: PID cooling control, cooling P band 1~255% of PB 
ON-OFF: 0.1 - 100.0(°F) hysteresis control (P band = 0) 
P or PD: 0 - 100.0 % offset adjustment 
PID:         Fuzzy logic modified Proportional band 0.1 ~ 900.0°F, 
 Integral time: 0 - 1000 Seconds, 
  Derivative time 0 - 360.0 seconds 
Cycle Time: 0.1 - 100.0 seconds 
Manual Control: Heat (MV1) and Cool (MV2) 
Auto-tuning: (MV2) Cold start and warm start 
Self-tuning: Select None and YES 
Failure Mode: Auto-transfer to manual mode while sensor break or A-D converter damage 
Sleep Mode: Enable or Disable 
Ramping Control: 0 - 900.0°F/minute or 0 - 900.0°F/hour ramp rate 
Power Limit: 0 - 100 % output 1 and output 2 
Pump / Pressure Control: Sophisticated functions provided 
Remote Setpoint: Programmable range for voltage or current input 
Differential Control: Control PV1-PV2 at setpoint 
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1.9.6.9 Profiler 

Number of Profiles: 50 
Number of Segments per Profile: 32 
Note: Total Segments are limited to 1000 Segments 
 

1.9.6.10 Digital Filter 

Function: First Order 
Time Constant: 0, 0.2, 0.5, 1, 2, 5, 10, 20, 30, 60 seconds programmable 
 

1.9.7 COMM Module (IF232 and IF485) Specifications 

Interface: RS-232 (IF232-one unit) or RS-485 or RS-422 (IF485- up to 247 units)  
Protocol: Modbus Protocol RTU mode  
Address: 1-247  
Baud Rate: 9.6 ~ 115.2 Kbits/sec.  
Data Length: 7 or 8 bits  
Parity Bit: None, Even or Odd  
Stop Bit: 1 or 2 bits  
 

1.9.8 Standard Ethernet Communication 

Protocol: Modbus TCP/IP, 10/100 Base T  
Ports: AUI (Attachment Unit Interface) and RJ-45, Auto- detect capability  
 

1.9.9 Real-time Clock 

Item Description 

Make Seiko Instruments 

Model MS621-fl11e 

Rating 3V,4mAH 

Typical Life Time 10 Years 

Buffer Period 6 Months 

Type Rechargeable 

Accuracy Maximum ± 2 Seconds/Day 

1.9.9.1 Real-time Clock accuracy vs Temperature inside of the housing 

Temperature Inside Housing Typical Error / Month 

10°C ~ 40 °C 18 Seconds 

0°C or 50 °C 52 Seconds 

-10°C or 60°C 107 Seconds 



 
 

 
 

Page 42 of 550 

1.9.10 Environmental & Physical Specifications 

Operating Temperature: 0 ~ 50 ˚C  
Storage Temperature: -30 ~ 70 ˚C  
Humidity: 20 to 90% RH (non-condensing) 
 Maximum relative humidity 90% is for ambient temperature up to 38˚C decreasing linearly to    

50% relative humidity at 50˚C  
Altitude: 2000 M maximum  
Insulation Resistance: 20 MΩ min. (at 500 VDC)  
Dielectric Strength: 2300VAC, 50/60 Hz for 1 minute between power terminal and earth 
Vibration Resistance: 10-55 Hz, 10m/ s² for 2 hours  
Shock Resistance: 30m/ s² (3g) for operation, 20g for transportation  
Operation Position: no inclined restriction  
Dimensions:  Panel Mount style:  PR10/PR20:144(W) x 144(H) x 193mm (D) 
                                          PR30:288(W) x 288(H) x 194mm (D)  
       Standard Panel Cut-out: PR10/PR20:137 x 137mm 
                                    PR30:281 x 281mm 
 

1.9.11 Approval Standards 

Safety:   
 UL 61010-1, CAN/ CSA-C22.2 No. 61010-1-12 
    CE: EN61010-1 (IEC1010-1) over voltage category II, Pollution degree 2 
Protective Class:    
 IP 65 front panel for indoor use  
 IP 20 housing and terminals 

(Non-UL Certify, Self-Declaration of Conformity)  
EMC:                    
           Emission:  EN61326-1 (EN55022 class A, EN61000-3-2, EN61000-3-3) 
 Immunity: EN61326-1 (EN61000-4-2, EN61000-4-3, EN61000-4-4, 
 EN61000-4-5, EN61000-4-6, EN61000-4-8, EN61000-4-11) 
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2. Installation and Wiring 

 Sometimes dangerous voltages capable of causing death are present in this instrument. Before doing 
the installation or any troubleshooting procedures, the power to the equipment must be switched off 
and isolated. Units suspected of being faulty must be disconnected and removed to a properly 
equipped workshop for testing and repair. Component replacement and internal adjustments must be 
made by a qualified maintenance person only. 

 To minimize the possibility of fire or shock hazards, do not expose this instrument to rain or excessive 
moisture. 

 Do not use this instrument in areas under hazardous conditions such as excessive shock, vibration, dirt, 
moisture, corrosive gases or oil. The ambient temperature of the area should not exceed the maximum 
rating specified in the specification 

 Remove stains from this equipment using a soft, dry cloth. Do not use harsh chemicals, volatile 
solvents such as thinner or strong detergents to clean the equipment in order to avoid deformation. 

 If the equipment is used in a manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired. 

 The installation that the safety of any system incorporating the equipment is the responsibility of the 
assembler of the system. 
L'installation ainsi que la sécurité de tout système intégrant l'équipement relèvent de la responsabilité 
de l'assembleur du système. 

 

2.1 Unpacking 

Upon receipt of the shipment, remove the recorder from the carton and inspect the unit for shipping damage. 
If any damage is found, contact your local representative immediately. Note the model number and serial 
number for future reference when corresponding with our service centre. The serial number (S/N) is labelled 
on the box and the housing of the recorder. 
The recorder is designed for indoor use only and is not intended for use in any hazardous area. It should be 
kept away from shock, vibration, and electromagnetic fields (such as variable frequency drives), motors and 
transformers. It is intended to operate under the following environmental conditions. 
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Environmental Parameter Specification 

Operating Temperature 0°C to 50 °C 

Humidity 20% to 90% RH (Non-condensing) 

Altitude 2000 M Maximum 

Pollution Degree II   

Pollution Degree Level II as 
defined in 

UL 61010-1, CAN/CSA-C22.2 No. 61010-1-12 

OVERVOLTAGE 
CATEGORY (OVC) 

II 

Power 90 ~ 250 VAC, 50/60 Hz or 11-36 VDC 

Input Voltage Fluctuation -10% ~ +10% 

Enclosure type 
Indoor use 
The product is Open type, intended to be installed in a final enclosure. 

 
For any repair or maintenance needs, please contact us. 
 

偉林電子股份有限公司 

Brainchild Electronic Co.,Ltd. 
Tel : 886-2-27861299 
 

 

Protective Earth 
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2.2 Dimensions 

2.2.1 Panel Mounting Style                                      

2.2.1.1 PR10 

                                       

 
2-1 PR10 Front Side 

                    

 
2-2 PR10 Right Side 

 
 
 



 
 

 
 

Page 46 of 550 

 
 

2-3 PR10 Panel Cut-out Dimensions 

                                 

2.2.1.2 PR20 

 

 
 

2-4 PR20 Front Side 
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2-5 PR20 Right Side 

 
 

 
 

2-6 PR20 Panel Cut-out Dimensions 
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2.2.1.3 PR30 

 
 

2-7 PR30 Front Side 
 

 
 

2-8 PR30 Right Side 
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2-9 PR30 Cut-out Dimensions 

Note: 
 Do not over tighten mounting clamp screws that could result in distortion of the case. 
 There is no mounting angle restriction. 
 The mounting torque used for 4 sides of the housing should be 2.0 kgf-cm and not more than 2.5 

Kgf-cm 
 

2.2.2 Portable Styles 

 
PR10                             PR20                                     PR30 
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2.2.2.1 Bottom Side View of PR20 & PR10   

 

 
 

2-10 PR10 & PR20 Portable Type Bottom Side View 
             

2.2.2.2 Front Side View of PR20 & PR10 
 
         
                                     

                                
 

2-11 PR10 & PR20 Portable Type Front Side View 
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2.2.2.3 Bottom Side View of PR30 

 

                     
 

2-12 PR30 Portable Type Bottom Side View 
 
 
 
                                      

2.2.2.4 Front Side View of PR30      
 

                 
 

2-13 PR30 Portable Type Front Side View  
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2.2.2.5 Bottom Stand Clips 
 

               
 

2-14 Portable Type Bottom Stand Clips 

 
 
 

2.2.2.6 Top Holding Handle 
 

                        
 
 

2-15 Portable Type Top Holding Handle 
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2.3 Input and Output Configuration 
 

Input and Output Configuration 
The Input and Output cards need to be inserted to the rear slots or removed from the rear slots at the Power 
OFF condition. Failure to do so may cause damage to the module or device or both. The Device will 
automatically detect the cards at Power ON, once it is inserted into the rear slots. 
 

2.3.1 Analog Input Card (AI203, AI206 & AI306) 

 AI203/ AI206/ AI306 are analog input cards with 3 and 6 channels respectively. Each card includes 
universal inputs of TC (J, K, T, E, B, R, S, N, L, U, P, W5, W3, LR, A1, A2, A3, and M), RTD, mV, mA, V. 
The accepted input types and sensor range for analog input are listed in Chapter 1.9. Plug the AI card into 
the rear slot then power on. The recorder will automatically detect the card and display the specific input 
type and its location in a specific slot in System Information mode while doing the configuration. 
 The configuration Menu can be reached by pressing Menu and then pressing more and then pressing 
Config key. It will display a tree-type configuration layout for easy user configuration. By using Up/Down Key 
and Enter Key, AI configuration window can be reached. In this window, the user can configure the AI 
parameters. The user can select the desired input type and other parameters for analog input in this window. 
 

 
 

 

AI203                                     AI206                                       AI306 
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2.3.2 Relay Output Card (RO206) 

 The relay output card RO206 includes 6 relays rated 1 Amp/240 VAC each. Plug the card into a rear slot 
and power on the recorder.  The recorder will automatically detect the card and display the output type and 
its location in a specific slot in System Info mode while doing the configuration.  
 The configuration Menu can be reached by pressing Menu and then pressing more and then pressing 
Config key. It will display a tree-type configuration layout for easy user configuration. By using Up/Down Key 
and Enter Key, DO configuration window can be reached. In this window, the user can configure the DO 
parameters. The user can select the desired output type and other parameters for Relay output in this 
window. The item "Reverse" is to reverse the output status. 
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2.3.3  Digital Input Card (DI206)   

 This card includes 6 channels of event inputs.  As above, plug the card into rear slot and power on the 
recorder. The recorder will automatically detect it, and then display the input type and its location in a 
specific slot in System Information mode while doing the configuration. 
The configuration Menu can be reached by pressing Menu and then pressing more and then pressing 
Config key. It will display a tree-type configuration layout for easy user configuration. By using Up/Down Key 
and Enter Key, DI configuration window can be reached. In this window, the user can configure the DI 
parameters. The user can select the desired input type and other parameters for digital input in this window. 
The item "Type" is for the user to decide if this channel will have a logic level or Pulse Counter input. If you 
select Pulse Counter, the item "Frequency" will appear for you to select input frequency (100Hz). The item 
"Events" can be added to do further control. 
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2.3.4 Combination Digital Input and Output Card (RD233)   

This card includes 3 relays rated 5 Amp/240VAC each and 3 Channels of Digital Inputs. As above, plug the 
card into rear slot and power on the recorder. The recorder will automatically detect it, and then display the 
input type and the output type on its location in a specific slot in System Information mode while doing the 
configuration. The first 3 channels are for relays (Terminal 1 to 9) and the last 3 channels are for Digital 
inputs (Terminals 10 to 18). The setup is similar to relay output card and digital input card. 
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2.3.5 Analog Output Cards (AO206) 

 These cards are 6-channel analog output cards.  They are used to retransmit process values to other 
devices like meters, controllers, etc. The configuration Menu can be reached by pressing Menu and then 
pressing more and then pressing Config key. It will display a tree-type configuration layout for easy user 
configuration. By using Up/Down Key and Enter Key, AO configuration window can be reached. In this 
window, the user can configure the AO parameters. The user can select the desired output type and other 
parameters for analog output in this window. 
Note: There is a dip switch on the AO206 card to select the current or voltage output for each channel. 
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2.3.6 PID Process Control Module (PC201) 

 This is a single loop PID Control Module which consists of Universal Input. The Module output can be 
configured by using the Configuration Menu. The configuration Menu can be reached by pressing Menu and 
then pressing more and then pressing Config key. It will display a tree-type configuration layout for easy 
user configuration. By using Up/Down Key and Enter Key, PID Controller and Profile configuration window 
can be reached. In this window, the user can configure the Controller parameters and profiles of PID Control 
Module. The user can select the desired output type and other parameters for analog output in this window. 
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2.3.7 IO Modules Expansion 

Note: 
 The IO Modules should not be removed or Inserted to the device when the power is ON. This 

should be carried out in the Power OFF Condition only. 
 For removing the IO Modules, First, remove the metal screws then remove the plastic screws, after 

that press the lock on the top and bottom of the Card and pull to remove it. Failing to do so will 
damage the IO Card. Please follow the Recorder user manual for more information. 

 The Maximum Torque for the metal screw is 3Kg-cm (2.6in-lb) and the Maximum Torque for the 
plastic screw is 0.8Kgf-cm (.7in-lb). 

 Calibration should be carried out by a qualified Engineer with qualified equipment only. 
 Thermocouple inputs require 1-hour initial warm-up time during initial setup. 
 For some industries who prefer circular chart displays, PR30 can offer this Unique feature and set 

the display speed for each page/circle in 30 minutes, 1, 2, 4, 8, 12 hours, 1, 2 days, or 1, 2, 4 weeks. 
  

 
 
 
 
 
 

Plastic screws                                                                      
position                                                                                    Metal 

screws 
position 
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IO Modules Expansion 

 
 

                  
 

PR10                                                                   
(4  Slots, up to 6 AI)         

                                   

     
 

  PR20 
(4  Slots, up to 24 AI) 
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PR30 
 (16 Slots, up to 48 AI) 

 

2.4 Wiring 

2.4.1 Wiring Precautions 
 

  Care must be taken to ensure that the maximum voltage rating specified on the label is not exceeded. 

  For the panel-mount version, it is recommended that near an external fuse or an external switch rated 
at 2A/250 VAC should be used. 

  Beware not to over tighten the terminals screws.  The torque should not exceed 0.4 N-m (3.6 Lb-in or 
4.0 Kg F-cm). 

  With the exception of the thermocouple wires, all wires should be stranded copper conductor with the 
maximum gauge of 18 AWG. 

  Connect a grounding conductor with 1.6mm diameter minimum to provide protective grounding prior to 
turning on the equipment. 

  Power Terminal Block plug wiring size 14-22 AWG. 
Câblage de la fiche du bornier d'alimentation, taille 14-22 AWG. 
Tighten terminal screws with a torque value of 12 b-in. 
Serrez les vis des bornes avec un couple de 12 lb-in. 
The rating of the power wire used must be at least 105°C. 
La température nominale du fil d'alimentation utilisé doit être d'au moins 105°C. 

  
Use Copper Conductors Only. 
Utilisez uniquement des conducteurs en cuivre. 
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2.4.2 Analog Input Wiring 

2.4.2.1 AI206 Wiring 
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2.4.2.2 AI203 Wiring 
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2.4.2.3 AI306 Wiring 
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2.4.3 Relay Output Wiring 

2.4.3.1 RO206 
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2.4.4 Digital Input Wiring 

2.4.4.1 DI206 
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2.4.5 Combination Relay Output and Digital Input Wiring 

2.4.5.1 RD233 
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2.4.6 Analog Output Wiring 

2.4.6.1 AO206 
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2.4.7 PID Process Control Card Wiring 

2.4.7.1 PC201 
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2.4.8 RS-232, RS-422, and RS-485 Wiring 

2.4.8.1 RS232 Wiring 
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2.4.8.2 RS422 Wiring 

 
 

 
                             

RS232 to RS422 Converter 
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2.4.8.3 RS485 Wiring 

 
       

2.5 External Memory Card 

There are two types of external storage for the User to use in the recorder. One is the SD card and the other 
is USB memory. There are two slots for inserting USB memory, one in the front and other on the rear side of 
the recorder.  If the bigger capacity USB memory is required, the user may buy it locally. The SD card slot is 
on the front side. Please see the below figures for more information. 

 

Note 
 

 The maximum capacity of external memory supported by the recorder is 32GB. The external memory must be 
formatted to FAT or FAT32. 

 To read measured data and events on a USB memory and SD card memory, it is necessary to install either the 
free basic software or the Extensive Data Acquisition software on PC first.  

 

RS232 to RS485 Converter 
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Security Lock 

 



 
 

 
 

Page 74 of 550 

3. BASIC FUNCTIONS OF RECORDERS 

3.1 Configuration 

 The configuration of the recorder follows a tree type layout. This makes it easy for the users to go through 
the different sub-menus easily and do not miss any configuration.     
                

 
 

3.2 Firmware 

The PR series recorder has 4 different versions of firmware for the user to select as per the application 
requirement. 

1. Standard Firmware 
2. Plus 1 Firmware 
3. Plus 2 Firmware 
4. Plus 3 Firmware 

3.2.1 Standard Firmware 

 The standard version of firmware has Input and output configuration, Math functions (Counter, Totalizer), 
PID Controller function with PID Process control card. This firmware does not include External channels, 
Custom Edited Display, Batch, or FDA 21 CFR part11 functions.   

3.2.2 Plus 1 Firmware 

 The plus 1 firmware has the external channel, Batch, FDA 21CFR Part 11 functions along with the functions 
available in standard version firmware. This firmware does not include custom display function. 

3.2.3 Plus 2 Firmware 

 The plus 2 firmware version has custom display function similar to HMI along with the functions available in 
standard version firmware. This firmware does not include external channel, Batch, FDA 21CFR part11 
functions. 
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3.2.4 Plus 3 Firmware 

 The plus 3 firmware has all the functions of standard, plus1, plus 2 version firmware. 

3.3 Pulse Input through Digital Input 

 The recorder will support pulse input up to 100Hz via a digital input. The digital input can be configured as a 
pulse counter to count the no of pulses.  

3.4 PID Control with Ramp & Soak Profile Function 

 The recorder has the option to use PID control function by using the PC201 PID process control card. The 
PID Control Module includes Ramp & Dwell function. It is useful to control the process with varying setpoint 
from time to time. There are 50 different Profiles can be configured with 32 Segments/Profile with the limit of 
1000 Segments totally. 

3.5 On-Field Calibration 

 The Device allows the user to do on-field calibration for the device. No need to send the device to the 
factory for Calibration. 
Note: The calibration must be carried out by a skilled person with proper instruments. 

3.6 Communication with Third-Party Interfaces 

 The Recorder has the flexibility to communicate with Third-party Interfaces via protocols such as Modbus 
TCP/IP or Modbus RTU as either a Modbus Master or Modbus Slave. The detailed configuration and related 
information are available in Chapter 5 Configuration, and Section 5.9.  

3.7 Web Server 

The Recorder real time trend and Digital data can be viewed in any place in the world if the recorder have 
Web Server connectivity. For this, the Recorder should be connected to the Internet with a fixed IP address 
provided by the Internet Service provider.   
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3.8 Email 

 Important system events and alarms can be sent as an email.  The detailed configuration and related 
information are available in Chapter 5, Configuration, and Section 5.9.5. 

3.9 Handwriting Messages on Historical Trend Screens 

 Handwriting Messages on Historical trend screen is a useful feature for the user to highlight important 
events. The User can write handwritten messages using a stylus on Historical Trend screens. This is shown 
in the below picture.                          
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3.10 Custom Display Screen 

In plus 2 and plus 3 versions of the firmware, the recorder allows the user to download the custom screens 
linked with Analog and Digital Tags from the custom display editor software Panel Studio. The custom 
display screens are called custom page in the recorder. The software used to create custom screen called a 
custom screen editor (Panel studio). 
 

 

3.11 Log Speed Flexibility 

 The recorder has various log speed flexibility for the user to select as per their requirement. The available 
log speeds are 100ms/Dot, 1 Sec/Dot, 2 Sec/Dot, 5 Sec/Dot, 10 Sec/Dot, 15 Sec/Dot, 20 Sec/Dot, 30 Sec/ 
Dot, 1 Min/Dot, 2 Min/Dot, 5 Min/Dot, 10 Min/Dot, 15 Min / Dot, 1 Hour/Dot, 2 Hour/Dot. The User has a lot 
of flexibility in logging speeds to select as per the application requirement. 

3.12 System Clock Synchronization via Internet 

 The Recorder System clock can be synchronized via the internet and Summer Saving Time can be defined. 
The detailed configuration and related information are available in Chapter 5, Configuration, and Section 5.8.  

3.13 Increased Security 

 The security mode can be configured as normal or CFR-21. For normal, there is only one password can be 
defined for configuration. For CFR-21, there are 9 levels of password with 30 users can be defined for 
different functions. The detailed configuration and related information are available in Chapter 5, 
Configuration, and Section5.11. 

3.14 Auto Output to Printer 

 The Historical data can be directly printed automatically by a printer or can be saved as a PDF file using a 
PDF printer. The detailed configuration and related information are available in Chapter 5, Configuration, 
and Section 5.13. 
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3.15 External Channels 

 Besides onboard AI and DI inputs, the recorder can accept inputs through Modbus communication. The 
PR10, PR20, and PR30 can have a maximum of up to 24, 48 and 96 channels respectively. The detailed 
configuration and related information are available in Chapter 5, Configuration, and Section 5.9. 

3.16 Batch 

 Using this function, the recorded data can be stored in batches.  This makes it easy for the user to analyse 
the historical data. 

3.17 FDA 21 CFR PART 11 

 This feature is meant to comply with U.S. Food and Drug Administration with a human health concern. 
When this feature is enabled, the recorded data cannot be manipulated. 

3.18 Circular Chart  

 PR30 has a unique feature to display the trend in circular chart mode. The recorder has various log speed 
flexibility for the user to select as per their requirement. The available log speeds are 100ms/Dot, 1 Sec/Dot, 
2 Sec/Dot, 5 Sec/Dot, 10 Sec/Dot, 15 Sec/Dot, 20 Sec/Dot, 30 Sec/ Dot, 1 Min/Dot, 2 Min/Dot,   5 Min/Dot, 
10 Min/Dot, 15 Min / Dot, 10 Min/Page, 30 Min/Page, 1 Hour/Page, 2 Hour/Page, 4 Hour/Page,   
8 Hour/Page, 12 Hour/Page, 1 Day/Page, 2 Day/Page, 1 Week/Page, 2 Week/Page, 4 Week/Page,              
1 Hour/Dot, 2 Hour/Dot.  The User has a lot of flexibility in logging speeds to select as per the application 
requirement. 
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3.19 Multilingual Languages 

 The recorder provides multiple language options for the user to select as per their convenience. The 
available languages are Brazil Portuguese, Chinese (Simplified, Traditional), Czech, Danish, Dutch, English, 
French, German, Greek, Italian, Japanese, Korean, Polish, Portuguese, Russian, Spanish, Swedish, Thai, 
Turkish. Other Languages are negotiable. 

3.20 USB Bar-code Reader, Keyboard and Mouse Connectivity 

 The recorder supports the data entry through USB Keyboard, Mouse and Bar-code reader for the 
configuration.  
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4. GETTING STARTED 
The recorder has a TFT touch screen display capable of complex graphical representation, internal memory 
and SD card slot or USB drive slot for data storage. The unit is easily programmable, and the average user 
will probably never need to use most of the features or functions available in the recorder. This chapter will 
give the user a brief system overview and guide the first-time user in a simplified setup which will enable 
you to begin recording with the least amount of effort. 

4.1 Screen Navigation 

The recorder has a TFT touch screen which shows graphics. The screen also acts as a touch keypad. The 
user has only to lightly touch the screen area to operate. If the Beep volume is enabled then the unit will 
provide a short audible beep, each time the screen is touched. The default display of the recorder which 
shows after power-on is as below. 

 

 
 

 The screen is divided into two distinct areas such as Title Bar, across the top of the screen and the 
Graphics Area below the Title bar. 
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4.1.1 Title Bar 

The Status Bar consists of Menu key , Page Type, Page Name, Alarm Status, Internal memory status, 

External memory status, Date and Time. 

 

 
 
 
 

4.1.1.1 Menu key  

 The menu key will allow the user to access the menus available in the recorder. When the user presses the 

menu key , the available menus are displayed. 

 

     
 

Menu key              Page Type                    Page Name             Alarm Status        Internal Memory Status    Date and Time 
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4.1.1.1.1 Real-Time 

 Real-time menu will allow the user to access the real-time display of the configured display pages, 
Overview display, PID Control card display page and custom screen display page. 
 
New modifications since V1.50: 
 Digital values and trend graph will change simultaneously on real-time UI. 

 

 

4.1.1.1.2 Mode 

 Mode Menu will allow the user to change the graphical display mode. The available display modes are 
Trend, Bar Graph, Digital, Mix Mode, Individual Mode and Circular Mode (only for PR30). 
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4.1.1.1.3 Alarm 

 Alarm menu will allow the user to access the real-time alarm page. In this page, the user can view the real-
time alarms and acknowledge the alarms. 
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 The user can acknowledge the alarm by pressing the ACK  key. The user can navigate the alarm 

display by using the scroll keys     . The user can go back to the Home screen by pressing 

the Home  key. The user can access other menus by pressing the menu  key. 

 

4.1.1.1.4 Status 

 The status menu will show the status of DI, DO, AO, Totalizer, Counter. 
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 By using the DI, DO, AO, Counter, Totalizer tabs the individual status can be viewed in the respective tabs. 

The selected tab can be changed by using the left and right scroll keys  . The user goes back to the 

home screen by pressing the Home  key. The up-down scroll keys   are used to scroll down the 

pages in individual tabs. The user can access other menus by pressing the menu   key. 

 

 
 

4.1.1.1.5 History 

 History menu will allow the user to access the historical data of the display pages. The user can select the 
required historical display page by pressing the required page key in the history menu. 
 
New modifications since V1.50: 
 Historical UI will show only raw data. 
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PR30 

 

Go to Menu  > History > Page #.  

The historical display page will allow the user to navigate the historical data and do the handwritten remarks 

on the display page. The user can do the navigation on the screen using the four scroll keys    

. The user can increase or decrease the zoom rate by using the two  . The handwritten  

messages within the data can be searched by using  key. The zoom rate can be selected by using the 

soft-key . The data at a particular time can be searched by the soft-key . The location of the 

displayed data can be switched between internal memory and external memory by using the soft-key . 

The user goes back to the home screen by pressing the Home  key. The user can access other menus 

by pressing the menu  key.  

New modifications since V1.60:  

 Log Marker tab will be added under history page.  

 Before operation, go to Menu > Config > Marker to change log name up to 50 

New modifications since V1.70: 

 Select tab  will be added for PR10/20 to extend tab of Marker, handwriting and Hiding color tab.  

 Log Marker tab will be added under history page to create log job.  

 Handwriting tab will be move to selecting more […] tab.  
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New modifications since V1.70: 

 Allow users to hide temporarily unnecessary coloured pens without affecting page settings. 

 Hiding colour tab will be added under history page.   

 For PR10/20, select more  tab firstly and find color hiding  tab. For PR30, find the tab from 

the left-side bar. Deselect the specific color to hide from the chart and click <OK>. 

 

     
PR10/20 

 

 
PR30 

4.1.1.1.5.1 Handwriting Messages on Historical Trend Screens 

 Handwriting Messages on Historical trend screen is a useful feature for the user to highlight important 

events. The User can write handwritten messages using a stylus on Historical Trend screens.  

If the user wants to write a message, then they can press the  pen key in the screen below. 
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 Then using the stylus, the user can write any message in Historical Trend Pages as shown below. 
 

 
   

If the user wants to change the width of the written message, he/she can choose the width key   to 
change the width of the pen. 
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 If the user wants to change the colour of the pen, he/she can change it by using the  key to change the 

colour of the pen. 

  

 
  

 If the user wants to erase part of a message, he/she can do this by using the  key to erase part of the 
message. 
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 If the user wants to undo part of a message, he/she can do this by using the key  to undo the last part 
of the message.  
 

 
  

If the user wants to delete the written message, he/she can this do by using the key  to delete the written 
message. 
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 If the user wants to save the written message, he/she can do this by using the key  to save the written 
message. 
 

 
 

 By using the  key, the user can exit the page without saving the data.  
 
Note: The handwriting messages are saved once can’t be modified or deleted. 



 
 

 
 

Page 93 of 550 

4.1.1.1.6 Event 

 Event menu will allow the user to access the historical events and reports. By using the Event and Report 
tabs the event list and report list can be viewed in the respective page. The selected tab can be changed by 

using the left and right scroll keys  . The user goes back to the home screen by pressing the 
Home/key. The up-down scroll keys   are used to scroll down the pages in individual tabs.  The 

  keys are used to navigate rows and columns.  The user can access other menus by pressing the 
menu  key. 
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The Event power can be navigated by using the scroll keys     . The stored location of 

displayed historical events can be switched between internal memory and SD card by using the soft-key 

. 

 

 
 

The Report list can be navigated up and down by using   keys. The report of previous and next day, 

week, month depends on the selection of mode can be navigated by using   keys.  

New modifications since V1.70: 

 The mode can be switched between List/ Summary by using <Mode> key; displayed Daily, Weekly, 

Monthly by using <Period> key. 
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New modifications since V1.60: 

 The marker list can be navigated by using the scroll keys     , which should firstly 

mark several log jobs in the history page.  

 

4.1.1.1.7 More 

More menu will allow the users to access more menus for the operation. The more consists of the below 
menus. 

1. Dump 
2. Clear 
3. Operate 
4. Config 
5. Stop 
6. Logout 
7. Batch 
8. Shutdown 

 
New modifications since V1.50: 
 Add options "Last Month" and "Select a Period" for Dump and Clear functions. 
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4.1.1.1.7.1 Dump    

 Dump the historical data from internal memory to external memory such as SD Card or USB Disk. The user 
can select the data to be dumped to external memory. The recorder will allow the user to select the period 

to be dumped after pressing the  key. The available period option to be selected will differ for normal 
mode and batch mode. 
 

 
 

Dump Option-Batch Mode 
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Dump Option- Normal Mode 

4.1.1.1.7.2 Clear 

 Clear all the historical data and event list stored in the memory. The user can select the data to be cleared. 

The recorder will allow the user to select the period to be cleared after pressing the  key. The 
available option period to be selected will differ for normal mode and batch mode. 

 

 
 

Clear Option- Normal Mode  
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Clear Option-Batch Mode 

4.1.1.1.7.3 Operate 

 Manually operate the jobs from the available jobs directly without any events. The details of all the jobs are 
explained in section 5.3. 
 
New modifications since V1.50: 
 Add option "Select a Period" for Print and output functions. 
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4.1.1.1.7.4 Config 

This will allow the user to access the configuration page. The configuration page configuration is explained 
in Chapter 5. 

 

 
PR10 

4.1.1.1.7.5 Stop 

 Stop the batch and logging. The Title bar will show pause when the logging is stopped. 
 

 
 

Logging Paused 
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4.1.1.1.7.6 Logout 

 Logout the user. 

4.1.1.1.7.7 Batch 

The user can configure the batch related information. The information can be configured are Batch name, 

Lot no, Batch comments. There are 10 comments are available for the user to configure. The comments can 

be navigated by using   keys. The Batch name and lot no can’t be edited during the batch is running. 

 

 
 

4.1.1.1.7.8 Shutdown 

 Shutdown the recorder. 
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5. CONFIGURATION 
This section will explain the procedure to configure the recorder. Press  (Menu), then More and then 

Config soft-key to enter Configuration mode.  A tree type layout appears with a provision to configure 

Channel, Tools, Message, Display, Instrument, Security, Auto-Output, Demo, and System Information.  In 

addition, the Save, Load, Default and Home soft buttons also appear.  

 

 
 

 
PR30 
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 There are four softkeys are available in the configuration page for the menu navigation. They are as below. 

 Enter key  Up directional key  Down directional key  Home key 

 Various options are available to enter into configuration page menus. 

Option-1:  Select the required menu by using up & down directional keys, then press “Enter” key  

Option-2:  Select the required menu directly with a touch, then press “Enter” key  

Option-3: Select the required menu by pressing the menu two times quickly, it is the same as a double click 

from a mouse 

  

 There are four softkeys are available to save, load, to load the default settings and move to the home 

screen. They are below. 

 Save 

Save configuration from the recorder to a USB disk or an SD Card.  

 Load 

Load configuration from a USB Disk or SD Card to the recorder. 

 Default 

Load the factory default settings to the configuration menu parameters. 

 Home 

Returns the display back to the home page. 

 

Note:  

After changing the configuration of any parameter in config menu, the user has to press back  and 

then press Home key  to save the configuration. If the recorder was powered off before this operation, 

the configuration will not be saved. 

5.1 Channel 

 This section will explain the configuration of different types of channels. They are as below. 
1. Analog Input (AI)  
2. Digital Input (DI)  
3. Math   
4. Analog Output (AO) 
5. Digital Output (DO)  
6. External device channels.  

 

5.1.1 Analog Input 

 After entering the Configuration menu, in “Channel”, select “AI”, then press the “Enter” key to get into 

Analog Input Channel configuration menu. It displays the Analog input AI1 as the first analog input channel 

configuration page.  Press directional navigation keys   at the bottom to select other channels.  Press 

directional keys   on the right-hand side to select the column.   After completing Configuration, 

press  soft-key, then press  soft-key to return to the main display. All configurations will be saved 

automatically. 
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Copy:  copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
 Press Copy key in the source channel and press paste key in the destination channel. 
 

5.1.1.1.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name. 

5.1.1.2 Desc 

 The description of a specific channel on the recorder.  

5.1.1.3 Type 

 Option available to enable or disable the channel 

5.1.1.4 Filter 

It is to reduce the noise of the input signal before logging. The filter can be set from 1 second to 16 seconds.  
It is a soft filter available to reduce the fast variation of analog inputs. There are two types of filters available 
for the users to select. They are moving average and difference. 

5.1.1.4.1 Moving Average 

 This will log an average of the values sampled in the configured Buffer Time. 
 For example, if the filter value is set as 5 sec for AI1, it means all the samples collected in the last 5 sec 
shall be averaged, and the averaged value is available to record as per Log method. 
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5.1.1.4.2 Difference 

 This will log the data only there is at least a difference between the current data and the last logged data for 
a period. The difference will be defined by the allowance and the period is defined by holding time. 

     For example, the allowance is set for 100 and the holding time is set for 100 msec. If the current value is 
1000 and the last value is 890 when you check the difference is 110. Since this difference is greater than 
100 it is with that value more than the holding time 100 msec, this value will be recorded. If the difference of 
current and last recorded value is greater than “difference value” but does not stay for the duration of 
holding time this value will not be recorded. So, the holding time will define the duration of the noise filter. 
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5.1.1.5 Log 

5.1.1.5.1 Data Type 

 The data type for logging is 2 bytes. 
 2-byte range: -32767 to +32767 

5.1.1.5.2  Trigger 

 Two options are available for the user to select. 
1. Disable: Select disable while the recording of a specific channel is not required at this time 
2. Enable: Select enable while the recording of a specific channel is required at this time 

5.1.1.5.3 Method 

 This is the method of logging measured data. Select the column Method and press Enter. Then choose the 
required Log method from the available methods Instant, Average, Minimum or Maximum of data. 
 
5.1.1.5.3.1 Instant 

 Logging the last measured data at the logging interval 
 
5.1.1.5.3.2 Average 

 Logging the averaged of sampled measured data at the logging interval 

5.1.1.5.3.3 Minimum 

 Logging the minimum of sampled measured data at the logging interval  

5.1.1.5.3.4 Maximum 

 Logging the maximum of sampled measured data at the logging interval 

5.1.1.5.4 Speed 

It is the logging speed (recording speed) of measured data. The available log speeds are as below. 
1. 100 msec/dot 
2. 1 Sec/dot 
3. 2 Sec/dot 
4. 5 Sec/dot 
5. 10 Sec/dot 
6. 15 Sec/dot 
7. 20 Sec/dot 
8. 30 Sec/dot 
9. 1 min/dot 
10. 2 min/dot 
11. 5 min/dot 
12. 15 min/dot 
13. 1 hour/dot 
14. 2 hour/dot      
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5.1.1.6 Sensor 

 

5.1.1.6.1 Type 

 Select the input type of the sensor for the channel. 
 

                  
               

   

5.1.1.6.2 Unit 

 The engineering unit of input. 

5.1.1.6.3 Range 

 Select the range for the input based on Sensor type 

5.1.1.6.4 Scale 

 Appears only for linear input type. The user can scale the input to the engineering unit as per the 
application requirement. 
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5.1.1.7 Offset 

 It is to offset the input value to correct the sensor error. 

5.1.1.8 Gain 

  It is a multiplier to correct the sensor error. 
               The correct value = (the process value x gain) + offset  

5.1.1.9 Modbus 

 The scaling of the channel value in Modbus communication. 

5.1.1.10 Events 

 Events are frequently used for Alarm purposes. The events can be used to operate digital outputs (DO), 
Timer, Totalizer, Counter or Report. There is a maximum of five events can be added to each analog input. 
 Press “Add” to add new event and Press “Remove” to remove selected event 
 

 

5.1.1.10.1  Type  

There are various types of events are available for the user to select for job or alarm purpose. They are 
listed as below. 

 (1) H 

It is a high event. When the process value is higher than the high limit, then the alarm or job associated 
with this event is actuated. 

(2) L 

 It is a low event. When the process value is lower than the low limit, then the alarm or job associated 
with this event is actuated. 

(3) HH  

It is a high high event. When the process value is higher than the high high limit, then the alarm or job 
associated with this event is actuated. This is another limit higher than the high limit for double warning. 

(4) LL 

It is a low low event. When the process value is lower than the low low limit, then the alarm or job 
associated with this event is actuated. This is another limit lower than the low limit for double warning.   
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(5) Dev+ 

It is the deviation+ event. This event will be triggered by the positive deviation of the process value. The 
job or alarm is activated when the process value is deviated by the value higher than the setpoint from 
the previous process value. 
 
For example,  
Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 51 
Then, job or alarm is activated 

(6) Dev- 

It is a deviation- event. This event will be triggered by the negative deviation of the process value. The 
job or alarm is activated when the process value is deviated by the value lower than the setpoint from the 
previous process value. 
 
For example, 
Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 29 
Then, job or alarm is activated. 

(7) Error 

It is an error event. This event will be activated when there is an error on the input of the channel. 
 

5.1.1.10.1.1 Start Condition  

Start Condition: None, <sp, >sp (setpoint)  
 
Select “Type” None: 
If None is configured, the alarm will be triggered according to the triggering rules. 
 
When setup, Type: H/HH, Start Condition: <SP  
For the event to be triggered, the first state of PV value must be small than SP and then goes higher than 
SP.  
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When setup, Type: L/LL, Start Condition: >SP  
For the event to be triggered, the first state of PV value must be larger than SP and goes lower than SP. 

 
 

 
 

5.1.1.10.2 Set Point (SP) 

 Setpoint for the event. 

5.1.1.10.2.1 Hysteresis 

 To avoid the alarm or event been activated too often, Hysteresis value can be defined for the event trigger 
setpoint. 

5.1.1.10.2.2 Holding time 

 To avoid the alarm or event been activated too often, the holding time can be defined for the event trigger 
setpoint. In the process sometimes SP is reached but it will go down immediately, this might due to process 
instability. To avoid this kind of nuisance situations, the holding time can be used to see that PV stays at 
above that SP more than the holding time and then only activate the action for that event. The range of 
holding time can be set from 1 min to 60 min and 1 to 60 sec. 
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5.1.1.10.3 Log 

 The event can be logged as an alarm or event. They can be selected from the available options. They are 
as below.  

 
New modifications since V1.60: 
 Modification: Sync up the timing for logging data and alarm/event. 
 

5.1.1.10.4 Log Alarm 

 Log the event as Alarm.  

5.1.1.10.4.1  Log Alarm (Auto Ack) 

 Log the event as alarms and acknowledge automatically 

5.1.1.10.4.2  Log Event 

 Log as event 

5.1.1.10.5 Job1 & Job2 

 The job is called as a task to be performed when the event is activated. There are two jobs Job1 and Job2 
can be added to perform in any event.  
 A typical example is to trigger an alarm buzzer in the event of high temperature.  Each channel can accept 
five different types of events (or alarms) and each event can create two jobs.  Please note that a job under 
Event is different from a job performed by Operate key.  The job is actuated by an event, and the Operate is 
actuated by manual control, no event necessary. 
 
 Note: Please refer to the section Jobs for full details about various jobs available  
 Note: Number of analog inputs shown on the AI screen depends on a number of Analog input cards 
inserted in the paperless recorder.  
 
Example: 
 If the temperature is increased to more than 120 OC, logs alarm and switches on digital output 1 only after 
1-minute holding time defined in the setting.  When the temperature is decreased to less than 80 OC, logs 
the alarm and switches off the digital output1 only after 1-minute holding time defined in the setting.   
 
The setting of events for the analog input in the channel configuration is as follows, 
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5.1.2 Digital Input 

 After entering the Configuration menu, in the Channel, select DI then Press the “Enter” soft-key to get into 

the Digital Input Channel configuration menu. It displays the Digital input DI1 as the first digital input channel 

configuration page.  Press directional navigation keys   at the bottom to select other channels.  Press 

directional keys   on the right-hand side to select the column.   After completing Configuration, 

press  soft-key, then press  soft-key to return to the main display. All configurations will be saved 

automatically. 

 

 
 

 
Copy:  copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
 Press Copy key in the source channel and press paste key in the destination channel. 

5.1.2.1.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name.  

5.1.2.2 Desc 

 The description of a specific channel on the recorder.  

5.1.2.3 Type 

 Type of Digital input. The digital input can be configured as Logic Level and pulse counter. To select the 
type, press the Type and then select the required type. 

5.1.2.3.1  Logic Level 

 This selection activates digital logic, which is either one or zero with a low frequency which is less than 1Hz, 
such as an external relay. 
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5.1.2.3.2 Pulse Counter 

 This selection will allow the digital input to read the high-speed pulse inputs up to 100 Hz. This is useful to 
get the flow rate from pulse output from flow meters.  
 

 
 

5.1.2.4 Events 

 A maximum of 2 events is supported for every digital Input channel. A maximum of two jobs can be 
configured for each event.  
 
*Note: Events will not appear if Logic Level selected as Pulse Counter 
 
Press “Add” to add new event and Press “Remove” to remove selected event 
 

 
 

5.1.2.4.1 Type 

 Select the event type Low L or High H 

5.1.2.4.1.1 Holding time 

 To avoid the alarm or event been activated too often, the holding time can be defined for the event trigger 
setpoint. In the process sometimes SP is reached but it will go down immediately, this might due to process 
instability. To avoid this kind of nuisance situations, the holding time can be used to see that the DI stays at 
high or low more than the holding time and then only activate the action for that event. The range of holding 
time can be set from 1 min to 60 min, 1 to 60 sec. 

5.1.2.4.2 Job1, Job2 

 The job is called as a task to be performed when the event is activated. There are two jobs Job1 and Job2 
can be added to perform in any event.  
 To configure a Job, select Job1, then press the Enter key. It will show a list of all the available jobs.  Select 
the required Job. 
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Note: Number of digital inputs shown one the DI screen depends on the number of Digital input 
cards inserted in the paperless recorder. 
 
Example:  

 After pressing a “Start” switch, latch ON Digital Ouput1, after pressing a “Pause” switch, latch Off Digital 
Output1.  
 Start Timer, Stop Timer, Reset Totalizer, Reset Counter, Reset MaxMinAve values of all the channels etc... 
 It is possible to display Digital input status via the status bar on any display page in the paperless recorder. 
If the digital input is not enabled then it shows as “Low”. If the digital input is enabled then it shows like 
“High”. To configure status bar, refer section Display  
 

 
 

Digital Input status can also be monitored from the  (Menu).  Press “Status” and then select “DI”, it will 

show the Digital Input Status as follows. 
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5.1.3 Math Channel  

 The Math channel is used to do mathematical operations. The Math channel can be configured as Math or 
counter or Totalizer. The maximum no of math channel in different PR recorders as below. 
 

PR Recorder PR10 PR20 PR30 

Maximum Math Channels 15 40 60 
 

 After entering the Configuration menu, in the Channel, select Math then Press the “Enter” soft-key to get 

into Math Channel configuration menu. It displays the Math channel Math1 as the first math channel 

configuration page.  Press directional navigation keys   at the bottom to select other channels.  Press 

directional keys   on the right-hand side to select the column.   After completing Configuration, 

press  soft-key, and then press  soft-key to return to the main display. All configurations will be 

saved automatically. 
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Copy:  copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
 Press Copy key in the source channel and press paste key in the destination channel. 

5.1.3.1.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name.  

5.1.3.2 Desc 

 The description of a specific channel on the recorder. 

5.1.3.3 Type 

 The type of math channel. The math channel can be configured as Math, Counter and Totalizer. The 
options available in type for the user to select are Disable, Math, Counter and Totalizer. The configuration 
menu will differ depends on the selection of Type. 

5.1.3.3.1 Disable 

 Disable the math channel. 
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5.1.3.3.2 Math 

 Configure the channel as Math channel. 
 

 

5.1.3.4 Log 

5.1.3.4.1 Data Type 

 The data type for logging is 2 byte or 4 bytes 
 2-byte range: -32767 to +32767 
 4-byte range: -3.4E+38 to +3.4E +38 

5.1.3.4.2  Trigger 

 Two options are available for the user to select. 
1. Disable: Select disable while the recording of a specific channel is not required at this time 
2. Enable: Select enable while the recording of a specific channel is required at this time 

5.1.3.4.3 Method 

 This is the method of logging measured data. Select the column Method and press Enter. Then choose the 
required Log method from the available methods Instant, Average, Minimum or Maximum of data. 

5.1.3.4.3.1 Instant 

 Logging the last measured data at the logging interval 
 

5.1.3.4.3.2 Average 

 Logging the averaged of sampled measured data at the logging interval 

5.1.3.4.3.3 Minimum 

 Logging the minimum of sampled measured data at the logging interval  

5.1.3.4.3.4 Maximum 

 Logging the maximum of sampled measured data at the logging interval 
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5.1.3.4.4 Speed 

 It is the logging speed (recording speed) of measured data. The available log speeds are as below. 
1. 100 msec/dot 
2. 1 Sec/dot 
3. 2 Sec/dot 
4. 5 Sec/dot 
5. 10 Sec/dot 
6. 15 Sec/dot 
7. 20 Sec/dot 
8. 30 Sec/dot 
9. 1 min/dot 
10. 2 min/dot 
11. 5 min/dot 
12. 15 min/dot 
13. 1 hour/dot 
14. 2 hour/dot      

5.1.3.5 Expression 

 This will appear only for the channel type as Math. Math channel expression can be configured on this 
menu. Once the user enters the expression menu the pop-up window will show the option for the user to 
configure the expression. The pop-up window consists of Source, Operator and keyboard. 
 

 
 

 The Source consists of all available Analog inputs, Digital Inputs, Math inputs, external channels.  The 
Operator consists of available mathematical expressions. Use Source, Operator and keyboard to define the 
Math equation.   
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5.1.3.5.1 Available Math Expressions 

 The available math expression for the user to configure the math expressions is as below. 

Expressions (Operator) Mathematics Functions 

+ Addition 

-  Subtraction 

* Multiplication 

/ Division 

SIN(x) sin(x) 

COS(x) cos(x) 

EXP(x) ex 

SQRT(x) Square root of x 

LN(x) loge(x) 

LOG(x) log10(x) 

ABS(x) Absolute of x 

POW (x, y) xy 

ROUND(x) The closest integral number to x 

HI (x, y) The bigger value between x and y 

Lo (x, y) The smaller value between x and y 

INV(x) 1/x 

TG(x) tan(x) 

CTG(x) 1/tan(x) 

ASIN(x) Sin-1(x) 

ACOS(x) Cos-1(x) 

ATG(x) Tan-1(x) 

x%y Remainder of x/y 

x^y xy 

RPF PFr=RPF(PFa) 

P1W2 
1-phase 2-wire 
Result:V*I*PF 

P1W3 
1-phase 3-wire 

(V1*I1*PF1+V2*I2*PF2) / 2 

P3W3 
3-phase 3-wire 

V1*I1*PF1+V2*I2*PF2 

P3W4 
3-phase 4-wire  

(V1*I1*PF1+V2*I2*PF2+V3*I3*PF3) / 1.73205 
 

 
 New modifications since V2.0 (2507)  
 Add function:  

Add new operations for <math expression> to be used in power calculation 
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Go to Configuration > Channel> Math > Math#>Type: Math > OK   

 
 
Go to .. Math#> Expression > P1W2/P1W3/P3W3/P3W4 > OK > Back > Home 

 
 
Go to Home > Realtime > Overview to check the math# results 

 



 
 

 
 

Page 120 of 550 

 
 RPF: a function, converting the real power factor (U1PFa) into imaginary power factor 
 P1W2: single phase two wire 

1) Arguments:V,I,PF 
2) Result:V*I*PF 

 P1W3: single phase three wire 
1) Arguments:V1,I1,PF1,V2,I2,PF2 
2) Result:(V1*I1*PF1+V2*I2*PF2)/2 

 P3W3: three-phase three-wire 
1) Arguments:V1,I1,PF1,V2,I2,PF2 
2) Result:V1*I1*PF1+V2*I2*PF2 

 P3W4: three-phase four-wire 
1) Arguments:V1,I1,PF1,V2,I2,PF2,V3,I3,PF3 
2) Result:(V1*I1*PF1+V2*I2*PF2+V3*I3*PF3)/1.73205 

 
 

5.1.3.6 Scale 

 The scale is used to do scale the math channel value. 
 

 

5.1.3.6.1 Unit 

 The user can define the engineering unit for the channel as per the application requirement. 

5.1.3.6.2 Transformation 

 This is mainly used to scale the non-linear process input value. The available options for the user in the 
transformation menu are disabled, value and math channel. 

5.1.3.6.2.1 Disable 

 The transformation function is disabled 

5.1.3.6.2.2 Value 

The transformation table will transform the value of the expression to the same math channel. 

5.1.3.6.2.3 Math Channel 

 The transformation table will transform the value of the expression to another math channel. 
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5.1.3.6.2.3.1 Method 

 New modifications since V1.70.  
 Add function: Add new option used to scale the linear process input value for math channel at 

Math.Transformation.Method. For setting linear method, input at least 2 lines to create <Table>.   
Go to Configuration > Channel > Math > Scale > Transformation > Math Channel > Method,  
Option Method: Linear/ Non-linear 

 

     
 
Go to Scale > Transformation > Table 
Add input/output values after setting as <Math Channel>, the content of <Table> cannot be empty! 
Add at least 2 points for transformation. For adding a new line, press <Mode> to toggle <Input> or 
<Output>, and press <Enter> to input selection/ number. When create more than 2 points, click 
<OK> to exit. 
 

   
 

5.1.3.6.2.3.2 Accept a value out of range 

 This will allow the user to restrict the maximum value to be displayed as per the value configured in the 
transformation table. 
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5.1.3.6.2.3.3 Table 

 The transformation table can be configured with this menu. The user can configure the table with a 
maximum of 64 rows with corresponding input and output values.  
 

 
 

Add  
 Press “Add” soft-key to add a new row into the Transformation table 

Delete  
 Press “Delete” soft-key to delete an existing row from the Transformation table 

Copy  
  Press to copy an existing row in the Transformation table to create a duplicate entry 

Mode  
 Press to toggle between Input and Output entries in the Transformation table 

Up & Down    
 To navigate among rows in the Transformation table 

Enter  
 To change the value of the selected rows. 
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5.1.3.6.3 Counter 

 Configure the channel as Counter 
 

 
 

5.1.3.6.3.1 Counter 

 The counter is used to configure the counter. 
 

 

5.1.3.6.3.1.1 Unit 

 Defines the unit of counter 

5.1.3.6.3.1.2 Preset 

 Defines the pre-set value for the counter.   

5.1.3.6.4 Totalizer 

 Configure the channel as a totalizer 
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5.1.3.6.4.1 Totalizer as Normal Totalizer 

 Configure the totalizer as normal totalizer for general totalizing applications. 
 

 

5.1.3.6.4.1.1 Input 

 Input type for the Totalizer. Select Analog Input or DI Pulse counter. 

5.1.3.6.4.1.2 Source 

 Select the source for the Totalizer from Analog input/Math/Counter/Totalizer/DI Pulse counter 
 

 
 

5.1.3.6.4.2 Totalizer for F0 Calculation Application 

 Configure the Totalizer as F0 for F0 calculation application. F0 expression used to calculate F0 value will be 
displayed for the user reference. 

5.1.3.6.4.2.1 Source 

 The input source T for calculation of F0. 

5.1.3.6.4.2.2 Ref.Temp 

 The reference temperature Tr for F0 calculation. Generally, steam pasteurization temperature Tr assumed 
as 121.0°C. 

5.1.3.6.4.2.3 Z 

The Temperature unit of logarithmic sterilization capability change Z for F0 calculation. Generally, Z 
assumed as 10°C 
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5.1.3.6.4.2.4 Time 

 The time interval Δt for F0 calculation.  
 

 
 

 
 

5.1.3.6.4.3 Action 

 Disables or enables the Totalizer 

5.1.3.6.4.4 Decimal 

 Defines the decimal point for the Totalizer 

5.1.3.6.4.5 Period 

 Select the period for the totalizer. The available options are Seconds, Minutes, Hours and Days  

5.1.3.6.4.6 Unit 

 Defines the unit of the totalizer 

5.1.3.6.4.7 Preset 

 Defines the pre-set value for the Totalizer. 
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5.1.3.6.4.8  Low Cut 

 Defines the Low-Cut value for the Totalizer. For example, if 0.0 is set as Low cut, then, if source channel 
AI1 is less than 0.0, the Totalizer value will not go to negative. 

5.1.3.7 Modbus 

 The scaling of the channel value in Modbus communication. 

5.1.3.8 Events 

 Events are frequently used for Alarm purposes. The events can be used to operate digital outputs (DO), 
Timer, Totalizer, Counter or Report. There is a maximum of five events can be added to each analog input. 
 Press “Add” to add new event and Press “Remove” to remove selected event 

 

5.1.3.8.1 Type  

 There are various types of events are available for the user to select for job or alarm purpose. They are 
listed as below. 

5.1.3.8.1.1 H 

 It is a high event. When the process value is higher than the high limit, then the alarm or job associated with 
this event is actuated. 

5.1.3.8.1.2 L 

 It is a low event. When the process value is lower than the low limit, then the alarm or job associated with 
this event is actuated. 

5.1.3.8.1.3 HH  

 It is a high high event. When the process value is higher than the high high limit, then the alarm or job 
associated with this event is actuated. This is another limit higher than the high limit for double warning. 

5.1.3.8.1.4 LL 

 It is a low low event. When the process value is lower than the low low limit, then the alarm or job 
associated with this event is actuated. This is another limit lower than the low limit for double warning.   

5.1.3.8.1.5 Dev+ 

It is a deviation+ event. This event will be triggered by the positive deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value higher than setpoint from the previous 
process value. 

5.1.3.8.1.6 Dev- 

It is a deviation- event. This event will be triggered by the negative deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value lower than setpoint from the previous 
process value. 
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5.1.3.8.1.7 Error 

It is an error event. This event will be activated when there is an error on the input of the channel.  

5.1.3.8.2 Setpoint 

 Setpoint for the event. 

5.1.3.8.2.1 Hysteresis 

 To avoid the alarm or event been activated too often, Hysteresis value can be defined for the event trigger 
setpoint. 

5.1.3.8.2.2 Holding Time 

 To avoid the alarm or event been activated too often, the holding time can be defined for the event trigger 
setpoint. In the process sometimes SP is reached but it will go down immediately, this might due to process 
instability. To avoid this kind of nuisance situations, the holding time can be used to see that PV stays at 
above that SP more than the holding time and then only activate the action for that event. The range of 
holding time can be set from 1 min to 60 min, and 1 to 60 sec. 

5.1.3.8.3 Log 

 The event can be logged as an alarm or event. They can be selected from the available options. They are 
as below.  

5.1.3.8.3.1 Log Alarm 

 Log the event as Alarm.  

5.1.3.8.3.2  Log Alarm (Auto Ack) 

 Log the event as alarms and acknowledge automatically 

5.1.3.8.3.3  Log Event 

 Log as event 

5.1.3.8.4 Job1 & Job2 

 The job is called as a task to be performed when the event is activated. There are two jobs Job1 and Job2 
can be added to perform in any event.  
 A typical example is to trigger an alarm buzzer in the event of high temperature.  Each channel can accept 
five different types of events (or alarms) and each event can create two jobs.  Please note that a job under 
Event is different from a job performed by Operate key.  The job is actuated by an event, and the Operate is 
actuated by manual control, no event necessary. 
 
 Note: Please refer to the section Jobs for full details about various jobs available  
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5.1.3.9 Examples for Math Channel Application 

5.1.3.9.1 Example 1 with Transformation Table 
 

 A chemical tank has a non-linear shape. The level is 0 to 1400 CMS. The Recorder should display 0 to 170 
Tons as per the following table 
 

 

5.1.3.9.2 Example 2 with Transformation Table 

 The input of 0 to 20mA for pressure 0 to 150 PSIG is required to display as per the below table.   
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The below steps are required to follow. 
1. Configure the AI Channel as per the input configuration. 

 

 
 

2. Configure one math channel with the required conversion using the transformation table. 
 

 
 

3. Configure the Expression with the input channel 
4. Add the Transformation table type as values 
5. Create the transformation table with the known values. 
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6. Now the Math channel will show the value as per the table. 

5.1.3.9.3 Relative Humidity Application 

 The relative humidity can be calculated using Math Channel application. For this, we need two analog 
inputs with RTD input to measure dry bulb temperature and wet bulb temperature. For this example, the 
recorder has two analog inputs with RTD input in AI1 to measure dry bulb temperature and AI2 to measure 
wet bulb temperature. The below are steps to be followed to calculate the relative humidity. 
 The relative humidity can be calculated by using the below formulae. 
 

 
 

 The formulae can be split into 3 different parts for easier understanding.  
1.  Calculate Ed with dry-bulb (Td) and wet-bulb (Tw) temperatures using the following equation. 

 

 
 

2. Calculate Ew with dry-bulb (Td) and wet-bulb (Tw) temperatures using the following equation. 
 

 
  

In the above equations, the temperatures units are °C. 
  

3. Calculate Relative Humidity (RH) using the following equation 
 

 
 

 The units of relative humidity are in % 
 

Example: 
 Assume that dry-bulb temperature (Td) = 20°C and wet-bulb temperature (Tw) = 15°C. 
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 3 Math channels are required to calculate one RH. 
Td = AI1, analog input for dry bulb temperature (PT100) 
Tw =AI2, analog input for wet bulb temperature (PT100) 
 
Math1 = Ed = 6.112*EXP((17.502*AI1)/(240.97+AI1))  
Math2 = Ew= 6.112*EXP((17.502*AI2)/(240.97+AI2))  
Math3=RH= (Math2-(0.66875*(1+0.00115*AI2) *(AI1-AI2))/Math1) *100 
 

 
 



 
 

 
 

Page 132 of 550 

 
 

 
 

Now Math3 will display Relative humidity in % 
 Math channels are virtual channels. They contain measured values based on equations. These values can 
be recorded similar to physically connected Analog inputs and display as digital values, trends, bar graphs 
etc. 
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5.1.3.9.4 Counter Example 

 The user requires the number of occurrences of an event in a day. The pressure switch in DI1 goes logic 
high is considered as an event in this application. The Pressure switch is connected in DI1. The High signal 
indicates the high pressure. 
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The counter value will be logged in the report and reset to start the count of the next day. The Historical 
report can be viewed in the Event mode Report tab with the selection of Daily mode. 

5.1.3.9.5 Totalizer Example 

 Water flow rate is in M3/Sec. The user needs to know about total water discharged and daily reports 
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The Totalizer value will be logged in the report and reset to start the totalizer of the next day. The Historical 
report can be viewed in the Event mode Report tab with the selection of Daily mode. The Weekly and 
monthly report can also be viewed by changing the mode. 
 

5.1.4 Analog Output 

The Analog Output card dip switches need to be set for the required output type. The default setting set to 
Voltage Output. For Current Output Set Dip Switches 1 to 5 to ON and 6 to 8 to OFF.  
The figure below shows the Dip Switches setting on the AO Card. 
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 After entering the Configuration menu, in the Channel, select AO then Press the “Enter” soft-key to get into 

AO Channel configuration menu. It displays the AO channel AO1 as the first AO channel configuration page.  

Press directional navigation keys   at the bottom to select other channels.  Press directional keys  

 on the right-hand side to select the column.   After completing Configuration, press  soft-key, 

then press  soft-key to return to the main display. All configurations will be saved automatically. 

 

 
 

Copy: Copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
Press Copy key in the source channel and press paste key in the destination channel. 

5.1.4.1 Desc 

 The description of a specific channel on the recorder. 

5.1.4.2 Type 

 The type of analog output channel. The analog output channel can be configured as Voltage or Current. 
The output menu will differ depends on the selection of Type. 

5.1.4.3 Output 

 Select the required output. The available options are Disable, 0 to 20mA and 4 to 20mA for current output 
and Disable, 0 to 5V, 1 to 5V and 0 to 10V for Voltage output 

5.1.4.4 Expression 

 The expression required for retransmission. Once the user enters the expression menu the pop-up window 
will show the option for the user to configure the expression. The pop-up window consists of Source, 
Operator and keyboard. 
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 The Source consists of all available Analog inputs, Digital Inputs, Math inputs, external channels.  The 
Operator consists of available mathematical expressions. Use Source, Operator and keyboard to define the 
Math equation.   

5.1.4.4.1 Available Math Expressions 

 The available math expression for the user to configure the math expressions is as below. 
 

Expressions Mathematics Functions 

+ Addition 

-  Subtraction 

* Multiplication 

/ Division 

SIN(x) sin(x) 

COS(x) cos(x) 

EXP(x) ex 

SQRT(x) Square root of x 

LN(x) loge(x) 

LOG(x) log10(x) 

ABS(x) Absolute of x 

POW (x, y) xy 

ROUND(x) The closest integral number to x 

HI (x, y) The bigger value between x and y 

Lo (x, y) The smaller value between x and y 

INV(x) 1/x 

TG(x) tan(x) 

CTG(x) 1/tan(x) 

ASIN(x) Sin-1(x) 

ACOS(x) Cos-1(x) 

ATG(x) Tan-1(x) 

x%y Remainder of x/y 

x^y xy 

 The analog output expression should follow the below syntax for the expression. 
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 For example, AO1 is required to retransmit current output 4 to 20mA corresponds to AI1 scaled with -120°C 
to 1000°C should have the expression as below. 
  4+ (20-4) *(AI1-(-120)) / (1000-(-120)) 

5.1.4.5 Modbus 

 The scaling of the channel value in Modbus communication. 
 

5.1.5 Digital Output 

 After entering the Configuration menu, in the Channel, select DO then Press the “Enter” soft-key to get into 

DO Channel configuration menu. It displays the DO channel DO1 as the first DO channel configuration page.  

Press directional navigation keys   at the bottom to select other channels.  Press directional keys   

  on the right-hand side to select the column.   After completing Configuration, press  soft-key, 

then press  soft-key to return to the main display. All configurations will be saved automatically. 

 

 
 

Copy:  copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
 Press Copy key in the source channel and press paste key in the destination channel. 

5.1.5.1 Desc 

 The description of a specific channel on the recorder. 

5.1.5.2 Reverse 

 The Reverse option is Enable or Disable. If it is enabled then the output state of DO will be reversed. 
 For example, when reverse is disabled, the relay output is Normally Open (NO). If the application requires 
that the output should be Normally Closed (NC) relay at Recorder, then enable “Reverse” for the selected 
Digital Output. The Relay output will be normally closed. 
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5.1.6 External 

The external channel is used to read the data from external devices with Modbus communication. In this, 
the recorder will act as a Master and read the data from Modbus slaves. The data will be logged and 
displayed by using External channels. The no of available External channels will be varied depends on the 
recorder model. The available External channel on the different recorder models as below. 
 

PR Recorder PR10 PR20 PR30 

No of External Channels 24 48 96 

 
After entering the Configuration menu, in the Channel, select External then Press the “Enter” soft-key to get 
into the External Channel configuration menu.  It displays the External channel External 1 as the first 

External channel configuration page.  Press directional navigation keys   at the bottom to select other 
channels.  Press directional keys   on the right-hand side to select the column.   After completing 
Configuration, press  soft-key, and then press  soft-key to return to the main display. All 
configurations will be saved automatically. 
 

 
 

Copy:  copy the channel configuration from one channel to another channel.  
Paste: Paste the copied configuration to the channel. 
 Press Copy key in the source channel and press paste key in the destination channel. 

5.1.6.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name.  

5.1.6.2 Desc 

 The description of a specific channel on the recorder.  

5.1.6.3 Type 

 Option available to enable or disable the channel 
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5.1.6.4 Log 

5.1.6.4.1  Data Type 

 The data type for logging is 2 bytes. 
2-byte range: -32767 to +32767 

5.1.6.4.2  Trigger 

 Two options are available for the user to select. 
1. Disable: Select disable while the recording of a specific channel is not required at this time 
2. Enable: Select enable while the recording of a specific channel is required at this time 

5.1.6.4.3 Method 

 This is the method of logging measured data. Select the column Method and press Enter. Then choose the 
required Log method from the available methods Instant, Average, Minimum or Maximum of data. 

5.1.6.4.3.1 Instant 

 Logging the last measured data at the logging interval 

5.1.6.4.3.2 Average 

 Logging the averaged of sampled measured data at the logging interval 

5.1.6.4.3.3 Minimum 

 Logging the minimum of sampled measured data at the logging interval  

5.1.6.4.3.4 Maximum 

 Logging the maximum of sampled measured data at the logging interval 

5.1.6.4.4 Speed 

It is the logging speed (recording speed) of measured data. The available log speeds are as below. 
1. 100 msec/dot 
2. 1 Sec/dot 
3. 2 Sec/dot 
4. 5 Sec/dot 
5. 10 Sec/dot 
6. 15 Sec/dot 
7. 20 Sec/dot 
8. 30 Sec/dot 
9. 1 min/dot 
10. 2 min/dot 
11. 5 min/dot 
12. 15 min/dot 
13. 1 hour/dot 
14. 2 hour/dot 
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5.1.6.5 Modbus Register Value Conversion 

5.1.6.5.1 Data Type 

The data type for logging is 2 byte or 4 bytes 
2-byte range: 0 to 65535 
4-byte range: 0 to 4294967295 

5.1.6.5.2 Modbus Register Value Range (M) 

 The user can configure the Modbus data range low (ML) and high (MH) according to the device connected. 

5.1.6.5.3 Actual Value Range (M) 

 The user can configure the Engineering unit, Actual value range low (AL) and Actual value range high (AH) 
as per the device. 

5.1.6.6 Modbus 

 The scaling of the channel value in Modbus communication. 

5.1.6.7 Events 

 Events are frequently used for Alarm purposes. The events can be used to operate digital outputs (DO), 
Timer, Totalizer, Counter or Report. There is a maximum of five events can be added to each analog input. 
 Press “Add” to add new event and Press “Remove” to remove selected event 
 

 

5.1.6.7.1 Type  

 There are various types of events are available for the user to select for job or alarm purpose. They are 
listed as below. 

5.1.6.7.1.1 H 

 It is a high event. When the process value is higher than the high limit, then the alarm or job associated with 
this event is actuated. 

5.1.6.7.1.2 L 

 It is a low event. When the process value is lower than the low limit, then the alarm or job associated with 
this event is actuated. 

5.1.6.7.1.3 HH  

 It is a high high event. When the process value is higher than the high high limit, then the alarm or job 
associated with this event is actuated. This is another limit higher than the high limit for double warning. 

5.1.6.7.1.4 LL 

 It is a low low event. When the process value is lower than the low low limit, then the alarm or job 
associated with this event is actuated. This is another limit lower than the low limit for double warning.   
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5.1.6.7.1.5 Dev+ 

It is a deviation+ event. This event will be triggered by the positive deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value higher than setpoint from the previous 
process value. 
 For example,  
  Setpoint =10 
  At 10.00.01 Hrs, Tag1=40 

 At 10.00.02 Hrs, Tag1 = 51  Then, job or alarm is activated 

5.1.6.7.1.6 Dev- 

It is a deviation- event. This event will be triggered by the negative deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value lower than setpoint from the previous 
process value. 
  
For example, 

Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 29              Then, job or alarm is activated. 

5.1.6.7.1.7  Error 

It is an error event. This event will be activated when there is an error on the input of the channel.  

5.1.6.7.2 Setpoint 

 Setpoint for the event. 

5.1.6.7.2.1 Hysteresis 

 To avoid the alarm or event been activated too often, Hysteresis value can be defined for the event trigger 
setpoint. 

5.1.6.7.2.2 Holding time 

 To avoid the alarm or event been activated too often, the holding time can be defined for the event trigger 
setpoint. In the process sometimes SP is reached but it will go down immediately, this might due to process 
instability. To avoid this kind of nuisance situations, the holding time can be used to see that PV stays at 
above that SP more than the holding time and then only activate the action for that event. The range of 
holding time can be set from 1 min to 60 min and 1 to 60 sec. 

5.1.6.7.3 Log 

 The event can be logged as an alarm or event. They can be selected from the available options. They are 
as below.  

5.1.6.7.3.1 Log Alarm 

 Log the event as Alarm.  

5.1.6.7.3.2  Log Alarm (Auto Ack) 

 Log the event as alarms and acknowledge automatically 
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5.1.6.7.3.3  Log Event 

  Log as event 

5.1.6.7.4 Job1 & Job2 

 The job is called as a task to be performed when the event is activated. There are two jobs Job1 and Job2 
can be added to perform in any event.  
 A typical example is to trigger an alarm buzzer in the event of high temperature.  Each channel can accept 
five different types of events (or alarms) and each event can create two jobs.  Please note that a job under 
Event is different from a job performed by Operate key. The job is actuated by an event, and the Operate is 
actuated by manual control, no event necessary. 
 
 Note: Please refer to the section Jobs for full details about various jobs available and section 
communication for more details about External Channel.  
 

5.2 Controller 

 This will allow the user to configure the PID process control card. The maximum no of PID Process control 
cards will vary depends on the recorder model as described below 
 

PR Recorder PR10 PR20 PR30 

No of PID Process control card 4 4 8 

 
 After entering the Configuration menu, in the Channel, select Controller then Press the “Enter” soft-key to 

get into Controller Channel configuration menu.  It displays the Controller channel C1 as the first Controller 

channel configuration page.  Press directional navigation keys   at the bottom to select other channels.  

Press directional keys   on the right-hand side to select the column.   After completing Configuration, 

press  soft-key, and then press  soft-key to return to the main display. All configurations will be 

saved automatically 

. 
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5.2.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name.  
 

5.2.2 Parameter 

 This will allow the user to configure the PID Control function on the Process Control Card. Press Parameter 

and then press  Enter soft-key to access the parameter configuration table. In the Configuration table, 

the user can edit the parameters of the Process Control Card as per their requirement by selecting the 

desired parameter using the UP-DOWN keys   and then press the Enter soft-key . The Enter 

soft-key will be disabled for the restricted parameters. 
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5.2.2.1 Parameter Configuration 

 The below table will explain the available parameters and their functions. 
 

Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

SP1 Setpoint 1 
Low: SP1L 
High: SP1H 

100.0°C 
(212.0°F) 

PV 

TIME Dwell Time 
Low: 0 
High: 6553.5 0.0 Minute 

A1SP Alarm 1 Setpoint 

If A1FN= 
Range of A1SP same as 

the range of 

PV1.H, PV1.L IN1 

PV2.H, PV2.L IN2 

P1.2 H, P1.2 L, D1.2 H, 
D1.2 L 

IN1, IN2 
 

100.0°C 
(212.0°F) 

*E1 

A1DV 
Alarm 1 Deviation 
Value 

Low: -200.0°C  (-360.0°F) 
High: 200.0°C (360.0°F) 

10.0°C  
(18.0°F) 

*E1 

A2SP Alarm 2 Setpoint 

If A1FN= 
Range of A1SP same as 

the range of 

PV1.H, PV1.L IN1 

PV2.H, PV2.L IN2 

P1.2 H, P1.2 L, D1.2 H, 
D1.2 L 

IN1, IN2 
 

100.0°C 
(212.0°F) 

*E2 

A2DV 
Alarm 2 Deviation 
Value 

Low: -200.0°C (-360.0°F) 
High: 200.0°C (360.0°F) 

10.0°C 
(18.0°F) 

*E2 

RAMP Ramp Rate 
Low: 0°C (0°F) 
High: 500.0°C (900.0°F) 

0.0 *E3 

OFST 
Offset Value for P 
control 

Low: 0 
High: 100.0 

25.0 % 

SHIF 
PV1 Shift (offset) 
Value 

Low: -200.0°C (-360.0°F) 
High: 200.0°C (360.0°F) 

0.0 PV1 

PB1 
Proportional Band 1 
Value 

Low: 0°C (0°F) 
High: 500.0°C (900.0°F) 

10.0°C                   
(18.0°F) 

PV 

TI1 
Integral Time 1 
Value 

Low: 0 
High: 1000 

100 Sec 

TD1 
Derivative Time 1 
Value 

Low: 0 
High: 360.0 

25.0 Sec 

CPB 
Cooling 
Proportional Band 
Value 

Low: 1 
High: 255 100 

% of 
PB 

DB 
Heating-Cooling 
Dead Band 

Low: -36.0 
High: 36.0 0 

% of 
PB 

SP2 Setpoint 2 

If PVMD= Range of SP2 same as the range of 

PV1 IN1 

PV2 IN2 

P1-2, P2-1 IN1, IN2 
 

37.8°C                   
(100.0°F) 

PV 
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

PB2 
Proportional Band 2 
Value 

Low: 0°C (0°F) 
High: 500.0°C (900.0°F) 

10.0°C                   
(18.0°F 

PV 

TI2 
Integral Time 2 
Value 

Low: 0 
High: 1000 

100 Sec 

TD2 
Derivative Time 2 
Value 

Low: 0 
High: 360.0 

25.0 Sec 

O1HY 
Output1 ON-OFF 
Control Hysteresis 

Low: 0.1 
High: 55.6°C (100.0°F) 

0.1 PV 

A1HY 
Hysteresis Control 
of Alarm1 

Low: 0.1 
High: 10.0°C (18.0°F) 

0.1 *E1 

A2HY 
Hysteresis Control 
of Alarm2 

Low: 0.1 
High: 10.0°C (18.0°F) 

0.1 *E2 

PL1 
Output 1 Power 
Limit 

Low: 0 
High: 100 

100 % 

PL2 
Output 2 Power 
Limit 

Low: 0 
High: 100 

100 % 

IN1 
IN1 Sensor Type 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 J_TC J Type Thermocouple 

1 K_TC K Type Thermocouple 

2 T_TC T Type Thermocouple 

3 E_TC T Type Thermocouple 

4 B_TC B Type Thermocouple 

5 R_TC R Type Thermocouple 

6 S_TC S Type Thermocouple 

7 N_TC N Type Thermocouple 

8 L_TC L Type Thermocouple 

9 PT.DN PT 100 Ohms DIN Curve 

10 PT.JS PT100 Ohms JIS Curve 

11 4-20 
4-20mA Linear  Current 

Input 

12 0-20 
0-20mA Linear  Current 

Input 

13 0-1V 
0-1V Linear Voltage 

Input 

14 0-5V 
0-5V Linear Voltage 

Input 

15 1-5V 
1-5V Linear Voltage 

Input 

16 0-10 
0-10V Linear Voltage 

Input 

17 SPEC 
Special defined   sensor 

Curve 
 

1 (0)  
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

IN1U IN1 Unit Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 °C 
Degree Celsius  

Unit 

1 °F 
Degree Fahrenheit 

Unit 

2 PU Process Unit 
 

0 (1)  

DP1 
IN1 Decimal Point 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 NO-DP No Decimal Digit 

1 1-DP One Decimal Digit 

2 2-DP Two Decimal Digits 

3 3-DP 
Three Decimal 

Digits 
 

1  

IN1L 
IN1 Low Scale 
Value 

Low: -19999 
High: 45536 

0 *E5 

IN1H 
IN1 High Scale 
Value 

Low: -19999 
High: 45536 1000 *E5 

SP1L 

 
SP1 Low Scale 
Value 

Low: -19999 
High: 45536 

0.0°C                   
(32.0°F) 

PV 

SP1H 

 
SP1 High Scale 
Value 

Low: -19999 
High: 45536 

1000.0°C                   
(1832.0°F) 

PV 

IN2 
IN2 Signal Type 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE IN2 No Function 

1 CT 
Current Transformer 

Input 

2 4-20 
4-20mA Linear 
Current Input 

3 0-20 
0-20mA Linear 
Current Input 

4 0-1V 
0-1V Linear Voltage 

Input 

5 0-5V 
0-5V Linear Voltage 

Input 

6 1-5V 
1-5V Linear Voltage 

Input 

7 0-10 
0-10V Linear Voltage 

Input 
 

1  

IN2U IN2 Unit Selection 

Parameter  
Value 

Display Symbol Description 

0 °C Degree Celsius Unit 

1 °F Degree Fahrenheit Unit 

2 PU Process Unit 
 

2  
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

DP2 
IN2 Decimal Point 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 NO-DP No Decimal Digit 

1 1-DP One Decimal Digit 

2 2-DP Two Decimal Digits 

3 3-DP 
Three Decimal 

Digits 
 

1  

IN2L 

 
IN2 Low Scale 
Value 

Low: -19999 
High: 45536 0 *E6 

IN2H 
IN2 High Scale 
Value 

Low: -19999 
High: 45536 1000 *E6 

EIFN 
Event Input 
Function 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE Event Input No Function 

1 SP2 
SP2 Activated to replace 

SP1 

2 PID2 
PB2, TI2, TD2 Activated to 

replace PB1, TI1, TD1 

3 SP.P2 
SP2, PB2, TI2, TD2 

Activated to replace SP1, 
PB1, TI1, TD1 

4 RS.A1 Reset Alarm 1 Output 

5 RS.A2 Reset Alarm2 Output 

6 R.A1.2 
Reset Alarm1 & Alarm2 

Output 

7 D.O1 Disable Output1 

8 D.O2 Disable Output2 

9 D.O1.2 Disable Output1 &Output 2 

10 LOCK Lock All Parameters 
 

1  

OUT1 Output 1 Function 

Parameter 
Value 

Display 
Symbol 

Description 

0 REVR 
Reverse 

(Heating)Control Action 

1 DIRT 
Direct (Cooling) Control 

Action 
 

0  

O1TY 
Output 1 Signal 
Type 

Parameter 
Value 

Display 
Symbol 

Description 

0 RELY Relay Output 

1 SSRD 
Solid State Relay 

Drive Output 

2 SSR 
Solid State Relay 

Output 

3 4-20 
4-20mA Current 

Module 

4 0-20 
0-20mA Current 

Module 

5 0-1V 0-1V Voltage Module 

6 0-5V 0-5V Voltage Module 

7 1-5V 1-5V Voltage Module 

8 0-10 0-10V Voltage Module 
 

0  

CYC1 
Output 1 Cycle 
Time 

Low: 0.1 

High: 100.0 
18.0 Sec 
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

O1FT 
Output 1 Failure 
Transfer Mode 

-0.1 for Bumpless transfer  

or  

0.0 ~ 100.0% to continue output 1 control 

function as the unit fails, power starts or manual 

mode starts. 

-0.1(BPLS) % 

OUT2 Output 2 Function 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE No function 

1 COOL PID Cooling Action 

3 DCPS 
DC Power supply 
module installed 

 

0  

O2TY 
Output 2 Signal 
Type 

Parameter 
Value 

Display 
Symbol 

Description 

0 RELY Relay Output 

1 SSRD 
Solid State Relay 

Drive Output 

2 SSR 
Solid State Relay 

Output 

3 4-20 
4-20mA Current 

Module 

4 0-20 
0-20mA Current 

Module 

5 0-1V 0-1V Voltage Module 

6 0-5V 0-5V Voltage Module 

7 1-5V 1-5V Voltage Module 

8 0-10 0-10V Voltage Module 
 

0  

CYC2 
Output 2 Cycle 
Time 

Low: 0.1 
High: 100.0 

18.0 Sec 

O2FT 
Output 2 Failure 
Transfer Mode 

-0.1 for Bumpless transfer  

or  

0.0 ~ 100.0% to continue output 2 control 

function as the unit fails, power starts or manual 

mode starts. 

-0.1(BPLS) % 
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

A1FN Alarm 1 Function 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE No alarm function 

1 TIMR Dwell timer action 

2 DE.HI Deviation high alarm 

3 DE.LO Deviation low alarm 

4 DB.HI 
Deviation band out of 

band alarm 

5 DB.LO 
Deviation band in band 

alarm 

6 PV1.H 
IN1 process value high 

alarm 

7 PV1.L 
IN1 process value low 

alarm 

8 PV2.H 
IN2 process value high 

alarm 

9 PV2.L 
IN2 process value low 

alarm 

10 P1.2.H 
IN1 or IN2 process 
value high alarm 

11 P1.2.L 
IN1 or IN2 process 

value low alarm 

12 D1.2.H 
IN1   IN2 difference 
process value high 

alarm 

13 D1.2.L 
IN1   IN2 difference 

process value low alarm 

14 LB Loop break alarm 

15 SEN.B 
Sensor break or A-D 

fails 
 

2  

A1MD 
Alarm 1 Operation 
Mode 

Parameter 
Value 

Display 
Symbol 

Description 

0 NORM Normal alarm action 

1 LTCH 
Latching alarm 

action 

2 HOLD Hold alarm action 

3 LT.HO 
Latching & Hold 

action 
 

0  

 
A1FT 

 
Alarm 1 Failure 
Transfer Mode 

Parameter 
Value 

Display 
Symbol 

Description 

0 OFF 
Alarm Output OFF as 

unit Fails 

1 ON 
Alarm Output ON as 

unit Fails 
 

1  
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

A2FN Alarm 2 Function 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE No alarm function 

1 TIMR Dwell timer action 

2 DE.HI Deviation high alarm 

3 DE.LO Deviation low alarm 

4 DB.HI 
Deviation band out of 

band alarm 

5 DB.LO 
Deviation band in band 

alarm 

6 PV1.H 
IN1 process value high 

alarm 

7 PV1.L 
IN1 process value low 

alarm 

8 PV2.H 
IN2 process value high 

alarm 

9 PV2.L 
IN2 process value low 

alarm 

10 P1.2.H 
IN1 or IN2 process 
value high alarm 

11 P1.2.L 
IN1 or IN2 process 

value low alarm 

12 D1.2.H 
IN1   IN2 difference 
process value high 

alarm 

13 D1.2.L 
IN1   IN2 difference 

process value low alarm 

14 LB Loop break alarm 

15 SEN.B 
Sensor break or A-D 

fails 
 

2  

A2MD 
Alarm 2 Operation 
Mode 

Parameter 
Value 

Display 
Symbol 

Description 

0 NORM Normal alarm action 

1 LTCH 
Latching alarm 

action 

2 HOLD Hold alarm action 

3 LT.HO 
Latching & Hold 

action 
 

0  

A2FT 
Alarm 2 Failure 
Transfer Mode 

Parameter 
Value 

Display 
Symbol 

Description 

0 OFF 
Alarm Output OFF as 

unit Fails 

1 ON 
Alarm Output ON as 

unit Fails 
 

1  

SELF 
Self-Tune Function 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE 
Auto tuning (Self Tune) 

Function disabled 

1 YES 
Auto tuning (Self Tune) 

Function Enabled 
 

0  
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

SLEP 
Sleep mode 
Function Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 NONE 
Sleep Mode Function 

disabled 

1 YES 
Sleep Mode Function 

Enabled 
 

0  

PVMD PV Mode Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 PV1 
Use PV1 as Process 

Value 

1 PV2 
Use PV2 as Process 

Value 

2 P1-2 
Use PV1-PV2 

Difference as Process 
Value 

3 P2-1 
Use PV2-PV1 

Difference as Process 
Value 

 

0  

SP2F 
Format of Setpoint 
2 Value 

Parameter 
Value 

Display 
Symbol 

Description 

0 ACTU 
Setpoint2 (SP2) is an 

Actual Value 

1 DEVI 
Setpoint2 (SP2) is a 

Deviation Value 
 

0  

FILT 
Filter Damping 
Time Constant of 
PV 

Parameter 
Value 

Display 
Symbol 

Description 

0 0 
0 second time 

constant 

1 0.2 
0.2 second time 

constant 

2 0.5 
0.5 second time 

constant 

3 1 
1 second time 

constant 

4 2 
2 seconds time 

constant 

5 5 
5 seconds time 

constant 

6 10 
10 seconds time 

constant 

7 20 
20 seconds time 

constant 

8 30 
30 seconds time 

constant 

9 60 
60 seconds time 

constant 
 

2  
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Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

SPMD 
Setpoint Mode 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 SP1.2 
Use SP1 or SP2 

(depends on EIFN) as 
setpoint 

1 MIN.R 
Use minute ramp rate as 

setpoint 

2 HR.R 
Use hour ramp rate as 

setpoint 

3 PV1 
Use IN1 process value 

as setpoint 

4 PV2 
Use IN2 process value 

as setpoint 

5 PUMP 
Selected for pump 

control 
 

0  

ERR1 
Historical Error 
Record 1 

Low: 0 
High: 65535 

0  

ERR2 
Historical Error 
Record 2 

Low: 0 
High: 65535 

0  

BPL1 
OUT1 Bumpless 
Transfer Value 

Low: 0.00 
High: 100.00 

 % 

BPL2 
OUT2 Bumpless 
Transfer Value 

Low: 0.00 
High: 100.00 

 % 

FILE 
Default File 
Selection 

Parameter 
Value 

Display 
Symbol 

Description 

0 0 
Perform Default Setting 

by using °C File 

1 1 
Perform Default Setting 

by using °F File 
 

  

PV 
Current Process 
Value 

Low: -19999 
High: 45536 

 PV 

SV 
Current setpoint 
Value 

Low: -19999 
High: 45536 

 PV 

MV1 
Current Output 1 
Value 

Low: -0.00 
High: 100.00 

 % 

MV2 
Current Output 2 
Value 

Low: -0.00 
High: 100.00 

 % 

ALM 

Contains 
Conditional Code 
of parameters 
Resolution and 
Current Alarm 
Status 

Refer Note B33 

  

DV 
Current Deviation 
(PV-SV) Value 

Low: -12600 
High: 12600 

 PV 

PV1 IN1 Process Value 
Low: -19999 
High: 45536 

 *E5 

PV2 IN2 Process Value 
Low: -19999 
High: 45536 

 *E6 



 
 

 
 

Page 154 of 550 

Parameter 
Notation 

Parameter 
Description 

Range*B Default 
Value  

Unit*E 
 

PB 
Current 
Proportional Band 
Value 

Low: 0 
High: 500.0°C           (900.0°F)  PV 

TI 
Current Integral 
Time  
Value 

Low: 0 
High: 4000  Sec 

TD 
Current Derivative 
Time  
Value 

Low: 0 
High: 1440  Sec 

EROR Current Error Code Refer Note B34   

 
PROG 

Program 
Identification 
Code 
Contains 
Program 
Number and 
Version 
Number 

Parameter 
Value 

Product 

4.XX 
BTC-4300 controller & PID Process 

Control card of PR 
 

  

MODE 

Contains 
Lockout 
Status code 
and Current 
system mode 

Parameter Value Description 

X.0 Perform normal mode 

X.1 Enter calibration mode 

X.2 Enter auto-tuning mode 

X.3 Enter failure mode 

X.4 Enter manual mode 

X.5 Enter sleep mode 

0.X Unlock condition 

1.X SP1, SEL1   SEL5 are unlocked 

2.X Lock all parameters except SP1 

3.X All parameters are locked 
 

  

CJCT 

 
Cold Junction 
Compensatio
n 
Temperature 

Low: -40.0°C 
High: 90.0°C  °C 

PVR 
Current Process 
Rate 
Value 

Low: -16383 
High: 16383  PV/min 

PVRH 
Maximum Process 
Rate Value 

Low: -16383 
High: 16383 

 PV/min 

PVRL 
Minimum Process 
Rate Value 

Low: -16383 
High: 16383 

 PV/min 

SPC 
Current Target 
Value of 
 setpoint 

Low: -19999 
High: 45536  PV 

 
Notes 
*B:  The ranges of some parameters are dependent on the input types. The range of IN1 and IN2 for various 
input type is shown in the following table 
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Input Type Range Low Rang High 

J_T/C -120°C(-184°F) 1000°C(1832°F) 

K_T/C -200°C(-328°F) 1370°C(2498°F) 

T_T/C -250°C(-418°F) 400°C(752°F) 

E_T/C -100°C(-148°F) 900°C(1652°F) 

B_T/C 0°C(32°F) 1820°C(3308°F) 

R_T/C 0°C(32°F) 1767.8°C(3214°F) 

S_T/C 0°C(32°F) 1767.8°C(3214°F) 

N_T/C -250°C(-418°F) 1300°C(2372°F) 

L_T/C -200°C(-328°F) 900°C(1652°F) 

PT100_DN -210°C(-346°F) 700°C(1292°F) 

PT100_JS -210°C(-346°F) 600°C(1112°F) 

CT 0 Amps 90 Amps 

Linear (mA or Voltage) -19999 45536 
5-1 PID Process Control Card Input Types 

 
*B33: Description of Alarm Value 
      MSB                      LSB 
  15     14     13     12   11     10    9        8      7       6      5        4     3        2       1       0 
     
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

=BIN2K 
If BIN2= 8~18, then 
BIN2K=00 
If BIN2=1, then BIN2K=01 
If BIN2=19, 21, 22, 23 then 
BIN2K=10 
Otherwise, BIN2K=11 

 

=BIN1K 
If BIN1<11, then BIN1K=00 
If 11≤ BIN1<17, then 
BIN1K=01 
Otherwise, BIN1K=10 

 

=DP2K=DP2 

 

=DP1K=DP1 

 
=0 

 

=BPVMDK 
If BPVMD=1 then 
BPVMDK=0 
Otherwise BPVMDK=1 

 
=AOFNK 
If AOFN = 0, 2, 3 then 
AOFNK = 00 
If AOFN = 1 then 
AOFNK = 01 
If AOFN = 4, 7 then 
AOFNK = 10 
If AOFN = 5, 6 then 
AOFNK =11 
 

 

=A2FNK 
If A2FN = 8, 9 then 
A2FNK = 0 
Otherwise A2FNK = 1 
 

 

=A1FNK 
If A1FN = 8, 9 then 
A1FNK = 0 
Otherwise A1FNK = 1 
 

 

=ALMK 
=00: No Alarm 
activated 
=01: Alarm 1 
activated 
=10: Alarm 2 
activated 
=11: Alarm 1 & 
alarm 2 activated 
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Error 
Code 

Display 
Symbol 

Error Description Corrective Action 

1 Er 01 
Illegal setup values used: PV1 is used for 
both PVMD and SPMD that is 
meaningless for control. 

Check and correct setup values of PVMD and 
SPMD, PV and SV can't use the same value for 
normal control 

2 Er 02 
Illegal setup values used: PV2 is used for 
both PVMD and SPMD that is 
meaningless for control 

Same as error code1 

3 Er 03 

Illegal setup values used: P1-2 or P2-1 is 
used for PVMD while PV1 or PV2 is used 
for SPMD. Dependent values are used 
for PV and SV will produce the incorrect 
result of control 

Check and correct setup values of PVMD and 
SPMD. 
The difference between PV1 and PV2 can't be 
used for PV while PV1 or PV2 
is used for SV 

4 Er 04 

Illegal setup values used: COOL is used 
for OUT2, but DIRT (cooling action) is 
already used for OUT1 or PID mode is 
not used for OUT1 (that is PB1 or PB2 
=0, and TI1 or TI2 =0) 

Check and correct setup values of OUT2, PB1, 
PB2, TI1, TI2 and OUT1. IF OUT2 is required 
for cooling control, the control should use PID 
mode (PB ≠ 0, TI ≠ 0) and OUT1 should use 
reverse mode (heating action), otherwise, don't 
use OUT2 for cooling control 

5 Er 05 

Illegal setup values used: unequal IN1U 
and IN2U or unequal DP1 and DP2 while 
P1-2 or P2-1 is used for PVMD or, PV1 or 
PV2 is used for SPMD or, P1.2.H, P1.2.L, 
D1.2.H or D1.2.L is used for A1FN or 
A2FN. 

Check and correct setup values of IN1U 
, IN2U, DP1, DP2, PVMD, SPMD, A1FN or 
A2FN. Same unit and decimal point 
Should be used if both PV1 and PV2 are used 
for PV, SV, alarm1 or alarm 2. 

6 Er 06 
Illegal setup values used: OUT2 select 
=AL2 but A2FN select NONE 

Check and correct setup values of OUT2 and 
A2FN. OUT2 will not perform alarm function if 
A2FN select NONE. 

7 Er 07 
Illegal setup values used: Dwell timer 
(TIMR) is selected for both A1FN and 
A2FN. 

Check and correct setup values of A1FN and 
A2FN. Dwell timer can only be properly used for 
single alarm output. 

9 Er 09 

Communication error: receive an error 
due to parity error, framing error, overrun 
error, receive buffer full error, frame 
check-sum error or receive disturbed 

1.Correct the communication software to meet 
the protocol requirements 
2. Add a terminating resistor to the multi-drop 
link (RS-485) to minimize the noise. 
3. Use twisted-pair wire for RS-485 interface 
connection to minimize the noise. 
4. Check the polarity of RS-485 interface 
connection. 

10 Er 10 Communication error: bad function code 
Correct the communication software to meet the 
protocol requirements. 

11 Er 11 
Communication error: register address 
out of range 

Don't issue an over-range address of the 
register to the slave. 

12 Er 12 
Communication error: access a non-
existent parameter 

Don't issue a non- existent parameter to the 
slave. 

14 Er 14 
Communication error: attempt to write a 
read-only data 

Don't write read-only data or protected data to 
the slave. 
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Error 
Code 

Display 
Symbol 

Error Description Corrective Action 

15 Er 15 
Communication error: write a value which 
is out of range to a register 

Don't write an over-range data to the slave 
register. 

17 Er 17 
Computing error: Illegal (abnormal) 
floating-point data 

Software bug. Return to factory for repair. 

18 Er 18 
Computing error: Arithmetic result 
overflow or underflow 

Software bug. Return to factory for repair. 

19 Er 19 Computing error: divided by zero Don't use an equal value for AOLO and AOHI. 

20 Er 20 Computing error: Illegal BCD data entry Software bug. Return to factory for repair. 

21 Er 21 
Timing error:  A to D conversion data 
error due to overrun 

A to D converter doesn't work properly. Return 
to factory for repair. 

22 Er 22 
Timing error: check-sum error received 
during multi-chip communication 
procedure 

1. Correct the multi-chip communication 
software to meet the protocol requirement. 
2. Return to factory for repair. 

23 Er 23 
Timing error: wrong function code 
received during multi-chip communication 
procedure 

1. Correct the multi-chip communication 
software to meet the protocol requirement. 
2. Return to factory for Repair. 

26 AtEr 
 
Fail to perform 
the auto-tuning function 

1. The PID values obtained after the auto-tuning 
procedure are out of range. Retry auto-tuning. 
2. Don’t change setpoint value during the auto-
tuning procedure. 
3. Don’t change Event input state during the 
auto-tuning procedure. 
4. Use manual tuning Instead of auto-tuning. 

27 CAER 
Incorrect calibration procedure or 
tolerance of analog component too big to 
meet the specified accuracy 

1. Pay more attention to the calibration 
procedures. 
2. Return to factory for repair. 

28 CAPE 
Memory comparison error, the different 
value detected in the EEPROM and 
mapped RAM 

1. Check and correct the wiring and grounding 
problems to minimize the system noise. 
2. Return to factory for repair. 

29 EEPE EEPROM can't be written correctly Return to factory for repair. 

32 CJER 
Cold junction compensation device(s) 
malfunction 

Return to factory for repair. 

33 YYER 
Key switch shorted or related PCB circuit 
shorted 

Return to factory for repair. 

34 LLL2 Input 2 (IN2) signal too low 

1. Check if the input 2 sensor used is accordant 
with IN2 type selection. 
2. Check the connection polarity of input 2 
sensor. 
3. Replace input 2 sensor. 

35 HHH2 Input 2 (IN2) signal too high 
1. Check if the input 2 sensor used is accordant 
with IN2 type selection. 
2. Replace input 2 sensor. 

36 LLL1 Input 1 (IN1) signal too low 

1. Check if the input 1 sensor used is accordant 
with IN1 type selection. 
2. Check the connection polarity of input 1 
sensor. 
3. Replace input 1 sensor. 
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Error 
Code 

Display 
Symbol 

Error Description Corrective Action 

37 HHH1 Input 1 (IN1) signal too high 
1. Check if the input 1 sensor used is accordant 
with IN1 type selection. 
2. Replace input 1 Sensor. 

38 SB2E 

Input 2 (IN2) sensor break, or input 2 
current below 1 mA if 4-20 mA is 
selected, or input2 voltage below 
0.25V if 1 - 5V is selected 

Replace input 2 sensor. 

39 SB1E 

Input 1 (IN1) sensor break, or input 1 
current below 1 mA if 4-20 mA is 
selected, or input1 voltage below 
0.25V if 1 - 5V is selected 

Replace input 1 sensor. 

40 ADER 
A to D converter or related component(s) 
malfunction 

Return to factory for repair. 

*B34: Error Messages 
5-2 Error Messages and Corrective Actions 

*C: The Parameters are pre-set with the default values specified in the table. 
*E: The unit PV means that the unit of the parameter is the same as the unit of PV (process value). The unit 
of PV is determined by PVMD, IN1, IN2, IN1U, and IN2U. 
 
*E1: Unit determination for A1SP, A1DV and A1HY 

If A1FN= Range of A1SP same as the range of 

DE.HI,DE.LO,DB.HI,DB.LO PV 

PV1.H, PV1.L PV1 

PV2.H,PV.L PV2 

P1.2.H, P1.2.L, D1.2.H, D1.2. L PV1, PV2 
5-3 Unit Determination for A1SP, A1DV, A1HY 

*E2: Unit determination for A2SP, A2DV and A2HY 

If A2FN= Range of A2SP same as the range of 

DE.HI,DE.LO,DB.HI,DB.LO PV 

PV1.H, PV1.L PV1 

PV2.H, PV.L PV2 

P1.2.H, P1.2.L, D1.2.H, D1.2.L PV1, PV2 
5-4 Unit Determination for A2SP, A2DV, A2HY 

*E3: Unit determination for Ramp 

If SPMD= Unit 

MIN.R PV/Minute 

HR.R PV/Hour 
5-5 Ramp Unit 

*E4: Unit determination for AOLO and AOHI 

If AOFN= Same Unit as Unit of 

PV1 PV1 

PV2 PV2 

P1-2, P2-1 PV1, PV2 

SV PV 

MV1, MV2 % 
5-6 Unit Determination of AOLO & AOHI 
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*E5: Unit is the same as the unit of PV1 (IN1)  
*E6: Unit is the same as the unit of PV2 (IN2)  

5.2.2.1.1  Default 

 This will allow the user to load the default values of the Process Control Card Parameters 
 

5.2.3 Channel 

 The Channel will allow the user to configure the channels to be logged in the recorder from PID process 
control card. Press Channel and then press Enter soft-key to access the Channel parameter of Process 
Control Card. 
 

 
 

 After entering the Configuration menu, in the Channel, select Controller then Press the Enter soft-key to get 

into Controller Channel configuration menu. After entering particular controller configuration menu then 

selects channel then press Enter to enter into the controller channel configuration menu. It displays the 

Controller C1 channel C1-1(C1_PV) as the first Controller channel configuration page.  Press directional 

navigation keys   at the bottom to select other channels.  Press directional keys   on the right-

hand side to select the column.   After completing Configuration, press  soft-key, then press   

soft-key and then press  soft-key to return to the main display. All configurations will be saved 

automatically. 

 There are five channels available for every PID Process control card for logging. They are listed as below. 
1. C1_PV – Process Value 
2. C1_SV- Set Value 
3. C1_ALM - Alarm 
4. C1_EROR - Error 
5. C1_ProfileERROR – Profile Error 

 Similar to C1 PID Process control card C2, C3, C4, C5, C6, C7, C8 PID process control card parameters 
also available depends on the recorder model no and their connection on the recorder 
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5.2.3.1 Name 

 Enables the user to define the name for each channel with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
channel name.  

5.2.3.2 Desc 

 The description of a specific channel on the recorder.  

5.2.3.3 Type 

 Option available to enable or disable the channel 

5.2.3.4 Source 

 There are five parameters from each PID process control cards are available as source logging. They are 
listed as below 

1. PV – Process Value 
2. SV- Set Value 
3. ALM - Alarm 
4. EROR - Error 
5. ProfileERROR – Profile Error 

The first channel of every PID Process control card will always show PV as the source. Similar to this SV, 

ALM, EROR and ProfileERROR are available as source in second, third, fourth and fifth channels of every 

PID Process control card. The source can’t be changed by the user. The user can only enable or disable the 

channel from the logging. These parameters can be logged to the recorder by enabling those channels in 

the type. By using the   Key to switch between Channels. 

5.2.3.5 Log 

5.2.3.5.1 Data Type 

 The data type for logging is 2 bytes. 
 2-byte range: -32767 to +32767 

5.2.3.5.2 Trigger 

 Two options are available for the user to select. 
1. Disable: Select disable while the recording of a specific channel is not required at this time 
2. Enable: Select enable while the recording of a specific channel is required at this time 

5.2.3.5.3 Method 

 This is the method of logging measured data. Select the column Method and press Enter. Then choose the 
required Log method from the available methods Instant, Average, Minimum or Maximum of data. 

5.2.3.5.3.1 Instant 

 Logging the last measured data at the logging interval 

5.2.3.5.3.2 Average 

 Logging the averaged of sampled measured data at the logging interval 
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5.2.3.5.3.3 Minimum 

 Logging the minimum of sampled measured data at the logging interval  

5.2.3.5.3.4 Maximum 

 Logging the maximum of sampled measured data at the logging interval 

5.2.3.5.4 Speed 

It is the logging speed (recording speed) of measured data. The available log speeds are as below. 
1. 100 msec/dot 
2. 1 Sec/dot 
3. 2 Sec/dot 
4. 5 Sec/dot 
5. 10 Sec/dot 
6. 15 Sec/dot 
7. 20 Sec/dot 
8. 30 Sec/dot 
9. 1 min/dot 
10. 2 min/dot 
11. 5 min/dot 
12. 15 min/dot 
13. 1 hour/dot 
14. 2 hour/dot 

5.2.3.6  Modbus 

 The scaling of the channel value in Modbus communication. 

5.2.3.7 Events 

Events are frequently used for Alarm purposes. The events can be used to operate digital outputs (DO), 
Timer, Totalizer, Counter or Report. There is a maximum of five events can be added to each analog input. 
 Press “Add” to add new event and Press “Remove” to remove selected event 

  
 

5.2.3.7.1 Type  

 There are various types of events are available for the user to select for job or alarm purpose. They are 
listed as below. 

5.2.3.7.1.1 H 

 It is a high event. When the process value is higher than the high limit, then the alarm or job associated with 
this event is actuated. 

5.2.3.7.1.2 L 

 It is a low event. When the process value is lower than the low limit, then the alarm or job associated with 
this event is actuated. 
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5.2.3.7.1.3 HH  

 It is a high high event. When the process value is higher than the high high limit, then the alarm or job 
associated with this event is actuated. This is another limit higher than the high limit for double warning. 

5.2.3.7.1.4 LL 

 It is a low low event. When the process value is lower than the low low limit, then the alarm or job 
associated with this event is actuated. This is another limit lower than the low limit for double warning.   

5.2.3.7.1.5 Dev+ 

It is a deviation+ event. This event will be triggered by the positive deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value higher than setpoint from the previous 
process value. 
 
For example,  
Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 51 
Then, job or alarm is activated 

5.2.3.7.1.6 Dev- 

It is a deviation- event. This event will be triggered by the negative deviation of the process value. The job or 
alarm is activated when the process value is deviated by the value lower than the setpoint from the previous 
process value. 
For example, 
Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 29 
Then, job or alarm is activated. 

5.2.3.7.1.7  Error 

It is an error event. This event will be activated when there is an error on the input of the channel. 

5.2.3.7.2 Setpoint 

 Setpoint for the event. 

5.2.3.7.2.1 Hysteresis 

 To avoid the alarm or event been activated too often, Hysteresis value can be defined for the event trigger 
setpoint. 

5.2.3.7.2.2 Holding time 

 To avoid the alarm or event been activated too often, the holding time can be defined for the event trigger 
setpoint. In the process sometimes SP is reached but it will go down immediately, this might due to process 
instability. To avoid this kind of nuisance situations, the holding time can be used to see that PV stays at 
above that SP more than the holding time and then only activate the action for that event. The range of 
holding time can be set from 1 min to 60 min and 1 to 60 sec. 
 
New modifications since V1.50: 
 New option in seconds for Event->Set Point->Holding Time. 
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5.2.3.7.3 Log 

 The event can be logged as an alarm or event. They can be selected from the available options. They are 
as below.  

5.2.3.7.3.1 Log Alarm 

 Log the event as Alarm.  

5.2.3.7.3.2  Log Alarm (Auto Ack) 

 Log the event as alarms and acknowledge automatically 

5.2.3.7.3.3  Log Event 

 Log as event 

5.2.3.7.4 Job1 & Job2 

 The job is called as a task to be performed when the event is activated. There are two jobs Job1 and Job2 
can be added to perform in any event.  
 A typical example is to trigger an alarm buzzer in the event of high temperature.  Each channel can accept 
five different types of events (or alarms) and each event can create two jobs.  Please note that a job under 
Event is different from a job performed by Operate key.  The job is actuated by an event, and the Operate is 
actuated by manual control, no event necessary. 
 Note: Please refer to the section Jobs for full details about various jobs available  
 Note: Number of controller channels shown on the controller screen depends on the number of PID 
process control cards inserted in the paperless recorder.  

5.2.4 Configuration of Process Control Card 

5.2.4.1 Heat Only ON-OFF Control  

 Select REVR for OUT1, Set PB1 to 0, SP1 is used to adjust setpoint value, O1HY is used to adjust the 
dead band for ON-OFF control, and TIME is used to adjust the dwell timer (enabled by selecting TIMR for 
A1FN or A2FN). The output 1 hysteresis (O1HY) is enabled in case of PB1 = 0. The heat only on-off control 
function is shown in the following diagram. 
 

 
The ON-OFF control may introduce excessive process oscillation even if Hysteresis is minimized to the 
smallest. If ON-OFF control is set (i.e. PB1 = 0), TI1, TD1, CYC1, OFST, CPB and PL1 will be hidden and 
have no function to the system. The manual mode, auto-tuning, self-tuning and Bumpless transfer will be 
disabled too. 
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Select REVR for OUT1, set TI1 to 0, SP1 is used to adjust setpoint value; TIME is used to adjust the dwell 
timer (enabled by selecting TIMR for A1FN or A2FN). OFST has been enabled in case of TI1 = 0 is used to 
adjust the controlled offset (manual reset). Adjust CYC1 according to the output 1 type (O1TY). Generally, 
CYC1= 0.5 ~ 2 sec for SSRD and SSR, CYC1=10 ~ 20 sec for relay output. CYC1 is ignored if the linear 
output is selected for O1TY. If PB1 is not equal to 0. 
 OFST is measured by % with range 0 - 100.0 %. In the steady-state (i.e. process has been stabilized) if the 
process value is lower than the setpoint a definite value, say 5 C, while 20 C is used for PB1, that is lower 
25 %, then increase OFST 25 % and vice versa. After adjusting the OFST value, the process value will be 
varied and eventually, coincide with the setpoint.  
 Using the P control (TI1 set to 0), the auto-tuning and self-tuning are disabled. Manual reset (adjust OFST) 
is not practical because the load may change from time to time and often need to adjust OFST repeatedly. 
PID control can avoid this situation. Selecting REVR for OUT1, SP1 is used to adjust setpoint value. 
 TIME is used to adjust the dwell timer (enabled by selecting TIMR for A1FN or A2FN). PB1 and TI1 should 
not be zero. Adjust CYC1 according to the output 1 type (O1TY). Generally, CYC1 = 0.5 ~ 2 sec for SSRD 
and SSR, CYC1 = 10 ~ 20 sec for relay output. CYC1 is ignored if the linear output is selected for O1TY. 
 In most cases, the self-tuning can be used to substitute the auto-tuning. See If self-tuning is not used 
(select NONE for SELF), then use auto-tuning for the new process, or set PB1, TI1 and TD1 with historical 
values. If the control result is still unsatisfactory, then use manual tuning to improve the control. This 
Process Control Card contains a very clever PID and Fuzzy algorithm to achieve a very small overshoot and 
very quick response to the process if it is properly tuned. 

5.2.4.2 Cool Only ON-OFF Control  

 ON-OFF control, P (PD) control and PID control can be used for cool control. Set OUT1 to DIRT (direct 
action). The other functions for cool only ON-OFF control, cool only P(PD) control and cool only PID control 
are same as Heat only ON-OFF Control except that the output variable (and action) for the cool control is 
inverse to the heat control, such as the following diagram shows: 
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5.2.4.3 Heat Cool Control  

 The Heat-Cool Control can use one of 6 combinations of control modes. Setups of Parameters for each 
control mode are shown in the following table. 

 

 
Note  
The ON-OFF control may result in excessive overshoot and undershoot problems in the process. The P (or 
PD) control will result in a deviation process value from the setpoint. It is recommended to use PID control 
for the Heat-Cool control to produce a stable and zero offset process value. 
 
Other Setup Required  
 O1TY, CYC1, O2TY, CYC2, A2SP, A2DV, O1TY & O2TY are set in accordance with the types of OUT1 & 
OUT2 installed. CYC1 & CYC2 are selected according to the output 1 type (O1TY) & output 2 type (O2TY). 
Generally, selects 0.5 ~ 2 sec. for CYC1, if SSRD or SSR is used for O1TY; 10 ~ 20 sec. if the relay is used 
for O1TY, and CYC1 is ignored if the linear output is used. A similar condition is applied for CYC2 selection. 
 
Examples 
 Heat PID+Cool ON-OFF: Set OUT1= REVR, A1FN or A2FN= PV1.H, A1FN or A2MD=NORM, A1HY or 
A2HY=0.1, PB1=0, TI1=0, TD1=0, and set appropriate values for O1TY and CYC1. 
 Heat PID+Cool PID: set OUT1=REVR, OUT2=COOL, CPB=100, DB=-4.0, PB1=0, TI1=0, TD1=0, and set 
appropriate values for O1TY, CYC1, O2TY, and CYC2. 
 
CPB Programming  
 The cooling proportional band is measured by % of PB with range 1~255. Initially set 100% for CPB and 
examine the cooling effect. If cooling action should be enhanced then decrease CPB. If cooling action is too 
strong then increase CPB. The value of CPB is related to PB and its value remains unchanged throughout 
the self-tuning and auto-tuning procedures.  
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 Adjustment of CPB is related to the cooling media used. For air is used as cooling media, adjust CPB at 
100(%). For oil is used as cooling media, adjust CPB at 125(%). For water is used as cooling media, adjust 
CPB at 250(%) 
 
DB Programming 
 Adjustment of DB is dependent on the system requirements. If the more positive value of DB (greater dead 
band) is used, an unwanted cooling action can be avoided but an excessive overshoot over the setpoint will 
occur. If the more negative value of DB (greater overlap) is used, an excessive overshoot over the setpoint 
can be minimized but an unwanted cooling action will occur. It is adjustable in the range -36.0% to 36.0 % of 
PB1 (or PB2 if PB2 is selected). A negative DB value shows an overlap area over which both outputs are 
active. A positive DB value shows a dead band area over which neither output is active 

5.2.4.4 Heater Break Alarm  

 A current transformer CT94-1 should be installed to detect the heater current if a heater break alarm is 
required. The CT signal is sent to input 2, and the PV2 will indicate the heater current is 0.1 Amp. 
Resolution. The range of the current transformer is 0 to 50.0 Amps. 
Example 
 A furnace uses two 2KW heaters connected in parallel to warm up the process. The line voltage is 220V 
and the rating current for each heater is 9.09A. If we want to detect anyone heater break, set A1SP=13.0A, 
A1HY=0.1 A1FN=PV2.L, A1MD=NORM, then 
 

 

5.2.4.5 Loop Break Alarm  

 A1FN selects LB if alarm 1 is required to act as a loop break alarm. Similarly, if alarm 2 is required to act as 
a loop break alarm, then set OUT2 with=AL2 and A1FN with LB. TIME, A1SP, A1DV and A1HY are hidden 
if alarm 1 is configured as a loop break alarm. Similarly, TIME, A2SP, A2DV and A2HY are hidden if alarm 2 
is configured as a loop break alarm. 
 One of 4 kinds of alarm modes can be selected for alarm 1 and alarm 2. These are Normal alarm, latching 
alarm, holding alarm and Latching/Holding alarm. However, the Holding mode and latching/Holding mode 
are not recommended to be chosen for loop break alarm since loop break alarm will not perform holding 
function even if it is set with holding or latching/holding mode.  
 Loop Break Conditions are detected during a time interval of 2TI1 (double of integral time, but 120 seconds 
maximum). Hence the loop break alarm doesn't respond quickly as it occurs. If the process value doesn't 
increase (or decrease) while the control variable MV1 has reached to it's a maximum (or minimum) value 
within the detecting time interval, a loop break alarm (if configured) will be actuated. 
 Loop Break Alarm (if configured) occurs when any of the following condition happens 

1 Input sensor is disconnected (or broken). 
2 Input sensor is shorted. 
3 Input sensor is defective. 
4 Input sensor is installed outside (isolated from) the process. 
5 Controller fails (A-D converter damaged). 
6 Heater (or generally, chillers, valve, pump, motor etc.) breaks or fails or uninstalled 
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7 Switching device (used to drive heater) is open or shorted. 

5.2.4.6 Sensor Break Alarm  

 Alarm 1 or alarm 2 can be configured as sensor break alarm by selecting SENB for A1FN or A2FN. The 
sensor break alarm is activated as soon as the failure mode occurs. Note that A-D failure also creates a 
sensor break alarm. TIME, A1SP, A1DV, and A1HY are hidden if alarm 1 is configured as a sensor break 
alarm. Similarly, TIME, A2SP, A2DV and A2HY are hidden if alarm 2 is configured as a sensor break alarm.  
One of 4 kinds of alarm modes can be selected for sensor break alarm. These are Normal alarm, latching 
alarm, holding alarm and Latching/Holding alarm. However, the Holding alarm and Latching/Holding alarm 
are not recommended to be chosen for sensor break alarm since sensor break alarm will not perform 
holding function even if it is set with holding or latching/holding mode. 

5.2.4.7 Failure Transfer  

 The controller will enter failure mode as one of the following conditions occurs. 
1 SB1E Error occurs (due to the input 1 sensor break or input 1 current below 1mA, if 4-20mA is 

selected or input 1 voltage below 0.25V if 1-5 V is selected) if PV1, P1-2 or P2-1 is selected for 
PVMD or PV1 is selected for SPMD. 

2 SB2E Error occurs (due to the input 2 sensor break or input 2 current below 1mA, if 4-20 mA is 
selected or input 2 voltage below 0.25V if 1-5 V is selected) if PV2, P1-2 or P2-1 is selected for 
PVMD or PV2 is selected for SPMD. 

3 ADER error occurs due to the A-D converter of the controller fails. 
Output 1 and output 2 will perform the failure transfer function as one of the following conditions occurs. 

1 During power starts (within 2.5 seconds). 
2 The controller enters the failure mode. 
3 The controller enters the manual mode. 
4 The controller enters the calibration mode. 

 
Output 1 Failure Transfer, if activated, will perform  

1  If output 1 is configured as proportional control (PB1≠0), and BPLS selected for O1FT, then 
output 1 will perform Bumpless transfer. Thereafter the previous averaging value of MV1 will be 
used for controlling output 1. 

2  If output 1 is configured as proportional control (PB1 ≠ 0), and a value of 0 to 100.0 % is set for 
O1FT, then output 1 will perform failure transfer. Thereafter the value of O1FT will be used for 
controlling output 1. 

3  If output 1 is configured as ON-OFF control (PB1 = 0), then output 1 will be driven OFF if O1FN 
selects REVR and be driven ON if O1FN selects DIRT. 

4  If output 1 is configured as ON-OFF control (PB1=0), then output 1 will be driven OFF if O1FN 
selects REVR and be driven ON if O1FN selects DIRT. 

 
Output 2 Failure Transfer, if activated, will perform  

1  If OUT2 selects COOL, and BPLS is selected for O1FT, then output 2 will perform Bumpless 
transfer. Thereafter the previous averaging value of MV2 will be used for controlling output 2. 

2  If OUT2 selects COOL, and a value of 0 to 100.0 % is set for O2FT, then output 2 will perform 
failure transfer. Thereafter the value of O2FT will be used for controlling output 2. 

 
Alarm 1 Failure Transfer is activated as the controller enters failure mode. Thereafter the alarm 1 will 
transfer to the ON or OFF state pre-set by A1FT. 
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Exception 
 If Loop Break (LB) alarm or sensor Break (SENB) alarm is configured for A1FN, the alarm 1 will be 
switched to ON state independent of the setting of A1FT. If Dwell Timer (TIMR) is configured for A1FN, the 
alarm 1 will not perform failure transfer. 
Alarm 2 Failure Transfer is activated as the controller enters failure mode. Thereafter the alarm 2 will 
transfer to the ON or OFF state pre-set by A2FT. Alarm 2 Failure Transfer is activated as the controller 
enters failure mode. 
 
Exception 
 If Loop Break (LB) alarm or sensor Break (SENB) alarm is configured for A2FN, the alarm 2 will be 
switched to ON state independent of the setting of A2FT. If Dwell Timer (TIMR) is configured for A2FN, the 
alarm 2 will not perform failure transfer. 

5.2.4.8 Bumpless Transfer 

The Bumpless transfer function is available for output 1 and output 2 (provided that OUT2 is configured as 
COOL). Bumpless Transfer is enabled by selecting BPLS for O1FT and/or O2FT and activated as one of 
the following cases occurs. 

1  Power starts (within 2.5 seconds). 
2  The controller enters the failure mode.  
3 The controller enters the manual mode.  
4 The controller enters the calibration mode.  

 As the Bumpless transfer is activated, the controller will transfer to open-loop control and uses the previous 
averaging value of MV1 and MV2 to continue control. 

5.2.4.8.1 Without Bumpless Transfer 

 Since the hardware and software need time to be initialized, the control is abnormal as the power is 
recovered and results in a large disturbance to the process. During the sensor breaks, the process loses 
power. 

 

5.2.4.8.2 With Bumpless Transfer 

 After Bumpless transfer is configured with the correct control variables applied, the disturbance is small 
when the power is recovered. During the sensor breaks, the controller continues to control by using its 
previous value. If the load doesn't change, the process will remain stable. Thereafter, once the load 
changes, the process may run away. Therefore, the user should not rely on a Bumpless transfer for a longer 
time. For the fail-safe reason, an additional alarm should be used to announce the operator when the 
system fails. For, a Sensor Break Alarm, if configured, will switch to failure state and announces the 
operator to use manual control or take a proper security action when the system enters failure mode. 
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Warning: After the system fails, never depend on Bumpless transfer for a long time; otherwise it 
might cause a problem to the system to run away. 

5.2.4.9 PV1 Shift 

 In certain applications, it is desirable to shift the controller display value from its actual value. This can be 
easily accomplished by using the PV1 shift function. Press the “scroll " key to the parameter SHIF in card 
parameter. The value you adjust here, either positive or negative, will be added to the actual value. The 
SHIF function will alter PV1 only. 
 Here is an example. A process is equipped with a heater, a sensor and a subject to be warmed up. Due to 
the design and position of the components in the system, the sensor could not be placed any closer to the 
part. Thermal gradient (different temperature) is common and necessary to an extent in any thermal system 
for heat to be transferred from one point to another. If the difference between the sensor and the subject is 
35 C, and the desired temperature at the subject to be heated is 200 C, the controlling value or the 
temperature at the sensor should be 235 C. You should input -35 C as to subtract 35 C from the actual 
process display. This, in turn, will cause the controller to energize the load and bring the process display up 
to the setpoint value. 
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5.2.4.10 SP1 Range 

 SP1L (SP1 low limit value) and SP1H (SP1 high limit value) in the setup menu is used to confine the 
adjustment range of SP1. 
Example: A freezer is working in its normal temperature range -10°C to -15°C. In order to avoid an 
abnormal setpoint, SP1L and SP1H are set with the following values: SP1L = -15°C SP1H = -10°C 
Now SP1 can only be adjusted within the range from -10 C to -15 C. 

5.2.4.11 Dwell Timer 

 Alarm 1 or alarm 2 can be configured as dwell timer by selecting TIMR for A1FN or A2FN, but not both, 
otherwise, Error will appear. As the dwell timer is configured, the parameter TIME is used for dwell time 
adjustment. The dwell time is measured in minute ranging from 0 to 6553.5 minutes. Once the process 
reaches the setpoint the dwell timer starts to count from zero until time out. The timer relay will remain 
unchanged until time out. The dwell timer operation is shown in the following diagram. 

 
 If alarm 1 is configured as dwell timer, A1SP, A1DV, A1HY and A1MD are hidden. The same case is for 
alarm 2. 
Example 
Set A1FN=TIMR or A2FN=TIMR but not both. Adjust TIME in minutes. A1MD (if A1FN=TIMR) or A2MD (if 
A2FN=TIMR) is ignored in this case. 
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5.2.4.12 Process Alarms 

 A process alarm sets an absolute trigger level (or temperature).  When the process (could be PV1, PV 2 or 
PV1-PV2) exceeds that absolute trigger level an alarm occurs. A process alarm is independent of setpoint. 
Adjust A1FN (Alarm 1 function) in the setup menu.  One of 8 functions can be selected for process alarm. 
These are PV1.H, PV1.L, PV2.H, PV2.L, P1.2.H, P1.2.L, D1.2.H, and D1.2.L.  
 When the PV1.H or PV1.L is selected the alarm examines the PV1 value.  When the PV2.H or PV2.L is 
selected the alarm examines the PV2 value. When the P1.2.H or P1.2.L is selected the alarm occurs if the 
PV1 or PV2 value exceeds the trigger level.  When the D1.2.H or D1.2.L is selected the alarm occurs if the 
PV1-PV2 (difference) value exceeds the trigger level. The trigger level is determined by A1SP (Alarm 1 
setpoint) and A1HY (Alarm 1 hysteresis value) in the configuration for alarm 1. The hysteresis value is 
introduced to avoid interference action of alarm in a noisy environment. Normally A1HY can be set with a 
minimum (0.1) value. A1DV and/or A2DV are hidden if alarm 1 and/or alarm 2 are set with process alarm.  

5.2.4.12.1 Alarm Modes 

 One of 4 kinds of alarm modes can be selected for alarm 1 and alarm 2.  These are Normal alarm, latching 
alarm, holding alarm and Latching/Holding alarm. 

5.2.4.12.1.1 Normal Alarm: A1MD = NORM 

 When a normal alarm is selected, the alarm output is de-energized in the non-alarm condition and 
energized in an alarm condition. 

5.2.4.12.1.2 Latching Alarm: A1MD = LTCH 

 If a latching alarm is selected, once the alarm output is energized, it will remain unchanged even if the 
alarm condition is cleared. The latching alarms are disabled when the power is shut off or if event input is 
applied with proper selection of EIFN. 

5.2.4.12.1.3 Holding Alarm: A1MD = HOLD 

 A holding alarm prevents an alarm from power-up.  The alarm is enabled only when the process reaches 
the setpoint value (maybe SP1 or SP2). Afterwards, the alarm performs the same function as a normal 
alarm. 

5.2.4.12.1.4 Latching / Holding Alarm: A1MD = LT. HO 

 A latching/holding alarm performs both holding and latching function. 
 

 
 

5-1 Normal Process Alarm 
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5-2 Latching Process Alarm 

 

 
5-3 Holding Process Alarms 

 
 

 
 

5-4 Latching/Holding Process Alarm 

 
Although the above descriptions are based on alarm 1, the same conditions can be applied to alarm 2. 
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5.2.4.12.2 Alarm Types 

5.2.4.12.2.1 Deviation Alarm 

 A deviation alarm alerts the user when the process deviates too far from the setpoint. The user can enter a 
positive or negative deviation value (A1DV, A2DV) for alarm 1 and alarm 2. A hysteresis value (A1HY or 
A2HY) can be selected to avoid interference problem of alarm in a noisy environment. Normally, A1HY and 
A2HY can be set with a minimum (0.1) value. Trigger levels of alarm are moving with the setpoint. 
For alarm 1, Trigger levels=SP1+A1DV 1/2 A1HY. 
For alarm 2, Trigger levels=SP1+A2DV 1/2 A2HY. 
 A1SP and/or A2SP are hidden if alarm 1 and/or alarm 2 are set with deviation alarm. One of 4 kinds of 
alarm modes can be selected for alarm 1 and alarm 2. These are Normal alarm, latching alarm, holding 
alarm and Latching/ Holding alarm. 

 
5-5 Normal Deviation Alarm 

 
5-6 Latching Deviation Alarm 

 

 
5-7 Holding Deviation Alarm 
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5-8 Latching/Holding Deviation Alarm 

5.2.4.12.2.2 Deviation Band Alarm 

 A deviation band alarm pre-sets two reference levels relative to the setpoint. Two types of deviation band 
alarm can be configured for alarm 1 and alarm 2. These are deviation band high alarm (A1FN or A2FN 
select DB.HI) and deviation band low alarm (A1FN or A2FN select DB.LO).   A1SP and A1HY are hidden if 
alarm 1 is selected with deviation band alarm. Similarly, A2SP and A2HY are hidden if alarm 2 is selected 
with deviation band alarm. Trigger levels of deviation band alarm are moving with the setpoint. 
 For alarm 1, trigger levels=SP1± A1DV.  
 For alarm 2, trigger levels=SP1 ±A2DV. 
 One of 4 kinds of alarm modes can be selected for alarm 1 and alarm 2.  These are Normal alarm, latching 
alarm, holding alarm and Latching/Holding alarm. 

 
 

5-9 Normal Deviation Band Alarm 

 

 
 

5-10 Latching Deviation Band Alarm 
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5-11 Holding Deviation Band Alarm 

 
 

5-12 Latching/Holding Deviation Band Alarm 

5.2.4.13 Event Input 

 The Event input accepts a digital type signal. Three types of signals can be connected to event input. These 
are Relay or switch contacts Open collector pull low TTL logic level. One of the ten available functions can 
be chosen by using (EIFN) contained in the setup menu. 

1 NONE: Event input No function. If chosen, the event input function is disabled. The controller will 
use PB1, TI1 and TD1 for PID control and SP1 (or other values determined by SPMD) for the 
setpoint. 

2 SP2: If chosen, the SP2 will replace the role of SP1 for control. SP2: If chosen, the SP2 will 
replace the role of SP1 for control. 

3 PID2: If chosen, the second PID set PB2, TI2 and TD2 will be used to replace PB1, TI1 and TD1 
for control. 

4 SP.P2: If chosen, the SP2, PB2, TI2 and TD2 will replace SP1, PB1, TI1 and TD1 for control 
Note: If the second PID set is chosen during Auto-tuning and/or Self-tuning procedures, the new 
PID values will be stored in PB2, TI2 and TD2. 

5 RS.A1: Reset Alarm 1 as the event input is activated. However, if the alarm 1 condition is still 
existent, the alarm 1 will be retriggered again while the event input is released. 

6 RS.A2: Reset Alarm 2 as the event input is activated. However, if alarm 2 conditions are still 
existent, the alarm 2 will be retriggered again while the event input is released. 

7 R.A1.2: Reset both Alarm 1 and Alarm 2 as the event input is activated. However, if the alarm 1 
and/or alarm 2 are still existent, the alarm 1 and/or alarm 2 will be triggered again while the 
event input is released. 
Note: The RS.A1, RS.A2 and R.A1.2 are particularly suitable to be used for a Latching and/or 
Latching/Holding alarms. 

8 D.O1: Disable Output 1 as the event input is activated. The output 1 control variable MV1 is 
cleared to zero. 

9 D.O2: Disable Output 2 as the event input is activated. The output 2 control variables MV2 is 
cleared to zero. 

10 D.O1.2: Disable both Output 1 and Output 2 by clearing MV1 and MV2 values as soon as the 
event input is activated. 
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Note: When any of D.O1, D.O2 or D.O1.2 is selected for EIFN, the output 1 and/or output 2 will 
revert to their normal conditions as soon as the event input is released. 

11 LOCK: All parameters are locked to prevent from being changed. 
12 SP2F Function: Define the format of SP2 value. If SP2F in the setup menu is selected with 

ACTU, the event input function will use SP2 value for its second setpoint. If SP2F is selected 
with DEVI, the SP1 value will be added to SP2. The sum of SP1 and SP2 (SP1+SP2) will be 
used by the event input function for the second setpoint value. In certain applications, it is 
desirable to move second setpoint value with respect to setpoint 1 value. The DEVI function for 
SP2 provides a convenient way in this case. 

5.2.4.14 Second Setpoint 

 In certain applications, it is desirable to change the setpoint automatically without the need to adjust the 
setpoint. You can apply a signal to event input terminals. The signal applied to event input may come from a 
Timer, a PLC, and an Alarm Relay, a Manual switch or other devices. Select SP2 for EIFN which is 
contained in the setup menu. This is available only with the case that SP1.2, MIN.R or HR.R is used for 
SPMD, where MIN.R and HR.R are used for the ramping function. 
Application 1: A process is required to be heated at a higher temperature as soon as its pressure exceeds 
a certain limit. Set SPMD=SP1.2, EIFN=SP2 (or SP. P2 if the second PID is required for the higher 
temperature too). The pressure gauge is switched ON as it senses a higher pressure. Connect the output 
contacts of the pressure gauge to the event input. SP1 is set with normal temperature and SP2 is set with a 
higher temperature. Choose ACTU for SP2F. 
Application 2: An oven is required to be heated at 300°C from 8.00 AM to 6.00 PM After 6.00 PM it is 
desirable to be maintained at 80°C. Use a programmable 24 hours cycle timer for this purpose. The timer 
output is used to control event input. Set SPMD=SP1.2, and EIFN=SP2 (or SP. P2 if the second PID is 
required to be used for the second setpoint). SP1 is set with 300°C and SP2 is set with 80°C. Choose 
ACTU for SP2F. After 6.00 PM the timer output is closed. The event input function will select SP2 (=80°C) 
to control the process. 

5.2.4.15 Second PID Set 

 In certain applications, the process characteristics are strongly related to their process value. The Process 
Control Card provides two sets of PID values. When the process is changed to a different setpoint, the PID 
values can be switched to another set to achieve an optimum condition. 
 The optimal PID values for a process may vary with its process value and setpoint. Hence if a process is 
used for a wide range of setpoint, dual PID values are necessary to optimize the control performance. If the 
first PID set is selected (event input is not applied) during the auto-tuning procedure, the PID values will be 
stored in PB1, TI1 and TD1. Similarly, if the second PID set is selected (event input is applied while PID2 or 
SP. P2 is selected for EIFN) during auto-tuning, the PID values will be stored in PB2, TI2 and TD2 as soon 
as auto-tuning is completed. 
Application 1: Programmed by Setpoint 
 Choose   SP. P2 for EIFN then both setpoint and PID values will be switched to another set simultaneously. 
The signal applied to event input may come from a Timer, a PLC, and an Alarm Relay, a Manual Switch or 
other devices. 
Application 2: Programmed by Process Value 
 If the process value exceeds a certain limit, 500°C for example, it is desirable to use other PID values to 
optimize the control performance. The user can use a process high alarm to detect the limit of the process 
value. Choose PV1H for A1FN, A1MD selects NORM, adjust A1SP to be equal to 500° C, and choose PID2 
for EIFN. If the temperature is higher than 500°C, then alarm 1 is activated. The alarm 1 output is 
connected to event input; the PID values will change from PB1, TI1 and TD1 to PB2, TI2 and TD2. 
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5.2.4.16 Ramp & Dwell 

5.2.4.16.1 Ramp 

The ramping function is performed during power up as well as any time the setpoint is changed. Choose 
MINR or HRR for SPMD, the unit will perform the ramping function. The ramp rate is programmed by using 
RAMP which is available in user configuration of Process Control Card 
Example without Dwell Timer 
 Select MINR for SPMD, IN1U selects °C, DP1 selects 1-DP, Set RAMP=10.0. SP1 is set to 200°C initially 
and changed to 100°C after 30 minutes since power-up. The starting temperature is 30° C. After power up 
the process is running like the curve shown below 

 
Note: When the ramp function is used, the lower display will show the current ramping value. However, it 
will revert to show the setpoint value as soon as the up or down key is touched for adjustment. The ramping 
value is initiated to process value either power up or RAMP and /or setpoint is changed. Setting the RAMP 
to zero means no ramp function at all. 

5.2.4.16.2 Dwell 

The dwell timer can be used separately or accompanied with a Ramp. If A1FN selects TIMR, the alarm 1 
will act like a dwell timer. Similarly, alarm 2 will act like a dwell timer if A2FN selects TIMR. The timer is 
programmed by using TIME which is contained in the Configuration menu. The Timer starts to count as 
soon as the process reaches its setpoint, and triggers an alarm as time out. Here is an example. 
 
Example with Dwell Timer 
 Select TIMR for A1FN, IN1U selects F, DP1 selects NODP, Set TIME=30.0 SP1 is set to 400 F initially and 
corrected to 200 F before the process reaches 200° F. As the process reaches setpoint (i.e. 200°F) the 
timer starts to count. The TIME value can still be corrected without disturbing the Timer before time out. The 
TIME is changed to 40.0 after 28 minutes since the process reached its setpoint. The behaviour of process 
value and alarm 1 are shown below. Once the timer output was energized it will remain unchanged until 
power down or an event input programmed for resetting alarm is applied. 
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Note: The TIMR can't be chosen for both A1FN and A2FN simultaneously; otherwise an error code will 
produce. 

5.2.4.16.3 Ramp &Dwell 

 A Ramp can be accompanied with a dwell timer to control the process. Here is an example. 
 
Example Ramp & Dwell Timer 
 Select HRR for SPMD, IN1U selects PU, DP1 select 2-DP, Set RAMP=60.00 A2FN selects TIMR, Set 
TIME=20.0 as power is applied the process value starts from 0.00 and set SP1=30.00, SP2=40.00. The 
timer output is used to control event input. 
 

 

5.2.4.17 Remote Setpoint 

 SPMD selecting PV1 or PV2 will enable the Process Control Card to accept a remote setpoint signal. If PV1 
is selected for SPMD, the remote setpoint signal is sent to Input 1, and Input 2 is used for process signal 
input. If PV2 is selected for SPMD, the remote setpoint signal is sent to Input 2, and Input 1 is used for 
process signal. To achieve this, set the following parameters in the Configuration menu. 
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Case 1:  
Use Input 2 to accept the remote setpoint  
FUNC=FULL 
IN2, IN2U, DP2, IN2L, IN2H, are set according to the remote signal. 
PVMD=PV1 
IN1, IN1U, DP1, are set according to the processed signal 
IN1L, IN1H if available, are set according to the processed signal 
SPMD= PV2 
 
Case 2:  
Use Input 1 to accept the remote setpoint  
FUNC=FULL 
IN1, IN1U, DP1, IN1L, IN1H, are set according to the remote signal. 
PVMD=PV2 
IN2, IN2U, DP2, are set according to the processed signal 
IN2L, IN2H if available, are set according to the processed signal 
SPMD= PV1 
Note: If PV1 are chosen for both SPMD and PVMD, an Error Code will appear. If PV2 are chosen for both 
SPMD and PVMD, an Error Code will appear. The user should not use these cases, otherwise, the Process 
Control Card will not control properly. 

5.2.4.18 Differential Control 

 In certain applications, it is desirable to control the second process such that its process value always 
deviates from the first process with a constant value. To achieve this, set the following parameter in the 
Setup menu. 
FUNC=FULL 
IN1, IN1L, IN1H are set according to input 1 signal 
IN2, IN2L, IN2H are set according to input 2 signal 
IN1U, DP1, IN2U, DP2, are set according to input 1 and input 2 signal 
PVMD=P1-2 or P2-1 
SPMD=SP1.2 
 The response of PV2 will be parallel to PV1 as shown in the following diagram 

 
The PV display will indicate PV1-PV2 value if P1-2 is chosen for PVMD or PV2-PV1 value if P2-1 is chosen 
for PVMD. If the user needs PV1 or PV2 to be displayed instead of PV, they can use the Display Mode to 
select PV1 or PV2 to be viewed. If PVMD selects P1-2 or P2-1, while SPMD selects PV1 or PV2, an Error 
Code will appear. In this case, the signals used for input 1 and input 2 should be the same unit and same 
decimal point, that is, IN1U=IN2U, DP1=DP2, otherwise, Error Code will appear. 
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5.2.4.19 Output Power Limit 

 In a certain system, the heater (or cooler) is over-designed such that the process is too heavily heated or 
cooled. To avoid excessive overshoot and/or undershoot the user can use the Power Limit function. Output 
1 power limit PL1 is contained in Configuration. If output 2 is not used for cooling (that is COOL is not 
selected for OUT2), then PL2 is hidden. If the controller is used for ON-OFF control, then both PL1 and PL2 
are hidden 
Example: 
 OUT2=COOL, PB1=10.0°C, CPB=50, PL1=50, PL2=80 the output 1 and output 2 will act as following 
curves 

 
NOTE: 
 The adjusting ranges of MV1 (H) and MV2 (C) for manual control and/or failure transfer are not limited by 
PL1 and PL2. 
 

5.2.4.20 Digital Filter 

 In a certain application, the process value is too unstable to be read. To improve this programmable low 
pass filter incorporated in this Process Control Card can be used. This is a first-order filter with time 
constant specified by FILT parameter which is contained in the setup menu. The default value of FILT is 0.5 
sec. before shipping. Adjust FILT to change the time constant from 0 to 60 seconds. 0 second represents no 
filter is applied to the input signal. The filter is characterized by the following diagram. 
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Note 
 The Filter is available only for PV1 and is performed for the displayed value only. The controller is designed 
to use the unfiltered signal for control even if Filter is applied. A lagged (filtered) signal, if used for control, 
may produce an unstable process. 

5.2.4.21 Auto-Tuning and Manual Tuning 

The Auto-tuning and Manual tuning can be executed by pressing the mode key in the Process control 

module real-time display page. Press  and Press Real-Time and Press C1 to access the Process 

Control module C1real time display page. In a similar way, the real-time pages of other process control 

modules also can be accessed. 

 Press Mode and select Auto-tuning to perform auto-tuning for the process. During the Auto-tuning process, 

the PV display will blink continuously. 

Press Mode and select Manual control to perform manual tuning for the process. In this, the user can 

control the process manually by adjusting the output value manually. 

 Press Back to exit auto-tuning or manual tuning when it is in progress. 
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5.2.5 Profile 

This will allow the user to configure the ramp and soak profiles for PID process control card. The recorder 

can be configured with a maximum of 50 profiles with each 32 segments limited to 1000 segments in total.  

 After entering the Configuration menu, select Profile then Press the “Enter” soft-key to get into Profile 

configuration menu.  It displays the Profile Profile1 as the first Profile configuration page.  Press directional 

navigation keys   at the bottom to select other profiles.  Press directional keys   on the right-

hand side to select the configuration menu column.   After completing Configuration, press  soft-key, 

then press  soft-key to return to the main display. All configurations will be saved automatically. 

 

 
 

5.2.5.1 Ramp & Dwell 

 Many applications need to vary temperature or process value with time. Such applications need a controller 
which varies a setpoint as a function of time. This Process Control Process Control Card can do this. The 
setpoint is varied by using a setpoint profiler. The profile is stored as a series of “ramp” and “dwell 
“segments, as shown below. 
 

 
 

 In each segment, you can define the state of up to 3 event outputs which can drive either relay, logic or 
Triac outputs, depending on the modules installed. A profile is executed either once, repeated a set number 
of times or repeated continuously. If repeated a set number of times, then the number of cycles must be 
specified as part of the profile. 
 Below are the available types of segment 
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5.2.5.1.1 Ramp 

 Ramp to a new setpoint at a set rate or in a set time 

5.2.5.1.2 Time to Target 

 Ramp to a segment with a Setpoint in a set time. 

5.2.5.1.3 Dwell 

 Dwell for a set time 

5.2.5.1.4 Go Back 

 Jump to a specified segment in the same profile 

5.2.5.1.5 End 

 Make this segment the end of the profile 
 The below four kinds of combination is allowable for connecting segments. 
Ramp-Ramp 
Ramp-Dwell 
Dwell-Ramp 
Dwell-Dwell 

5.2.5.2 Name 

Enable the user to define the name for each Profile with the maximum limit of 18 Characters. Select “Name”, 
then press “Enter”, soft-key, a keyboard with several keys appears. Press “Shift” to select special 
characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new Profile name. 

5.2.5.3 Segments 

 The user can add or Insert or Remove the segments of the Profile in this section. Press Add and then 
press Enter soft-key to access the Segment Configuration window. 

5.2.5.3.1 Type 

 Select the Segment type. The Available segment types are as below. 
1 Ramp 
2 Time to Target 
3 Dwell 
4 Go Back 
5 End 



 
 

 
 

Page 185 of 550 

5.2.5.3.1.1 Ramp Segment Parameters 

 
 

 
 
Condition 
 The condition to be selected for the Ramp Segment to follow to reach the setpoint as Ramp and Setpoint 
or Ramp and Time. The Ramp and Setpoint will change the setpoint to reach the Setpoint in that segment 
in the Ramp Rate specified. The Ramp and Time will change the Setpoint based on the ramp rate specified 
for the duration mentioned. 
 
Rate 
Ramp Rate of the segment to reach the setpoint. The Ramp Rate unit can be set for /Sec./Min, /Hour. The 
Ramp Rate Value can be defined in value. 
 
Duration 
Duration of the segment for the Ramp can be set in Hour: Minute: Second. 
 
PID 
The PID Values to be used for this RAMP is PID1 or PID2. 
 
Hold Back 
As the setpoint ramps up or down (or dwells), the measured value may lag behind or deviate from the 
setpoint by an undesirable amount. "Holdback" is available to freeze the profile at its current state. The 
action of Holdback is the same as a deviation alarm. It can be enabled or disabled. Holdback has three 
parameters. 

1 Holdback wait time 
2 Holdback band   
3 Holdback type 
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 If the error from the setpoint exceeds the set holdback band (Band), then if the holdback feature is enabled 
it will automatically freeze the profile at its current point. At the same time, the holdback timer begins to 
count. When the value of holdback timer exceeds the value of holdback wait time (wait time), the profiler will 
no longer be freeze and jump to its next segment, at the same time an error code HBER will be displayed. If 
the error comes within the holdback band (Band), then the program will resume normal running.  
 
Hold Back Types 
 There are four different Holdback types. The choice of type is made by setting the Holdback parameter 
when creating a profile with any one of the following 

1 OFF-Disables Holdback - no action is taken. 
2 Deviation Lo-Deviation Low Holdback holds the profile back when the process value deviates 

below the setpoint by more than the holdback band (Band). 
3 Deviation High-Deviation high holdback holds the profile back when the process value deviates 

above the setpoint by more than the holdback band (Band). 
4 Deviation Lo/High -Deviation Lo/High Holdback is a combination of the two. It holds the profile 

back when the process value deviates either above or below the setpoint by more than the 
holdback band (Band). 

 
Hold Back Action 
 Holdback action is defined by the below parameters. 

1 Wait Forever 
2 Wait Time 

 If wait forever is enabled then the process will wait until the PV has come within Holdback band (Band). If 
wait forever is disabled then the holdback action specified in Action after a timeout will be finished after 
the time specified in wait time. The available holdback actions are Hold and Continue. The hold will hold 
the segment and continue will move to the next segment. 
 

 
 

5-13 Holdback on Dwell 

 

 
 

5-14 Holdback on Positive Ramp 
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5-15 Holdback on Negative Ramp 

 

5.2.5.3.1.2 Dwell Segment Parameters 

 
 

Duration 
Duration of the segment for the Dwell can be set in Hour: Minute: Second. 
 
PID 
 The PID Values to be used for this Dwell is PID1 or PID2. 
 

5.2.5.3.1.3 Go Back Segment Parameters 

 

 
 This segment will jump to the specified in the segment mentioned on the Segment for the no of cycles 
mentioned in Cycle. 

5.2.5.3.1.4 End Segment Parameters 

 

 
 

 This is an End segment of the profile to End the profile with setpoint mentioned in Setpoint with the PID 
values in the selection of PID1 or PID2 as per the selection. 
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5.2.5.3.1.5 Time to Target Segment Parameters 

 

 
 

 This is similar to the ramp segment with automatic calculation of ramp rate by the Process Control Card 
with the reference of Setpoint and duration given by the user. 
 
Setpoint 
Setpoint to be reached in this segment. Of the segment  
 
Duration 
Duration of the segment to reach the setpoint 
 
PID 
The PID Values to be used for this RAMP is PID1 or PID2. 
 
Holdback 
Hold back actions to enable or not. Refer the details in Ramp segment section for the detailed explanation. 
 

5.2.5.4 Jobs 

 The job is called as a task to be performed when the event is activated. There are two jobs Start-Job and 
End Job can be added to perform any event.  
 A typical example is to trigger an alarm buzzer in the event of high temperature.   
 Note: Please refer to the section Jobs for full details about various jobs available  

5.2.5.4.1  Start/End Jobs 

 
Start: Define the job to be done at the start of the Profile (Ramp &Dwell) 
End:  Define the job to be done at the End of the Profile (Ramp &Dwell) 
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5.2.5.5  Start/ Stop Profile (Ramp &Dwell) 

The Profile can be started, Hold or stop from the Real-time display page of the process control module. The 
Profile can be selected and run from the Run button on the display page. Press Run and select the profile to 
be run then press OK to start the Profile. 

 
 

 Press Hold to hold the profile. Press Stop to stop the Profile. 
 

 
 
 The real-time display page will show the Profile and Segment no along with the remaining time of that 
particular segment. 



 
 

 
 

Page 190 of 550 

 

5.2.5.6 Oven Control with Zone Temperature Recording Application 

 An Oven is designed to dry the products with 6 zones. The Zone Temperature is controlled by a single 
temperature controller. The temperatures of the different zones are recorded to ensure the operation of 
different zones. Generally, for this application one temperature controller and 6 channel recorder are 
required. By using PR Series Recorder with PID Control card it can be achieved with one device.  
The oven required to dry the products at 500°C for 1 hour. All the 6 zones temperature needs to be 
recorded. For this dwell timer of PID Control card needs to be used to control the oven temperature and 
Analog inputs of Recorder needs to be connected with Thermocouple inputs from all the zones. The system 
configuration is as below. 

 
 

To achieve this function set the following parameters in the PID Control setup menu and configure the 
Recorder as per the recording requirements. 
FUNC=BASC (Basic function) 
IN1=K_TC    IN1U= C 
DP1=1_DP  OUT1=REVR 
O1TY=RELY CYC1=18.0 
O1FT=BPLS A1FN=TIMR 
A1FT=ON  SELF=NONE 
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5.3 Jobs 

 There are various types of jobs available in the recorder to activate by an event. The available jobs are 
listed below. 
 
New modifications since V1.50: 
 Jobs "Print HistoricalData" and "Output HistoricalData" will output only raw data. 
 
New modifications since V2.0 (2507).  
 Note:  

The job function does not work and cannot be used during when the device is suspended, paused, 
temporily disabled. 

 

5.3.1 No Action 

 Do nothing 

5.3.2 Send Email 

 Send Email directly from Recorder 

5.3.3 Pause 

 Stop logging data. 

5.3.4 Start 

 Start logging data. 

5.3.5 Sound Buzzer 

 Sound the buzzer.  It stops once any key is pressed. 

5.3.6 Dump Data 

 Dump the historical data from internal memory to external memory such as SD Card or USB Disk. The user 
can select the data to be dumped to external memory. 

5.3.7 Enable Fast Mode 

 Enables the fast mode logging of 100 msec for the specific channel irrespective of the channel configuration 

5.3.8 Disable Fast Mode 

 Disable the fast mode for the specific channel. 
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5.3.9 DO Latch On 

 Set digital output/relay on, and then select Target, let’s say from one of DO 1 to DO 6.  The relay is latched 
when it is activated.  

5.3.10 DO Latch Off 

 Set digital output/relay off, and then select Target, let’s say from one of DO 1 to DO 6.  The relay is un-
latched when it is activated. 

5.3.11 DO Process 

Set digital output/relay on for process high or low, and then select the target, let’s say from 1 of DO 1 to DO 
6.  The relay is not going to be latched when it is activated. 

5.3.12 Enable Timer 

 Start the timer, and then select Target timers 

5.3.13 Disable Timer 

 Stop the timer, and then select Target from Timers 

5.3.14 Preset Totalizer 

 Set a pre-set value to the target Totalizer. 

5.3.15 Reset Totalizer 

 Reset Totalizer to zero. Select a single Target Totalizer or All totalizers 

5.3.16  Enable Totalizer 

 Starts the Totalizer. Select a single Target Totalizer or All totalizers 

5.3.17  Disable Totalizer 

 Stops the Totalizer.  Select a single Target Totalizer or All totalizers 

5.3.18 Preset Counter 

 Set a pre-set value to the target counter. 

5.3.19 Reset Counter 

 Resets the counter to zero.  Select a single Target counter or all counters 

5.3.20 Inc Counter 

 Increases the counter by 1.  Select a Target counter or all counters 

5.3.21 Dec Counter 

 Decrease the counter by 1.  Select a Target counter or all counters 

5.3.22 Log Report 

Log a report for the selected channels. The options available to select for the report are Counter, Totalizer, 
Analog inputs (Min/Max/Avg), Math (Min/Max/Avg), All Counters, All Totalizers, and All Channels 
(Min/Max/Avg).  

5.3.23 Reset MinMaxAve 

 Reset the minimum, maximum and average values of the previously sampled data. The statistical data will 
calculate from the new sample of reports. 

5.3.24 Print Historical data 

 Prints the historical data. The period of data to be printed will follow the configuration in Auto output menu. 
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5.3.25 Print Event List 

 Prints the historical event list. The period of data to be printed will follow the configuration in Auto output 
menu. 

5.3.26 Print Report List 

 Prints the historical data of log report data. The period of data to be printed will follow the configuration in 
Auto output menu. 

5.3.27 Print Snapshot 

 Prints the snapshot of the screen. 

5.3.28 Output Historical Data 

This will generate a historical data output in CSV format in external storage. It will also contain event reports. 

5.3.29 Copy Value and Paste Value 

 This is mainly used for retransmission of Analog inputs using external (communication) Analog output 
channels. Since we have the limitation of Analog outputs on the Recorder. These external channels can be 
used by using the copy value and paste value. This can be used by using an event or timer when job 1 is 
copy value, job2 will be paste value. 

5.3.30 Select Controller 

 Select the PID Process controller card 

5.3.31 Run Profile 

 Select the profile to run. 
 

5.4 Display 

 This will allow the user to configure the real-time display pages on the recorder. The maximum no of display 
pages and pens per display page will vary depends on the recorder model no. 
  

 PR10 PR20 PR30 

Display pages 8 20 21 

Pens/Page 6 6 10 

 
 After entering the Configuration menu, select “Display” then Press the “Enter” key to get into the Display 

configuration menu. It displays the Display page Page1 as the first display page configuration page.  Press 

directional navigation keys   at the bottom to select other pages. Press directional keys   on 

the right-hand side to select the menu column. After completing Configuration, press   soft-key, then 

press  soft-key to return to the main display. All configurations will be saved automatically. 

 
New modifications since V1.50: 
 Only the channels with the same logging speed can be selected in one page. 
    1.Changing logging speed of a channel which is already selected by a page will disable the selection. 
    2.Loading config files coming from previous version will also prompt about this rule if any. 
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Copy:  copy the configuration from one page to another page.  
Paste: Paste the copied configuration to the page. 
 Press Copy key in the source page and press paste key in the destination page. 
 

5.4.1 Name 

 Enables the user to define the name for each page with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
display page name.  

5.4.2 Mode 

 Defines the default mode of displaying data for the page. The available options are Trend, Bar, Digital, Mix, 
Circular, Individual and Disable modes. 
Note: 
 Circular Trend mode is available only in PR30. 

5.4.3 Speed 

 This is the display speed. The available display speeds are as below. 
1. 100 msec/dot 
2. 1 Sec/dot 
3. 2 Sec/dot 
4. 5 Sec/dot 
5. 10 Sec/dot 
6. 15 Sec/dot 
7. 20 Sec/dot 
8. 30 Sec/dot 
9. 1 min/dot 
10. 2 min/dot 
11. 5 min/dot 
12. 15 min/dot 
13. 10 min/page (Circular Mode only) 
14. 30 min/page (Circular Mode only) 
15. 1 hour/page (Circular Mode only) 
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16. 2 hour/page (Circular Mode only) 
17. 4 hour/page (Circular Mode only) 
18. 8 hour/page (Circular Mode only) 
19. 12 hour/page (Circular Mode only) 
20. 1 day/page (Circular Mode only) 
21. 2 day/page (Circular Mode only) 
22. 1 week/page (Circular Mode only) 
23. 2 week/page (Circular Mode only) 
24. 4 week/page (Circular Mode only) 
25. 1 hour/dot 
26. 2 hour/dot      

5.4.4 Direction 

 Sets the trend direction to be horizontal or vertical. 

5.4.5 Background 

 Sets the background colour of Trend to black or white 

5.4.6 Print Enable 

 This will enable or disable the data of the configured pen on this page in print Historical data and output 
historical data jobs.  

5.4.7 Trend Graph Scale 

 The trend scale of the pens to be enabled or disabled on the display page. 
 

 
5-16 Trend Scale 
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5-17 Circular Scale 

 

5.4.8 Pen 

 This will configure the display pens of that display page and their properties. 

5.4.8.1 Channel 

 Selects a specific channel for that pen from the analog input, Math, Counter, Totalizer, External   Channels.  
Select disable if a specific pen is not required to display any channels.  

5.4.8.2 Color   

 Selects the colour for that pen. 

5.4.8.3 Width 

 Selects the width of that pen. The available options are 1, 2, and 3. 

5.4.8.4 Range Low 

 Defines the low scale for that pen on the display.  

5.4.8.5 Range High 

 Defines the high scale for that pen on the display. 

5.4.8.6 Reference Points 

 This will draw two reference points on the display. This will be displayed only in individual mode, in trend 
mode with only one pen per page and in circular mode with only one pen per page. The reference points 
have two points 1&2 to configure when it is enabled. It will not be displayed when it is disabled. 
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5-18 Reference Points Display 

5.4.8.7 Trend Graph Scale Position 

The position of the trend scale from left to right of that pen in display page. The scale can be disabled by 
selecting disable in the position. 
 
Note 
 To illustrate the difference between Display Hi, Display Lo, Scale Hi, and Scale Low, here is a typical 

example, with input 0-10V, Scale Low=0.00, Scale Hi=100.00, to have better resolution and vision on 
Bar graph, set the Display Lo=0.00 and Display Hi=50.00 so that the Bar displays from value 0.00 to 
50.00.   

 The decimal point is defined by Scale Hi and Scale Low, and not by Display Hi, or Display Lo. 

5.4.8.8 Status Bar 

 To make it convenient when viewing the status of Digital Input, Digital Output, Math channel, Totalizer, 
Counter and AO, the user may enable these items in the status bar. The Status bar is displayed at the lower 
part of the display page. One status bar can be configured for each page. Each status bar consists of 6 tags 
in PR20 and 10 tags in PR30 for the user configuration. 
 
Note 
Status bar configuration is not shared in all the pages. You may define a different setup for status bars in 
each page per your requirements. 
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5.5 Batch 

This will allow the user to configure the batch configuration. This menu will be visible to the user when the 

batch is enabled in instrument menu configuration. After entering the Configuration menu, select “Batch” 

then Press the “Enter” key to get into the Batch configuration menu. It displays the Display page Page1 as 

the first display page configuration page. Press directional keys   on the right-hand side to select 

the menu column.   After completing Configuration, press  soft-key, then press  soft-key to return to 

the main display. All configurations will be saved automatically. 
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5.5.1 Name 

 Enables the user to define the name for Batch with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
batch name.  

5.5.1.1 Lot Number 

 Define the starting Lot number of the batch. 

5.5.1.1.1 Auto Increment 

 If this option is enabled then the lot number will be automatically incremented by one for the next batch. If 
this option is disabled then there is a popup window will appear on the screen to enter the batch details 
when starting the batch by using the start option in the menu. 
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5.5.2 Desc 

 The description of the batch for logging. 

5.5.3 Example for Batch Application 

 The operator wants to start a batch every day at 8.00 am and stop the batch at 12.00 am.  
 
Configuration 
Timer1 
Type: Daily   
Action: Enable 
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Time – Hour: 8 Min: 0      Sec: 1 
Job1: Start  Job2: No Action 
 
Timer2 
Type: Daily  
Action: Enable 
Time – Hour: 12 Min: 0      Sec: 1 
Job1: Pause Job2: No Action 
 

5.5.4 How to View Batch Data in Recorder 

1. Press on   (Menu)-History-Page1 

2. Press “Search”, select required Batch and press “OK” 

3. Batch details including lot number can be archived by pressing soft-key “Batch” 
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5.5.5 How to Dump Batch Data to an External USB Memory 

1. Press on   (Menu)-More then press on Dump 
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2. Select “All” or required lots and press “OK” 
 
For example, Batch1-1, Batch 1-2, Batch1-3 are available 
Initial 1 Lot means, Batch1-1 
Initial 2 Lots means, Batch1-1 and Batch1-2 
Initial 3 Lots means, Batch1-1, Batch1-2 and Batch1-3 
 
Note 
Provision not available to dump only a specific lot. 
 
3. Press on “Yes” to dump data from internal memory to external SD Card or USB memory. 

 

 
 
 If there are 3 batches, let’s say Batch1-1, Batch1-2 and Batch1-3, then there are three different folders in 
the external storage after completing of dump 
 

 
Note 
 The data available in external memory is in a proprietary format to avoid any kind of tampering.  The PC 
software is required to view this data. 
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5.6 Start / Stop 

 This will allow the users to configure the jobs when the logging is started or stopped. 
 

 
 

5.6.1 Start 

 Configure the job for the start action. This job will be activated when the logging is started. 

5.6.2 Stop 

 Configure the job for the stop action. This job will be activated when the logging is paused or stopped. 
 

5.7 Marker    

 New modifications since V1.60.  
 Add function: Marker for trend and circular graph on real-time and history UI. 

 
This will allow the users to configure the markers logs displayed for Trend & Circular graphic of the 
Realtime & History pages. 
- Go to Menu  > Configuration > Marker # 
- Go to Menu  > History > Page #  
- Go to Menu  > Event  > Marker # 
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 The Marker function allows the user to configure text log-maker displayed on real-time & history UI page, 
displayed based on configured from history pages. Add buttons more  for UI extension for logging 
markers manually. The configured markers will sync display the marker-log result under the mode for trend 
graph with horizontal or vertical and circular graph. 
Marker jobs are inserted into the existing job list and the inspection of compatibility with old version is 
necessary. Logging markers only works when PR is not stopped. The automatic and manual actions of 
logging markers could happen at the same time.  
 
Configure Names of Marker jobs up to 50 markers 
Go to Homepage, Select tab More > Config. After entering the Configuration menu, select “Marker” then 

Press the “Enter”   key on the right to get into Marker configuration menu. It displays up to 50 marker-

string Marker1 Text as the first-timer to configure. Press directional keys     on the right-hand side 

to select the marker items. Select the first one by pressing “Enter” key again on the right. Use directional 

navigation keys, “Right” , “Left” , “Backspace”, “Copy”, “Paste”, “Backspace” and letter/ 

number keys to type a name.  After completing Configuration, press “OK” key to exit.  Return to the 

Configuration main. 

  



 
 

 
 

Page 206 of 550 

 
 

Setup Timer for Marker 
 *After Marker configured, go back to Config tab, and continued to configure Timer. 

Back to Configuration menu, select “Timer” then Press the “Enter”  key to get into Timer configuration 

menu. It displays Timer Timer1 as the first-timer to configure. Set Type as Repeat Countdown, selecting 

action as Enable and then select Time interval, such as 10 sec. Select Job 1 marker among 50 items, and 

job 2 as Log marker page. Press “OK” key to exit. 

 

 
 

Add Log Marker jobs 
Marker jobs can only be used automatically. Go to Configuration > Channel > AI/DI/Math/External > Event. 

Under Event, add one event. In the sub-item of the event, go to Event > Job1 > Select Marker. Select 

marker name. Go to Event > Log Maker > Page #. Select marker page. Select the type for auto adding 

markers. Go to Event > Type > H/L/HH/LL/Dev+/Dev-/Error. 
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Marker jobs can be added manually. Go to Home > History > Page #. Select the time to add marker by 

using the buttons    or tap on the screen. For PR10/20, find the  selecting more button 

(PR10/20) and find <Marker>. Select <Marker> to choose the name from the tables. By choosing <Input 

Text>, it goes to keyboard screen to retype a new name. 
 

 
PR30 

 

 
PR10/20 
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Go Back to Home > Realtime/ History 

 After completing Configuration, press “Back”  softkey, then press “Home”    softkey to return to 

the main display. All configurations will be saved automatically. 

The marker output examples are listed as below. The marker logs will display on Realtime/ History. 
 
 
 
 
 
 
 
 
 
 
 
 
    

 
 

 

Mode > Circula                                               Mode > Trend 
 

Go Back to Home > Realtime/ History 

After completing Configuration, press “Back”  softkey, then press “Home”    softkey to return to the 

main display. All configurations will be saved automatically. 

                                                                 

5.8  Timer 

This will allow the user to configure the timers on the recorder. The no of timers available on the recorder 
will vary depends on the recorder model no. They are listed as below. 
 

 PR10 PR20 PR30 

Timer 6 20 48 

  
After entering the Configuration menu, select “Timer” then Press the “Enter” key to get into Timer 

configuration menu. It displays Timer Timer1 as the first-timer to configure. Press directional navigation 

keys   at the bottom to select other timers. Press directional keys   on the right-hand side to 

select the menu column.   After completing Configuration, press  soft-key, then press  soft-key 

to return to the main display. All configurations will be saved automatically. 

Copy:  copy the configuration from one timer to another timer.  
Paste: Paste the copied configuration to the timer. 
 Press Copy key in the source timer and press paste key in the destination timer. 
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The timers can be used to execute a job on a time basis. The timers can be categorized into Countdown, 
Repeat Countdown, Daily, Weekly and Monthly.  
 

5.8.1 Type 

 Select the type of Timer. The available options for the users are as below. 
1. Countdown 
2. Repeat Countdown 
3. Daily 
4. Weekly 
5. Monthly     

5.8.1.1 Countdown 

 This timer will execute only once and activate the defined jobs after the defined time. 

5.8.1.2 Repeat Countdown 

 This timer will execute in a loop continuously and activate the defined jobs in the defined interval of time. 

5.8.1.3 Daily 

 This timer will activate the defined jobs at a defined time every day. 

5.8.1.4 Weekly 

 This timer will activate the defined jobs at a defined time every week. 

5.8.1.5 Monthly 

 This timer will activate the defined jobs at a defined time every month. 
Note 
Countdown and Repeat countdown timers will not follow RTC clock time. They will start the timer from 0 
once they are activated. Daily, Weekly and Monthly timers will follow the RTC Clock time to execute the jobs. 
 

5.8.2 Action 

 Disables or enables the timer. 
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5.8.3 Job1, Job2 

 2 jobs can be configured for each timer. 

5.8.4 Timer Example-1 

 Switch on the water pump every day at 8.00 am and switch off at 10.00 am. This application requires a 
“Daily” timer which works with Real-Time Clock.  Configuration settings are as follows. 
Timer1   
Type: Daily  
Action: Enable 
Time – Hour: 8 Min: 0     Sec: 0 
Job1: DO Latch On, Target: DO1 
Job2: No Action 
 
Timer2   
Type: Daily 
Action: Enable 
Time – Hour: 10 Min: 0     Sec: 0 
Job1: DO Latch Off, Target: DO1 
Job2: No Action 

5.8.5 Timer Example-2 

 Let’s say, when a digital input high event is triggered by high pressure, switch on a relay after a 10 seconds 
delay. 

Digital Input1 
Event1 
Type: H 
Job1: Enable Timer, Target: Timer1 
Job2: No Action 
Event2 
Type: L 
Job1: DO Latch Off, Target: DO1 
Job2: No Action 
 
Timer1 
Type: Countdown, Action: Disable 
Time – Hour: 0 Min: 0     Sec: 10 
Job1: DO Latch On, Target: DO1 
Job2: No Action 

5.8.5.1 Timer Example-3 

 The user requires to get a daily report from the recorder about the minimum, maximum and average 
values of the process every day.  After production has finished, the user can press Menu, then Event then 
selects Report and presses the Mode key to select the Daily mode.  It will show the report on a daily basis. 

Timer1   
Type: Daily 
Action: Enable 
Time – Hour: 17  Min: 01 
Job1: Log Report   Target: ALL CH MinMaxAve  
Job2: Reset Min/Max/Ave Target: ALL CH  
(Reset historical data in order to log new data for the next day.) 



 
 

 
 

Page 211 of 550 

5.9 Clock 

 This will allow the user to configure the clock and related configuration including summer saving time 

adjustment. After entering the Configuration menu, select Clock then Press the Enter key to get into the 

Clock configuration menu. It displays the clock configuration menu to configure. Press directional keys  

 on the right-hand side to select the menu column. After completing Configuration, press  soft-key, 

then press  soft-key to return to the main display. All configurations will be saved automatically. 

 

 
 

5.9.1 Date Style 

 Selects the Date style format for the recorder. The available options are MM/dd/yy and dd/MM/yy, 
yyyy/MM/dd. 

 

5.9.2 Time Zone 

Select the time zone for the recorder 

5.9.3 Synchronize via Internet 

 This will allow the recorder to synchronize the clock time from a time server via an Internet connection on 
the recorder. If this option is enabled then the recorder will connect with Time server every day at the 
defined time to synchronize the clock. 

5.9.4 Date / Time 

 This will allow the user to set the clock manually. After modifying the clock data press  to apply the 
modified time. 

5.9.5 Summertime 

In some countries of North America and Europe, clocks are adjusted forward one hour near the start of 
spring and are adjusted backwards in autumn.  This is commonly referred to as Daylight Savings Time.  
Here it is referred to as Summer Time. The summertime can be enabled by selecting enable in the Type 
and configuring From and To time. 
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5.10 Communication 

 This will allow the user to configure the communication-related parameters. After entering the Configuration 

menu, select Communication then Press the Enter key to get into Communication configuration menu. It 

displays the communication configuration menu to configure. Press directional keys   on the right-

hand side to select the menu column.   After completing Configuration, press  soft-key, then press  

soft-key to return to the main display. All configurations will be saved automatically. 

 

          
 

5.10.1 Ethernet 

 This will configure the Ethernet port configuration. 
 IP 
 Select the IP type as Static or DHCP as per the requirement. Select DHCP if the server on the network 
automatically allocates the IP address for the recorder. Select STATIC to manually set a fixed address for 
the recorder.  

IP Address:  Defines the IP address of the recorder on the network 
Subnet Mask: Defines the Subnet Mask address on the network 
Default Gateway:  Defines the Gateway address. 
DNS Server: This is required if the recorder needs to be connected to the Internet 
Modbus Server: When Recorder is configured as Slave Recorder (Server in Modbus TCP) in Modbus 
communication, the recorder needs to be configured with the port no. 
Modbus TCP Port:  Modbus TCP Port no. The default setting is 502 for Modbus TCP 
Web Server: This will allow the user to enable or disable the webserver feature on the recorder. 
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5.10.2 Serial 

 This will configure the serial port of the recorder. 
Protocol: Selects the Modbus protocol. The available options are Modbus RTU Master and Modbus 

RTU Slave.  
Address: Recorder Slave Address in the network  
Baud rate: Selects the communication baud rate for communication. The available options are 9600, 

14400, 19200, 38400, 57600, 115200 
Data format: Selects the communication data format for communication. The available options are 

none, 8, 1 or Odd, 8, 1 or Even, 8, 1 
 

5.10.3 Modbus Server / Slave 

 This will allow the user to select the data type for the recorder communication when it acts as a slave in 
Modbus RTU or server in Modbus TCP. 
 Type of Register Value: The user can select the data type as an Integer or Floating point. 
 

5.10.4 Modbus Client/Master 

 This will allow the user to configure the external channel communication with the recorder. 

5.10.4.1 Connections 

 Add the connections to the recorder. There is a maximum of 24/48 devices can be connected with PR10 
and PR20 and a maximum of 96 devices can be connected with PR30. To add a connection, select 
connections and then press Enter key.  It will show the connection menu parameters. 

Name: Configure the connection name 
Type: Select the connection type as Serial or Ethernet 
Slave ID: Configure the Slave Id of the device to be connected. 
IP: This is enabled only if Type = Ethernet. Configure the IP address of the slave. 
Port: This is enabled only if Type = Ethernet. Configure the port no of the slave. 
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5.10.4.2 Commands 

 This will allow the user to configure the Modbus register address from the slaves needs to be map to an 
external channel. There is a maximum of 24/48 commands can be added in PR10 and PR20 and 96 
commands can be added in PR30. To add a command, select commands and then press Enter key.  It will 
show the commands menu parameters. 
 

 
 

○ Action: Enable or Disable the command 
○ To Channel: Configure the first and last channel of the external channel to be mapped.  

○ First: Enter first external channel details, Ex: Ext1  
○ Last: Enter last external channel details, Ex: Ext24 

○ From Device: Configure the slave device to be mapped, 
○ Register: Configure the Modbus address of the slave 

○ Type: Select the Register type as per slave. The available options are Input and Holding 
Registers, Discrete Input and Output coil. 
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○ Start Address: Enter Start register address. For example, 400001 as 1 
○ Data Type: Configure the data type as per slave configuration. This is available for Input 

and Holding Registers only. The available data types are as listed below. 
Int16/Uint16/Int32_B/Int32_L, UInt32_B, UInt32_L, Float_B, Float_L 

 

 
 

○ Connection: Select the required connection where the slave is configured. 
 

5.10.4.3 Sample Rate 

 Configure the sampling rate for communication. 
○ Ethernet :   Configure the Ethernet communication sampling rate from the available options 100 

msec/dot, 1 sec/dot, 2 sec/Dot, 5 sec/dot, 10 sec/dot 
○ Timeout : Timeout for Ethernet Communication. The default timeout is 100ms 
○ Serial :   Configure the Serial communication sampling rate from the available options 100 

msec/dot, 1 sec/dot, 2 sec/Dot, 5 sec/dot, 10 sec/dot 
○ Timeout : Timeout for Serial Communication. The default timeout is 100ms 
○ Interval between two commands : Configure the interval between two commands in serial 

communication. The default time is 10 msec. 
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5.10.5 Email 

 This will allow the user to enable or disable the email function on the recorder. Once the email function is 
enabled then the recorder will show the required menus to configure the email server details. The user has 
to configure the email server configuration as per the email server. The below picture shows the sample 
configuration with an email account from Gmail to send the email. 
  

 
 
 The user can configure the starting time of a day to start sending an email. This time can be configured in 
Send after a scheduled time. This will avoid unnecessary email alarms when the process is not running or 
during maintenance. There are 10 different email address can be configured to send the emails. Every 
email action can select a particular sender or all the senders in the email job configuration. 
 
New modifications since V1.50: 
 A single email address can be assigned to multiple groups. 

 

 
 
 The system events can be enabled or disabled to send email notification by enabling or disabling the option 

System event send email function. Press Email Test  key to test the email configuration. If the 

configuration and the connection are successful then the recorder will send email to all the sender in the 

configuration. If there is a problem in email delivery then it will give an error message as below. 
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 The email server should accept less secure app access. The below show the configuration of the Gmail 
account accepts the less secure app access. 
 

 
 

5.10.6 Example for IO Modules as External Channels for Analog Input 

 Paperless recorder connected with IO modules with slave address 2 and 3 via RS485 communication. The 
communication parameters for the communication are as below. 

 Baud Rate: 9600 
 Parity: None 
 Data Length: 8 Bit 
 Stop Bit: 1 
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The below picture shows the system configuration. 
  

 
 The below table shows the Modbus address mapping of IO Modules which needs to be mapped to external 
channels of the recorder. 
 

 
 
 The recorder communication protocol must be set as Modbus Master to communicate with external 
channels. 

 
 

Paperless Recorder 

IO Module 

Slave Id=2 

RS-485 

IO Module 

Slave Id=3 
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 Configure the communication parameters as per the slave (IO Module) configuration. 
 

 
   

 
 

 Add connections and commands as per IO module configuration. 
 

 
5-19 Connection for Slave ID 2 

 

 
5-20 Connection for Slave ID 3 
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5-21 Mapping of IO Module and External Channel for Slave ID2 

 

 
5-22 Mapping of IO Module and External Channel for Slave ID 3 

 
 After the mapping of the IO module with the external channel is successful then all mapped external 
channel needs to be configured for displaying the data with proper scaling. 
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Configure display page to display External channel in display pages 
 

 
 

5.10.7 Example for IO module as External Channel for Relay Output 

 Paperless recorder connected with IO module with slave Id 2&3 for increasing the relay outputs. The 
communication parameters for the communication as below 

 Baud Rate: 9600 
 Parity: None 
 Data Length: 8 Bit 
 Stop Bit: 1 

The below picture shows the system configuration. 
 

 
 The below table shows the Modbus address mapping of IO Modules which needs to be mapped to external 
channels of the recorder. 
 

 
  

Paperless Recorder 

IO Module 

Slave Id=2 

RS-485 

IO Module 
Slave Id=3 
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The recorder communication protocol must be set as Modbus Master to communicate with external 
channels. 
 

 
 

 Configure the communication parameters as per the slave (IO Module) configuration. 

 
 

 
 Add connections and commands as per IO module configuration. 
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5-23 Connection for Slave ID 2 

 

 
5-24 Connection for Slave ID 3 

 

 
5-25 Mapping of IO Module and External Channel for Slave ID 2 

 

 
5-26 Mapping of IO Module and External Channel for Slave ID 3 

 
 After the mapping of the IO module with the external channel is successful then all mapped external 
channel can be used for relay output by using copy value and paste value job. 
 Configure Math1 with the expression as 0 and Math2 with the expression as 1. Then using copy value 
Math1 or Math2 as job1 and paste value Ext1 as job 2 to use the external channel relay output. 
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5-27 Configuring Math1 as 0 

 

 
5-28 Configuring Math2 as 1 

 

 
5-29 Configuring Ext1 for AI1 alarm 

  
Similar way, other external channels also can be used for alarm and other operations. 
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5.10.8 Example for IO module as External Channel for Analog Output 

 Paperless recorder connected with IO module with slave Id 2 for increasing the analog outputs. The 
communication parameters for the communication as below 

 Baud Rate: 9600 
 Parity: None 
 Data Length: 8 Bit 
 Stop Bit: 1 

 
 The below picture shows the system configuration. 

 
 The below table shows the Modbus address mapping of IO Module which needs to be mapped to external 
channels of the recorder. 
 

 
  
The recorder communication protocol must be set as Modbus Master to communicate with external 
channels. 

Paperless Recorder IO Module 

Slave Id=2 RS-485 
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Configure the communication parameters as per the slave (IO Module) configuration. 
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 Add connections and commands as per IO module configuration. 
 

 
5-30 Connection for Slave ID 2 

 
 

 
 

5-31 Mapping of IO Module and External Channel for Slave ID 2 

 
 After the mapping of the IO module with the external channel is successful then all mapped external 
channel can be used for analog output by using copy value and paste value job. 
 Configure Math1 with the expression for analog output for retransmitting AI1. Then using copy value Math1 
as job1 and paste value Ext1 as job 2 in timer to retransmit the AI1 value to external channel. 
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5-32 Configuring Math1 as retransmission of AI1 Value 

 

 
 

5-33 Configuring timer to retransmit AI1 value via Ext1 

  
Similar way, other external channels also can be used for retransmitting other channels. 
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5.10.9 Example for Controller as External Channels 

 Paperless recorder connected with temperature controller with slave address 2 via RS485 communication. 
The communication parameters for the communication are as below. 

 Baud Rate: 9600 
 Parity: None 
 Data Length: 8 Bit 
 Stop Bit: 1 

 The below picture shows the system configuration. 
 
 
 
 
 
 
 
 The below table shows the parameters needs to be mapped and logged from the temperature controller to 
external channels of the recorder. 
 

 
  
The recorder communication protocol must be set as Modbus Master to communicate with external 
channels. 

 
 

 Configure the communication parameters as per the slave (controller) configuration. 

Paperless Recorder Temperature Controller 

Slave Id=2 RS-485 
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 Add connections and commands as per controller configuration. 

 
 

5-34 Connection for Slave ID 2 

 

 
5-35 Mapping of Controller with External Channels 

 
 After the mapping of the controller with the external channel is successful then all mapped external channel 
needs to be configured for displaying the data with proper scaling. 
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 Configure display page to display External channel in display pages 
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5.10.10 Example for SIO Module as External Channel via PC-E 

 Paperless recorder connected with SIO module with slave address 1 using RS485 to Ethernet Converter 
PC-E connected with Ethernet communication.  
 
 
 
  
  
 
 
The communication parameters for the communication are as below. 
SIO Module Configuration 

Address: 1 
Baud Rate: 9600 
Parity: None 
Data Length: 8 
Stop Bit: 1 

The below table shows the Modbus mapping of SIO series IO module. 
 

 
 
PC-E Configuration 

 
5-36 PC-E Ethernet Configuration 

Paperless Recorder PC-E 
Ethernet to RS485 

Converter 

SIO IO Module 
Slave Id=1 Ethernet RS-485 
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5-37 PC-E Mode Configuration 

 

 
5-38 PC-E PS485 Configuration 
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The recorder communication protocol must be set as Modbus Master to communicate with external 
channels 
  
Configure the communication parameters as per the slave (PC-E and SIO) configuration. Add connections 
and commands as per PC-E and SIO module configuration. 
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 Configure the sample rate for the communication. 

 
 

 Configure External channel parameters and scaling. 
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 Configure display page to display External channel in display pages 
 

 
 

5-39 Display Page for Ext1 
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5.10.11 Example for Recorder as Modbus Slave 

 In this example, the recorder will act as a Modbus slave with id 2 and 3 which will communicate with 
Modbus Master on the PC via RS485 communication. 
 
 
 
 
 
 
 
 
 
 
 

 
      

 
5-40 PR as a Modbus Slave with ID 2 

 

PC with Modbus 
Master 

Paperless Recorder 
Slave Id=2 

RS-485 

Paperless Recorder 
Slave Id=3 
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5-41  PR as a Modbus Slave with ID 3 

5.11 Instrument 

 This will allow the user to configure the Instrument related parameters like Batch, Security mode. After 

entering the Configuration menu, select Instrument then Press the Enter key to get into the Instrument 

configuration menu. It displays the Instrument related configuration menu to configure. Press directional 

keys   on the right-hand side to select the menu column. After completing Configuration, press 

 soft-key, and then press  soft-key to return to the main display. All configurations will be saved 

automatically. 

 

 
 

5.11.1 Name 

 This enables the user to define the name for the recorder with a maximum of 18 characters.  
Select “Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
recorder name.  
 

5.11.2 Language 

 There are 20 different languages available for the user to select for the user interface. They are English, 
Simplified Chinese, Traditional Chinese, Japanese, Korean, French, German, Italian, Polish, Spanish, 
Portuguese, Brazil Portuguese, Russian, Thai, Czech, Danish, Dutch, Swedish, and Turkish & Greek. 
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5.11.3 Security 

 This will allow the user to select the security mode as Normal or CFR-21. Once the CFR-21 mode is 
enabled the related menus will be shown for the user to configure. 
 
New modifications since V1.60: 
 Modification: The state before the modification of the configuration will be appended to the audit trail. 
 Modification: The options for "Log Reason for Change" are changed to "Disable","Ask" and "Must". 

 

5.11.3.1 Logout 

The automatic log out time for the device to log out when there is no user interface on the device. This 
option is available only for CFR-21. 

5.11.3.2 Password Validity 

The user can configure the validity of the password for a period. The available options are 30 days, 60 days, 
90 days, 120 days, 150 days, 180 days and unlimited. 
 

 

5.11.4 Batch Control 

 The batch function can be enabled or disabled.  
Note: It is necessary to restart the recorder after changing the batch control. 
 

5.11.5 EMS 
  

 New modifications since V2.0 (2507).  
 Add function:  

Add EMS function to Config after enabled. EMS config is used to set E1~E8, as Energy Management 
System.       
EMS function is available in Plus1 and Plus3 versions. 
 
(1) UI for EMS Config 

Auto-Config Channels, Commands, Pages. 
(2) UI for EMS Realtime 

Go to Menu > More > Configuration, before setting EMS option, unable to display on the list.  
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Go to Configuration > Instrument > EMS > Enable > OK 

 
 

Go to .. Instrument > Math > Expression > Naming Mood > Channel Name > OK 

    
 

Go to Configuration > Display > Overview > Auto > OK 

   
 

Power off the device and power on again  
Go to Configuration; EMS has been created to the Config list 
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 New modifications since V2.0 (2507)  
After EMS option created, go back to Config tab, and continued to configure EMS. From E1~E8, reset any 
configuration as Auto Config and select Wiring as 3-Phase. Reset single selection from Vlla ~ kWh as V or 
not. Go back to the Home, from    
 Add function: 

 

EMS management data summary:  
To display the EMS energy management results data, setting the EMS options, from E1~ E8 under 
EMS, set the Config as Auto Config and set Wiring as 3 Phase. Go back to Home > Realtime, select 
E#, the data will show summary data. 
 

 
 

Go to Configuration > EMS > E# > Reset Config > Yes > Wiring (E#) > 3 Phase > OK >  "Vlla" ~ 

"kWh" > Back > Home > Saving Configuration > Realtime > E# > Summary/ Power/ Phase/ Volts 
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1) Auto Config and 3-Phase 

Go to Configuration > EMS > E# > Reset Config > Yes > Wiring (E#) > 3 Phase > OK >  "Vlla" ~ 

"kWh". Reset optional items for Signal Selection, as V(Yes) or X(Not). 
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2) Realtime EMS data  
Go Back > Home > Saving Configuration > Realtime > E# > Summary/ Power/ Phase/ Volts. Select 
E1~E8 summary from Realtime sub-menu. 
 

  
 

5.11.6 Volume 

 The buzzer volume of the recorder can be disabled or can be set from 1 to 10. The buzzer can be disabled 
by configuring Volume as Disable. 
 

5.11.7 Tool Bar 

 The drop-down menu of the menu  key can be hidden automatically after a period of inactivity. The 
inactivity timer can be configured by configuring 10Sec or 20Sec or 30Sec in Auto Hide. If Auto Hide is 
configured with disable then the drop-down menu will not be hidden. 
 

5.11.8 Scan Page 

 The configured displayed pages can be scrolled automatically after a period of idle time configured in Idle 
Time with a constant interval configured in Scan Rate. The idle time can be configured from 1 Min to 10 Min 
and Scan rate can be configured from 5 sec to 30 sec. The scrolling of pages can be disabled by 
configuring Idle Time as Disable. 
 

5.11.9 LCD 

 The LCD Brightness can be configured from level 0 to 6. Level 0 is the lowest brightness and level 6 is for 
the highest possible brightness.  
 The lifetime of LCD can be increased by configuring screen saver to turn off the display after a period of 
inactivity on the screen. During the screen saver mode, the data will be recorded continuously without any 
loss. The LCD screen only is off at that time. The screen saver time can be configured from 1 Min to 60 Min. 
The screen saver can be disabled by configuring Disable in Screen saver. 
 

5.11.10 Storage 

The external storage type can be chosen from the available options SD Card or USB Disk. The default 
setting for external storage set as SD card. The maximum size of the external memory supported is 32GB. 
The external storage must be formatted in FAT or FAT32 format.  
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New modifications since V1.50: 
 If the size of the event data file in the memory card exceeds 4G, the system will package it and create 

a new file. The packaged content can be viewed after importing it to the PC. 
 
 If the data folder in the memory card exceeds the limit, the system will package it and create a new 

file. The packaged content can be viewed after importing it to the PC. 
 

5.11.11 Data Transfer 

 The data transfer option can be set as Dump and Clear or Transfer and Remain. Dump and Clear will clear 
the data from internal memory after dumping. Transfer and remain will keep the data in internal memory 
after dumping. 

5.11.11.1 Show Message at the End 

 This will be enabling or be disabling the conformation message after dumping is finished. 

5.11.11.2 Auto-Dump 

 New modifications since V1.70.  
 Add function: Add Auto-Dumping to keep the latest data in the external media (SD/ Pendrive).  

Go to Configuration > Instrument > Data Transfer > Auto-Dump > Idle Time > Time  
Go to Configuration > Instrument > Data Transfer > Auto-Dump > Interval > Time 

 

  
 

  
 

5.11.12 Custom Page 

 The user can enable or disable the custom page download via Ethernet from Panel Studio Software by 
choosing Enable or Disable in Allow Download via Ethernet.  

5.11.12.1 Power on 

 The user can set a custom page to display after power on. This set page will show after the recorder after 
power on. 
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5.11.13 Setup Start-up Image 

 The user can add a start-up image like a logo to show during power on.  

5.11.13.1 Procedure to Setup a Start-up Image 

1. Copy the image to the main path of the SD Card or USB Disk 
2. Insert the external storage to PR 
3. Set the external storage to SD card or USB as per the connected storage 
4. Select the image by using the setup start-up page option in the Instrument menu. 
5. After completing Configuration, press  soft-key, then press  soft-key to return to the 

main display. All configurations will be saved automatically. 
6. Now the recorder will start with the selected image. 

5.11.13.2 Math 

 The user can set a custom page to display after power on. This set page will show after the recorder after 
power on. 
 
 New modifications since V1.70.  
 Add function:  

Added new option allows users to edit math expression with channel codes or channel names. 
Depending on the settings, the system converts between channel codes and channel names for all 
math expressions. 
Naming mode of channel names is supported since V1.61 
Go to Configuration > Instrument > Math > Expression > Naming for Channel Variable > OK 
Go to Configuration > Channel > Math > Expression 

 

  
                                              Instrument > Math Expression 

  
Channel > Math 
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 New modifications since V2.0 (2507).  
 Add function:  

Add EMS function to Config after enabled. EMS config is used to set E1~E8, as Energy Management 
System. 
(1) UI for EMS Config 

Auto-Config Channels, Commands, Pages. 
(2) UI for EMS Realtime 

Go to Menu > More > Configuration, before setting EMS option, unable to display on the list.  
 

Go to Configuration > Instrument > EMS > Enable > OK 

 
 

Go to .. Instrument > Math > Expression > Naming Mood > Channel Name > OK 

    
 

Go to Configuration > Display > Overview > Auto > OK 

   
 

Power off the device and power on again  
Go to Configuration; EMS has been created to the Config list 
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5.12 Security 

5.12.1 Normal 

 If normal mode is selected in security mode in the instrument menu then the user can define a common 
password with a maximum of 18 characters. Once the password has been configured then the user needs 
to key in the password to access Config, Dump, Clear, Operate softkeys. These keys enable the user to 
do configuration, dump data, clear data or manually operate the job. For easy access, the user may leave 
the password field empty.  
 After entering the Configuration menu, select Password then Press the Enter key to get into the password 
configuration menu. 
 

5.12.2 CFR-21 

 If CFR-21 is selected in security mode in the instrument menu then the data recorded in the instrument will 
comply with FDA 21 CFR Part11. The recorder also provides audit trial report through the event list. There 
are 30 different user accounts can be configured with different level of authority. There are different levels of 
security can be configured.  
 
New modifications since V1.60: 
 Modification: The state before the modification of the configuration will be appended to the audit trail. 
 Modification: The options for "Log Reason for Change" are changed to "Disable","Ask" and "Must". 

5.12.3 User Account 

 This will allow the user to configure the user account like user name, function permissions.  After entering 

the Configuration menu, select User Account then Press the Enter key to get into the user account 

configuration menu. It displays user account user1 as the first user to configure. Press directional navigation 

keys   at the bottom to select other users. Press directional keys   on the right-hand side to 

select the menu column.   After completing Configuration, press  soft-key, then press   soft-key to 

return to the main display. All configurations will be saved automatically. 
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5.12.3.1 User Name 

 This enables the user to define the user name for the user account with a maximum of 18 characters. 
Select “User Name”, then press “Enter”, soft-key, a keyboard with several keys will appear. Press “Shift” to 
select special characters. Press “Caps” to select capital letters. Press soft-key “OK” after entering a new 
recorder name.  
 

5.12.3.2 Active 

 The user account can be enabled or disabled by choosing Enable or Disable in Active. 

5.12.3.3 Permissions 

 There is a different access level can be configured for a different function. Each user can give access or not 
by configuring the function enable or disable. The different functions can be given access for different users 
as listed below. 

1. Login from PC 
2. Dump 
3. Clear 
4. Operate 
5. Config 

 Channel 
 Clock 
 Instrument 
 User Account 

6. Pause 
7. Batch 
8. Shutdown 

Note: It is necessary to restart the recorder after changing the security mode. 
 

5.13 Demo 

 The Demo mode is a simulation mode used as a sales tool for demonstration purposes.  It is set to simulate 
AI analog inputs and Math functions. After entering the Configuration menu, select Demo then Press the 
Enter key to select Enable or Disable the Demo.   After completing Configuration, press   soft-key to 
return to the main display. All configurations will be saved automatically. It is necessary to save and restart 
the recorder after changing the demo menu option. 
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5.14 Auto-Output 

 This will allow the user to configure the auto output configuration for automatic output in output historical 
data and print-related jobs. After entering the Configuration menu, select Auto-Output then Press the Enter 
key to get into the Auto output configuration menu. Press directional keys    on the right-hand side to 
select the menu column.   After completing Configuration, press  soft-key, then press  soft-key to 
return to the main display. All configurations will be saved automatically. 
 
New modifications since V1.50: 
 The setting "Interval" under Auto-Output is changed from time interval to dot interval. 
 Auto-dumping will be triggerred if the amount of batches >=900. 
 

 
 

5.14.1 Setup Printer 

This will allow the user to configure the printer. Select Setup Printer and press Enter soft key to access the 
printer configuration menu. 
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Printer:  Select the printer type.  There are five types of printer drivers supported. They are listed as below. 

1. HP PCL Laser 
2. Epson ESC/P 
3. Adobe PDF file 
4. HP PCL Inkjet 
5. Epson ESC/POS 

 Port: Select the printer port as per the connection. Select Network Printer for the printers connected in 
Ethernet port and select LPT1 for the printers connected in USB Port. 
 Color/Mono: Select the colour as per the printer configuration. The available options are Monochrome, 4 
color CMYK, 3 Color CMY. 
Printer Path: Configure the network printer path as per the connection. The syntax for the network printer 
path as given below. 

 For Network Printer 
       \\IP address of printer: Port no 

                                Example: 192.168.0.197:9100 
 For Shard printer 

                                 \\PC Name\Printer Share name 
                                           Example: \\THILLAI-PC\HP 
 Paper: Select the paper size. 
Orientation: Select the orientation as Portrait or Landscape. 
Draft Mode: Select Draft mode for printing as draft mode. 
 

5.14.2 Print Header 

 The user can Enable or Disable the headers in the printing. Generally, the recorder will print with related 
information of the data in the header in all the pages. This header can be disabled by selecting Disable in 
Print header. 

5.14.3 Title 

 The title available on the print header can be configured in this option.  

5.14.4 Historical Data 

The period and interval of historical data to be printed can be configured by selecting the period and interval. 
Print Historical Data and Print Event List will follow the period configured in this menu. 

Period:  Select Last hours or Last days 
Hours/Days:  Select number of hours or number of days to be printed. 
Time of Alignment: Timestamp/ System Time  
Interval:  Select interval of data to be printed from 100 msec /1 Sec / 2 Sec / 5 Sec / 10 Sec / 15 
Sec / 20 Sec / 30 Sec / 1 Min / 5 Min / 10 Min / 15 Min / 20 Min / 30 Min / 45 Min / 1 Hour / 2 Hour 
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New modifications since V1.70.  
 Add function: Add new option at Auto-Output.Historical Data.Period.Time-Alignment, for users to align 

the time range. 
Go to Configuration > Auto-Output > Historical Data > Period > Time Alignment > System Time 
 

 
 

5.14.5 Report Data 

 The mode of the report to be printed can be selected in this option. This print Report List will follow the 
mode configured in this menu. In the Mode, select which kind of Reports are required. Available options are 
List, Daily, Weekly and Monthly. 
 New modifications since V1.70.  
 Add function: Add new option at Report Data Viewing & Output 

Go to Configuration > Auto-Output > Report Data > Period/ Mode 
Period: Daily/ Weekly/ Monthly 
Mode: Summary/ List   
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5.14.6 Output Files 

 The output files can be compressed by choosing to enable in compress menu. 
 

5.14.7 USB Printer Configuration 

 The USB printers can be connected directly via front or rear USB port of the recorder. The printer should 
support PCL4 or PCL5 or PCL6 or ESCP. 
 
Note: Do not use USB printer supporting only PCL to print single line alarms, otherwise, pages will be  
Wasted 
 
 
 
 
 
 
 
 

5.14.8 Network Printer Configuration 

 The network printers or shared printers can be connected via Ethernet port of the recorder. The printer 
should support PCL4 or PCL5 or PCL6 or ESCP. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Paperless Recorder USB Printer 

USB 

Paperless Recorder Network Printer 

Ethernet  

 
5-42 Network Printer Connection 

Paperless 

Recorder 

PC 
Ethernet 

Printer 
USB or Ethernet 

5-43 Shared Printer Connection 
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5.14.9 Sample Configuration of Printer 

 Steps to be followed for printer configuration as below. 
1. Select the Printer Driver 

 
2. Select the Port. LPT1 for USB Printer and Network printer for Network Printer and Shared printer. 

 
3. Set the Printer Path as per the connection. 

 For USB Printer the path is not applicable. 

 
 For Network Printer set the path as below format 

      \\IP address of printer: Port no 
                                 Example: 192.168.0.197:9100 
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 For Shard printer set the path as below format 

                                    \\PC Name\Printer Share name 
                                       Example: \\THILLAI-PC\HP 

 
 

4. Press  and then press  soft-key to save the configurations. Now the recorder is ready 
for printer connectivity. 

5. Press Menu and Operate to select the print snapshot to test the printer function. 
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6. If the print job fails to print then the recorder will pop up an error message as below. 
 

 
 

5.15 System Information 

This will provide the system information for the user like system version, memory information, MAC address, 

IP address, Connected IO cards in every slot. This page will allow the user to calibrate the touch screen and 

upgrade the system firmware. 

 After entering the Configuration menu, select System Information then Press the Enter key to get into 

System Information page. Press directional keys   on the right-hand side to move between the 

information. Press  soft-key, and then press  soft-key to return to the main display. All 

configurations will be saved automatically. 
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 The System Information page contains  soft-key to access Touch Screen Calibration and Firmware 

upgrade Menu.  

 

5.15.1 Firmware Upgrade 

The recorder firmware can be updated by using the Update core system option in the maintain menu option. 
For doing the firmware upgrade follow the below steps. 

1. Download the latest firmware from the supplier website. 

2. Unzip the file and copy the file Recorder_PV210.Bin file to SD Card or USB Disk as per the 

selection of External Storage in Instrument menu. The file must be copied to root path of the SD 

Card or USB Disk. The SD Card or USB disk must be formatted to FAT or FAT 32 format. 

3. Plug the SD Card or USB Disk to the recorder. 

4. After entering the Configuration menu, select System Information then Press the Enter key to 

get into System Information page. After Entering the System Information Menu Press menu 

press   key. The system will show the below options to select. 
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5. Select Update Core System to upgrade the firmware.  
 

After the upgrade firmware process is finished the system required to be restarted and do the 
screen calibration. 
Note: 
All the data and configuration stored on the recorder will be deleted during the firmware upgrade 
procedure.  
Do not power off the recorder until the upgrade process is finished. Failing to do so may damage 
the recorder flash memory. 

 
New modifications since V2.0 (2507).  
 Note:  

If the firmware is later than version 1.38, then the user can directly update to the latest after download 
the latest. 
If the firmware is earlier than version 1.38, please firsly update to version 1.38 only, and then update to 
the latest. 

 

5.15.2 Touch Screen Calibration 

 After entering the system information menu in the configuration menu press  key. The system will 
show the below options to select 
 

 
 
 Select Touch Calibrate and press OK to do the screen calibration. The below screen will appear 

to do the screen calibration.   
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1. A “+” symbol appears in the centre of the LCD screen. Carefully press using a stylus or finger on the 

centre of the target.  
2. Repeat this procedure as the target moves around the screen. Once the ‘+’ symbol disappears, touch 

the screen to complete the screen calibration.  
By pressing the ESC key from the USB keyboard connected to the recorder can exit the screen 
calibration screen. The screen calibration is necessary to achieve proper operation on the screen. 
 

5.16 Calibrate 

This function is used for calibrating Individual Analog channel. This can be protected by a password. After 

entering the Configuration menu, select Calibrate then Press the Enter key to get into the Calibration menu. 

Press directional keys   on the right-hand side to select the menu column. After completing 

Configuration, press  soft-key, and then press  soft-key to return to the main display. All 

configurations will be saved automatically. 

 The Calibration must be carried out by qualified personnel only with proper instruments. The system will 

show the warning message as shown below when the user is accessing the calibration menu. 
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  After Entering the calibration menu, the screen shows the below screen. 
 

 
 

Type: Choose Channel for calibrating Analog Input and Analog Output, Controller for calibrating PID 
process control card input. 
Channel: Select the Analog Input or Analog Output Channel from the list to calibrate.  
Sensor: Select the input type and its range to be calibrated. 
Calibration Password: Set Password to access the Calibration parameters. 
 
Note 
Channel #3 should be calibrated first in all types of Analog Input cards. An analog temperature sensor is 
installed in channel # 3.  When channel # 3 is calibrating, the cold junction voltage measured by this 
temperature sensor will be loaded into a register. If channel # 3 is not calibrated, the default value of cold 
junction voltage will be used for all channels. It does not matter what order you perform a calibration after 
calibrating input 3, there is no need to follow a sequence, and anyone of T/C, RTD, mA or VDC can be done 
independently. 
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Channel: Select the AO channel to be calibrated 
Type: Select the AO type to be calibrated as Voltage or Current. 
Note: The AO Card Dip switch also needs to be set as per the type selection. 
Calibration Password: Set Password to access the Calibration parameters. 
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Type: Choose Channel for calibrating Analog Input and Analog Output, Controller for calibrating PID 
process control card input. 
Controller: Select the PID process control card to be calibrated. 
Input: Choose the input of the process control card to be calibrated.  
Sensor Type: Choose the sensor type of the input to be calibrated. 
Calibration Password: Set Password to access the Calibration parameters. 
 

5.16.1 Calibrate an AI with 0-5V 

 After Entering the Calibration menu, select the channel, input type and range then press calibrate key. 
 

 
 
 The system will prompt for a user conformation to do the calibration of the channel. 
 

 
 

Press Yes to do the Calibration on No to exit. The system will inform the user to input the low-value input 
to the channel. 

 

 
  
 After input 0 V, select OK, the user can see the below screen. 
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 After successful calibration lower AD calibration the system will request the user to input higher range input 
to the input channel. 

 
 

 After input 5V, press OK, the user can see the below screen. 
 

 
 

 After successful calibration of upper AD calibration, the system will show the calibration completed 
message. 

 
  
Press Back key to exit the calibration Menu. The system will prompt the user to save the new calibration or 
not. Select Yes to apply the new calibration to the channel and No to exit without saving the calibration data. 
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5.16.2  Calibrate an AI with K Type Thermocouple 

 After Entering the Calibration menu, select the channel, input type and range then press calibrate key. 
 

 
 

 The system will prompt for a user conformation to do the calibration of the channel. 

 
 

 Press Yes to do the Calibration on No to exit. The system will inform the user to input the low-value input to 
the channel. 

 
 

 After input 0mV, select OK, the user can see the below screen. 
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 After successful calibration lower AD calibration the system will request the user to input higher range input 
to the input channel. 
 

 
 

After input 60mV, press OK, the user can see the below screen. 
 

 
 

 After successful calibration of upper AD calibration, the system will show the calibration completed 
message. 
 

 
  
Press Back key to exit the calibration Menu. The system will prompt the user to save the new calibration or 
not. Select Yes to apply the new calibration to the channel and No to exit without saving the calibration data. 
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5.16.3 Calibrate an AI with Pt100 RTD 

 After Entering the Calibration menu, select the channel, input type and range then press calibrate key. 
 

 
 

 The system will prompt for a user conformation to do the calibration of the channel. 
 

 
 

 Press Yes to do the Calibration on No to exit. The system will inform the user to input the low-value input to 
the channel. 
 

 
 
After input 100Ω, select OK, the user can see the below screen. 
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After successful calibration lower RTD calibration the system will request the user to input higher range 
input to the input channel. 
 

 
 

After input 300Ω, press OK, the user can see the below screen. 
 

 
 
 After successful calibration upper RTD calibration, the system will show the calibration completed message. 
 

 
  
 Press Back key to exit the calibration Menu. The system will prompt the user to save the new calibration or 
not. Select Yes to apply the new calibration to the channel and No to exit without saving the calibration data. 
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5.16.4 Calibrate an AO with 4 to 20 mA 

 After Entering the Calibration menu, select the channel, output type then press calibrate key. 
 

 
 

 The system will prompt for a user conformation to do the calibration of the channel. 
 

 
 

 Press Yes to do the Calibration on No to exit. 
 Connect a Current measuring meter before starting calibration. 
 

 
 
 The system will inform the user to input the low-value input to the channel. 
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 Input the value shown on the meter 
 

 
 

 After inputting the value, the user can see the below screen. 
 

 
 

 After successful calibration of the lower input value, the system will request the user to input higher input to 
the channel. 
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Input the value shown on the meter. 
 

 
 
 After input the value press OK, the user can see the below screen. 
 

 
 

After successful calibration of upper-value calibration, the system will request the user to input offset 
input to the channel. 

 
 

 Input the value shown on the meter 
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 After input the value press OK, the user can see the below screen. 
 

 
 
 After successful calibration of offset value calibration, the system will show the calibration completed 
message. 

 
  
 Press Back key to exit the calibration Menu. The system will prompt the user to save the new calibration or 
not. Select Yes to apply the new calibration to the channel and No to exit without saving the calibration data. 
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5.16.5 Calibrate an AO with 0 to 10 V 

 After Entering the Calibration menu, select the channel, output type then press calibrate key. 
 

 
 

 The system will prompt for a user conformation to do the calibration of the channel. 
 

 
 

 Press Yes to do the Calibration on No to exit. 
 Connect a Voltage measuring meter before starting calibration. 
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The system will inform the user to input the low-value input to the channel. 
 

 
 

 Input the value shown on the meter 
 

 
 

 After inputting the value, the user can see the below screen. 
 

 
 

After successful calibration of the lower input value, the system will request the user to input higher 
input to the channel. 
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Input the value shown on the meter. 
 

 
 
 After input the value press OK, the user can see the below screen. 
 

 
 

After successful calibration of upper-value calibration, the system will request the user to input 
offset input to the channel. 
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Input the value shown on the meter 
 

 
 

 After input the value press OK, the user can see the below screen. 
 

 
 

After successful calibration of offset value calibration, the system will show the calibration 
completed message. 
 

 
  

Press Back key to exit the calibration Menu. The system will prompt the user to save the new 
calibration or not. Select Yes to apply the new calibration to the channel and No to exit without 
saving the calibration data. 
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5.16.6 Calibrate PID Process Control Card with K Type Thermocouple 

 After Entering the Calibration menu, select the type as controller and choose the PID process control card 
and its input and input type to be calibrated, then press calibrate key. 
 

 
 

 The system will prompt the user confirmation to calibrate. 
 

 
 

Press Yes to do the Calibration on No to exit. The system will inform the user to input the low-value 
input to the channel of the process control card. 

 

 
 

 After input 0mV, select OK, the user can see the below screen. 
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After successful calibration lower AD calibration, the system will request the user to input higher 
range input to the input channel of the process control card. 
 

 
  

After input 60mV, press OK, the user can see the below screen. 
 

 
 

After successful calibration of upper AD calibration, the system will prompt the user to connect 
the input as K type thermocouple with 0°C at ambient temperature 0°C. 
 

 
 

After input K type thermocouple with 0°C at ambient temperature 0°C, press OK, the user can 
see the below screen. 
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After successful calibration of lower cold junction calibration, the system will show the calibration 
completed message. 
 

 
 

Press Back key to exit the calibration Menu. The system will prompt the user to save the new 
calibration or not. Select Yes to apply the new calibration to the channel and No to exit without 
saving the calibration data. 

 

 
 

5.17 Procedure to Upgrade and Restore Factory Default Settings 

 This procedure will allow the user to recover the device when the recorder application is not running or 
malfunctioning like hanging. The below procedure should be followed to recover the device. 
 Power ON the Recorder while Pressing the Reset Button 
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Now the screen will appear like below 
 

 
 
Format: 
Press the Format Button for at least 3 seconds to return the Recorder to factory Settings. 
After the Recorder is done the formatting, it will ask for Screen Calibration. Do the Screen Calibration by 
touching the ‘+’ symbol on the screen. Repeat the step of calibration as long as the symbol ‘+’ moves on the 
screen. Once the calibration is finished touch the screen to exit. The recorder has now been returned to 
factory default settings. 
 
Upgrade: 
 Download the Firmware from the link given. Generally, the file will be compressed. The compressed file 
needs to be unzipped then copy the file Recorder_PV210.BIN to the main path of the SD Card.  
Ensure that the SD card is formatted to FAT32 or FAT. Insert the SD card to the SD Card Slot on the 
Recorder. Press Upgrade Button for at least 3 Seconds to upgrade the image from SD Card.  
Follow the on-Screen instructions. 
 After the Recorder is done the upgrade, it will ask for Screen Calibration. Do the Screen Calibration by 
touching the ‘+’ symbol on the screen. Repeat the step of calibration as long as the symbol ‘+’ moves on the 
screen. Once the calibration is finished touch the screen to exit the calibration mode and enter into the 
recorder application. 
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6. PC BASED SOFTWARE 
 The PC Software can be used for configuration of the recorder, viewing and analysing of historical data, 
real-time monitoring and logging of data, custom screen development for the recorder. There is 4 software 
available for these functions as listed below. 

1. Configuration Viewer- For Configuration 
2. Historical Viewer- For analysis and viewing of historical data 
3. Real-time Viewer-For real-time monitoring and logging 
4. Panel Studio- For Custom screen development 

6.1 Free Basic Software 

 The free basic software provided with recorder consists of Configuration Viewer and Historical Viewer. 

6.1.1 Historical Viewer Software Installation 

 The Historical Viewer software installation will install Historical Viewer and Configuration Viewer on the PC.    

6.1.1.1 System Requirements 

Item Minimum Requirements 

System IBM PC compatible computer with Intel Pentium IV or above 

Operating System Windows XP or above 

Memory 1 GB 

Hard Disk 50 GB Free Space on the hard disk 

Communication Ports RS232 or RS485 or Ethernet Port 

Ethernet Port no 502, 26530 to 26533 to be opened 

Others USB Port or SD Card Slot 

6.1.1.2 Software Installation 

 Historical viewer software can be installed by following the below procedure. 
1. Download the Historical viewer software form the manufacturer’s website. 
2. Install latest Dot Net software from Microsoft website  
3. Install the software by double-clicking the setupwizard.exe from Historical Viewer folder. 

 
4. Select the language for installation 
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5. Select the software components to be installed and select install 
 

 
 

6. Follow on-screen instructions to select the installation path and press next to continue the 
installation. 
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7. Follow onscreen instructions to complete the installation. Once the installation is completed the 
system will show the installation complete message. 

 

 
 

8. After installation is successful, the shortcut for Historical viewer software will be 
created on the desktop. 
 

9.  The structure of Historical viewer on the start menu as below. 

 . 

6.1.1.3 Uninstallation of Software 

 The software can be uninstalled by selecting the uninstall option on the start menu. 
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6.1.2 Start and Exit  

 The Historical Viewer program can be started by using the shortcut  on the desktop or selecting the 
program Historical Viewer from the Start menu.  
 The program can be exit by simply closing the program X symbol on the top right corner of the screen. 

6.1.3 Historical Viewer 

 When running the program first time the initial screen displays like below. 

 

6.1.3.1 Historical Viewer-Tool Bar 

 The historical viewer has below tools on the tool bar. 

 New 

 Open 

 Save As 

 Print 

 Trend View 

 Event / Alarm List 

 Report List 

 Value List 

 Manually Export data to Excel 

 Copy Curves to Clipboard 

 Remark 

 Latest Event / Alarm List 

 Manually Export data to Database Format (*.CSV) 

 Snapshot 

 Show Statistics 

 Manually Export data in PDF 

 Search by Specific Time 
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 Search by Specific Period 

 Search by Handwrite 

 Fast Backward 

 Backward 

 Forward 

 Fast Forward 

 Zoom In 

 Zoom Out 

 Zoom All 

 Zoom Size 

 Zoom By Time 
 Zoom By Time and Value 

 Select Period (Period A to B) 

 By Horizontally 

 By Vertically 

 White Background 

 Black Background 

 Show Trend View 

 Show Circular View 

 Next Page 

 Manually import measured data 

 Configuration 

 Page Configuration 

 Scale Selection 

 Batch Selection 

 Signature List 

 Logout 

 Seek by Tag Name 

 Seek by Event / Alarm 

 Seek by Trend Remark 
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 Seek by signature 

 Trend Scale List 

 Batch Comments 

 Decode Method 
 

6.1.3.2 Historical Viewer-Menu Bar 

 The menu bar consists of 8 menus. They are listed as below. 
1. File(F) 
2. Edit(E) 
3. View(V) 
4. Display(D) 
5. Page(P) 
6. Search(S) 
7. Language(L) 
8. Help(H) 

 
 

6.1.3.2.1 File (F) 

 Below are the sub menu options available in File Menu. 

 
 

1. New:  Create a new project. 
2. Open:  Open an existing project. 
3. Save As: Save the project with a new name. 
4. Print:  Print the data. 
5. Recent: Open recently opened projects. 
6. Logout: Log out the current user. 
7. Exit: Exit the program. 
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6.1.3.2.2  Edit (E) 

 Below are the sub menu options available in Edit Menu. 
 

 
 

1. Manually Import:  Manually import the data from the device;  
Go to Edit > Manually import or Tool bar > Manually import data  
New modifications since V1.70 
 Historical Software adds new range for importing data from PR, Option for dumping data 

via network to PC after selecting data range by data range 
- All/ Last Month/ Selected Period (Range) 

   
2. Automatically Import and Export Option: Automatically import the data from the device and 

exported to Excel, PDF or Database format 
3. Manually export data to Excel: Manually export the data to excel 
4. Manually export data to Database Format: Manually export the data to the database 

format .csv 
5. Manually export data to PDF: Manually export the data to PDF 
6. Clear: Clear the data from the project for a specific time period or all. 
7. Copy: Copy the screen 
8. Remark: Add remark to the data 
9. Snapshot: Print the snapshot of the trend view. 
10. Show Statistics: Show the statistical data Min, Max, Ave, P-P, Mean, RMS, Point A, Point B, 

Difference of point A and point B (A-B) of the displayed trend. 
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11. Signature: Shows the list of signatures on the data. 

 

 
 

12. Display Configuration Option: Select the display configuration as automatically or manually.  

6.1.3.2.3 View (V) 

 Below are the sub menu options available in the View menu. 
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This will allow the user to select the different zoom rate for the data, vertical or horizontal direction of the 
trend and black or white background. 

6.1.3.2.4 Display (D) 

 The below are the sub menu options available in Display Menu. 
 

 
 

1. Trend View: View the data in trend view mode. 
2. Event/Alarm List: View the Event and alarm List of the data. 
3. Report List: View the report list of the data. 
4. Value List: View the data in Value List mode. 

6.1.3.2.5 Page (P) 

 The below are the sub menu options available in Page Menu. 
 

 
 

 The user can select the display page to be viewed from the shown list. 
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6.1.3.2.6 Search (S) 

 Below are the sub menu options available in Search Menu. 

 
 

1. By Time: Search the data at a particular time. 
2. By Period: Search between two periods. Hold the mouse left key and move to select the period 

A and Period B. 
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3. By Handwrite: Search the data by handwriting. 
4. By Tag Name: Search the data by tag name. 
5. By Event/Alarm: Search the data by Event or Alarm. 
6. By Remark: Search the data by the remark. 

 

6.1.3.2.7 Language (L) 

 The display language of the software can be changed by selecting any one of the available languages from 
the sub-menu. 
 

 
 

6.1.3.2.8 Help (H) 

 The help menu provides information about the software and the necessary information. 

 
1. Historical Viewer: Open the software help file. 
2. About: Provides the information about the software like version and other related information. 

6.1.3.3 Configuration Viewer-Tool Bar 

The toolbar of configuration Viewer consists of the below tools. 

 New 

 Open 

 Save 

 Delete 

 Bank 
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 Fast Backward 

 Backward 

 Forward 

 Fast Forward 

 Receive Configuration 

 Send Configuration 

6.1.3.4 Configuration Viewer-Menu Bar 

 The menu bar consists of 8 menus. They are listed as below. 
1. File(F) 
2. Edit(E) 
3. Language(L) 
4. Help(H) 
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6.1.3.4.1 File (F) 

 Below are the sub menu options available in File Menu. 

 
 

1. Save: Save the changed configuration. 
2. Exit: Exit the program. 

6.1.3.4.2 Edit (E) 

 Below are the sub menu options available in Edit Menu. 

 
 

1. Import: Import the configuration from the device or storage media. 
2. Export: Export the configuration to the device or storage media. 
3. Bank: Change the connection properties for the project.  
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6.1.3.4.3 Language (L) 

 The display language of the software can be changed by selecting any one of the available languages from 
the sub-menu. 
 

 

6.1.3.4.4 Help (H) 

 The help menu provides information about the software and the necessary information. 
 

 
1. Configuration Help: Open the software help file. 
2. About: Provides the information about the software like version and other related information. 
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6.1.3.5 Create a New Project 

 To Create a new project, follow the below procedure. 

1. Click the icon  or select New from File Menu.  
2. The software will prompt the user to select the device type. Select Recorder (PR) and click 

OK to create a new project. 
 

 
 

3. The Software will prompt the user to configure the project name and the path for the 
recorder. 

 
 
 Input the project name in the new project name field.    
 If the device is connected to PC via Ethernet then select Ethernet in the file path and 

input the IP address of the recorder then press OK. 
Note: If the recorder is configured with static IP purchased from the Internet service 
provider and connected with Internet then the data can be received from the recorder 
anywhere in the world using this software. 

 If the historical data is dumped to SD Card or USB Disk then remove the SD card or 
USB disk from the recorder. Insert SD Card or USB disk to the PC then select Storage 
Media in the file path and then select the path then press OK. The same procedure can 
be followed for the files copied from SD card USB disk on the PC by selecting the file 
path on the PC.  

4. After the successful connection with the assigned path via Ethernet or Storage device, the 
software will display the configuration of the device on the project via configuration viewer. If 
the security is set for CFR21 then the user login is required. 
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5. After receiving the configuration close the configuration viewer to automatically import and 
view the historical trend of historical data. If the security is set for CFR21 then the user login 
is required.  
 

 
 

6. If the data is an import from storage media then the system will prompt the user to delete the 
data from storage media or not after import. 

 
 



 
 

 
 

Page 295 of 550 

7. If the security is configured as CFR21 then it is necessary to sign for imported data before 
close the project or logout. 
 

 
 

8. If the connection to the recorder fails then the software will show the error message. 
 

 
 

6.1.3.6 Open an Existing Project 

 To open and upload the new data to an existing project the following procedures to be followed. 

1. Click the icon  or select Open from File Menu.  
2. The software will list the projects from the default project path for the user to select. 

 
 

3. Select the project and click open to open the project. 
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4. The existing data will be displayed along with the login option for CFR21 security. 

5. Click  icon or select manually import from Edit menu to manually import the data from 
the device. The progress will be shown with a progress bar. 
 

 
 

6. After the successful import of the data, the software will display the data. 
 

 
 

Note: The device configuration must be the same as the existing project to upload new data to the 
project. Otherwise, the software will show a warning message to create a new project. 
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6.1.3.7 Automatic Import of Data 

 The historical data can be imported automatically from the device in the defined interval of time. The 
following steps to be followed for automatic import. 

1. After creating a new project or opening an existing project select automatic import and export 
option from the Edit menu. 

 

 
 

2. Select automatically, set the time interval, File path. The time interval can be set from 1 hour to 
24 hours. 

 
 

3. Now the software will automatically import the data from the device to the project. 

 



 
 

 
 

Page 298 of 550 

6.1.3.8 Automatic Import and Export of Data 

 The historical data can be imported automatically and exported to Excel, PDF or Database format. 
1. After creating a new project or opening an existing project select automatic import and export 

option from the Edit menu. 
 

 
 

2. Select automatically and export to excel or automatically and export to database format or 
automatically and export to PDF, set the time interval, File path and File attributes. The time 
interval can be set from 1 hour to 24 hours. The file attribute can be written to single file or 
multitude files. 

 

 
 

4. Now the software will automatically import the data from the device to the project and export to 
Excel or PDF or Database format. 
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6.1.3.9 Multiple Projects Automatic Import and Export of Data 

 The software supports the import of multiple projects automatically and exported to Excel, PDF or Database 
format. For doing multiple projects import the following procedures need to be followed.  

1. Create individual projects for individual recorders.  
2. Set the export option in current project tab of Automatically Import and Export Option 

 
3. Select the project to be imported automatically in multiple project tab. 

 

 
 

4. Set the login credentials and the import interval. The login credential must be same for all the 
projects. 

5. Now the software will automatically import the data from the device to all the projects and export 
to Excel or PDF or Database format as per the selectio 
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6.2 Extensive Software 

 The extensive software Data Acquisition Studio (DAQ) consists of Real-time Viewer, Configuration Viewer 
and Historical Viewer. 

6.2.1 Data Acquisition Studio Software Installation 

 The Data Acquisition Studio installation will install Real-time Viewer, Historical Viewer and Configuration 
Viewer on the PC.    

6.2.1.1 System Requirements 

Item Minimum Requirements 

System IBM PC compatible computer with Intel Pentium IV or above 

Operating System Windows XP or above 

Memory 1 GB 

Hard Disk 50 GB Free Space on the hard disk 

Communication Ports RS232 or RS485 or Ethernet Port 

Others USB Port or SD Card Slot 

Licence USB Licence Key 

6.2.1.2 Software Installation 

 The Data Acquisition Studio software can be installed by following the below procedure. 
1. Download the Data Acquisition Studio software form the manufacturer’s website. 
2. Install latest dot Net software from Microsoft website  
3. Install the software by double-clicking the setupwizard.exe from Data Acquisition Studio folder. 

 
 

4. Select the language for installation and  

 
 

5. Select the software components to be installed and select install 
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6. Follow on-screen instructions to select the installation path and press next to continue the 

installation. 

 
7. Follow onscreen instructions to complete the installation. Once the installation is completed the 

system will show the installation complete message. 
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8. After installation is successful, the shortcut for Real-time Viewer and Historical viewer software will 
be created on the desktop.  

6.2.1.3 Uninstallation of Software 

 The software can be uninstalled by selecting the uninstall option on the control panel Add or Remove 
Programs. 

6.2.2 Start and Exit  

 The Real-time Viewer program can be started by using the shortcut on the desktop or selecting the 
program Real-time viewer from the start menu.  
 The program can be exit by simply closing the program X symbol on the top right corner of the screen. 

6.2.3 Real-Time Viewer 

 When running the program first time the initial screen displays like below. 

 

6.2.3.1 Real-Time Viewer – Tool Bar 

 The real-time viewer has the following toolbars. 
 

 

 New 

 Open 

 Save As 

 Display Page Choice 

 Configuration Data’ 

 Measured Data 

 Arrange All (Mixed Mode) 

 All Channel Digital 

 Status 

 Auto Page Mode 

 Show Event/Alarm List 

 Digital Mode Display 

 Bar Graph 

 Trend Mode 

 IO Module Configuration (only for IO Modules) 
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 Controller Configuration (only for Controllers) 

 Recorder Configuration (only for recorders) 

 Manually Operate Jobs 

 Reset Counters of IO Module (only for IO modules) 

 Mute Alarms 

6.2.3.2 Real Time Viewer – Menu Bar 

 The menu bar consists of 6 menus. They are listed as below. 
1. File(F) 
2. View(V) 
3. Page(P) 
4. Window(W) 
5. Language(L) 
6. Help(H) 

 

6.2.3.2.1 File (F) 

 The File menu consists of the below sub-menu. 

 
 

1. New:  Create a new project. 
2. Open:  Open an existing project. 
3. Save As: Save the project with a new name. 
4. Close: Close the current project 
5. Recent: Open recently opened projects. 
6. Create DDE link in Excel: Create Dynamic Data Exchange in Excel for real-time values. 
7. Exit: Exit the program. 
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6.2.3.2.2 View (V) 

 The View menu consists of the below sub-menu. 

 
1. Configuration Data:  Opens the configuration data of the project. 
2. Measured Data:  Opens the historical data of the project via Historical Viewer. 

6.2.3.2.3 Page (P) 

 The Page menu consists of the available display pages to select. The user can select the display page to 
be viewed from the shown list. 

 

6.2.3.2.4 Window (W) 

 The Window menu consists of different display modes to select. The user can select the display mode to be 
viewed from the shown list. 

 
 

1. Trend:  Shows the display page in trend mode. 
2. Bar:  Shows the display page in bar graph mode. 
3. Digital: Shows the display page in digital display mode. 
4. Event:  Shows the Event/ Alarm List display. 
5. Arrange All: Shows the display page with Trend, Bar Graph, Digital Display and Event/Alarm 

List. 
6. All Channel Digital: Shows all the configured channels in the digital mode as an overview.  
7. Status: Shows the status of counters and Totalizers. 
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6.2.3.2.5 Language (L) 

The display language of the software can be changed by selecting any one of the available languages from 
the sub-menu. 

 

6.2.3.2.6 Help (H) 

 The help menu provides information about the software and the necessary information. 

 
 

1. Real-time Viewer: Open the software help file. 
2. About: Provides the information about the software like version and other related information. 
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6.2.3.3 Real-time Configuration Viewer-Tool Bar 

 The real time configuration has the following tools on the tool bar. 

 

 Save 

 Backup the configuration 

 Delete the project 

 Option 

 Print 

 Bank 

 Channel Configuration 

 Display Page Configuration 

 Tools 

 Comment 

 Setup Controller (only for Controllers) 

 Setup all Display pages in Digital Mode Overview display. 

 Fast Backward 

 Backward 

 Forward 

 Fast Forward 

 Project Auto configure 

 Close and return to main program. 

6.2.3.3.1 Option 

 The Options menu of real-time configuration has the following options. 
1. Share 
2. Email 
3. Communication 
4. Format 
5. Display 
6. Print auto-output 
7. User Manage 
8. The display of AI serial for IO Modules (only for IO Modules) 
9. Auto start project 
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1. Share 
The share menu will allow the user to configure for share or not to share the data with others. 

 

 
 

Share/do not share options are available for user selection. If the share option is selected, 
then historical data available on the computer can be shared from other computers. On 
selection of this share data, the shared folder will be created and the following message will 
be shown 
 

 
 
For example, the recorder is connected to the PC with a real-time viewer and wish to 
analyse historical data at a different computer. While opening the project in the second 
Computer, directly link to the project file available under C:\Data Acquisition Studio 
through network configuration. This will minimize the data transfer between Modbus slaves 
and the computers and make it more efficient by using available resources through the 
network Configurations. 
 

2. Email 
The Email menu will allow the user to configure the email server to send an email on an 
event or alarm. The default Port number 25 is used to send email from the SMTP server. If 
the network administrator configured a different port in LAN for accessing internet/email, 
then the user has to modify the port number accordingly. 
 To send an email for any event, the procedure is as follows. 

 Set SMTP server details as below. Please contact system or network 
administrator for the server details if the computer is connected in LAN. 

 Host, Port, User name,  
 From: Sender email address 
 To: Receiver email address (Max.10 email addresses can be selected) 
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 In case, email is successful, it delivers as follows 

Type: HI Alarm 
Source: Tag1 
Active Time: 05/08/09, 13:31:04 
Value: 50 
Comment: Level high 

 If Email is failed to deliver, then it prompts the following error message. In this 
case, it   requires to check all the email settings 

 

 
3. Communication 

The communication menu will allow the user to configure the communication parameters 
for the project.  
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Sampling rate: It is used to set data display time for Real-Time Viewer. User can select 
One from the following for real-time monitoring. 

 
Time out: This is time set for generating time out errors related to real-time viewer 
Communication. 
For example, if Recorder and PC with data acquisition software are located at different 
places connected through Ethernet across different gateways, and then the user can adjust 
sampling rate and time out settings to avoid errors in communication. When the real-time 
viewer is running, please observe the following taskbar at the bottom side of the screen. 
 

 
 

Here, scan time should always be less than the sampling rate. Otherwise, communication 
errors will occur. If PC and Modbus slave devices are connected by a long-distance 
network, then there might be chances that scan time gets increased. So check this and set 
sampling-rate more than scan time. Also, the user can set time out settings to generate 
Communication failure errors. Maximum time out settings possible is 60 sec. For example, 
scan time is adjusted and time out setting = 30 sec. This means, if scan time is more than 
the sampling rate for more than 30 sec, then communication errors will be generated. 
 

4. Format 
The Format menu will allow the user to configure the date-time format and set the name for 
the software on the PC. 
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5. Display 
The Display menu will allow the user to configure the display properties for communication 
error, latest event/alarm list, auto page scrolling and screen display for alarm action. 

 
 

Auto-page: 
The Auto page function is to rotate pages at a set time interval. If this option is enabled and 
time is set, then, display pages in Real-Time Viewer will be rotated cyclically as per the set 
time 
Action: Enable, Disable options are available 
Interval: This is the time interval and max. 60 sec. is possible 
 

6. Print Auto-output 
The Print auto-output menu will allow the user to configure to do the automatic printing of 
historical data from the PC in the pre-defined interval. 
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7. User Manage 
The User Manage menu will allow the user to configure the user security for the project. 
The user can set the password and auto-logout time. 
 

Disable: The security function will be disabled. 
Set Password: Set password only for user security. 
User Security Level: The user can set the password and auto-logout time for security. 
 

 
 

8. The display of AI serial for IO modules 
This is applicable only for the IO module. If the IO module is connected with the real-time 
viewer then this option will allow the software to check the input status of the IO module 
and display according to the selection in this tab. 
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9. Auto start project 
This tab will allow the user to configure the last project to be started when the software 
started. 
 

 

6.2.3.3.2 Bank Configuration 

 There are four banks are available in real-time viewer configuration to configure for the devices to connect 
with the software. All four banks will utilize different communication ports for communication. Ethernet and 
serial communication ports can be used for communication.  

1. Ethernet Bank Configuration 
The Ethernet port can be configured with port no as 502 and protocol as Modbus_TCP 

 
 

2. RS232/RS485 Bank Configuration 
The serial RS232 or RS485 ports can be configured with Protocol as Modbus_RS232 and 
other communication parameters such as com port no, Baud Rate, Parity, Data Bits and 
Stop Bits as per the connection. 
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Note: It is possible to connect more than one device with the software with a different mode of 
connection. For example, one device can be connected via Ethernet and another device can be 
connected via RS485 or RS232. 

6.2.3.3.3 Channel Configuration 

 The channels are auto-configured with all the configured tags from the recorder by the software. The 

configured tags channels can be viewed by selecting the channel configuration icon  in the real-time 
configuration. It will display the configured device and channel information. 

 
 
 The channel configuration can be modified or deleted by selecting Modify or Delete options. There are 
additional channels can be added by selecting Add option in the software. The available channels are as 
below. 

1. Recorder Channels from Recorder 
2. Controller Channels from Controller 
3. IO Module Channel from IO Modules 
4. Math channels for a Math operation 
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5. Linear Channels for 3rd party Modbus slave devices to connect via Modbus protocol. 
 

 
 

6. Simulate Channels to simulate the input signals by the software 
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All the channel configurations are similar to recorder channel configuration. Every channel can be 
configured with 5 different types of events or alarms similar to the recorder and each event can be 
configured with two jobs.  

Device Type: Display channel source 
Bank: Display current Bank number 
Tag Name: It is to define the name for each channel in a maximum of 9 characters 
Auto-Update: If you wish to modify Tag name and modify the configuration, deselect it 
Use Gateway-Device Node address: It is the address of selected device type 
IP address: Display current gateway IP address 
Log Type: Enable/Disable. Select disable while a specific channel is not required at this time. 

Select enable while a specific channel is required 
Log Speed: It is the logging speed (recording speed) of measured data. Select Log Speed 

column, then choose 1, 2, 5, 10, 15, 20, 30 seconds, 1,2,5,10,15 Minutes, 1 Hour, 2 
Hour. 

Log Method: The method of logging measured data. Select the column, and then choose the Log 
method of Instant, Average, Minimum or Maximum data 

Instant: logging in the last measured data at the sampling interval 
Average: logging in averaged measured data at the sampling interval 
Minimum: logging in minimum measured data at the sampling interval 
Maximum: logging in maximum measured data at the sampling interval 
 

New modifications since V1.50: 
 
The maximum/minimum/average of channels will be calculated according to each log interval. 
 
Trigger: Select various types like “by time” or “by change” or disable 
By Time: Datalog based on Log Speed and Log Method 
By Change: Depends on Tolerance setting. Log speed and Log Method is disabled if this option 

is selected and if this option is selected sampling rate is fixed at 1 sec. This option is 
selected to save memory in PC If data logging is required in set log speed (fixed time 
interval), select Trigger as by timer. If data logging is required only when there is a 
change in process value, then select Trigger as by change. This will save memory 

Tolerance: This is enabled if “by change” is selected at Trigger Type. For example, If tolerance is 
set at 0.5, then if the new process value is more than or less than 0.5, then only the 
new sample will be logged 

Data Byte Type: Choose 2 or 4 or 8 byte 
Range Low: Range low for the specific channel in the selected device, ex: 4.00 mA  
Range High: Range high for the specific channel in the selected device, Ex: 20.00 mA  
Decimal: select one of the options - 0, 1, 2, 3 or 4 
Gain: It is a multiplier to correct the sensor error. The correct value = (the process value + offset) 

x gain 
Offset: It is offset value to correct the sensor error 
Unit: The engineering unit of input 
Sensor: It displays input type automatically as per the type of IO card selected 
Scale Low: Defines the low scale with decimal if necessary. For instance, input 0-10 V, the Scale 

Low can be set up with value 0.00 to be correspondent to low range 0 V. 
Scale High: Defines the high scale with decimal if necessary. For instance input 0-10 V, the Scale 

High can be set up with value 100.00 to be correspondent to high range 10 V. 
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6.2.3.3.4 Event 

The Event is frequently used for Alarm purpose. The event can also be used for digital output 
DO, Timer, Totalizer, Counter or Report. 

Type: There are various types of H, L, HH, LL, R, r or Error to be selected for job or Alarm 
purpose. 

H: High limit. When the process is over a high limit, the alarm or job is actuated. 
L: Low limit. Any the process is lower than the low limit, the alarm or job is actuated 
HH: High high limit, to set up another limit higher than the high limit for double warning. 
LL: Low low limit, to set up another limit lower than the low limit for double warning. 
R: Increasing the rate of change. The job or alarm is actuated when the rate of increasing process 

value is greater than the specified rate time interval. For example, when the Setpoint is set to 
100_1S, if the process is increasing greater than the value 100 in 1 second, then job or alarm 
will be actuated. 

r: Decreasing the rate of change. The job or alarm is actuated when the rate of decreasing 
process value is greater than the specified rate time interval. For example, when the Setpoint is 
set to 50_2S if the process is decreasing greater than the value 50 in 2 seconds, then job or 
alarm is actuated. 

Dev+: It is deviation+ event. This event will be triggered by the positive deviation of the process 
value. The job or alarm is activated when the process value is deviated by the value higher 
than setpoint from the previous process value. 

 
For example,  

Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 51 
Then, job or alarm is activated 

Dev-: It is deviation- event. This event will be triggered by the negative deviation of the process 
value. The job or alarm is activated when the process value is deviated by the value lower 
than setpoint from the previous process value. 

For example, 
Setpoint =10 
At 10.00.01 Hrs, Tag1=40 
At 10.00.02 Hrs, Tag1 = 29 

         Then, job or alarm is activated. 
Error: If there is an error in channel input, then alarm or job is actuated 
Setpoint: To set up the process value for actuating Job1 and /or Job2 
Hysteresis: To avoid job has been activated too often, the option available to set for no reaction 

in 0.1% to 10% of full span (Low Scale to High Scale). 
Job1, Job2: When an event occurs, the task to be performed is called the job. A typical example 

is to trigger sound buzzer in the event of high temperature. Each pen can accept five 
events (or alarms) and each event can create two jobs. Various types of jobs can be 
selected: 
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6.2.3.3.5 Jobs 

 The following jobs are available for configuration to be executed on an event 
No Action: Do nothing 
Log Alarm (Auto Ack): Record alarm with acknowledgement automatically 
Log Alarm: Record alarms 
Log Event: Record events 
Send Email: Send an email if it is configured on an event 
Sound Buzzer: Sound the buzzer on an event 
DO Latch On: Set digital output/relay on, and then select Target let say DO 1. The relay is 

latched when it is activated. Digital Output relays will be shown if the digital output 
IO module is configured and available in the database 

DO Latch Off: Set digital output/relay off, and then select Target say DO 1. The relay is latched 
when it is activated. Digital Output relays will be shown if the digital output IO 
module is configured and available in the database 

DO Process: Set digital output/relay on for process high or low, and then select Target from DO 1 
to DO 6. The relay is not going to be latched when it is activated. Digital Output 
relays will be shown if the digital output IO module is configured and available in 
the database 

Enable Timer: Start the timer, and then select Target from Timer1 to Timer 100 or all Timers 
Disable Timer: Stop the timer, and then select Target from Timer1 to Timer 100 or all Timers 
Preset Totalz: Start the totalizer with a preset value, and then select Target from Tolz 1 to Tolz 

50. It requires configuring totalizer via tools and enabling it to appear totalizer 
number in the jobs after selecting Preset Totalizer 

Reset Totalz: Reset totalizer into zero, and then select Target from Tolz 1 to Tolz 50. It requires 
configuring totalizer and enabling it to appear totalizer number in the jobs after 
selecting Preset Totalizer 

Enable Totalz: Start the totalizer, and then select Target from Tolz 1 to Tolz 50. It requires 
configuring totalizer and enabling it to appear totalizer number in the jobs after 
selecting Preset Totalizer 

Disable Totalz: Stop the totalizer, and then select Target from Tolz 1 to Tolz 50. It requires 
configuring totalizer and enabling it to appear totalizer number in the jobs after 
selecting Preset Totalizer 

Preset Counter: Start the Counter with a preset value, and then select Target from Cont1 to 
Cont50. It requires configuring Counter via tools to appear counter number after 
selection of Preset counter in the jobs 

Reset Counter: Resets the counter into zero, and then select Target from Cont1 to Cont50. 
Inc Counter: Increase the counter, and then select Target from Cont1 to Cont50 
Dec Counter: Decrease the counter, and then select Target from Cont1 to Cont50 
Log Report: Make the report for Counter and Totalizer 
Reset MinMaxAve: In Report function, after logging the MinMaxAve data of AI and Math 

channels for one day for example, then reset historical data in order to log new 
data for the next day 

Log Message: Log customized comments for alarm as messages on an event. A total of 100 
messages available for customer customization 

Print Historical Data: Prints the historical data as per print auto output configuration. 
Print Event List: Prints the event list as per print auto output configuration. 
Print Report List (Min/Max/Ave): Prints the report list as per print auto output configuration. 
Print Snapshot: Prints the snapshot of the screen. 
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Output Historical Data: Output historical data to CSV format as per print auto-output 
configuration. 

Log Report (Instant): Log the report with instant values. 

6.2.3.3.6 Display Page Configuration 

‘The display page configuration will allow the user to configure the display pages as per the requirement. 
The display pages will be auto-configured along with the auto channel configuration. The user can modify 
the channel and pages as per their requirement. There are 200 display pages available in Total with 24 
pens/page. 

Mode: This is for page enable or disable. 
Page Marks: This is the name for the specific page. Ex: Section Kiln. Maximum 38 characters are 

allowed 
Speed: This is the real-time trend display resolution. Select one of the options in 1 sec/dot, 2 

sec/dot, 5 sec/dot, 10 sec/dot, 15 sec/dot, 20 sec/dot, 30 sec/dot, 1 min/dot, 2 min/dot, 5 
min/dot, 10 min/dot, 15 min/dot, 1hour/dot, 2hour/dot,10 min/page, 30 min/page, 1 
hr/page, 2 hrs/page, 4 hrs/page, 8 hrs/page, 12hour/page, day/page and week/page. If 
you wish to see both Real-time and historical combined, then, select say day/page at the 
display. Then, the Real-time trend in screen will be for the last 24 hrs update dynamically 

Direction: Selects the trend direction horizontal or vertical. 
Background: Defines the background colour of Trend mode in black or white 
Pen: Defines a specific channel as a drawing pen, its colour, width, Display Hi and Display Low. 
Channel: Selects a specific analog input AI or Mathematics Math, or selects Disable if a specific 

channel is not required. 
Color: Selects the colour for each pen. 
Width: Selects the width of the trend, 1-thin, 2-medium, 3-wide. 
Low: Defines the low scale for a pen on the display. 
High: Defines the high scale for a pen on the display. 
Forward / backward button: It is to navigate to next/earlier 8 sets of pens for display 

configuration 
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6.2.3.3.7 Tools Configuration 

 The real-time viewer has Timers, counters, Totalizers as tools for the user to use as per the application 
requirement.  

1. Timers 
 Maximum 100 timers available for configuration  

Type: Countdown, Repeat Countdown, Daily, Weekly or Monthly. 
Countdown: Defines the interval of time, e.g. days, hours, minutes and seconds. (Not Real-Time 
clock) 
Repeat Countdown: Repeats the previous countdown. 
Daily, Weekly or Monthly: The timer works in the selected interval of Real-Time clock  
Action: Disables or enables the timer. 

         Job1, Job2: various jobs as described in jobs for each timer. 

 
 

2. Counters 
Maximum 50 counters are available. 
Name: Defines the name of the counter. 
Desc: Defines the description for a specific counter on the display. 
Unit: Defines the unit of counter 
Preset: Defines the preset value for the counter. The counter starts from a preset value. 
Event: Defines the type, setpoint, Job1 or Job2. 
Type: Select one of three options: None, Process Hi, Process Low 
Setpoint: Defines the setpoint of process value to trigger the counter. 

        Job1, Job2: various jobs as described in jobs for each counter 
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3. Totalizers 

Maximum 50 Totalizers are available. 
Name: Defines the name of the totalizer. 
Desc: Defines the description for a specific totalizer on the display. 
Source: Select a specific analog input or Math input to be used for totalizing. 
Action: Disables or enables the totalizer. 
Decimal: Defines the decimal point for the totalizer. 
Period: Selects second, minute or hour used for the totalizer. 
Unit: Defines the unit of totalizing 
Preset: Defines the preset value for the totalizer. The totalizer starts from a preset value. 
Low Cut: If Source channel has below this setting, then the value is skipped from Totalizing 
Event: Defines the type, setpoint, Job1 or Job2. 
Type: Select one of three options: None, Process Hi, Process Low 
Setpoint: Defines the setpoint of process value to trigger the totalizer. 

        Job1, Job2: various jobs as described in jobs for each totalizer. 
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6.2.3.3.8 Comments 

 There are 100 comments are available to customize the alarm messages. The user can select one 
comment from this list when to log message or send Email jobs are configured. Each comment can accept a 
maximum of 50 characters. 

 
  

6.2.3.3.9 Auto Configuration 

 The Auto configuration will automatically configure the tags from the recorder, IO Module and controllers. 
This will simplify the project setup procedure. 
Device type: Select Recorder (PR) for the addition of Recorder into the network 
Bank: Select bank from 1 to 4 as per bank configuration 
Auto-update: Select if it is required to acquire a database of Recorders and give tag name for the channels 
automatically 
IP Address: IP address of the Recorder. After Entering the IP address press ‘+’ to add to the IP List.   
IP List: IP List of the Recorders. If any recorder needs to be removed from the list then select the IP 

address from the list then press’-‘ to remove the IP from the list. 
Use Converter: Device Node Address: If the device is connected to PC via PC-E converter then select this 

option and enter the node address of the device. 
From: Start address of the device in the RS485 network.  
To: End address of the device in the RS485 network. This is not applicable for Recorders. 
 Click on “OK” to add all the Recorders into network configuration  
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6.2.3.4 Create a New Project 

 To create a new project follow the below steps. 

1. Click the icon  or select New from File Menu.  
2. Set a name for the project 
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3. The Software requests the user for auto-configuration. Press No to configure the 
communication Banks. 

 

4. Click Bank icon  to configure communication bank. 
 

 
 

5. There are 4 different banks are available for the user to configure. It will allow the software to 
read the data from different communication networks like RS232, RS485, and Ethernet.  
5.1. If the device is connected to PC via Ethernet port then configure the bank with Protocol 

as Modbus_TCP and port no as 502. 

 
 

5.2. If the device is connected to PC via RS232 or RS485 port then configure the bank with 
Protocol as Modbus_RS232 and other communication parameters such as com port no, 
Baud Rate, Parity, Data Bits and Stop Bits as per the connection. 
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5.3. After configuring the banks close the configuration viewer and restart the program. 

 

6. Click the icon  or select New from File Menu.  
7. Set a name for the project  

 

 
 

8. The Software requests the user for auto-configuration. Press yes to configure the tags of the 
device automatically by the software. 
 

 
 

9. Add the device to the project as per the connection. 
9.1. Select Recorder (PR) as a device type to read the data from the PR series Recorder. 
9.2. Select the Bank as per the connection and select the checkbox of Auto-update Tag 

contents to update the tags automatically. 
9.3. Configure the log speed and log method 
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9.4. Enter the IP address and press  key to add the device to the project.  It there are 

any existing devices in the list and needs to be removed then select the IP address and 

press  key to remove. 

 

 
 

9.5. If the device is connected via Ethernet to RS485 converter PC-E then select the 
checkbox use converter: Device Node Address and enter the node address of the 
device. If multiple devices are connected via PC-E Converter then select the Set node 
range checkbox and enter the starting and end node addresses. 

9.6. Press OK to establish the communication and auto-update the tags from the recorder. 
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9.7. If there is more than one device is added to the project then the tag configuration of all 
the devices will be listed as below. 
 

 
 

 
 

10. Close the Real-time configuration viewer to update the tag contents and logging the data 

from the configured devices to PC. The configuration Viewer can be closed by pressing the 

X key on the right side top or  key. 
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11. Press yes to apply the new settings to the project. 
 

 
 

12. If the USB Licence key is not plugged to the USB port of the PC then the Software will show 
the warning message and start the demo mode. The software will stop working after the 
demo period. 

 
 

13. Press OK to start in demo mode. 
14. If the USB Licence key is plugged into the USB Port of the PC then the software will start 

reading the data from the devices and log the data to the PC. 
 

 

6.2.3.5 Open an Existing Project 

 To open an existing project the following procedures to be followed. 

1. Click the icon  or select Open from File Menu.  
2. The software will list the projects from the default project path for the user to select. 
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3. Select the project and click Open to open the project. 
4. If the USB Licence key is not plugged to the USB port of the PC then the Software will show 

the warning message and start the demo mode. The software will stop working after the 
demo period. 

 
 

5. Press OK to start in demo mode. 
6. If the USB Licence key is plugged into the USB Port of the PC then the software will start 

reading the data from the devices and log the data to the PC. 
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6.2.3.6 Add a Device to the Existing Device 

 It is possible to add a device to the existing project and log the data. For adding the device to the existing 
project follow the procedure as follows. 

1. Open the project by using the Open project option as explained above. 

2. Go to Configuration by using Configuration data in the View menu or  icon on the 
Toolbar. 

 
 

3. Click Add and configure the device information to add an additional device to the project. 
 

 
 

4. Now the real-time configuration will update the tags with new device information. 
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5. Close the Real-time Configuration Viewer to update the project with the new device. 
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6.2.3.7 PR-DAQ RS485 Communication 

 The recorder can be connected to real-time viewer software using RS232 or RS485 port of recorder and PC 
by following the below procedure. 

1. Save the PR Configuration to the SD card or USB Disk depends on the selection of External 
Storage in Instrument Menu. 

2. Press the Save Button on the Configuration page to  Save the PR  Configuration  to the SD card or 
USB Disk 

 
 

3. Remove SD card or USB Disk from PR 
4. Connect the SD Card or USB Disk to PC. 
5. Open Real-time Viewer in DAQ Software 
6. Set the Bank and PR Communication Parameter properly for RS485 Communication.  
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7. Create a new project 
8. Select Device Type as PR and select the Bank related to RS485 setting 

 

 
 

9. Select the path of the SD card or USB Disk where Configuration was saved from PR 
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10. DAQ will import the data from the configuration file and start collecting real-time data from the 
Recorder. 
 

 
 

11. Close the Real-time configuration viewer to update the tag contents and logging the data from the 

configured devices to PC. The configuration Viewer can be closed by pressing the X key on the 

right side top or  key. 

 

 
 
12. Press yes to apply the new settings to the project. 
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13. If the USB Licence key is not plugged to the USB port of the PC then the Software will show the 

warning message and start the demo mode. The software will stop working after the demo period. 

 

 
 
14. Press OK to start in demo mode. 
15. If the USB Licence key is plugged into the USB Port of the PC then the software will start reading 

the data from the devices and log the data to the PC. 
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6.2.3.8 PR-DAQ Ethernet Communication 

 The recorder can be connected to real-time viewer software using the Ethernet port of recorder and PC by 
following the below procedure. 

1. Open Real-time Viewer in DAQ Software 
2. Set the Bank and PR Communication Parameter properly for Ethernet Communication.  
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3. Create a new project 
4. Select Device Type as PR and select the Bank related to Ethernet setting. Enter the IP address and 

press  key to add the device to the project.  It there are any existing devices in the list and needs 

to be removed then select the IP address and press  key to remove. 
 

 
 

5. If the device is connected via Ethernet to RS485 converter PC-E then select the checkbox use 
converter: Device Node Address and enter the node address of the device. If multiple devices are 
connected via PC-E Converter then select the Set node range checkbox and enter the starting and 
end node addresses. 

6. Press OK to establish the communication and auto-update the tags from the recorder. 
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7. If there is more than one device is added to the project then the tag configuration of all the devices 
will be listed as below. 

 
 

8. Close the Real-time configuration viewer to update the tag contents and logging the data from the 

configured devices to PC. The configuration Viewer can be closed by pressing the X key on the 

right side top or  key. 

 

 
 
9. Press yes to apply the new settings to the project. 
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10. If the USB Licence key is not plugged to the USB port of the PC then the Software will show the 
warning message and start the demo mode. The software will stop working after the demo period. 

 

 
 

11. Press OK to start in demo mode. 
12. If the USB Licence key is plugged into the USB Port of the PC then the software will start reading 

the data from the devices and log the data to the PC. 
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6.2.4 Dynamic Data Exchange (DDE) 

 Dynamic Data Exchange (DDE) is a standard inter-application communication protocol built into Microsoft 
Windows operating systems and supported by many applications that run under Windows. DDE takes data 
from one application and gives it to another application. It allows Windows programs that support DDE to 
exchange data between themselves. 
 Data from DAQ software can be exchanged with Excel on the DDE link. After completion of all network 
configuration (adding of all Modbus slaves), then open Data acquisition studio software – Real-time viewer.  
Open the existing project or create a project then go to File Menu in Real-time Viewer then select Create 
DDE Link in Excel. 
 

 
 
 Specify the path and file name as follows. By default, the file name will start with DDE and the project name 
with underscore. Save the file name in PC at the selected path as above to proceed further. 
 

 
 

 For example, if Desktop is selected in the path, then excel file should be available in Desktop. If the MS 
Office is not installed on the PC, then you cannot open the excel file created in the above procedure. Please 
contact your system administrator to install MS office software in the PC. Now try to open the file from 
Desktop created for using DDE application with the recorder through Real-time viewer Software. 
 

 
 

 Click on update to activate DDE between DAQ software and Excel application. If the DDE is successful, 
then real-time data of the channels should be updated in the excel file as shown in the sample screen. 
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 DDE expression format to get real-time data from the Real-time Viewer software is as follows. 
 
=RealTime_Viewer|TagService!_TagN 
Where N = 1,2,3….. 
Application = RealTime_Viewer 
Topic = Tag Service 
Tag name = _Tag1 (Please observe underscore before the tag number) 
It is possible to exchange data related to AI, DI, DO, Counters and Totalizers between 
DAQ software and third-party applications running under Windows operating systems via DDE. 

6.2.4.1 Procedure to Find the Tag Number for the Tag Name to Use in DDE Applications 

 Create a DDE link from Real-time viewer. 
 Open Excel file. Three columns appear in the excel file as Name, Unit and Value as shown in the 

Excel file. 
 Name: This is tag name actually defined in the channel configuration 
 Unit: This is unit for the tag name defined in the channel configuration 
 Value: This is the specific cell where the process value for the tag will appear in real-time. 

 To find the DDE format for any tag in channel configuration, for a specific tag, double click at 
“Value” column for the corresponding tag defined at Name. For example, For Name= AI1 is at 
R2C1, double click at cell R2C3 to see DDE format for AI1. Click on Esc button at the keyboard to 
see process value at the cell from displaying DDE format. 
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 If any “Error” appears in any cell at excel, possible reasons are no data available at the selected 

tag. Check the channel configuration and make sure value is available 
 If any “NAME” text appears in the excel file, it indicates that particular tag is not configured 

properly. Tag name may not available at DAQ software. 
Note: 
      If Excel file is not opening from the selected path, then check the following  

 RAM size in the PC is very less. Restart the computer and then create the DDE link once 
again and open the Excel file. 

 Increase virtual memory in the PC. Please contact the system administrator to check the 
virtual memory settings at the PC. 

         My computer-properties-advanced-performance settings –advanced virtual memory. 

6.2.4.2 DDE with 3rd Party Applications 

Once the data is available at Excel at a particular cell, then data can be exchanged with the 3rd 
party applications like PLC, SCADA, and Visual Basic etc. If data is to be exchanged with PLC, 
then PLC programmer can write Visual basic macro in Excel from the following link 

Excel – Tools – macro 
For the source code examples, PLC programmer may check the PLC manuals for DDE sample 
macros. It is also possible to exchange data from recorder to SCADA applications through DDE. 

6.2.5 Configuration of Recorder 

 There are three ways to configure the recorder. They are listed as below. 
1. On the Recorder 
2. Software via Ethernet port 
3. Removable media 

6.2.5.1 On the Recorder 

 It is possible to configure the recorder directly on the device using the touch screen interface. Press    
(Menu), then More and then Config soft-key to enter Configuration mode. The user can directly configure 
all the parameters on this page. Refer to chapter 5 for more details. 
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6.2.5.2 Software via Ethernet Port 

The below steps to be followed to configure via software using the Ethernet port of the recorder. 
1. Connect Recorder to PC via cross over or straight Ethernet cable 
2. Check the IP address of PC. Make sure to set the IP address of Recorder in the same 

domain as PC 
For example, the IP address of PC: 192.168.0.200 
 The IP address of Recorder: 192.168.0.11 

3. Use “Ping” from DOS command prompt and check the communication quality. If there is no 
response, check the cable or IP address configuration of PC or IP address configuration of 
the recorder 
 

 
 

4. Double click the historical viewer icon at desktop and follow on-screen instructions to create 
a new project. 

 

5. Click the icon  or select New from File Menu.  
6. The software will prompt the user to select the device type. Select Recorder (PR) and click 

OK to create a new project. 
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7. The Software will prompt the user to configure the project name and the path for the 
recorder. 

 
 

8. Click “OK”. 

 
 

9. Click “Yes”.  It will open the Recorder configuration screen 

 

 
 

Note: The configuration screen is the same as the screen available directly in the recorder. Refer to chapter 
5 for more details. 

10. Do the required changes in the configuration.  Click at Send configuration icon  
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11. Now the recorder configuration has been updated with the new configuration. 

6.2.5.3 Removable Media 

 The recorder can be configured via removable media by following the steps given below. 
1. In recorder, insert an empty SD card or USB disk. 
2. In the recorder, Press   (Menu), then More and then Config soft-key to enter 

Configuration mode. In the configuration, menu press Save to save the configuration to the 
removable media. The removable media can be selected by external storage option in the 
Instrument menu. The default selection for external storage is SD Card.  

 

 
 

 
 

3. Press “Yes” to save the configuration to storage media.  
4. Remove the removable media from the recorder. Insert into PC 
5. Check the contents of storage media. It should have the following files. 
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6. Double click the historical viewer icon at desktop and follow on-screen instructions to create 
a new project. 

 

 
 

7. Select PR Recorder. Click “OK” 

 
8. Select “Storage Media”.  Then enter the path of the Recorder files in the USB stick or SD 

card.  Click “OK” 

 
9. Click “Yes”.  It will open the Recorder configuration screen 

 

 
 

Note: The configuration screen is the same as the screen available directly in the recorder. Refer to chapter 
5 for more details. 
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10. Do the required changes in the configuration.  Click at Send configuration icon  

 
 

11. In the recorder, Press (Menu), then More and then Config soft-key to enter 
Configuration mode. In the configuration menu Press “Load”  

 

 
 

 
12. Press “OK”  

 

 
13. Press “Yes”  
14. Now the recorder configuration has been updated with the new configuration. 
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6.3 Custom Screen Editing Software - Panel Studio 

 Using this software the user can develop custom screens for custom display same as HMI and SCADA.  All 
the graphics developed on the screens can also be configured for animations. 
 

 
 

 
  
Use this editing software to develop custom screens on the Recorder.  It is mainly used for application 
development for operator interface in industrial applications such as display real-time value of process 
parameters like temperature, flow, pressure, visualize process data in meaningful ways such as bar graphs, 
dial, meter, level, digital LED, animation like visibility control, blinking, horizontal movement, vertical 
movement etc. 
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6.3.1 Panel Studio Software Installation 

 The panel studio Software will install the following components on the PC. 
 Microsoft installer V3.1 
 Microsoft.Net framework V3.5 SP1 
 Panel Studio Custom Screen Editing Software  
 OPC server (Only Required for HMI) 
 Demo projects (Only Required for HMI) 
 Historical viewer 
 HMI Remote viewer (Only Required for HMI) 

6.3.1.1 System Requirements 

Item Minimum Requirements 

System IBM PC compatible computer with Intel Pentium IV or above 

Operating System Windows XP or above 

Memory 1 GB 

Hard Disk 50 GB Free Space on the hard disk 

Communication Ports Ethernet Port 

Others USB Port  

Licence  Optional USB Licence Key for Symbol Factory 

6.3.1.2 Software Installation 

 The Panel Studio software can be installed by following the below procedure. 
1. Download the Panel Studio software form the manufacturer’s website. 
2. Install latest dot Net software from Microsoft website  
3. Install the software by double-clicking the setupwizard.exe from Panel Studio folder. 

 

 
 

4. Select the required Software needs to be installed on the PC and press Install key to continue the 
installation. 
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5. Follow onscreen instructions to complete the installation. Once the installation is completed the 
system will show the installation complete message. 
 

 
 

6. After installation is successful, the shortcut for Panel Studio, Historical Viewer and HMI Remote 
Viewer will be created on the desktop.  
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6.3.1.3 Uninstallation of Software 

 The software can be uninstalled by selecting the uninstall option on the control panel Add or Remove 
Programs. 

6.3.2 Start and Exit  

 The Panel Studio program can be started by using the shortcut on the desktop or selecting the 
program Panel Studio from the Start menu.  
 The program can be exit by simply closing the program X symbol on the top right corner of the screen. 
 

6.3.3 Project status 

 During design time, it is possible to check the current status of resources being used 
 

 
 

 
 

 “Image” means symbols used from graphics and symbol factory. These symbols are also considered 
objects, so, if you add symbols, it also updates the quantity in objects. 
For example, if the user adds 2 symbols and one rectangle object. Then, Images = 2, Objects = 3 
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6.3.4 Create a New Project 

 Open Panel Studio Software and select create a new project to create a new project. 
 

 
 

 
 

Name: It is the Name of the Project. For example, CustomScreen_PR 
Location: It is the path for project file storage.  
Model: Select the Recorder Model No from the list. For ex: PR20                                            
Width: It is pixels, resolution in dots available on X-axis 
Height: It is pixels, resolution in dots available on Y-axis 
Author: Write author name/system integrator name for future reference 
Version: It is for version management 
Password: It is for user security of the project. The Project can be protected by assigning a 

password to open the project.  
Comments: It is for project management 

 
 After entering all the above details, click “OK” to create a new project. 
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6.3.5 Menu Bar  

 The menu bar has below menus. 
 

 

6.3.5.1 File 

 
 
 

1. New Project: To create a new project 
2. Open Project: To open an existing project 
3. Close Project: To close the present project 
4. Save Project: To save Project in the default path  
5. Save Project As: Saves project in a selected path other than default path specified while 

creating new project settings. 
6. Screen: Create a new screen on the project. 
7. Upload: To upload project from Recorder back to PC  
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8. HMI Update: This function will allow the user to update the clock, firmware, language on the 
HMI. This function is available only for HMI. 

9. Environment: This will allow the user to modify the project environment configurations. 
10. Recently: It is to open recently opened projects 
11. Exit: To exit from the current project 

6.3.5.1.1 Environment 

 

6.3.5.1.1.1 General 

 
1. Language: Select the Language for the project environment. 20 languages are supported by 

Panel Studio Software including English, Simplified Chinese, Traditional Chinese, 
Japanese, French, German, Italian, Polish, Spanish, Portuguese, Brazil Portuguese, 
Russian, Thai, Czech, Danish, Dutch, Korean, Swedish, Turkish and Greek. 

2. Environment font: Select the font required for the design-time environment. Example: Menu, 
Tool Box, Project explorer, function editor etc. 

3. Project Path: Location to the storage of project files. Default project path: C:\Program 
Files\Panel Studio\Demo Project 

4. Graphic Path: Location of default basic Symbols. Default graphics path: C:\Program 
Files\Panel Studio\Panel Studio\Basic Symbols 

5. Security: This is to protect opening the software in specific Personal computer (Not for the 
project). Once the password is entered, it is required to enter the password 
correctly to open the software for the current session. This is useful in a factory 
environment to prevent unauthorized users to open the software. 

Note: If the user needs a password for a specific project, click “Settings” in the project explorer, select 
“General” tab, and then enter the Password. 

 In general, it is preferred to back up project files regularly in other standard storage media like CD, 
DVD etc. It is recommended to store project files in separate folders on the D: drive instead of C: drive. 
Developers may make a hard disk partition and save all project files in drives other than the location of the 
operating system in the event that if there are problems with Operating system, it is still possible to retrieve 
project files.  
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6.3.5.1.2 Download and Upload  

 Please refer to the section “Project tools” for more detailed information. 

6.3.5.1.3 Snap and Grid 

 Used to define grid behaviour in the design-time environment.  
 

 
1. Grid: Select this option and select “Show grid” if grids are to appear on the screen at 

design time.  
2. Snap lines: Select this option if grids are not required to appear in the screen at 

design time.  
3. Snap: Select this option if component coordinates should within grids all the time. 

6.3.5.1.4 Object Default Setting 

 Define default font size, Fill color, Back color and Fore color for the properties of most of the objects (label, 
Checkbox, Rectangle, Ellipse, Pie, Table, Dial, Level, Meter, Slider, Thermometer etc.). 
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6.3.5.2 Edit 

 

6.3.5.3 Format 

 

 
 

1. Align:  Used to align selected components, objects etc. for adjusting their position precisely in the 
screen layout. Available options for selection are Center, Right, Left, Tops, middle & Bottom. 

  Example: Align two Labels to the left in Recorder screen. 
Assume both labels are created in Screen1. Select both labels first using the mouse.  Alternatively, 
select the first label by left-clicking the mouse, then press “Ctrl” on the keyboard and select the 
second label by left-clicking the mouse. Now, in Menu, click “Format”, then select “Align”, then 
select “Left”.  

 
Before Align adjustment  

 

 
After Left Align adjustment 
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2. Make the Same Size: To adjust different objects to the same Width, Height, Both width and height, 
Size to grid etc. 

 Example: Adjust five buttons to the same size i.e., height and width. 
Create five buttons first. Then, select all these buttons via Mouse, then click “Format”, then select 
“Make the same size”, then select “Both” 

 
Before size adjustment 
 

 
 
After Same Size adjustment 
 

 
 

3. Horizontal spacing: It allows adjustment of horizontal spacing between any objects to make 
Equal/Increase/Decrease/Remove. 

For example, there are 3 buttons located at the bottom area of a page. Spaces between these buttons 
are not equal and the screen does not look good. Select all the 3 buttons via Mouse or using “Ctrl” on the 
keyboard along with the mouse.  Then in the Menu bar, click “Format”, then select “Horizontal spacing”, 
then select “Make equal”. Now, space between all these buttons has an equal distance. 

 
Before Spacing adjustment 
 

 
 
 
After Horizontal spacing adjustment 
 

 
 

4. Vertical spacing: It allows adjustment of vertical spacing between any objects to make 
Equal/Increase/Decrease/Remove 

 
Before Spacing adjustment 
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After vertical spacing adjustment 
 

 
 

5. Center in Page: It allows adjustment objects to the centre of the page horizontally and vertically. 
For example, there are 3 buttons located on the screen. You wish to locate them in the centre of the page 
horizontally. Select these buttons and apply this feature to adjust buttons as per requirement. 

Before Center adjustment    

 
 

After Center adjustment    

 
6. Order 

 Bring to back: Moves objects to the back  
 Bring to Front: Moves objects to the front 

For example, There is a Rectangle box and a label with different colours. If you wish to keep label text 
in front of the Rectangle, select the Rectangle, choose the option, “Bring to Back” and for the label, 
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choose the option “Bring to Front”, such that both are visible at the same time allowing overlapping of 
two objects for clear display. 

 
7. Lock Controls: It is to lock control for further development. Apply this for a second time to unlock 

the control. 

6.3.5.4 View 

 
 
Select the required items to view in window layout. 

1. Properties 
  If “properties” is checked as shown above, in the right side bottom of the screen layout, the 

properties box will appear showing all the properties for the component/object that is selected. 
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In above example, a rectangle is drawn, and once it is selected, the right side bottom corner will show 
all the properties for this specific rectangle if “properties” is checked in the View dropdown menu. It is 
possible to modify the properties of the rectangle from the property grid.  Alternatively, if you double 
click on the rectangle, you will see a pop-up window where you can edit properties.  

 
2. Output 

  If the output is selected in the View drop-down menu, this window appears just below the 
screen working area. This window will display any errors that appear during the compilation of 
the project. 

In Menu, click “Tools”, then “Build”, or alternatively, on the “standard” bar, click the icon  to prepare 
the build for the application. The project will then compile.  A summary is shown in the output window 
as shown below. 

 

 
 

3. Zoom 
  It is used to Zoom the current screen to various %, and it is useful during screen editing, 

particularly if the screen size of the PC screen is small. If 200% is used and if the PC screen 
size is small, then horizontal and vertical slider will appear automatically in screen to navigate 
to other areas of the screen easily. 

4. Fullscreen 
  It is to display full screen.  After selection, the screen layout will be as shown below. To go 

back, in the menu, click at “View” and then “Fullscreen” again  
5. Reset window layout 

  Used to display the default screen layout showing the screen working area, toolbox, project 
explorer, output window etc.  

   
Ex: If the user deselects the “project explorer” in the View drop-down menu, then it will not show the Project 
Explorer at the right side of the window layout. In this case, the user may select Project explorer again in the 
View drop-down menu. Alternatively, in Menu, click “View”, then “Reset Window Layout”, then it will reset all 
the view selections and show default window layout. 
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6.3.5.5 Objects 

 

 
 
 More details about Basic objects, Enhanced objects, Symbol factory and Graphics are explained in section 
“Tool Box” 
 

 

 
 

 
 

 If you would like to increase font size in the Menu bar, then, in the menu, click File, then click 
“Environment” and then set font settings. 
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6.3.5.6 Project  

 

 
 Above details are explained at section “Project Tools” 

6.3.6 Standard Bar  

 The standard bar has below tools. 
 

 

 New Project 

 Open Project 

 Save Project 

 Undo 

  Redo 

 Cut 

 Copy 

 Paste 

 Delete 

 Search 

 Show Grid 

 Align to Grid 

 Build 

 Offline Simulator 

 Online Simulator 

 Stop simulation 

 Download 

  Zoom Size 

 Full screen 
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6.3.7 Format Bar  

 The Format bar has below tools. 
 

 

 Bring to Front     

 Bring to Back    

 Lock the control 

 Group 

 Ungroup 

 Align left 

 Align centre 

 Align right 

 Align Top 

 Align bottom  

 Align middle  

 Make the same width 

 Make the same height 

 Make the same size 

 Size to grid 

 Make horizontal spacing equal  

 Increase horizontal spacing 

 Decrease horizontal spacing  

 Remove horizontal spacing 

 Make vertical spacing equal 

 Increase vertical spacing 

 Decrease vertical spacing   

 Remove vertical spacing 

 Center vertically  

 Center Horizontally 
 

6.3.8 Project Explorer 

 The project explorer has the below options on the right side of the screen in software. 
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6.3.8.1 Screen 

 This is to add a new screen to the project. It is possible to set screen into the following types 
1. Page 
2. Template 
3. Popup 

When a new project is created, screen1 (Page type) is created by default. It is not possible to change 
screen1 to either template or popup. Screen1 (start page) should be “Page” type only. 

 
How to add a new page 
In Project Explorer, select “Screen1”, then right click your mouse.  It will show the screen below. Click 
“Add”, and Screen2 will be created and will appear as shown below. 

 

 
 

 
 

Now, Select Screen1, then check its properties. For example, It is possible to change the background 
colour of a screen from the page properties 

 

 
 

 
 

Right-click mouse keeping the pointer on any page, then, user can edit screen properties via the 
wizard. 
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It is possible either to open, delete or rename a screen. Select the appropriate screen in the project 
explorer, then “Right-click” the mouse to show the above Screen dialogue.  
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Note: These screen display names are the same as those available at project explorer. These are different 
from the title bar (Text) defined for the screen.  
 
 

 Properties 
 Back Color: Defines the background colour of a component. 

 Events 
Activated: Defines tasks to be executed before opening a Screen. 
Deactivated: Defines tasks to be executed before closing a Screen. 

 Screen Style 
Page No: Displays the current page number. 
Screen Height: Defines/Displays the current screen height. 
Screen Width: Define/Display current screen width. 

 Template: Select the Template page for this screen. 
 Type: Defines the type of screen. Available options include Template, Page and Popup. 
 

6.3.9 Toolbox 

 These can be accessed from the menu bar also from objects.  

 

 

6.3.9.1 Basic Objects 

 It is to draw simple shapes on the screen, data entry, data display, alarms view etc.  
 

 
 
 There are three ways to insert the above objects into the screen. 
i) Drag and drop. 
ii) Select the object, say a line, then use the mouse to draw a line on the screen. 
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iii) Select the object, then double click (mouse left click) quickly by keeping the pointer on the selected 
object.  Then, the object will appear on the screen.  For example, select “line” and Double click it 3 
times by keep mouse pointer online, you can see 3 lines appear on the screen. 

After inserting an object to screen, it is possible to edit its properties either by Graphical User Interface (GUI) 
dialogue or editing properties directly in the property grid.  
 
How to edit via GUI dialogue 
Insert any object in a screen.  Select the object, right-click the mouse, and then select properties. Or  
Insert any object in a screen. Double click on the Object.  A GUI dialogue will open automatically. 

 
 

How to edit via the Property grid 
 By default, the property grid will appear at the bottom-right area of the screen editor.  If it is not available, 
click on the “View” drop-down menu, then click “Reset Window Layout”.  The property grid will appear at the 
bottom right side of the screen editor just below the Project Explorer. 
 

 
 

Property grid 
 

 

 Before placing any objects in screens, check the section File- Environment and set default font size, 
fill color, fore color and back color for the objects as shown below. 
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6.3.9.1.1 Common Properties 

Appearance 
 Back Color: Sets the background colour of the component.  
 Fore Color: Sets the Fore colour of the component. 
 Bevel:  Used to set the border including inner border, outer border and style of the border. 
 Inner Border: True/False 
 Outer Border: True/False 
Style 
 9 styles are available. They are None, Flat, Single, Double, Raised, Lowered, Double Raised, Double 
Lowered, Frame Raised, and Frame Lowered 

 
Behaviour 

Visible: True/False, determines whether component/control is visible or hidden 
Enable: This is for event control. If linked with a Digital tag, when the tag value =1 in run time, 
events configured for the object will be executed. If the tag value = 0, events will be not executed  

 
Data  

Tag Binding: Select the Tag of the desired process value 
Write design-time value: If selected, it writes the value available at “Text” in design time and in 
run time replacing the default value defined at Tag data base. 
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Design 
 Name: It is the name of the component.  
 Security level: Define the security level for the component. 
 Locked: True/False: It is to Move or Resize the component. 
Layout 
 Dock: Defines which borders of the control are bound to the container. 
 Location: The coordinates of the upper-left corner of the component relative to the upper-left 

corner of the container. Set X and Y position on the screen in pixels. 
 Size: Size of the component in pixels. Set the height and width of the component in pixels. 

 Pointer: It is to deselect the tool selection. 

6.3.9.1.2 Function editor 

This is very useful to select different functions to execute based on operator actions.  During Run time, this 
provides an easy way for an application developer to use a ready-made macro instead of writing scripts.  
Insert a Button into any screen and configure events. The following functions are supported. 
 

 
 
Page Control functions 
 

 
 
Every screen has a screen number.  The pointer will be the screen number for navigation.  
 GotoFirstPage: It is used to navigate from the current screen to the first screen  
 GotoPreviousPage: Used to navigate from the current screen to the previous screen  
 GotoNextPage:  Used to navigate from the current screen to next screen  
 GotoLastPage:  Used to navigate from the current screen to the Last screen  
 GotoPage:  Used to navigate from the current screen to a specific screen by name 
 GotoPageByNumber:  Used to navigate from the current screen to a specific page by number 
 GotoPopUp:  Used to open specific pop up screens by name  
 ClosePopUp:  Used to close pop up screens by name 
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Tag functions 
 

 
 SetValuetoTag:  Writes a value to a tag  
 Example: Set 90 to TagA when the operator presses on a button during run time. 
 

 
 
 AddValuetoTag:  Used to add value to Tag  
 SubtractValuefromTag:  Used to subtract value from Tag  
 CopyTagBtoTagA:  Used to copy TagB value to TagA  
 

 
 
 AddTagBtoTagA:  Used to add TagB to TagA and store result in TagA 
 SubtractTagBfromTagA:  Used to subtract TagB from TagA and store the result in TagA. 
  SwapTagAforTagB:  Used to swap TagB data with TagA 
 CopyStringTagBtoTagA:  Used to copy the string type of TagB to TagA 
 SetStringtoTag:  Used to write a string to a String type Tag 
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 CopyBlockfromTagBtoTagA:  Used to copy a block of tags from TagB to Tag1 
 

 For example Copy 4 continuous tags from Tag5 to a target location starting with Tag1.  Tag5 is 
copied to Tag1, Tag6 is copied to Tag2, and so on. 

 Note: Maximum block size is limited to 80 tags 
 

 
  
 EditValuetoTag:  Used to edit tag value during run time from a keypad. For example, if this 

function is called from the button “clicked” event, then, a keypad will open 
during run time and the user can enter a setpoint.  

 TurnBitOn:  Used to turn on a bit. 
 If a momentary Turn on is required, then in “Clicked” action, select Turn On, then, in “Released” 

action, select “Turn OFF”. 
 TurnBitOFF:  Used to turn off a bit  
 Togglebit:  Used to toggle the bit 
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 If a button is not switching properly at the PLC, then, in the “General” tab, select the “Hold” checkbox 
and enter the hold time. The default value is 50 msec. If required, adjust this to 100 msec. and check again 
if the button is switching properly. 

 
 

 

 If the button is not switching properly at PLC, then, in General, Tab, select “Hold” checkbox and enter 
the hold time. The default value is 50 msec. If required, adjust this to 100 msec. and check again. 
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6.3.9.1.3 Line 

  Line:  An object used to draw a line and do animation in Run time when linked with a Tag.  
 User can edit properties via GUI dialogue or property grid. After drag/drop of the object to a screen, double 
click the object to open the GUI dialogue, or, select the object and directly enter properties via the property 
grid available at the bottom right corner of the screen editor. 

 
General 
Appearance 
 Line Width: Define the Line width 
 Direction: Horizontal or Vertical 
Points 
 Point1: Define X and Y coordinate for the line starting point and they show current position. 
 Point2: Defines the X and Y coordinates for the line endpoint and shows the current position. 
Tag Binding 
 Select a Tag to be linked with this line. This is useful if the animation is required. 
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Animation 
 This is to do animation online in Run Time 
Movement 
 Select “Enable Move” checkbox if movement animation is required during Run time. 
 
 Start Position: Defines X and Y coordinates for the start position when the tag value is at its 

minimum during Run Time. 
 
 End Position: Define X and Y coordinate for end position when the tag value is at its max. 

During the run time. 
The X position indicates movement from Left to Right, this is Horizontal movement.  The Y 
position indicates movement from Top to Bottom, this is Vertical movement. 
 For example: Recorder 7” (High Performance) project, 800 X 480 pixels, Normal 
installation, Horizontal (Left to Right) = 800 pixels, Vertical (Top to Bottom) = 480 pixels 
 Enable move: Selected 
 Start position X = 0, Y = 0 
 End position X = 800, Y = 0 
 Tag Value, From = 0, Tag Value To = 100 
 Now, in Run time, when the Tag value = 0, the line will be at the Top left. When the 
Tag value = 100, the position of the line will be at the Top Right 

Size 
 Select “Enable Size” checkbox to enlarge/decrease the size of the component during Run time. 
 
 Start Size: Defines X and Y coordinates for the starting size when the tag value is at its 

minimum during Run time. 
 End size: Define X and Y coordinate for end size when the tag value is max. Run time. 
 
Tag Value 

Select a Tag to be linked with this line. This is useful if the animation is required to be done on 
the line. 
 

Bands 
 This is to select various bands as part of animation during Run Time 
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Band Count 
 A maximum of 32 bands is available. 
 For example: In the above sample, 

If the Tag value is 0 to 20, the line will be Yellow  
If the Tag value is 21 to 80, then, line colour = Green  
If the Tag value is above 80, line colour = Red 

6.3.9.1.4 Polygon 

 Polygon:  Used to draw a polygon. After finishing the drawing, double left-click the polygon using the 
mouse to complete the Polygon.  It is also possible to link a polygon to a tag and define some user-friendly 
animation to appear during Run time. 
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Animation 
 This is to do animation with a Polygon in Run Time 
 Fill 

Select “Enable Fill” if filling animation is required on a Polygon object during Run time. 
When a tag value changes during Run time, it shows the polygon filling with a defined 
colour inside the Polygon object. It’s like a bar graph where the filling is within the polygon 
shape. 

 Start Fill: Defines a Start value for Fill 
 End Fill: Defines an End value for Fill 
  
 Movement 

Used to define a movement position.  This is the same as previously explained for the Line 
object earlier. 

 Size 
Used to define the amount of size increase/decrease. This is the same as previously 
explained for the Line object earlier. 



 
 

 
 

Page 377 of 550 

Tag Value 
Select a Tag to be linked with the Polygon object. This is useful if the animation is required to be 
done with the Polygon. 

 

 
Band editor 
  A maximum of 32 bands is available.  
 

For example: In the above sample, 
If the Tag value is 0 to 20, Polygon fill colour = Yellow   
If the Tag value is 21 to 80, then, Polygon fill colour = Green  
If the Tag value is above 80, Polygon fill colour = RED 

If required, it is also possible to configure the blink property and set blink colour for any band. 

6.3.9.1.5 Rectangle 

Rectangle:  Used to draw a Rectangle and do animation during Run time when linked with a Tag. 
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Animation Supported: Fill, Movement and Size  
 The above features are the same as explained for Line and Polygon objects 
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Band editor 
   A maximum of 32 bands is available.  
 

For example: In the above sample, 
If the Tag value is 0 to 20, Rectangle fill colour = Yellow   
If the Tag value is 21 to 80, then, Rectangle fill colour = Green  
If the Tag value is above 80, Rectangle fill colour = Red 

If required, it is also possible to configure blink property and set blink colour for any band. 
 

6.3.9.1.6 Ellipse 

Ellipse:  Used to draw an Ellipse or a circle and do animation during Run time when linked with a Tag.  
   

 
 

 
 
Animation Supported: Fill, Movement and Size  
 The above features are the same as explained for Line and Polygon objects. 
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Band editor 
 A maximum of 32 bands is available.  

For example: In above the sample, 
If the Tag value is 0 to 20, Ellipse fill colour = Yellow   
If the Tag value is 21 to 80, then, Ellipse fill colour = Green  
If the Tag value is above 80, Ellipse fill colour = Red 

If required, it is also possible to configure blink property and set blink colour for any band. 
 

6.3.9.1.7 Arc 

 Arc:  Used to draw an Arc and do animation during Run time when linked with a Tag. 
 

 
 
Start Angle: Defines the start angle.    
Sweep Angle: Defines the end angle 
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Supported Animation: Movement and Size 
 

 
 
 

Band editor 
 A maximum of 32 bands is available. Band editor for “Arc” is the same as explained for the “Line” object 
earlier. 
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6.3.9.1.8 Table 

 It is used to draw a table during design time by specifying the number of rows & columns. All rows/columns 
will have equal width and height. It is possible to place labels on rows (Linked with Tags) for displaying 
process values to appear like a tabular column. User can edit properties via the GUI dialogue or Property 
grid as per convenience. After dragging/dropping the object to the screen, double click on the object to open 
GUI dialogue. 
 

 While working with a Table, in page properties, select Snap to Grid = False so that it will be easy to 
place labels/textboxes in required positions easily. 
 

 
 

 Drag and Drop Table from Basic objects to the screen, then double click on Table.  The following screen 
will open. 
 

 
 

Note: Deselect “The same Width” to adjust column width in the Table 
Note: Deselect “Same Height” to adjust Row height in the Table 
 



 
 

 
 

Page 383 of 550 

Property grid 
 

   
 
Properties 
 Back Color: It is the back colour of the table 
 Fore Color: It is the colour for the lines of the table 
 Line Width: It is the width of the lines of the table 
 Columns: Defines the number of columns in the table 
 Rows:  Defines the number of rows in the table 
 Name: The unique name for the table in a specific page 
 Locked:  Used to determine if the table is locked for further moving and resize in design time 

and the user can set this in the property grid. 

6.3.9.1.9 Numeric Up/Down 

 Numeric Up/Down is a Graphical User Interface widget that allows the user to increase or decrease the 
value of a tag by pressing up or down arrows during Run time, or to enter a numeric value directly via a 
keypad. Users can edit properties via GUI dialogue or Property grid for convenience. After drag/drop of a 
numeric up/down object to the screen, double click on the object to open GUI dialogue. 
 Every Numeric Up/Down button should be linked with an Analog Tag. 
 

 

  Except the Up/Down arrow, if a user presses another area of the Numeric Up/Down component in 
the recorder during Run time, a numeric keypad will open. The user can then enter a numeric value directly. 
The numeric keypad will not appear in the PC during Online/Offline simulation, the user can use the 
keyboard directly to enter a numeric value. 
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Increment 
 Select the value to be incremented/ decremented each time when the up/down arrow is pressed during Run 
time.  
 
 
Properties 
 Write design-time value: If selected, it writes value available at “Text” during design time and 

also during run time replacing the default value defined in the Tag 
database. 

 Rounding: Rounds to the nearest value 
 Decimal: Enter the number of decimal points 
 Value:  Current Tag value. It is used to enter a value during design time and to check how value 

is displayed during Run time.    
 Increment: Value to be incremented during Run time after pressing the Up/Down button. 
 Minimum: Defines the minimum value  
 Maximum: Defines the maximum value  
 

 
 
Soft keyboard 
 If enabled, it is possible to control the keypad appearance during run time. For example, if the alignment is 
selected as Middle center, then, when keypad appears in run time, it will be located to Middle center in 
screen 
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Events 
  Defines events to be executed when the operator presses the Up/Down arrow and changes the value 
during Run time. 
 

            

6.3.9.1.10 Digital LED 

 This object is used to view a process value in a digital format. Generally, it is linked with an analog type tag 
(example: an analog input tag at a PLC, which is received as 4-20 mA signals from field transmitters to 
define things like Temperature, Pressure, Flow, Level, Position etc...) 
 

 
 
 For common properties like Back Color, Bevel, etc., please refer section “Common Properties 
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Property grid 
 

 
 
Properties 
 Back Color: Defines background color for the component 
 Inner border: Select if the inner border is required for the component 
 Outer border: Select if the outer border is required for the component 
 Style: Defines border style. Available options are Single, Double, Raised, Lowered, Double 

Raised, Double Lowered, Frame Raised and Frame Lowered 
 Active Color: Defines Active Color of Segment for Digits 
 Inactive Color: Defines the color of inactive segments. In the seven-segment LED display, 

some segments may be active and some other segments may be inactive 
depending on numeric values. 

 Digit Height: Defines the height of digits  
 Digit Width: Define the width of digits  
 Digit Space: Defines the space between digits  
 Segment Space: Defines the space between segment to segment for digits 
 Segment Thickness: Defines the thickness of segments for digits 
 Decimals: Defines the number of decimal points 
 Tag Binding: Selects the Analog Tag of process value  

6.3.9.1.11 Digital Box 

 Digital Box is a Graphical User Interface widget that displays a digital tag value along with four predefined 
labels as attributes for the process value in Run time. 
 

 
 

 
 Digital Boxes are normally used with Analog tags to display process values like Temperature, Pressure, 
and Flow etc.  They also allow 4 different labels as attributes for displaying tag related information.  
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Properties 
 
 Attribute1: attribute to be displayed at Top left side of Digital Box 
 Attribute2: attribute to be displayed at Top Right side of Digital Box 
 Attibute3: attribute to be displayed at Bottom Left side of Digital Box 
 Attibute4: attribute to be displayed at Bottom Right side of Digital Box 
 Attribute font: Define font for the attribute, select type font, and size of font and style of font.  

Styles include Regular, Bold, Italic, Underline, and Strikeout. 
 Back color: Defines background-colour 
 Fore Color: Define fore-colour for the font 
 Decimal: Defines the number of decimal places for the value to be displayed 
 Value font:  Used to adjust the size of the display process value font, select type of font, size of 

font and style of font.  Styles include Regular, Bold, Italic, Underline and Strikeout. 
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6.3.9.1.12 Text box 

 Used to Read/Write Alphanumeric text in Run time. It can be linked with any type of tag.  
 

 
 If the object is linked with String type tag, an alpha-numeric keypad opens during Run time if a user touches 
the object. If the object is linked with an Analog or Digital tag, a numeric keypad opens during Run time if a 
user attempts to touch the object. If a digital tag is used, make sure “decimal” is set to 0. 
 
Alphanumeric keypad 
 

 
Numeric keypad 
 

 
 



 
 

 
 

Page 389 of 550 

 
 
Note: For common properties of all components, please check the beginning of this section. 
 Write design-time value: If selected, it writes the value available at “Text” during design time 

and also during run time replacing the default value defined in the Tag 
database. 

 
 
 Soft keyboard: If enabled, it is possible to control the keypad appearance during run time. For 

example, if “alignment” is selected as the Middle centre, then, when the keypad 
appears during run time, it will be located in the middle-centre of the screen 
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6.3.9.1.13 Label 

 The “Label” object is used to write a simple line of text for user information on the screen. Example: Tag 
name, Pump number display etc. It is also used to display process values (read-only) to operators if linked 
with a Tag. 
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Note: For common properties of all the components, please check the beginning of this section. 
Properties 
 Text: Defines text associated with this component and it should be entered at design time only.  
 
 Text Align: It is for Alignment of text.  Available options include Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom 
Right 

 Text Font: Defines font for the text including the type of font, size of font and style of font. Styles 
include Regular, Bold, Italic, Underline and Strikeout. 

 Tag Binding: Select the Analog Tag of a process value 
 Decimal: Defines the number of decimal points 

6.3.9.1.14 Date and time Label 

 

 
 
 Used to display Date and Time in the screen. 
 

 
 

 If date and time are required in more than one screen, it is better to create a screen and select the 
screen type as “Template”, and then link this template to all other required screens to display Date and 
Time automatically. This is more efficient than keeping Date and Time label in more than one screen 
since it uses less memory. 
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6.3.9.1.15 Button 
 

 
 

 A Button is commonly used to perform an action after the operator presses it with their finger, or by clicking 
using a mouse during Run time.  
 Generally, “Button” is used to turn ON a bit, Turn OFF a bit etc. when used with Digital type tags.  Example: 
Start Pump, Stop pump etc.  
 Three kinds of “Events” are supported for a button. Clicked, Pressed and Released. Several functions are 
supported which can be configured from “Events” and all the functions are covered in the next section 
“Function editor”. 

 
Properties 
 Back Color: Selects Back colour for the object.  Also, it is possible to select a transparent mode if required.  

 

 
 
 Text: Defines the required text to be displayed on the object. It is also possible to enter the multiline text 

from firmware V1.20 onwards 
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 Show select: True/False. If it is selected, then, when the operator presses this button, it will 

show a dotted line just inside the button. When the operator presses another 
button, it automatically shows the selected “show” status to the latest button and 
deselects “select” status for the previous button pressed by the operator.  

 Border Style: Defines border style. Available options include none, fixed single and fixed 3D 
 Image: Selects the Image to be displayed on the object. The image can be selected from either 

Basic symbols or Symbol factory, or a custom image can be used if they are formatted 
as BMP, WMF, jpg, gif or png. 

 

 
 

 Text font: Define the font including the name of the font, size of font and style of font 
 

 
 

 Timing: This is an advanced feature and used to make sure operator action is properly received 
by PLC when the PLC has a large scan time. 

 Hold time: This is generally applicable for a “Clicked” event. This keeps executing the action 
defined at the “Clicked” event for the time defined at hold time. We suggest using 
holding time greater than the PLC scan time. Example: 300 msec. 
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Example: 
Push-button Function 
 

 
 
 Example: Operator presses button for only 200msec. When the operator clicks the button, Tag1=1.  When  
operator releases the button, Tag1 = 0, holding time = 1000 msec.  
 Since holding time is set for a clicked action, the released action “TurnBitOff” will be executed only after 
completing 1000 msec, not immediately after the operator releases the button. In this case, if the PLC scan 
time is 800 msec, the operator click action will be detected properly because the button will remain active for 
1000 msec.  
 

 
 
 Auto Repeat & Interval time: This is generally applicable for a “Pressed” event. It is to repeat 

the action defined at the “Pressed” event as per the set interval 
time.  

 
 Example: When the operator keeps the button pressed, the setpoint should be incremented by 

1 for every 1 second.   
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 Auto-repeat with time interval and holding time cannot be used together.  
 
 Tag binding: Select the tag that should be linked to the button to show a different display during 

run time based on configuration available at Band editor. Any of the configured 
Analog or Digital tags can be selected. 

 

 
 

 If Tag1 is an Analog Type (32 bit), it is also possible to show a different display based on individual bits. By 
default, it is disabled. You can select the bit from the combo box and then configure the band editor per 
project requirements. 
 

 
 

 Bands: Defines bands for the button.   
 Back color: Defines the back color for the selected band 
 Fore color: Defines the forecolour to appear for the selected band in run time 
 Text: Define the text to be displayed for the selected band in run time 
 Visible: Controls if the button is visible 
 Blink: Select if blink is required when the tag value reaches a selected band during run time. If 

yes is selected, it allows the user to enter a blinking colour. 
 Bitmap file: Select the image to be displayed on the button when the tag value reaches this 

band in run time.  
 For example, When Tag1=0, shows Red coloured motor symbol on the button. When Tag1=1, 

shows Green coloured motor symbol on the button. 
  Note: Two different symbols are required for the above example 

Bmp, WMF, jpg, gif and png types are supported. If the selected file is different than WMF, then, it 
is also possible to select Image layout and transparent options. 
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 From File browser: To select the image from a specified location 
 From Basic Symbol:  To select images from the free basic symbols (*.wmf format) available in 

Recorder editing software.   
 From symbol factory: It allows the user to select symbols from the symbol factory (in WMF 

format). 
 Image layout: None, centre and Stretch options are available. Stretch means the selected 

bitmap will be stretched to the size of the button.  
 Note: If the bitmap has poor resolution when stretch is used, it may show a low-quality image in 

the screen. 
 Flip: Used to flip a button. This needs to be configured during design time. Available options 

include None, Horizontal, Vertical and Both. 
 Rotation:  Used to rotate the button at predefined angles.  This needs to be configured during 

design time.  Available options include 0O, 90O, 180O and 270O. 

 Value: Defines the maximum range of the selected band. The low range will be the value 
defined at the previous band. There is no need to enter any value for band 1 as its value 
is 0 which is low range. 

 If the button is linked with a Digital Tag, then, in the band editor, it will show only two bands for value 
0 and 1. When a button is linked with an Analog tag, it is possible to configure up to 32 bands for showing 
different states of the button based on the value of the tag.  It shows statuses similar to the word lamp. 
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Security control: Defines the security level for the button. It allows the user to operate the button only 

when the operator security level is equal to or more than the security level 
defined here. Please refer section “Security” at Project explorer for more 
information about security features. 

Events 
 Clicked: Define the action that happens when the user presses the button during Run time.  If 

required, it is possible to configure a holding time for this action.  

 Holding time is a very useful function. If the PLC has a large scan time, sometimes the operator 
“clicked” action will be not detected by the PLC. In this case, it is possible to have a hold time for a “clicked” 
event so that operator action will be continuously present for the time defined at “holding”, such that the PLC 
will receive the operator action properly. 

  If the operator touches a button and releases his/her finger instantly, it is called a “Clicked” action. 
During this time, a total of three actions will be executed. Click, Pressed and Released 
 

 
Case-1 
Holding time = 0 
In the above example, Tag1 value becomes 3 
 
Case-2 
Holding time = 5000m sec 
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In the above example, if the scan time for Tag1 is 1000m sec, the Tag1 value becomes approximately 8. 
When the button is clicked, the “Clicked” and “Pressed” event action occurs, and the Tag1 value becomes 2. 
Since the holding time is 5 sec, for the next 5 seconds, the Tag1 value is incremented by 1 each second.  
So, Tag1 value becomes 7. When the button is released, Tag1 value is incremented by 1 again, so it 
becomes 8. The above example is for illustration only to understand events for the button object. 
Pressed: Define the action that happens when a user continuously presses on a button. If required, it is  
possible to configure Auto-repeat and interval time for this action. 

 Once an operator touches a button, the “clicked” event will be executed first.  If the operator keeps 
holding the button continuously, the “pressed” action will continuously be executed. When the operator 
releases their finger, the “released” action will be executed. 
 Auto-repeat: On, Time interval=1000 msec. In this example, the Tag1 value will first increment by 1, then it 
will keep incrementing by 1 once every 1000 msec. as long as the operator presses the button.  The Tag1 
value will also be incremented by 1 when the operator releases the button.  
 Released: Defines the action when the user releases the button 
Switch Function 
 With this function, two buttons are required. One button to turn a tag ON, and a second button to turn a tag 
OFF. 
 

 
 

 
 
 
 When the operator clicks Button1, Tag1 will = 1. Now, Tag1 will = 1 even after the operator releases the 
button, and it will continue to maintain its earlier state. When the operator clicks Button2, Tag1 will = 0. 
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6.3.9.1.16 Bit Lamp 

 A bit lamp is used to show the digital input status for the operator. It is linked with either a digital input tag or 
an Analog input tag. By using the band editor, it is possible to display a different foreground colour, different 
background colour, different text, different symbols, different Blink colour, and control visibility when the Tag 
value is 0 or 1.  
 When a Bit lamp is linked with a digital tag, it has only two bands by default.  The Band1 value is 0 and the 
Band 2 value is 1. 
 For example: If Tag1 = 0, shows Red coloured background with an Orchid colour blink. If Tag9=1, show 
green coloured background.  

 
GUI Wizard 
 

 
 
 

 
 
 Bitmap File: Select the image to be displayed when the tag value reaches this band in run time.  



 
 

 
 

Page 400 of 550 

 
 For example: When Tag1=0, shows Red coloured motor symbol. When Tag1=1, shows Green 

coloured motor symbol  
 Note: Two different symbols are required for the above 
 Bmp, WMF, jpg, gif and png types are supported. If the selected file is other than WMF, then it is 

also possible to select Image layout and transparent options. 
 

 
 
 From File browser: Allows the user to select images in formats of BMP, WMF, jpg, gif and png 
 From Basic Symbol: Allows the user to select WMF format images from basic symbols 
 From symbol factory:  Allows for selecting symbols from symbol factory in .wmf format 
 Image layout: None, centre and Stretch options are available. Stretch means the selected 

bitmap will be fixed to the size of the bit lamp  
 Note: If the bitmap has poor resolution when stretch is used, it may show a low-quality image in 

the screen. 
 Flip:  Used to flip bit lamp and needs to be configured during design time. Available options 

include None, Horizontal, Vertical and Both. 
 Rotation:  Used to rotate a bit lamp in predefined angles and needs to be configured at design 

time. Available options include 0 O, 90 O, 180 O and 270 O 

 Circle: By default, a bit lamp object shape is in Rectangle. Select this if you wish to change the 
bit lamp shape to a circle. It is more useful to show the status of digital inputs for the 
operator during Run time. 

 
How to show the status of an individual bit in Analog type tag 
Sometimes, you will get a 16 bit/32 bit tag from a PLC with different diagnostic information, and you 
would like to show 16 bit/32 bit lamps in the Recorder screen. 
When a Bit lamp is linked with an Analog tag, for example, Int16/Int32, it has two bands.  By default, 
Band1 value is 0 and the Band 2 value is 1. In this case, using each bit lamp, it is possible to show the 
status of each individual bit status within 32 bits as per configuration available at band editor. 
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In the above figure, Tag2 is an analog type (4 bytes), so, a TagBitNo combo box will appear for the 
selection of the required bit within 32 bits (0 to 31). 
If Tag2 is Digital type tag, then, TagBitNo. The combo box is not visible. 
 

6.3.9.1.17 Word Lamp 

 
 
 Word lamps are similar to Bit lamps but linked with an Analog type tag only. It can have many bands. By 
using the band editor, it is possible to display a different foreground colour, different background colour, 
different text, different symbols, different Blink colour, and control visibility when Tag values change values 
during Run Time. 
 
For example: Tank Level indicator 
When Tag1 value is  
0 to 10, Text = Low Low Level, Color = Yellow Blinking 
11 to 20, Text = Low Level, Color = Yellow Background 
21 to 80, Text = Normal, Color = Green back ground 
81 to 90, Text = High level, Color = Red back ground 
91 to 100, Text = High High Level, Color = Red blinking 
Create 5 bands as shown 
 
GUI Wizard/Dialog 
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Band1 range = 0 to value defined at band2-1.  i.e., 0 to 10 
 
 

 
 

Band2 range: Band 2 value to Band3 value-1 i.e., 11 to 20 
 

 
 
Band3 range: Band 3 value to Band4 value-1 i.e., 21 to 80 
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Band4 range: Band 4 value to Band5 value-1 i.e., 81 to 90 
 

 
 
Band5 range: More than or equal to the value defined at band 5 (In this case number of bands=5) i.e., 
greater than 91 

6.3.9.1.18 CheckBox 

 The Checkbox (or tick box) is a graphical user interface widget that permits the user to make multiple 
selections from a number of options during run time.  

 
 Every checkbox is linked with a single Digital tag from the Tag Database. In the above white box, normally, 
white space means Not selected, False, Tag Value = 0 Tick mark means, True, Tag value = 1 
 A caption describing the meaning of the checkbox is normally shown adjacent to the checkbox. Inverting 
the state of a checkbox is done by touching with a finger or clicking the mouse on the box, or on the caption. 
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Properties 
 Write design-time value: If selected, it overwrites the default value defined in the tag database.  
 Checked: Default setting, available options True/False 
 For example: Tag1 is linked with Checkbox 1. If Checked, the tag = False, that means Tag1=0.  

If Checked, the tag = True, then Tag1 = 1. 
 Text: It is Text that appears near Checkbox as a caption. Example: Text = P101 
Events 
 Changed: Define action using function editor. When the operator presses on checkbox during 

Run time, the actions defined here will be executed. 
Example: There are three pumps named P101, P102 and P103, and the operator would like to select pump 
P101 for the start-up.  Using the checkbox, write a meaningful caption via the “TEXT” property to appear at 
the right side of checkbox, and link each of the above checkboxes with appropriate Tags.  Let’s say P101, 
P102 and P103.  Then, when P101 is selected by the operator in run time, P101 Tag value will become 1.  

 If “checked” = false is selected during design time, then Tag value will = 0. If the operator presses on 
checkbox during Run time, the symbol   will appear, and the Tag value will become 1. 
 If “checked” = True is selected during design time, the Tag value will = 1, and the appears during Run 
time. If the operator presses the checkbox during design time, the symbol disappears and the Tag value 
becomes 0. 

 If you are unable to select the required selection using the checkbox in Run time, please perform 
touch screen calibration. 

 If Checkbox is linked with an Analog type Tag, then, it is possible to select an individual bit. 
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6.3.9.1.19 Combo box 

 
 A combo box is a commonly-used graphical user interface widget. It is a combination of a drop-down list or 
list box and a single-line textbox, allowing the user to choose from the list of existing options in Run time. 
Generally, it is linked with an Analog tag. Based on the selection, the value of the tag will be changed, and it 
can be used in Logic at PLC.  
 
 It saves space in the Recorder screen by allowing the operator to select the option only when it is required 
by touching the down arrow at the right side of the Combo box. 
 Every Combo box is linked with a single Analog tag from properties. 
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Note: Do not keep any empty space between different text entries, otherwise, unpredictable results may 
occur. 
Property grid 

 
 

 
 

 
 
Properties 
  Button Width: Defines the width of a Button. It modifies the width of the down arrow at the right 

side of the combo button. 
 Items: Defines all the available options during design time. 
 For example, there are 7 options available to select a process. Tag1, an analog tag, is linked to 

Combo box1 Now, If Option A is selected, then during Run time, Tag1 value will = 0, If Option B is 
selected, then Tag1 value will = 1 …. ….. If Option G is selected, then Tag1 value will = 6  

Events 
 Changed: Defines an action using function editor. When the operator presses on a combo box  

 To increase up/down arrow size on the combo box, increase the size of the text font. 
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6.3.9.1.20 List Box 

 

 
 A list box is a Graphical User Interface widget that allows the user to select a single item from a list of 
available items. The available options are entered during Design time and they are available for selection 
during Run Time. On selection, it writes a value to a Tag based on the order number. Every List Box should 
be linked with an Analog tag.  
GUI Wizard/dialogue 
 

 
 

 
 
Note: Do not keep any empty space between different text entries, otherwise, unpredictable results may 
occur. 
Property Grid 
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Properties   
 Scroll Bar Width: Defines the width of the scroll bar that appears on Right side of the List box. 
 Items: Define all the available options in design time. 
 For example, there are 6 options available to select a process. Tag1, an analog tag, is linked to List box1 
Now, If “Select A” is selected, then Tag1 value will = 0 If “Select B” is selected, then Tag1 value will = 
1 …. ….. If “Option G” is selected, then Tag1 value will = 5 
 
Events 
 Changed: Define actions using function editor. When the operator presses on list box item in 

Run time, the actions defined here will be executed.  

6.3.9.1.21 Group Panel 

 Used to group objects in a screen.  
Procedure 

 Click on “Group Panel” at Basic Objects 
 On-Screen, just draw a rectangle with your mouse over the objects that you would like to group 

together.  It will appear as shown below: 
 

 
 Now, double click on Group Panel object 
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 Select “Group Controls” checkbox and click “OK” 
Now, you will be able to move grouped objects to another location or rescale them to fit another 
screen size etc. 

 Group Controls: Select the checkbox to apply the group function. De-select the checkbox for 
ungrouping 

6.3.9.2 Enhanced Objects 

 Fine components are available for User interface and display. The components include Dial, Digital LED, 
Level, Meter, Slider, Switch, Thermometer and Toggle. 

6.3.9.2.1 Common Properties 

Appearance 
 Back Color: Set the background colour of the component.  
 Bevel: Used to set border including inner border, outer border and style of the border. 
 Inner Border: True/False 
 Outer Border: True/False 
 Style: 9 styles are available 

 None, Flat, Single, Double, Raised, Lowered, Double Raised, Double lowered, Frame Raised, 
Frame Lowered. 

 Behaviour 
 Visible: True/False.  Determines whether the control is visible or hidden. 
 Enable: This is for event control. If linked with a Digital tag, if the tag value =1 during run time, 

events configured for the object will be executed. If tag value = 0, events will be not 
executed 

 Data  
 Tag Binding: Select the Analog Tag of process value  
 Write design-time value: If selected, the value entered here during design time will be replaced 

by the default value defined in the tag database. 
 
Design 
 Name Label1, It is the name of the component. Every component will have a UNIQUE number 

on a page. If more than one Label is available on the same page, the number will be 
incremented automatically.  The user can also change the name of this component if 
required. Component “Name” property is very useful and it can be used in scripts also. 

 
Example: Task: Change Label1 “back” color to blue during Run time when Tag1 is equal to 1. 

if(Tag1 == 1) 
{ 
Screen1.Label1.BackColor=Color. Blue; 
} 
 
Screen1: It is the location of Label1  
Label1: Object name 
BackColor: Property of Label related to background-colour 
Colour.Blue: Target Color  

 
If the above script is executed in scheduler once per second, then when Tag1 = 1, the back colour for 
Label1 will change to Blue during Run time. 
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 Properties are case sensitive. 
BackColor: OK 
Backcolor: Not OK 

 Security Level: Define the security level for the component to be used by the operator. If the 
operator security level is less than the security level defined for component, it 
will not allow the operator to operate the component. 

 Locked: True/False: It is to Move or Resize the component. 
Layout 
 Dock: Defines which borders of the control are bound to the container. 
 Location:  The coordinates of the upper-left corner of the component relative to the upper-left 

corner of the container. Set X and Y position on the screen in pixels. 
 Size: Size of the component in pixel. Set the height and width of the component in pixels. 
 Position: It is the defined position of Label, Value etc., for some components.  Available options 

include None, Top Left, Bottom Right, Both and Internal.  

Position naming convention for components 
For example Level component, Label Position = Bottom Right 
If Orientation is Vertical, the Label will be displayed on the right side of the component. 
If Orientation is Horizontal, the Label will be displayed on the bottom side of the component. 

6.3.9.2.2 Level 

 Levels are normally used to display a process parameter value in several steps. Generally, it is linked with 
Analog type tag (Analog input type tag at PLC, which is received as 4-20 mA signal from field transmitters 
like Ear level transmitters (sound detectors in ball mills, etc.).  
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Properties 
 Back Color: Defines the background color for the component. 
 Labels Position: Define the label position. Available options are Top Left, Bottom Right and 

Both. Naming convention depends on orientation. If orientation = Vertical, then, 
if “Top left” is selected, the label position will be shown on the “Left” side.  If 
orientation = Horizontal, then if “Top Left” is selected, the label position will be 
shown on the “Top” side of the component. 

 Orientation:  Vertical/Horizontal. Select direction. 
 Text Font:  Used to set the font of the label.  Options include Name of Font, Size of font and 

style of font. Supported styles include Regular, Bold, Italic, Underline & Strikeout. 
 Bevel:  Defines inner border and outer border for the component. Please refer to common 

properties at the beginning of this section for more details. 
 Decimals: Define the number of decimals to be displayed for value to be displayed along with 

level component in run time. 
 Tag Binding:  Selects the Analog Tag of the process value. 
 

 
 
Ticks:  
 Ticks Position: Define Ticks Position. Available options include Top Left, Bottom Right, Both 

and None. 
 Ticks length: Define the length of Ticks in pixels. 
Scale:  
 Scale divisions: Define the number of Big Ticks in the Level graph.  
 Scale Sub Divisions: Define the number of ticks between two big ticks. 
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 Scale Label Divisions: Define the number of Labels to be displayed. Example: If Scale label 
division = 5, Scale = 0-100, then, it display labels as 0, 20, 40, 60, 80 & 
100. 

 Scale Width: Define Scale width. If ticks are selected to display on both directions, this is the 
defined width between two scales on both sides. 

Bar 
 Bar Width: Define the width of the Bar graph. 
 Divisions: Define the number of divisions (Like bricks) to appear in Bar graph. 
 Space: Define Space between divisions (bricks) in pixels. 
 

 
 
 Maximum: This is the max range of the process value (analog input tag) 
 Minimum: This is the minimum range of Process Value (analog input tag) 
 Example: If an Ear Level transmitter range is 0 to 100, set Minimum = 0, Maximum = 100. 
 Reverse Scale: True/False. If it is selected, then, zero will be on the bottom side and 100 will be 

at the top side for vertical orientation. 
 Step:  This is the minimum value to reflect the change in the Bar graph position. Bar Step and 

Bar division settings are closely related. If Bar divisions = 50 for a scale value of 0-100, 
then, if Step=2, when process value changes by value 2, it shows level value change 
clearly in level graph. 

 Value:  Used to enter a process value during design time and to check the bar graph display on 
the PC.  It requires the operator to enter a value in multiples of the step value.  
Otherwise, it is automatically rounded to the closest multiple of the step value. 

 Is Indicator only: If this is selected, the level graph is used for “Read” purposes only. If it is not 
selected, you can use a level graph for write purposes similar to the slider to 
send a setpoint from the Recorder to a PLC etc. Just use the finger to touch at 
various places in Level graph to set the level required. 

 Value Position: Define the position of process value to be displayed during Run time along next 
to the Level graph. Available options include None, Top Left, Bottom Right and 
Both. 
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 Sections colors: It is configured bands for the sections to show different colours for Labels and 

Ticks in the Level graph.  
Example: Three bands 
Section 1, Max % = 60 means, its band is from 0 to 60 %, and it will show labels and ticks in black colour. 
Section 2, Max % = 80 means its band is from 61 to 80 %. 
Section 3, Max % = 100 means its band is from 81 to 100 %. 
Note: Band setting is in % for the total Scale defined (Minimum to maximum). 

 
 Active Color Section:  Defines the active colour for the process value band. For example: If a 

process value range is 0-100, set different bands in % for the process 
value, and define colours to appear within the level Bar graph during 
Run Time. 

When the process value is between 0 and 50 % of scale, display bricks in Lime colour. 
When the process value is between 51 and 80 % of scale, display bricks in Yellow colour 
When the process value is between 81 and 100 % of scale, display bricks in Red colour. 
 
Configuration from Property grid 
 

 
 
 Click the “ColorSection Array and the following screen will appear.  Then, set all the bands and colours. 

 
 
 Inactive Color Section: Define Inactive colours for process value bands the same as above. 

Generally, light colours are selected for Inactive colours and dark 
colours with more contrast are selected for Active colours.  This way, 



 
 

 
 

Page 414 of 550 

users/operators will be able to differentiate between active and inactive 
colours easily. 

 
 

 Events: It is to trigger functions/jobs to be executed when the process value of tag linked with 
Level bar graph is changed during run time. 
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6.3.9.2.3 Meter 

 A Meter is a component generally used to display process values like pressure, Temperature, Flow etc.  
Generally, it is linked with an Analog tag (Analog input type tag at PLC, which is received as 4-20 mA signal 
from field transmitters like Temperature, pressure, etc...) 
 

 
  

 
 
Properties 
 Back colour: It is to set a background colour for the Meter. 
 Pointer Color: It is to set pointer Color. 
 Bevel: It is to set border including inner border, outer border, and style of the border. 
 Inner Border: True/False 
 Outer Border: True/False 
 Style: 9 styles are available 

 None, Flat, Single, Double, Raised, Lowered, Double Raised, Double lowered, Frame Raised, 
and Frame Lowered. 

 Text Font:  Used to set the font for the label including Name of Font, Size of font and style of 
font. Supported styles include Regular, Bold, Italic, Underline & Strikeout. 

 Tag Binding: Select the Analog Tag of the process value. 
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Labels:  
 LabelsCount: Number of labels to be displayed around the Meter. 
 Example: Pressure transmitter range 0-100 bar 
 Label count =10 Around the Meter, you will see labels marked with 10, 20, 30, 40, 50, 60, 70, 80, 

90 and 100.  
 LabelsRadius: It is to set the radius of Labels to be displayed around the Meter. 
 LabelsVisible: True/False, it is to set visibility for the label 

 Pointer  

 
 

 
 
 External Pointer Radius: It is used to set an external pointer Radius, define end position. 
 Internal pointer Radius: It is used to set the Internal Pointer Radius, defines start position. 
 Pointer Size: It is to set pointer Size in pixels. 
 Pointer Type: It is setpointer type. Available types include Triangle, Circle and Line. 
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Ticks 
 Ticks Count: Set the number of ticks between labels. 
 Ticks Length: Set Tick length in pixels. 
 Ticks Radius: Set Tick Radius  
 Ticks subdivision counts: Set Tick sub division counts 
 Ticks Visible: True/False, Set Ticks visibility 
Center 
 Width: Adjust the width of the meter within boundaries. 
 Height: Adjust the height of meter within boundaries. This is useful when a half-circle meter is 

required.  The meter needs to be adjusted to the centre as shown below. 
 

 
 
Circles 
 

 Border circle Color: Set border color for circle. 
 Circle Color: Set Color for circle. 
 Circle Radius: Set Radius for circle. 

Note: If Border circle colour is the same as the back colour, then the circle will not be visible. 
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Angles & Scale 
 Maximum: This is the maximum range of the Process Value (an Analog input Type Tag). 
 Minimum: This is the minimum range of Process Value (Analog input Type Tag). 
 Example: If pressure transmitter range is 0 to 100 bar, set Minimum = 0, Maximum = 100. 
 Start Angle: It is the start angle for the Range low (Analog input) 
 End Angle: It is the end angle for the Range high (Analog input) 
 Reverse Scale: It is to set scale direction in Meter 
 False: Anti-Clockwise 
 True: Clockwise 
 

 
 
 Reverse Scale = True 
 For example: If you want 00 (Left) to 180O (Right) Meter for Process value range 0-100, set the 

following. 
 Start Angle: 0O, End Angle: 180O and Reverse Scale = True. 
Behaviour 
 Step: It is the minimum value to reflect the change of pointer position in Meter. 
 For example: By default, Step = 0, i.e., the pointer moves its position in the Meter in Real-time 

even with a minor change in process value. 
 For example Step = 5, i.e., the pointer moves its position on the Meter in Real-time in steps of 5.   
 Value: It is used to enter process value in design time and check pointer position in PC. 
 Indicator only: By default, it should be selected so that the meter will be used for Reading 

purposes only. If it is not selected, then you can use the Meter for Write purpose 
similar to a Slider to send a setpoint from the Recorder to a PLC etc. Just use 
your finger and move the pointer to change the setpoint. 

 Write design-time value:  If selected, it writes design-time value instead of default value 
defined at the tag database. 
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Sections colours  
 It is to configure bands for the sections to show different colours for Labels and Ticks in Meter.  
Example: Three bands 
Section 1, Max % = 60. That means its band is from 0 to 60%.         It shows labels and ticks in black colour. 
 
Section 2, Max% =80 that means, its band is from 61 to 80 %. 
 
Section 3, Max % = 100 that means, its band is from 81 to 100 %. 
 
Note: Band setting is in % for the total Scale defined (Minimum to maximum). 

6.3.9.2.4 Slider 

 This is normally used to change the setpoint of a process by the operator from the Recorder during Run 
time. Generally, it is linked with an analog tag (analog output type tag at PLC, to send 4-20 mA signal out 
from PLC to external Controllers, Variable speed drives, etc.). 
 

 
 In the above figure, Scale divisions = 10 (Big ticks).Scale sub divisions = 5 (Small ticks between big ticks). 
Scale Label divisions = 10 (0, 10, 20 till 100). 
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Properties 
 Back color: Back colour for the component. 
 Active bar color: Define active bar color. 
 Slider bar color: Define border colour for the slider. 
 LED color: Color of the handle 
 Inactive bar color: Define inactive bar colour. 
 LabelsPosition: Define Label position. Available options include Top Left, Bottom Right, Both, 

Internal and None. 
 Orientation: Horizontal/Vertical. This is the orientation of the slider component.  In the above 

figure, it is in the Horizontal position. 
 Slide size: Define the height and width of the slider. 
 Text Font: It is to set the font for the label including Name of Font, Size of font and style of font. 

Supported styles include Regular, Bold, Italic, Underline & Strikeout. 
 Bevel: It is to set a border including inner border, outer border and style of the border. 
 Inner Border: True/False 
 Outer Border: True/False 
 Style: 9 styles are available 
 None, Flat, Single, Double, Raised, Lowered, Double Raised, Double lowered, Frame Raised, 

and Frame Lowered. 
 Tag Binding: Select the Analog Tag of the process value. 
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Ticks:  
 Ticks Position: Define ticks position. Available options include Top Left, Bottom Right, Both, 

Internal and None. 
 Ticks Length: Set Tick length in pixels 
 Scale:  
  Scale divisions: Define number of Scale divisions (Big ticks). 
  Scale Sub Divisions: Define the number of Subdivisions (Small Ticks between big ticks). 
  Scale Label Divisions: Define the number of Labels to appear.  Ex. 0, 10, 20 etc. till 100 

for scale 0 to 100. 

  Define the same value for both Scale divisions and Scale label divisions.  
  Scale Width: Define Scale width.  
 Note: This is only the width for Scale divisions. Example: If ticks position is selected on both 

sides, then it is the gap between two scale ticks (Top and Bottom in Horizontal orientation 
or Left and Right in vertical orientation).  

Bar:  
 Bar Width: Define width of Bar. 
 

 
 
Scale:  
 Maximum: This is the maximum range of Setpoint (Analog Tag, Normally Analog Output). 
 Minimum: This is the minimum range of Setpoint (Analog Tag, Normally Analog Output). 

 Example: If Controller setpoint is 0 to 100。C, set Minimum = 0, Maximum = 100. 

 Reverse Scale: If Selected, Scale labels will be displayed in Reverse. 
Behaviour:  
 Step: It is the minimum value change when the slider is moved. 
 For example: By default, Step = 0, i.e., Slider moves its position in Real-time even with a minor 

change in process value. 
 For example:  If Step = 5, Slider moves its position in Real-time in steps of 5.   
 Value: It is used to enter process value in design time and check the Slider position in PC. 
 Indicator only: If Indicator only is selected, the slider is used for Read-only. The operator will be 

not able to move the slider in Run time. If the Indicator only is not selected, the 
slider is used for reading/Write. The operator will be able to move the slider in 
Run time for example: change setpoint for variable speed drive. 
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 Value Position: Define position for the value to appear during Run time. Available options 
include Top left, Bottom Right, Both, Internal and None. 

 

 
 
 Sections colours: It is configured bands for the sections to show different colours for Labels and Ticks in 
Slider.  
 Example: Three bands 
 Section 1, Max% =60 means its band is from 0 to 60%.  It shows labels and ticks in black colour. 
 Section 2, Max% =80 means its band is from 61 to 80%.  It shows labels and ticks in brown colour. 
 Section 3, Max% =100 means its band is from 81 to 100%.  It shows labels and ticks in Red colour. 
 Note: Band setting is in % for the total Scale defined (Minimum to maximum). 
 

6.3.9.2.5 Thermometer 

 This is normally used to view process temperature by the operator during Run time. Generally, it is linked 
with an analog tag (Analog input type tag at PLC, which is received as 4-20 mA signal from field transmitters 
like Temperature etc...) 
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Properties 
 Back Color: Define back color for the component. 
 Liquid color: Shows temperature level (mercury) in Thermometer.  
 Tank Color: Define background colour of thermometer without mercury. 
 LabelsPosition: Define Label position. Available options include Top Left, Bottom Right, Both, 

Internal and None. The naming convention is based on the selected 
orientation of the component. 

 Orientation: Horizontal/Vertical. This is the orientation of the component.  In the figure above, it 
is in the Horizontal direction. 

 Indent: It is the gap between the border and the start of the scale. 
 Text Font: It is to set the font for the label including the Name of Font, Size of font and style of 

font. Supported styles include Regular, Bold, Italic, Underline & Strikeout. 
 Bevel: It is to set the border, including the inner border, outer border and style of the border. 
 Inner Border: True/False 
 Outer Border: True/False 
 Style: 9 styles are available 
  None, Flat, Single, Double, Raised, Lowered, Double Raised, Double lowered, Frame 

Raised, and Frame Lowered. 
 Tag Binding: Select the Analog Tag of the process value. 
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 Ticks Position: Define ticks position. Available options include Top Left, Bottom Right, Both, 
Internal and None. 

 Ticks Length: Set Tick length in pixels 
 Scale divisions: Define the number of scale divisions (Big Ticks) for the component. 
 Scale Sub Divisions: Define the number of Subdivisions between the above scale divisions 

(Number of Small ticks between any two Big Ticks).  
 Scale Label Divisions: Define the number of Labels to be displayed for the component as per 

Scale Range of process value. For ex: 0, 10, 20, 30…100. 
 Scale Width: Define Scale width. If you have ticks on both sides of the component, it defines the 

width between Upper (Left) & Lower(Right) scale divisions based on the 
orientation of component. 

 Bar Width: Define the width of Bar in pixels. 
 

 
 
 Maximum: This is the maximum range of the Setpoint (Analog Tag, Normally this is an Analog 

input, 20 mA, 10V DC etc.) 
 Minimum: This is the minimum range of Setpoint (Analog Tag, Normally this is an Analog input, 

4 mA, 0V DC etc.) 

 Example: If Temperature transmitter range is 0 to 100。C, set Minimum = 0, Maximum = 100. 

 Reverse Scale: True/False. Define Scale direction. 
 Step: It is the minimum value to reflect the change of mercury level. 
 For example: By default, Step = 0 means the Mercury level moves in Real-time even with a 

minor change in process value. 
 For example Step = 5 means the Mercury level moves its position in Real-time in steps of 5.   
 Value: It is used to enter a process value during design time and check the mercury level 

position on the PC. 
 Indicator only: If selected, this component is used for Read-only. If it is not selected, then this 

component can be used for Write/Read purpose. 
 Write design-time value:  If selected, it writes design-time values instead of default values 

defined in the tag database. 
 Value Position: Define position for the value to appear during Run time. Available options 

include Top left, Bottom Right, Both, Internal and None. The naming convention 
is based on the orientation of the component. 
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 Section Colors: Define bands to display Ticks and Label colour accordingly based on the value 

of the tag during Run time. 
 

6.3.9.2.6  Bar Box 

 Bar Box is a Graphical User Interface widget that displays a bar graph for an Analog Tag during Run Time.
 Every Bar box should be linked with an Analog Tag. 
 

 
 
Properties 
 Border Style: Define border style.  Options include fixed single, fixed 3D and none. 
 Direction: Define direction of Bar graph. Up/Down/Left/Right 
 Range high: Display scale high. 
 Range Low: Display scale low. 

Value: Default value. It is to check how fore colour, back colour displays in PC during design 
time.  

 Tag Binding: Select the Analog Tag of the process value. 
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Bands 
 It is to define various bands for the process value to appear and display animation in Run time. 
 Band count: Use up/down buttons to increase/decrease the number of bands. Maximum 32 

bands are supported. In each band, it is possible to configure back colour, fore 
colour and blink properties. 

 Back color: Define back colour. 
 Fore Color: Define fore colour. 
 Blink: Select “True” if blink is required and “False” if blink is not required. 
 Blink color: If “True” is selected for a blink, then this property is visible and you can select 

required blink colour. 
 Value: It is the band range. For the first band, it is always the Range Low value defined for the 

bar box. Band 1 high range is the value defined at Band2. Band 2 high range value is 
the value defined at Band3 and so on. 

6.3.9.2.7 Scale 

 The scale is a Graphical User Interface widget used along with bar box if required. 
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Properties 
 Back color: Define back color 
 Fore Color: Define fore color 
 Line width: Define width of line 
 Grids: Define number of grids  
 Direction: Define direction of Scale. Up/Down/Left/Right 

6.3.9.2.8 Picture box 

 Picture box permits the user to link different picture files into a Picture box component during design time 
and then later view them during Run time based on the value of the Tag. Supported formats include Bitmap 
file (*.bmp), Windows Metafile (*.wmf), JPEG File (*.jpg), Graphics Interchange Format (*.gif), Portable 
Network Graphic (*.png). 
          

 
 
Properties 
 Bitmap file Select the image to be shown in the object 
 Flip: It is to flip the picture file during design time. Available options are Horizontal, Vertical, Both 

and None. 
 Rotate: It is to select the direction for the picture file during design time to adjust direction. 

Available directions include 0O, 90O, 180O and 270O 
 Tag Binding: Select the Analog tag to be linked with the Picture box.  
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 Movement: Select “Enable Move” if it is required to move picture during Run time from Location 
1 to Location 2 based on a tag Value. Start and End coordinates for X and Y needs 
to be configured during Design time, and the Picture moves in Run time based on a 
Tag value. 

 Tag Value: Define Tag value  
 

 
 
 Band Count: Define the number of bands required. 
 Back Color: Define back colour for the selected picture file in a specific band. 
 Visible: Define visibility for the picture in a specific band. 
 Bitmap file: Select picture file for a specific band. 
 Image Layout: Position of the image within the Picture container. Available options include 

None/Center/Stretch.  When the stretch is selected, it attempts to fit the picture 
file to the size of the container.  

 Transparent: Select if no back colour is required for a picture file. 
 Flip: It is to flip the picture file during design time. Available options are Horizontal, Vertical, Both 

and None. 
 Rotate: It is to select the direction for the picture file during design time to adjust direction. 

Available directions include 0O, 90O, 180O and 270O 
 Example: You may take a photo of a section of the factory floor like a tank, then use this on the 

Recorder screen instead of a default symbol.  

 A bitmap file by the name sunset.jpg is linked with Picturebox1 in screen1. If you wish to have the 
same sunset.jpg in screen no2, do not create picture box and link with sunset.jpg again. Since a resource 
with name sunset already available, if you try to use the same image in another place, it may not allow you 
to do so and may give you an error message. If you really need the same image again, copy picture box1 at 
screen1 and paste it in screen no 2.   

6.3.9.3 Graphics 

 Graphics are used to place a symbol in a screen like a Tank, Motor etc... Basic symbols are available in 
Recorder Editing Software and it includes the following symbol categories. 
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Symbol categories 
 

No Category Symbols Colours Qty 

1 Arrows 7 6 42 

2 Blowers 5 6 30 

3 Boilers 4 6 24 

4 Conveyors 6 6 36 

5 Instruments- True Color 7 C 7 

6 Lamps 4 6 24 

7 Material handling 8 C 8 

8 Motors 4 6 24 

9 Nature-True Color 6 C 6 

10 Office-True Color 7 C 7 

11 Pipes 10 6 60 

12 Power-True Color 7 C 7 

13 Pumps 5 6 30 

14 Push buttons 8 6 48 

15 Tanks 5 6 30 

16 Valves 8 6 48 

17 Vehicles-True Color 6 C 6 

C = True Color 
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Some symbols are available in 6 different colours.  They are Red, Green, Yellow, Blue, Brown and Grey. 
 All the symbols are vector graphics.  They occupy less memory and have high quality. 
 It is possible to set the transparent property for symbols during design-time from the property grid. 
“Transparent” means the screen colour itself will appear as background colour, making the object appear to 
be see-through.  Also, it is possible to change the symbol background colour during design time and Run 
time.  
 How to set the “transparent property to a symbol from the property grid 
 

 
 

 
 
 Click “Bands”, then set “BackColor” to “Transparent” 
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Fig: Back color=Transparent 

 

 
 

Fig: Back Color=Green 
 
 Since all symbols are vector symbols, if a symbol is enlarged, it does not lose quality.  
 When Recorder Editing Software is installed, all basic symbols will be installed in the default folder 
C:\Program Files\Recorder Editing Software\Recorder Editing Software\Basic Symbols 
 In addition, if the application developer has any additional symbols, they can be placed in the same folder 
as the basic symbols for use in the project. 
 Example: Create a folder named “Custom”, and place it in C:\Program Files\Recorder Editing 
Software\Recorder Editing Software\Basic Symbols 
 It is possible to a set path for graphic symbols in the Recorder software.  On the Menu bar, click the “File” 
dropdown menu, select “Environment”, then select “Graphics path”.  All these will appear in a tree-type 
structure within Recorder editor avoiding the need to import these symbols using a “Picture Box”. 
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 Once a symbol is selected in the Recorder from Graphics, it is possible to change, Flip or rotate basic 

symbols in 00, 900, 1800 and 2700 

 
 
Properties 
 Tag Binding: Select an Analog Tag if the animation is required for the symbol in Run time. 
 

 
 
 Movement: Select the Enable/Move checkbox, then, enter the X and Y start and end positions 

(this is in pixels). 
 Tag Value:  Linked with the Start and End Positions. 
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 Ex: Recorder 7” (High Performance), Screen Resolution = 800 X 480, Horizontal installation, 
Width=800, Height=480.  Move symbol from Left to Right of the screen during Run time when 
tag value changes from 0 to 100  

 

 
  

To move the symbol from Left to Right, set start and end Positions for X coordinate in pixels, there 
is no need to set Y coordinates. 

 Tag value = 0 corresponds to Start Position (X) 
 Tag value = 1000 corresponds to End Position (X) 
 
 Ex: Recorder 7” (High Performance), Screen Resolution = 800 X 480, Horizontal installation, 

Width=800, Height=480.  Move symbol from Top to Bottom in the screen at Run time when 
tag value changes from 0 to 100 

 

 
 
 Ex: Recorder 7” (High Performance), Screen Resolution = 800 X 480, Horizontal installation, 

Width=800, Height=480.  Move symbol from Left Top to Right Bottom on screen at an angle 
during Run time when the tag value changes from 0 to 100 
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 Band Count:  Used to define bands for run-time animation of the symbol. Max. 32 bands are 

supported. 
 Back Color:  Define Back Color of the symbol that should appear in a specific band during Run 

time. 
 Visible:  Define visibility control for the symbol in a specific band during Run time. 
 Image: Select different image file to display in a specific band during Run time. 
 Flip: Define the flip position for the symbol in a specific band during Run time. Available options 

include None, Horizontal, Vertical and Both. 
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 Rotate: Rotate symbol to any predefined direction in a specific band during Run time. Available 

options include 0O, 90O, 180O and 270O 
 Example: There is Liquid level Tank. When the Tag value =0, an arrow should appear pointing in the Down 
direction indicating that a discharge of the tank is in progress.  When the Tag value = 1, the arrow should 
appear in the Up direction indicating the filling of the tank is in progress. 
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6.3.9.4 Symbol Factory 

 Symbol Factory contains more than 4000 symbols in 64 categories. 
 

No. Category Symbols No. Category Symbols 

1 3-D Pushbuttons Etc. 73 35 Machining 90 

2 Air Conditioning 140 36 Maps and Flags 23 

3 Architectural 49 37 Material Handling 118 

4 Arrows 63 38 Mining 63 

5 ASHRAE Controls & Equipment 
 
100 

39 Misc. Pipes 39 

6 ASHRAE Ducts 86 40 Misc. Symbols 1 57 

7 ASHRAE Piping 49 41 Misc. Symbols 2 79 

8 Basic Shapes 86 42 Mixers 24 

9 Blowers Etc. 34 43 Motors 38 

10 Boilers 36 44 Nature 71 

11 Buildings 42 45 Operator Interface 28 

12 Chemical 50 46 Panels  14 

13 Computer Hardware  38 47 Pipes  82 

14 Computer Keys  68 48 Plant Facilities  52 

15 Containers  56 49 Power  61 

16 Controllers  35 50 Process Cooling  20 

17 Conveyors, Belt 40 51 Process Heating  61 

18 Conveyors, Misc. 26 52 Pulp & Paper  35 

19 Conveyors, Simple 56 53 Pumps  99 

20 Ducts  51 54 Safety  27 

21 Electrical  83 55 Scales  36 

22 Finishing 45 56 Segmented Pipes  41 

23 Flexible Tubing  24 57 Sensors  55 

24 Flow Meters  35 58 Tank Cutaways  23 

25 Food  72 59 Tanks  145 

26 General Mfg.  68 60 Textures  181 

27 Heating 108 61 Valves  73 

28 HVAC  74 62 Vehicles  41 

29 Icons and Bitmaps  159 63 
Water & 
Wastewater  

112 

30 Industrial Misc. 19 64 Wire & Cable  21 

31 International Symbols 42  Total  4045 

32 ISA Symbols 183    

33 ISA Symbols (3-D) 123    

34 Laboratory 23    

 With Recorder Editing Software, only the first symbol from the symbol factory can be selected. If you 
need all symbols, order our Recorder Editing Software Plus, and we will supply a USB hardware lock to 
access more than 4000 symbol factory graphics. 

 It is possible to link an Analog Tag with a Symbol factory graphic and change its colours during Run 
time.  Up to 50 bands are supported. 
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Design Time 
 During design time, the applications engineer is allowed to change the colours of these symbols.  
Example: Change tank colour from standard greyscale to Green colour.  
 
Task: Place symbol on a screen 
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In Toolbox, click “Symbol Factory”, then drag and drop a standard control to the screen. 
 

       
 
Fig 1  Fig2  Fig3   Fig4 
 
Task: Increase the size of the symbol 
 
Select the symbol on the screen.  It will be as shown as in fig2 above. 
 
Then, move the mouse to a square pointer till an arrow appears.  Left-click and hold the mouse.  Drag the 
mouse to increase the size of the symbol as per your requirement and then it will be as shown as in Fig4 
above. Alternatively, in the property grid, enter the size in pixels as shown below. 
 

 
 
Task: Changing symbol to another category 

 
Drag and the drop symbol factory component onto a screen. 
 
Click  , then click on Symbol Factory.NET Properties.  
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Alternatively, select the symbol factory component using a single click (left) with the mouse.  Keep the 
mouse cursor on the symbol, then, double click (left) the mouse to open symbol properties.  The following 
screen will pop up.  
 

 
 
Select the required category, select the symbol, then click on the button “OK”, then the new symbol will be 
placed on the screen. 

  Click on Help in the above screen to open a Chm type help file (English) for the symbol factory. 
 

 
 If the above error message appears, it is required to reinstall the symbol factory.  
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Style 
 Used to define the style of the symbol in design time. 
 

 
 
Click on “Style”.  The following screen will appear. 
 

 
 

Orientation:  
 Flip: It is possible to flip the symbol during Design time.  Available options include Horizontal, 

Vertical, Both and None. 
 

   
 
 Flip=None  Flip = Horizontal 
  
 Rotation: It is possible to rotate the symbol during design time.  Available options include 00, 900, 

1800 and 2700 
Padding: Normally it is 0. It is used to decrease the size of the symbol within selected 
boundaries. 

 Stretch: It is used to stretch symbol within selected boundaries. 
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Fill Color:  
 Fill color mode: Available options include Original, Shaded, Solid and Hollow. 
 

    
 
Fill Color Mode: Original Shaded Solid  Hollow 
Fill Color:     N.A  Green  Green  N.A 
 
 Fill color: Define color to be filled in Shaded and Solid fill color mode. 
 
Background:  
 Back Style: Available options include Transparent & Opaque. Transparent means screen 

background colour will appear for the symbol. Opaque means, it is possible to set 
different background colours for a specifically selected symbol. 

 Back color: Define background color when the back style = Opaque. 
  
Blink:  
 Blink mode: Available options include No Blink, Blink Invisible, Blink shaded and Blink Solid.  
 NoBlink: Indicates “Blink” is not required for symbol during design time or Run time. Blink Speed 

and Blink colour = Not available when this is selected. 
 BlinkInvisible: Symbol will appear and disappear cyclically during both design time and Run 

time per the set Blink speed. Blink colour: Not Available for selection. 
 BlinkShaded: Symbol will flash 2 colours, one colour at a time on the same symbol per the set 

blink speed during both design time and Run time. 
Example  
 Fill Color mode = Shaded, Color = Green 
 Blink shaded setting: Blink mode=Blink shaded, Blink speed = Medium_800, Blink colour = Blue 

The green colour shaded symbol appears first, then the symbol turns into a blue shade after 
elapsing the preset time in the blink speed setting. 

   
 Blink speed: Define blink speed. Available options include Fast_400, Medium_800, and 

Slow_1200. Its period is in ms. 
 Blink color: Define background-colour  
 

 Normally, blink is not used during design time.  Default settings are as follows. 
1. Fill Color Mode = Original. If a different colour is required for the symbol, select Fill colour mode = 
Shaded, then define the Fill colour. 
2. By default, Back Style = Transparent in Background 
3. By Default, Blink mode = NoBlink 
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Animation 
 It is to define the animation for the symbol to appear at Run time in Recorder. 
 Animation mode: Define animation mode. Available options include Analog Color Fill, Discrete 

color fill, Analog integer color fill. 
 AnalogColorFill: Select this option if you wish to link an analog tag.  Then define the band for 

the colours. For example, 0 to 10, Color = Yellow, 10-90, Color = Green, 90-
100, Color = Red etc.(See next section “How beak points work” for more 
details) 

 DiscreteColorFill: Select this option if you wish to pass discrete values like 1,2,3… during Run 
time to the Tag linked with the symbol for the display of different colours. (See 
next section “How beak points work for more details) 

 AnalogIntegerColorFill: This is the same as Analog colour fill, but only integer values are 
passed to the Tag linked with the symbol. (See next section “How 
beak points work for more details) 

 Band count: Defines the number of bands required for the selected Animation mode 
 Styles: Define the style of symbols. Available options include Original, Shaded, Solid, Blink 

Invisible, Blink shaded and Blink solid. All definitions are the same as explained earlier.  

6.3.9.4.1 How breakpoints work 

The idea behind Breakpoints is that certain animation will occur when a property of the component changes. 
If this change falls within the defined parameters (see below), an animation will be triggered. 
Please note: The screenshots in the examples below are based upon the Symbol Factory .NET Standard 
Control, but the same principle applies to the Cutaway control. Two types of animation can be defined 
based upon the setting of Animation Mode: Analog Break Points and Discrete Breakpoints  
 Analog Breakpoints (Animation Mode = Analog integer colour fill or Analog colour fill) Analog breakpoints 
are defined as a value on which animation will trigger when a property of the component reaches that level. 
Depending upon your component, different properties will need to be changed depending upon the setting 
of Animation Mode. These properties are: 
 

Component Animation Mode Setting 
Property that Changes to 
trigger an Animation 

Standard  AnalogColorFill AnalogValue1 

Standard AnalogIntegerColorFill AnalogIntValue1 

Cutaway AnalogColorFill Level 

Cutaway AnalogIntegerColorFill LevelInt 
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Number and Ordering of Breakpoints 
 The number of breakpoints available to you is the number of bands defined minus 1. As a breakpoint is 
defined as the point to which an animation changes, make sure you arrange the breakpoints from high to 
low.  For example, suppose you had this screen: 

 

When the value of your property changes, this is what will happen to the control:  
 

Value of Property The band that is Active Appearance of Component 

Less than 10 Band5 Blink Shaded Red 

10 to < 20 Band4 Display Shaded Yellow 

20 to < 80 Band3 Original 

80 to < 90 Band2 Display Shaded Yellow 

Greater than 90 Band1 Blink Shaded Red 

  
 If you do not order your breakpoints in descending order, your results will be unpredictable. 
Discrete break points (Animation mode = Discrete color fill) 
 Discrete Breakpoints aren't really breakpoints, instead, they enable animation if the "DiscreteValue" of an 
element in the Bands Collection is set to true. However, since multiple DiscreteValue properties can be set 
at the same time, how does the component determine the animation to display? What it does is give priority 
to the animations based upon their order in the Bands Collection. If the first band in the collection (by default, 
Band1) has its DiscreteValue set to True, then that animation will be shown no matter which band also has 
its DiscreteValue set to true. As another example, if Band2 and Band5 each have their DiscreteValue set, 
the animation that is used will be the one defined in Band2.  Therefore, given the following definition of five 
bands: 
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 Here is what the animations will be shown based upon different values of Discrete Value 
 

Discrete Value 
for Band1 

Discrete Value 
for Band2 

Discrete Value 
for Band3 

Discrete Value 
for Band4 

Discrete Value 
for Band5 

Appearance of 
Component 

True False False False False 
Blink Shaded Red 
(Band1) 

False True False False False 
Shaded Yellow 
(Band2) 

False False True False False Original (Band 3) 

False False False True False 
Shaded Orange 
(Band 4) 

False False False False True 
Blink Shaded Black 
(Band 5) 

True True True True True 
Blink Shaded Red 
(Band 1) 

False True True True True 
Shaded Yellow 
(Band 2) 

True False False False True 
Blink Shaded Red 
(Band 1) 

False False False False False 
Original (No bands 
active) 
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6.3.9.5 Project Tools 

 

6.3.9.5.1 Build 

 Once the project is compiled successfully, it creates a build.  This build then needs to be transferred to the 
Recorder. If there are any errors during the preparation of the build, it will be shown in the output window 
just below the screen working area. If the Output screen is not visible below the screen working area, select 
it via Menu, “View”, and then click “Output” or apply “Reset window layout” from the Menu-“View” 
 

 

  After creating a build, if any errors are shown at Output window, do not attempt to download the 
application from PC to Recorder, or PC to USB flash disk first clear the errors and make sure that 
compilation errors are not present before transferring the application to the Recorder. 
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6.3.9.5.2 Build & Offline Simulation 

 First, it creates a build, and then runs an Offline simulation. 
 It is used to test the application on the PC before downloading the application to the Recorder, without 
connecting a PLC to either PC or Recorder. It is possible to enter some values for the tags via a table to 
check how the application would appear during run time. 
 

 
 
 Enter a value under the “SetVal” column, then press the enter key on your keyboard. It will accept, then 
show at “CurrentVal”.  You will now be able to see these values in objects linked with the specific tag. 

   It is better to run offline simulation frequently say once in a couple of hours or after completing 
specific screen editing by application engineer to verify how it will works on a Recorder so that if there are 
any compilation errors, it is easier to locate and rectify them. 

6.3.9.5.3 Stop 

 It is used to stop a simulation on the PC. When Offline simulation is running, click the  Icon to stop the 
current running simulation.  See the picture below.  It is located beneath the “help” dropdown menu. 
 

 
 

  If Offline simulation or online simulation is already running on the PC, and the user attempts to run it 
again, the build will fail. It prompts an error message similar to the following 
Screen1 
Build Started…. 
Could not write to Output file “C:\Program Files\Project\Recorder\Panel.exe” 
“The process cannot access the file because it is being used by another process” 
Build Failed 

 In the case of the above message is prompted, click the Stop icon  a couple of times and make sure 

that icon  is not available in Taskbar.  Click “Build” once again, then run the simulation.  
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6.3.9.5.4 Build & Download 

 It is to build first and then download the application from PC to Recorder. 

6.3.9.5.5 Download 

 It is to download the application from PC to Recorder 
Available Options 
 
i) PC to Recorder via Ethernet 
ii) Removable Disk to Recorder via USB flash disk 
 
PC to Recorder via Ethernet:  

 After creating an application, create a build on the PC, and make sure there are no 
compilation errors.  

 Connect Ethernet cable between PC and Recorder 
 In editor software, set Environment for Download via Ethernet and enter the IP 

address of the Recorder. In Environment, Select “Ethernet” at Download, then click 
the “OK” button. 

 In editor software, click “Project”, then click “Download” or click the   icon. 
 The software will build and transfer the application from the PC to the Recorder. If 

there are any errors during compilation, they need to be fixed.  Once the compilation 
errors are fixed, please attempt to download again. 

 

 
 
Removable disk to Recorder 
 

 After creating an application, create a build in the PC and make sure there are no 
compilation errors.  

 Connect USB flash disk into PC via USB port. 
 In Recorder editor software, set “Environment” to Download via Removable disk. In 

Environment, Select “Removable disk” at Download and then, click the “OK” button. 
 In Recorder editor software, click “Project” >> “Build and Download” or click the icon 

. Choose a Removable Disk and Save. 
 The application will transfer from the PC to the USB flash disk. 
 Insert USB flash disk into the Recorder. 
 Switch on Power to the Recorder. Press “Config” >> “Load“ >> “Custom Page“ >> 

“OK“.  
 It transfers the application from the USB flash disk to the Recorder. 
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6.3.9.5.6 Project Status 

 

 
 
 It is used for project management purposes and to know the limits and usage of objects. 
 
 Project used time: It shows how much time a project has been opened for editing purpose. 
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7. Web Server 
 It is used to view Paperless Recorder from a Remote location via the Internet. 
 

 

7.1  Requirements 

Item Minimum Requirements 

System IBM PC compatible computer with Intel Pentium IV or above 

Operating System Windows XP or above 

Memory 1 GB 

Hard Disk 5 GB Free Space on the hard disk 

Communication Ports Ethernet Port 

Browser Internet Explorer 10 or above, Google Chrome 

IP Address Static IP from Internet Service Provider 

 
Obtain a Static IP address from your Internet Service Provider (ISP). This IP address should be unique. 
Once the IP address is configured in the Recorder, use a Ping Instruction from the DOS prompt first to verify 
there is successful communication between the Recorder and the PC via the Internet.  
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7.2 How to configure Webserver Settings 

 For using Web server application in the PR series Recorder, Configuring the Recorder for a static IP 
address, and enabling the Web server. 

7.2.1 How to Configure Static IP Address 

 
 
 Press   (Menu), then More and then Config soft-key to enter Configuration mode. In the 
Configuration screen, select “Communication”, then press the “Enter” soft-key. 
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Select IP type = User Define. 
Enter the IP Address, Subnet Mask, Default Gateway, and DNS Server Settings in the Ethernet Settings.  
Note: Make sure to enter Global, Unique, static fix IP address received from the Internet service provider. 
 

7.2.2 How to Enable Web Server 

 

 
 

 Select Web Server Menu in the Communication screen. 
 Enable the Web Server for using Web Server application in the Recorder.  
 

 
 
 After completing the above steps, press the “Back” key, then the “Home” key to return to the main menu. It 
will save the configuration settings in the Recorder. Now the Recorder is ready for the Web Server 
Applications. 
 
Note: The Web Server update time on the browser is 1 second for real-time data and statuses and 5 
Seconds for Alarms. 
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7.3 How to Access Recorder Real-time Data in PC via Webserver: 

 Connect Paperless Recorder to the Internet 
 Open the browser (Internet Explorer 10 or Google Chrome) in the PC 

 

 
 

 Enter the IP address of the Recorder in the address bar of the browser. 
  Format: http://192.168.1.111 
 

 After a successful connection, the browser will show the real-time page of the recorder as shown 
below 

 

 
 

 By using the menu key  various real-time pages, various display mode, the status of DI, 
DO, AO, Counter and Totalizer, the real-time alarm on the recorder can be viewed. 
 

 
 

http://192.168.1.111/
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.  
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8. Modbus Communication 

8.1 Modbus Address Mapping 

8.1.1 Input Register (3xxxxx) Parameter Table for Modbus RTU Slave / TCP Server 

8.1.1.1 AI / DI / DO / AO Channel Data (Integer Type) 

Modbus 
Address 

Notation Register Name Access 

1 Reserve Reserve R 

2 AI1 AI 1 process value R 

3 AI2 AI 2 process value R 

4 AI3 AI 3 process value R 

5 AI4 AI 4 process value R 

6 AI5 AI 5 process value R 

7 AI6 AI 6 process value R 

8 AI7 AI 7 process value R 

9 AI8 AI 8 process value R 

10 AI9 AI 9 process value R 

11 AI10 AI 10 process value R 

12 AI11 AI 11 process value R 

13 AI12 AI 12 process value R 

14 AI13 AI 13 process value R 

15 AI14 AI 14 process value R 

16 AI15 AI 15 process value R 

17 AI16 AI 16 process value R 

18 AI17 AI 17 process value R 

19 AI18 AI 18 process value R 

20 AI19 AI 19 process value R 

21 AI20 AI 20 process value R 

22 AI21 AI 21 process value R 

23 AI22 AI 22 process value R 

24 AI23 AI 23 process value R 

25 AI24 AI 24 process value R 

26 AI25 AI 25 process value R 

27 AI26 AI 26 process value R 

28 AI27 AI 27 process value R 

29 AI28 AI 28 process value R 

30 AI29 AI 29 process value R 

31 AI30 AI 30 process value R 

32 AI31 AI 31 process value R 

33 AI32 AI 32 process value R 

34 AI33 AI 33 process value R 

35 AI34 AI 34 process value R 

36 AI35 AI 35 process value R 

37 AI36 AI 36 process value R 

38 AI37 AI 37 process value R 

39 AI38 AI 38 process value R 

40 AI39 AI 39 process value R 

41 AI40 AI 40 process value R 

42 AI41 AI 41 process value R 

43 AI42 AI 42 process value R 

44 AI43 AI 43 process value R 
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Modbus 
Address 

Notation Register Name Access 

45 AI44 AI 44 process value R 

46 AI45 AI 45 process value R 

47 AI46 AI 46 process value R 

48 AI47 AI 47 process value R 

49 AI48 AI 48 process value R 

50 DI1 DI 1 process value R 

51 DI2 DI 2 process value R 

52 DI3 DI 3 process value R 

53 DI4 DI 4 process value R 

54 DI5 DI 5 process value R 

55 DI6 DI 6 process value R 

56 DI7 DI 7 process value R 

57 DI8 DI 8 process value R 

58 DI9 DI 9 process value R 

59 DI10 DI 10 process value R 

60 DI11 DI 11 process value R 

61 DI12 DI 12 process value R 

62 DI13 DI 13 process value R 

63 DI14 DI 14 process value R 

64 DI15 DI 15 process value R 

65 DI16 DI 16 process value R 

66 DI17 DI 17 process value R 

67 DI18 DI 18 process value R 

68 DI19 DI 19 process value R 

69 DI20 DI 20 process value R 

70 DI21 DI 21 process value R 

71 DI22 DI 22 process value R 

72 DI23 DI 23 process value R 

73 DI24 DI 24 process value R 

74 DO1 DO 1 process value R 

75 DO2 DO 2 process value R 

76 DO3 DO 3 process value R 

77 DO4 DO 4 process value R 

78 DO5 DO 5 process value R 

79 DO6 DO 6 process value R 

80 DO7 DO 7 process value R 

81 DO8 DO 8 process value R 

82 DO9 DO 9 process value R 

83 DO10 DO 10 process value R 

84 DO11 DO 11 process value R 

85 DO12 DO 12 process value R 

86 DO13 DO 13 process value R 

87 DO14 DO 14 process value R 

88 DO15 DO 15 process value R 

89 DO16 DO 16 process value R 

90 DO17 DO 17 process value R 

91 DO18 DO 18 process value R 

92 DO19 DO 19 process value R 

93 DO20 DO 20 process value R 

94 DO21 DO 21 process value R 

95 DO22 DO 22 process value R 

96 DO23 DO 23 process value R 
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Modbus 
Address 

Notation Register Name Access 

97 DO24 DO 24 process value R 

98 AO1 AO 1 process value R 

99 AO2 AO 2 process value R 

100 AO3 AO 3 process value R 

101 AO4 AO 4 process value R 

102 AO5 AO 5 process value R 

103 AO6 AO 6 process value R 

104 AO7 AO 7 process value R 

105 AO8 AO 8 process value R 

106 AO9 AO 9 process value R 

107 AO10 AO 10 process value R 

108 AO11 AO 11 process value R 

109 AO12 AO 12 process value R 

 
Note: If the register value is 65534, then there is a communication error. 
 

8.1.1.2 AI / DI / DO / AO Channel Data (Float Type) 

Modbus 
Address 

Notation Register Name Access 

1001 Reserve Reserve R 

1003 AI1 AI 1 process value R 

1005 AI2 AI 2 process value R 

1007 AI3 AI 3 process value R 

1009 AI4 AI 4 process value R 

1011 AI5 AI 5 process value R 

1013 AI6 AI 6 process value R 

1015 AI7 AI 7 process value R 

1017 AI8 AI 8 process value R 

1019 AI9 AI 9 process value R 

1021 AI10 AI 10 process value R 

1023 AI11 AI 11 process value R 

1025 AI12 AI 12 process value R 

1027 AI13 AI 13 process value R 

1029 AI14 AI 14 process value R 

1031 AI15 AI 15 process value R 

1033 AI16 AI 16 process value R 

1035 AI17 AI 17 process value R 

1037 AI18 AI 18 process value R 

1039 AI19 AI 19 process value R 

1041 AI20 AI 20 process value R 

1043 AI21 AI 21 process value R 

1045 AI22 AI 22 process value R 

1047 AI23 AI 23 process value R 

1049 AI24 AI 24 process value R 

1051 AI25 AI 25 process value R 

1053 AI26 AI 26 process value R 

1055 AI27 AI 27 process value R 

1057 AI28 AI 28 process value R 

1059 AI29 AI 29 process value R 

1061 AI30 AI 30 process value R 

1063 AI31 AI 31 process value R 
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Modbus 
Address 

Notation Register Name Access 

1065 AI32 AI 32 process value R 

1067 AI33 AI 33 process value R 

1069 AI34 AI 34 process value R 

1071 AI35 AI 35 process value R 

1073 AI36 AI 36 process value R 

1075 AI37 AI 37 process value R 

1077 AI38 AI 38 process value R 

1079 AI39 AI 39 process value R 

1081 AI40 AI 40 process value R 

1083 AI41 AI 41 process value R 

1085 AI42 AI 42 process value R 

1087 AI43 AI 43 process value R 

1089 AI44 AI 44 process value R 

1091 AI45 AI 45 process value R 

1093 AI46 AI 46 process value R 

1095 AI47 AI 47 process value R 

1097 AI48 AI 48 process value R 

1099 DI1 DI 1 process value R 

1101 DI2 DI 2 process value R 

1103 DI3 DI 3 process value R 

1105 DI4 DI 4 process value R 

1107 DI5 DI 5 process value R 

1109 DI6 DI 6 process value R 

1111 DI7 DI 7 process value R 

1113 DI8 DI 8 process value R 

1115 DI9 DI 9 process value R 

1117 DI10 DI 10 process value R 

1119 DI11 DI 11 process value R 

1121 DI12 DI 12 process value R 

1123 DI13 DI 13 process value R 

1125 DI14 DI 14 process value R 

1127 DI15 DI 15 process value R 

1129 DI16 DI 16 process value R 

1131 DI17 DI 17 process value R 

1133 DI18 DI 18 process value R 

1135 DI19 DI 19 process value R 

1137 DI20 DI 20 process value R 

1139 DI21 DI 21 process value R 

1141 DI22 DI 22 process value R 

1143 DI23 DI 23 process value R 

1145 DI24 DI 24 process value R 

1147 DO1 DO 1 process value R 

1149 DO2 DO 2 process value R 

1151 DO3 DO 3 process value R 

1153 DO4 DO 4 process value R 

1155 DO5 DO 5 process value R 

1157 DO6 DO 6 process value R 

1159 DO7 DO 7 process value R 

1161 DO8 DO 8 process value R 

1163 DO9 DO 9 process value R 

1165 DO10 DO 10 process value R 

1167 DO11 DO 11 process value R 
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Modbus 
Address 

Notation Register Name Access 

1169 DO12 DO 12 process value R 

1171 DO13 DO 13 process value R 

1173 DO14 DO 14 process value R 

1175 DO15 DO 15 process value R 

1177 DO16 DO 16 process value R 

1179 DO17 DO 17 process value R 

1181 DO18 DO 18 process value R 

1183 DO19 DO 19 process value R 

1185 DO20 DO 20 process value R 

1187 DO21 DO 21 process value R 

1189 DO22 DO 22 process value R 

1191 DO23 DO 23 process value R 

1193 DO24 DO 24 process value R 

1195 AO1 AO 1 process value R 

1197 AO2 AO 2 process value R 

1199 AO3 AO 3 process value R 

1201 AO4 AO 4 process value R 

1203 AO5 AO 5 process value R 

1205 AO6 AO 6 process value R 

1207 AO7 AO 7 process value R 

1209 AO8 AO 8 process value R 

1211 AO9 AO 9 process value R 

1213 AO10 AO 10 process value R 

1215 AO11 AO 11 process value R 

1217 AO12 AO 12 process value R 

 
Note: If the register value is 3.0+E38, then there is a communication error. 

8.1.1.3 Math Channel Data (Integer Type) 

Modbus 
Address 

Notation Register Name Access 

201 Math1 Math 1 process value high word R 

202 Math1 Math 1 process value low word R 

203 Math2 Math 2 process value high word R 

204 Math2 Math 2 process value low word R 

205 Math3 Math 3 process value high word R 

206 Math3 Math 3 process value low word R 

207 Math4 Math 4 process value high word R 

208 Math4 Math 4 process value low word R 

209 Math5 Math 5 process value high word R 

210 Math5 Math 5 process value low word R 

211 Math6 Math 6 process value high word R 

212 Math6 Math 6 process value low word R 

213 Math7 Math 7 process value high word R 

214 Math7 Math 7 process value low word R 

215 Math8 Math 8 process value high word R 

216 Math8 Math 8 process value low word R 

217 Math9 Math 9 process value high word R 

218 Math9 Math 9 process value low word R 

219 Math10 Math 10 process value high word R 

220 Math10 Math 10 process value low word R 

221 Math11 Math 11 process value high word R 
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Modbus 
Address 

Notation Register Name Access 

222 Math11 Math 11 process value low word R 

223 Math12 Math 12 process value high word R 

224 Math12 Math 12 process value low word R 

225 Math13 Math 13 process value high word R 

226 Math13 Math 13 process value low word R 

227 Math14 Math 14 process value high word R 

228 Math14 Math 14 process value low word R 

229 Math15 Math 15 process value high word R 

230 Math15 Math 15 process value low word R 

231 Math16 Math 16 process value high word R 

232 Math16 Math 16 process value low word R 

233 Math17 Math 17 process value high word R 

234 Math17 Math 17 process value low word R 

235 Math18 Math 18 process value high word R 

236 Math18 Math 18 process value low word R 

237 Math19 Math 19 process value high word R 

238 Math19 Math 19 process value low word R 

239 Math20 Math 20 process value high word R 

240 Math20 Math 20 process value low word R 

241 Math21 Math 21 process value high word R 

242 Math21 Math 21 process value low word R 

243 Math22 Math 22 process value high word R 

244 Math22 Math 22 process value low word R 

245 Math23 Math 23 process value high word R 

246 Math23 Math 23 process value low word R 

247 Math24 Math 24 process value high word R 

248 Math24 Math 24 process value low word R 

249 Math25 Math 25 process value high word R 

250 Math25 Math 25 process value low word R 

251 Math26 Math 26 process value high word R 

252 Math26 Math 26 process value low word R 

253 Math27 Math 27 process value high word R 

254 Math27 Math 27 process value low word R 

255 Math28 Math 28 process value high word R 

256 Math28 Math 28 process value low word R 

257 Math29 Math 29 process value high word R 

258 Math29 Math 29 process value low word R 

259 Math30 Math 30 process value high word R 

260 Math30 Math 30 process value low word R 

261 Math31 Math 31 process value high word R 

262 Math31 Math 31 process value low word R 

263 Math32 Math 32 process value high word R 

264 Math32 Math 32 process value low word R 

265 Math33 Math 33 process value high word R 

266 Math33 Math 33 process value low word R 

267 Math34 Math 34 process value high word R 

268 Math34 Math 34 process value low word R 

269 Math35 Math 35 process value high word R 

270 Math35 Math 35 process value low word R 

271 Math36 Math 36 process value high word R 

272 Math36 Math 36 process value low word R 

273 Math37 Math 37 process value high word R 
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Modbus 
Address 

Notation Register Name Access 

274 Math37 Math 37 process value low word R 

275 Math38 Math 38 process value high word R 

276 Math38 Math 38 process value low word R 

277 Math39 Math 39 process value high word R 

278 Math39 Math 39 process value low word R 

279 Math40 Math 40 process value high word R 

280 Math40 Math 40 process value low word R 

281 Math41 Math 41 process value high word R 

282 Math41 Math 41 process value low word R 

283 Math42 Math 42 process value high word R 

284 Math42 Math 42 process value low word R 

285 Math43 Math 43 process value high word R 

286 Math43 Math 43 process value low word R 

287 Math44 Math 44 process value high word R 

288 Math44 Math 44 process value low word R 

289 Math45 Math 45 process value high word R 

290 Math45 Math 45 process value low word R 

291 Math46 Math 46 process value high word R 

292 Math46 Math 46 process value low word R 

293 Math47 Math 47 process value high word R 

294 Math47 Math 47 process value low word R 

295 Math48 Math 48 process value high word R 

296 Math48 Math 48 process value low word R 

297 Math49 Math 49 process value high word R 

298 Math49 Math 49 process value low word R 

299 Math50 Math 50 process value high word R 

300 Math50 Math 50 process value low word R 

301 Math51 Math 51 process value high word R 

302 Math51 Math 51 process value low word R 

303 Math52 Math 52 process value high word R 

304 Math52 Math 52 process value low word R 

305 Math53 Math 53 process value high word R 

306 Math53 Math 53 process value low word R 

307 Math54 Math 54 process value high word R 

308 Math54 Math 54 process value low word R 

309 Math55 Math 55 process value high word R 

310 Math55 Math 55 process value low word R 

311 Math56 Math 56 process value high word R 

312 Math56 Math 56 process value low word R 

313 Math57 Math 57 process value high word R 

314 Math57 Math 57 process value low word R 

315 Math58 Math 58 process value high word R 

316 Math58 Math 58 process value low word R 

317 Math59 Math 59 process value high word R 

318 Math59 Math 59 process value low word R 

319 Math60 Math 60 process value high word R 

320 Math60 Math 60 process value low word R 

 
Note: If the register value is 4294967294, then there is a communication error. 
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8.1.1.4 Math Channel Data (Float Type) 

Modbus 
Address 

Notation Register Name Access 

1401 Math1 Math 1 process value R 

1403 Math2 Math 2 process value R 

1405 Math3 Math 3 process value R 

1407 Math4 Math 4 process value R 

1409 Math5 Math 5 process value R 

1411 Math6 Math 6 process value R 

1413 Math7 Math 7 process value R 

1415 Math8 Math 8 process value R 

1417 Math9 Math 9 process value R 

1419 Math10 Math 10 process value R 

1421 Math11 Math 11 process value R 

1423 Math12 Math 12 process value R 

1425 Math13 Math 13 process value R 

1427 Math14 Math 14 process value R 

1429 Math15 Math 15 process value R 

1431 Math16 Math 16 process value R 

1433 Math17 Math 17 process value R 

1435 Math18 Math 18 process value R 

1437 Math19 Math 19 process value R 

1439 Math20 Math 20 process value R 

1441 Math21 Math 21 process value R 

1443 Math22 Math 22 process value R 

1445 Math23 Math 23 process value R 

1447 Math24 Math 24 process value R 

1449 Math25 Math 25 process value R 

1451 Math26 Math 26 process value R 

1453 Math27 Math 27 process value R 

1455 Math28 Math 28 process value R 

1457 Math29 Math 29 process value R 

1459 Math30 Math 30 process value R 

1461 Math31 Math 31 process value R 

1463 Math32 Math 32 process value R 

1465 Math33 Math 33 process value R 

1467 Math34 Math 34 process value R 

1469 Math35 Math 35 process value R 

1471 Math36 Math 36 process value R 

1473 Math37 Math 37 process value R 

1475 Math38 Math 38 process value R 

1477 Math39 Math 39 process value R 

1479 Math40 Math 40 process value R 

1481 Math41 Math 41 process value R 

1483 Math42 Math 42 process value R 

1485 Math43 Math 43 process value R 

1487 Math44 Math 44 process value R 

1489 Math45 Math 45 process value R 

1491 Math46 Math 46 process value R 

1493 Math47 Math 47 process value R 

1495 Math48 Math 48 process value R 

1497 Math49 Math 49 process value R 

1499 Math50 Math 50 process value R 
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Modbus 
Address 

Notation Register Name Access 

1501 Math51 Math 51 process value R 

1503 Math52 Math 52 process value R 

1505 Math53 Math 53 process value R 

1507 Math54 Math 54 process value R 

1509 Math55 Math 55 process value R 

1511 Math56 Math 56 process value R 

1513 Math57 Math 57 process value R 

1515 Math58 Math 58 process value R 

1517 Math59 Math 59 process value R 

1519 Math60 Math 60 process value R 

 
Note: If the register value is 3.0+E38, then there is a communication error. 

8.1.1.5 PID Process Control Module Data (Integer Type) 

Modbus  
Address 

Notation Register Name Access 

401 C1_PV Current process value R 
402 C1_SV Current setpoint Value R 

403 C1_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

404 C1_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

405 C1_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

406 C1_MV1 Current output 1 value R 
407 C1_MV2 Current output 2 value R 

408 C1_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

409 C1_ERROR Current error code5 R 

410 C1_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

411 C1_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

412 Reserve Reserve R 
413 C1_SP1 Setpoint 1 R 
414 C1_SP2 Setpoint 2 R 
415 C1_Profile Profile number R 
416 C1_Segment Segment number R 
417 C1_Cycle Cycle remaining for the current loop R 
418 C1_Run Profile running R 
419 C1_Hold Profile held R 
420 C1_Up Running ramp up segment R 
421 C1_Down Running ramp down segment R 
422 C1_Unit Current input unit R 

423 C1_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

424 C2_PV Current process value R 
425 C2_SV Current setpoint Value R 

426 C2_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

427 C2_IN1U 

IN1 unit selection2 
0 : ℃ 

1 : ℉ 
2 : PU 

R 

428 C2_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

429 C2_MV1 Current output 1 value R 
430 C2_MV2 Current output 2 value R 

431 C2_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

432 C2_ERROR Current error code5 R 

433 C2_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

434 C2_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

435 Reserve Reserve R 
436 C2_SP1 Setpoint 1 R 
437 C2_SP2 Setpoint 2 R 
438 C2_Profile Profile number R 
439 C2_Segment Segment number R 
440 C2_Cycle Cycle remaining for the current loop R 
441 C2_Run Profile running R 
442 C2_Hold Profile held R 
443 C2_Up Running ramp up segment R 
444 C2_Down Running ramp down segment R 
445 C2_Unit Current input unit R 

446 C2_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

447 C3_PV Current process value R 
448 C3_SV Current setpoint Value R 

449 C3_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

450 C3_IN1U 

IN1 unit selection2 
0 : ℃ 

1 : ℉ 
2 : PU 

R 

451 C3_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

452 C3_MV1 Current output 1 value R 
453 C3_MV2 Current output 2 value R 

454 C3_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

455 C3_ERROR Current error code5 R 

456 C3_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

457 C3_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

458 Reserve Reserve R 
459 C3_SP1 Setpoint 1 R 
460 C3_SP2 Setpoint 2 R 
461 C3_Profile Profile number R 
462 C3_Segment Segment number R 
463 C3_Cycle Cycle remaining for the current loop R 
464 C3_Run Profile running R 
465 C3_Hold Profile held R 
466 C3_Up Running ramp up segment R 
467 C3_Down Running ramp down segment R 
468 C3_Unit Current input unit R 

469 C3_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

470 C4_PV Current process value R 
471 C4_SV Current setpoint Value R 

472 C4_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

473 C4_IN1U 

IN1 unit selection2 
0 : ℃ 

1 : ℉ 
2 : PU 

R 

474 C4_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

475 C4_MV1 Current output 1 value R 
476 C4_MV2 Current output 2 value R 

477 C4_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

478 C4_ERROR Current error code5 R 

479 C4_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 



 
 

 
 

Page 470 of 550 

Modbus  
Address 

Notation Register Name Access 

480 C4_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

481 Reserve Reserve R 
482 C4_SP1 Setpoint 1 R 
483 C4_SP2 Setpoint 2 R 
484 C4_Profile Profile number R 
485 C4_Segment Segment number R 
486 C4_Cycle Cycle remaining for the current loop R 
487 C4_Run Profile running R 
488 C4_Hold Profile held R 
489 C4_Up Running ramp up segment R 
490 C4_Down Running ramp down segment R 
491 C4_Unit Current input unit R 

492 C4_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

493 C5_PV Current process value R 
494 C5_SV Current setpoint Value R 

495 C5_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

496 C5_IN1U 

IN1 unit selection2 
0 : ℃ 

1 : ℉ 
2 : PU 

R 

497 C5_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

498 C5_MV1 Current output 1 value R 
499 C5_MV2 Current output 2 value R 

500 C5_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

501 C5_ERROR Current error code5 R 

502 C5_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

503 C5_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

504 Reserve Reserve R 
505 C5_SP1 Setpoint 1 R 
506 C5_SP2 Setpoint 2 R 
507 C5_Profile Profile number R 
508 C5_Segment Segment number R 
509 C5_Cycle Cycle remaining for the current loop R 
510 C5_Run Profile running R 
511 C5_Hold Profile held R 
512 C5_Up Running ramp up segment R 
513 C5_Down Running ramp down segment R 
514 C5_Unit Current input unit R 

515 C5_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

516 C6_PV Current process value R 
517 C6_SV Current setpoint Value R 

518 C6_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

519 C6_IN1U 

IN1 unit selection2 
0 : ℃ 

1 : ℉ 
2 : PU 

R 

520 C6_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

521 C6_MV1 Current output 1 value R 
522 C6_MV2 Current output 2 value R 

523 C6_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

524 C6_ERROR Current error code5 R 

525 C6_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

526 C6_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

527 Reserve Reserve R 
528 C6_SP1 Setpoint 1 R 
529 C6_SP2 Setpoint 2 R 
530 C6_Profile Profile number R 
531 C6_Segment Segment number R 
532 C6_Cycle Cycle remaining for the current loop R 
533 C6_Run Profile running R 
534 C6_Hold Profile held R 
535 C6_Up Running ramp up segment R 
536 C6_Down Running ramp down segment R 
537 C6_Unit Current input unit R 

538 C6_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

    

539 C7_PV Current process value R 

540 C7_SV Current setpoint Value R 

541 C7_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

542 C7_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

543 C7_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

544 C7_MV1 Current output 1 value R 

545 C7_MV2 Current output 2 value R 

546 C7_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

547 C7_ERROR Current error code5 R 

548 C7_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 



 
 

 
 

Page 473 of 550 

Modbus  
Address 

Notation Register Name Access 

549 C7_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

550 Reserve Reserve R 

551 C7_SP1 Setpoint 1 R 

552 C7_SP2 Setpoint 2 R 

553 C7_Profile Profile number R 

554 C7_Segment Segment number R 

555 C7_Cycle Cycle remaining for the current loop R 

556 C7_Run Profile running R 

557 C7_Hold Profile held R 

558 C7_Up Running ramp up segment R 

559 C7_Down Running ramp down segment R 

560 C7_Unit Current input unit R 

561 C7_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

562 C8_PV Current process value R 

563 C8_SV Current setpoint Value R 

564 C8_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

565 C8_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

566 C8_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

567 C8_MV1 Current output 1 value R 

568 C8_MV2 Current output 2 value R 

569 C8_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

570 C8_ERROR Current error code5 R 

571 C8_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 
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Modbus  
Address 

Notation Register Name Access 

572 C8_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

573 Reserve Reserve R 

574 C8_SP1 Setpoint 1 R 

575 C8_SP2 Setpoint 2 R 

576 C8_Profile Profile number R 

577 C8_Segment Segment number R 

578 C8_Cycle Cycle remaining for the current loop R 

579 C8_Run Profile running R 

580 C8_Hold Profile held R 

581 C8_Up Running ramp up segment R 

582 C8_Down Running ramp down segment R 

583 C8_Unit Current input unit R 

584 C8_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 
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Note 1: PVMD 
Parameter Value Display Symbol Description 

0 PV1 Use PV1 as process value 

1 PV2 Use PV2 as process value 

2 P1 - 2 Use PV1 - PV2 (difference) as process value 

3 P2 - 1 Use PV2 - PV1 (difference) as process value 

 
Note 2, 3: IN1/IN2 unit 

Parameter Value Display Symbol Description 

0 ℃ Degree C unit 

1 ℉ Degree F unit 

2 PU Process unit 

 
Note 4: ALM 
      MSB                      LSB 
  15     14     13     12   11     10    9        8      7       6      5        4     3        2       1       0 
     
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

=BIN2K 
If BIN2= 8~18, then 
BIN2K=00 
If BIN2=1, then BIN2K=01 
If BIN2=19, 21, 22, 23 then 
BIN2K=10 
Otherwise, BIN2K=11 

 

=BIN1K 
If BIN1<11, then BIN1K=00 
If 11≤ BIN1<17, then 
BIN1K=01 
Otherwise, BIN1K=10 

 

=DP2K=DP2 

 

=DP1K=DP1 

 
=0 

 

=BPVMDK 
If BPVMD=1 then 
BPVMDK=0 
Otherwise BPVMDK=1 

 
=AOFNK 
If AOFN = 0, 2, 3 then 
AOFNK = 00 
If AOFN = 1 then 
AOFNK = 01 
If AOFN = 4, 7 then 
AOFNK = 10 
If AOFN = 5, 6 then 
AOFNK =11 
 

 

=A2FNK 
If A2FN = 8, 9 then 
A2FNK = 0 
Otherwise A2FNK = 1 
 

 

=A1FNK 
If A1FN = 8, 9 then 
A1FNK = 0 
Otherwise A1FNK = 1 
 

 

=ALMK 
=00: No Alarm 
activated 
=01: Alarm 1 
activated 
=10: Alarm 2 
activated 
=11: Alarm 1 & 
alarm 2 activated 
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Note 5: Error Code 
Error Code Error Description 

1 Illegal setup values used: PV1 is used for both PVMD and SPMD that is meaningless for control 

2 Illegal setup values used: PV2 is used for both PVMD and SPMD that is meaningless for control 

3 
Illegal setup values used: P1-2 or P2-1 is used for PVMD while PV1 or PV2 is used for SPMD. Dependent 
values are used for PV and SV will produce the incorrect result of control 

4 
Illegal setup values used: COOL is used for OUT2, but DIRT (cooling action) is already used for OUT1 or 
PID mode is not used for OUT1 (that is PB1 or PB2 =0, and TI1 or TI2 =0) 

5 
Illegal setup values used: unequal IN1U and IN2U or unequal DP1 and DP2 while P1-2 or P2-1 is used for 
PVMD or, PV1 or PV2 is used for SPMD or, P1.2.H, P1.2.L, D1.2.H or D1.2.L are used for A1FN or A2FN 

6 Illegal setup values used: OUT2 select =AL2 but A2FN select NONE 

7 Illegal setup values used: Dwell timer (TIMR) is selected for both A1FN and A2FN 

17 Computing error: Illegal floating-point data 

18 Computing error: Arithmetic result overflow or underflow 

19 Computing error: divided by zero 

20 Computing error: Illegal BCD data entry 

21 Timing error: A to D conversion data error due to overrun 

26 Fail to perform the auto-tuning function 

27 Incorrect calibration procedure or tolerance of analog component too big to meet the specified accuracy 

32 Cold junction compensation device(s) malfunction 

34 Input 2 ( IN2 ) signal too low 

35 Input 2 ( IN2 ) signal too high 

36 Input 1 ( IN1 ) signal too low 

37 Input 1 ( IN1 ) signal too high 

38 
Input 2 ( IN2 ) sensor break, or input 2 current below 1 mA if 4-20 mA is selected, or input 2 voltage below 
0.25V if 1 - 5V is selected 

39 
Input 1 ( IN1 ) sensor break, or input 1 current below 1 mA if 4-20 mA is selected, or input 1 voltage below 
0.25V if 1 - 5V is selected 

40 A to D converter or related component(s) malfunction 

 
Note 6: SPMD 

Parameter Value Display Symbol Description 

0 SP1.2 Use SP1 or SP2 (depends on EIFN) as setpoint 

1 MIN.R Use minute ramp rate as setpoint 

2 HR.R Use hour ramp rate as setpoint 

3 PV1 Use IN1 process value as setpoint 

4 PV2 Use IN2 process value as setpoint 

5 PUMP Selected for pump control 

 
Note 7: EIFN 

Parameter Value Display Symbol Description 

0 NONE Event input no function 

1 SP2 SP2 activated to replace SP1 

2 PID2 PB2, TI2, TD2 activated to replace PB1, TI1, TD1 

3 SP.P2 SP2, PB2, TI2, TD2 activated to replace SP1, PB1, TI1, TD1 

4 RS.A1 Reset alarm 1 output 

5 RS.A2 Reset alarm 2 output 

6 R.A1.2 Reset alarm 1 & alarm 2 

7 D.O1 Disable Output 1 

8 D.O2 Disable Output 2 

9 D.O1.2 Disable Output 1 & Output 2 

10 LOCK Lock all parameters 
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8.1.1.6 PID Process Control Module Data (Float Type) 

Modbus 
Address 

Notation Register Name Access 

1601 C1_PV Current process value R 
1603 C1_SV Current setpoint Value R 

1605 C1_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1607 C1_IN1U 

IN1 unit selection2 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

1609 C1_IN2U 

IN2 unit selection3 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

1611 C1_MV1 Current output 1 value R 
1613 C1_MV2 Current output 2 value R 

1615 C1_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1617 C1_ERROR Current error code5 R 

1619 C1_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1621 C1_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1623 Reserve Reserve R 
1625 C1_SP1 Setpoint 1 R 
1627 C1_SP2 Setpoint 2 R 
1629 C1_Profile Profile number R 
1631 C1_Segment Segment number R 
1633 C1_Cycle Cycle remaining for the current loop R 
1635 C1_Run Profile running R 
1637 C1_Hold Profile held R 
1639 C1_Up Running ramp up segment R 
1641 C1_Down Running ramp down segment R 
1643 C1_Unit Current input unit R 

1645 C1_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 
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Modbus 
Address 

Notation Register Name Access 

1647 C2_PV Current process value R 
1649 C2_SV Current setpoint Value R 

1651 C2_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1653 C2_IN1U 

IN1 unit selection2 

0 : ℃ 
1 : ℉ 
2 : PU 

R 

1655 C2_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1657 C2_MV1 Current output 1 value R 
1659 C2_MV2 Current output 2 value R 

1661 C2_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1663 C2_ERROR Current error code5 R 

1665 C2_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1667 C2_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1669 Reserve Reserve R 
1671 C2_SP1 Setpoint 1 R 
1673 C2_SP2 Setpoint 2 R 
1675 C2_Profile Profile number R 
1677 C2_Segment Segment number R 
1679 C2_Cycle Cycle remaining for the current loop R 
1681 C2_Run Profile running R 
1683 C2_Hold Profile held R 
1685 C2_Up Running ramp up segment R 
1687 C2_Down Running ramp down segment R 
1689 C2_Unit Current input unit R 

1691 C2_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1693 C3_PV Current process value R 
1695 C3_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1697 C3_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1699 C3_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1701 C3_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1703 C3_MV1 Current output 1 value R 
1705 C3_MV2 Current output 2 value R 

1707 C3_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1709 C3_ERROR Current error code5 R 

1711 C3_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1713 C3_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1715 Reserve Reserve R 
1717 C3_SP1 Setpoint 1 R 
1719 C3_SP2 Setpoint 2 R 
1721 C3_Profile Profile number R 
1723 C3_Segment Segment number R 
1725 C3_Cycle Cycle remaining for the current loop R 
1727 C3_Run Profile running R 
1729 C3_Hold Profile held R 
1731 C3_Up Running ramp up segment R 
1733 C3_Down Running ramp down segment R 
1735 C3_Unit Current input unit R 

1737 C3_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1739 C4_PV Current process value R 
1741 C4_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1743 C4_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1745 C4_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1747 C4_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1749 C4_MV1 Current output 1 value R 
1751 C4_MV2 Current output 2 value R 

1753 C4_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1755 C4_ERROR Current error code5 R 

1757 C4_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1759 C4_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1761 Reserve Reserve R 
1763 C4_SP1 Setpoint 1 R 
1765 C4_SP2 Setpoint 2 R 
1767 C4_Profile Profile number R 
1769 C4_Segment Segment number R 
1771 C4_Cycle Cycle remaining for the current loop R 
1773 C4_Run Profile running R 
1775 C4_Hold Profile held R 
1777 C4_Up Running ramp up segment R 
1779 C4_Down Running ramp down segment R 
1781 C4_Unit Current input unit R 

1783 C4_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1785 C5_PV Current process value R 
1787 C5_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1789 C5_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1791 C5_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1793 C5_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1795 C5_MV1 Current output 1 value R 
1797 C5_MV2 Current output 2 value R 

1799 C5_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1801 C5_ERROR Current error code5 R 

1803 C5_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1805 C5_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1807 Reserve Reserve R 
1809 C5_SP1 Setpoint 1 R 
1811 C5_SP2 Setpoint 2 R 
1813 C5_Profile Profile number R 
1815 C5_Segment Segment number R 
1817 C5_Cycle Cycle remaining for the current loop R 
1819 C5_Run Profile running R 
1821 C5_Hold Profile held R 
1823 C5_Up Running ramp up segment R 
1825 C5_Down Running ramp down segment R 
1827 C5_Unit Current input unit R 

1829 C5_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1831 C6_PV Current process value R 
1833 C6_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1835 C6_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1837 C6_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1839 C6_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 
2 : PU 

R 

1841 C6_MV1 Current output 1 value R 
1843 C6_MV2 Current output 2 value R 

1845 C6_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1847 C6_ERROR Current error code5 R 

1849 C6_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1851 C6_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1853 Reserve Reserve R 
1855 C6_SP1 Setpoint 1 R 
1857 C6_SP2 Setpoint 2 R 
1859 C6_Profile Profile number R 
1861 C6_Segment Segment number R 
1863 C6_Cycle Cycle remaining for the current loop R 
1865 C6_Run Profile running R 
1867 C6_Hold Profile held R 
1869 C6_Up Running ramp up segment R 
1871 C6_Down Running ramp down segment R 
1873 C6_Unit Current input unit R 

1875 C6_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1877 C7_PV Current process value R 

1879 C7_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1881 C7_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1883 C7_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

1885 C7_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

1887 C7_MV1 Current output 1 value R 

1889 C7_MV2 Current output 2 value R 

1891 C7_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1893 C7_ERROR Current error code5 R 

1895 C7_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1897 C7_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1899 Reserve Reserve R 

1901 C7_SP1 Setpoint 1 R 

1903 C7_SP2 Setpoint 2 R 

1905 C7_Profile Profile number R 

1907 C7_Segment Segment number R 

1909 C7_Cycle Cycle remaining for the current loop R 

1911 C7_Run Profile running R 

1913 C7_Hold Profile held R 

1915 C7_Up Running ramp up segment R 

1917 C7_Down Running ramp down segment R 

1919 C7_Unit Current input unit R 

1921 C7_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 

1923 C8_PV Current process value R 

1925 C8_SV Current setpoint Value R 
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Modbus 
Address 

Notation Register Name Access 

1927 C8_PVMD 

PV mode selection1 
0 : PV1 
1 : PV2 
2 : PV1 - 2 
3 : PV2 - 1 

R 

1929 C8_IN1U 

IN1 unit selection2 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

1931 C8_IN2U 

IN2 unit selection3 

0 : ℃ 

1 : ℉ 

2 : PU 

R 

1933 C8_MV1 Current output 1 value R 

1935 C8_MV2 Current output 2 value R 

1937 C8_ALM 
Contains conditional code of parameters' resolution and current alarm 
status4 

R 

1939 C8_ERROR Current error code5 R 

1941 C8_SPMD 

Setpoint mode selection6 
0: SP1.2 
1: MIN.R 
2: HR.R 
3: PV1 
4: PV2 
5: PUMP 

R 

1943 C8_EIFN 

Event input function7 
0: None 
1: SP2 
2: PID2 
3: SP.P2 
4: RS.A1 
5: RS.A2 
6: R.A1.2 
7: D.O1 
8: D.O2 
9: D.O1.2 
10: LOCK 

R 

1945 Reserve Reserve R 

1947 C8_SP1 Setpoint 1 R 

1949 C8_SP2 Setpoint 2 R 

1951 C8_Profile Profile number R 

1953 C8_Segment Segment number R 

1955 C8_Cycle Cycle remaining for the current loop R 

1957 C8_Run Profile running R 

1959 C8_Hold Profile held R 

1961 C8_Up Running ramp up segment R 

1963 C8_Down Running ramp down segment R 

1965 C8_Unit Current input unit R 

1967 C8_ProfileERROR 
Profile error 
0: Normal 
1: Holdback timeout 

R 
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8.1.1.7 System Information (Integer Type) 

Modbus Address Register Name Access 

901 Percentage free of internal memory R 

902 Percentage free of external memory R 

 

8.1.1.8 System Information (Float Type) 

Modbus Address Register Name Access 

2901 Percentage free of internal memory R 

2903 Percentage free of external memory R 

8.1.1.9 Alarm Status (Integer Type) 

Modbus Address Register Name Access 

3001 
Alarm Status 

Bit 0: System Alarm 
Bit 1 ~ Bit 15:AI 1 ~AI 15 

R 

3002 
Alarm Status 

Bit 0 ~ Bit 15:AI 16 ~AI 31 
R 

3003 
Alarm Status 

Bit 0 ~ Bit 15:AI 32 ~AI 47 
R 

3004 
Alarm Status 
Bit 0: AI 48 

Bit 1 ~ Bit 15: Math 1 ~ Math 15 
R 

3005 
Alarm Status 

Bit 0 ~ Bit 15: Math 16 ~ Math 31 
R 

3006 
Alarm Status 

Bit 0 ~ Bit 15: Math 32 ~ Math 47 
R 

3007 
Alarm Status 

Bit 0 ~ Bit 12: Math 48 ~ Math 60 
Bit 13 ~ Bit 15: DI 1 ~ DI3 

R 

3008 
Alarm Status 

Bit 0 ~ Bit 15: DI 4 ~ DI 19 
R 

3009 
Alarm Status 

Bit 0 ~ Bit 4: DI 20 ~ DI 24 
Bit 5 ~ Bit 15: Ext 1 ~ Ext11 

R 

3010 
Alarm Status 

Bit 0 ~ Bit 15: Ext 12 ~ Ext 27 
R 

3011 
Alarm Status 

Bit 0 ~ Bit 15: Ext 28 ~ Ext 43 
R 

3012 
Alarm Status 

Bit 0 ~ Bit 15: Ext 44 ~ Ext 59 
R 

3013 
Alarm Status 

Bit 0 ~ Bit 15: Ext 60 ~ Ext 75 
R 

3014 
Alarm Status 

Bit 0 ~ Bit 15: Ext 76 ~ Ext 91 
R 

3015 
Alarm Status 

Bit 0 ~ Bit 4: Ext 92 ~ Ext 96 
R 
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8.1.2 Holding Register (4xxxxx) Parameter Table for Modbus RTU Slave / TCP Server 

8.1.2.1 External Channels 2 Bytes Data (Integer Type)   

Modbus 
Address 

Notation Register Name Access 

1 Ext1 Measured data on External 1 R/W 

2 Ext2 Measured data on External 2 R/W 

3 Ext3 Measured data on External 3 R/W 

4 Ext4 Measured data on External 4 R/W 

5 Ext5 Measured data on External 5 R/W 

6 Ext6 Measured data on External 6 R/W 

7 Ext7 Measured data on External 7 R/W 

8 Ext8 Measured data on External 8 R/W 

9 Ext9 Measured data on External 9 R/W 

10 Ext10 Measured data on External 10 R/W 

11 Ext11 Measured data on External 11 R/W 

12 Ext12 Measured data on External 12 R/W 

13 Ext13 Measured data on External 13 R/W 

14 Ext14 Measured data on External 14 R/W 

15 Ext15 Measured data on External 15 R/W 

16 Ext16 Measured data on External 16 R/W 

17 Ext17 Measured data on External 17 R/W 

18 Ext18 Measured data on External 18 R/W 

19 Ext19 Measured data on External 19 R/W 

20 Ext20 Measured data on External 20 R/W 

21 Ext21 Measured data on External 21 R/W 

22 Ext22 Measured data on External 22 R/W 

23 Ext23 Measured data on External 23 R/W 

24 Ext24 Measured data on External 24 R/W 

25 Ext25 Measured data on External 25 R/W 

26 Ext26 Measured data on External 26 R/W 

27 Ext27 Measured data on External 27 R/W 

28 Ext28 Measured data on External 28 R/W 

29 Ext29 Measured data on External 29 R/W 

30 Ext30 Measured data on External 30 R/W 

31 Ext31 Measured data on External 31 R/W 

32 Ext32 Measured data on External 32 R/W 

33 Ext33 Measured data on External 33 R/W 

34 Ext34 Measured data on External 34 R/W 

35 Ext35 Measured data on External 35 R/W 

36 Ext36 Measured data on External 36 R/W 

37 Ext37 Measured data on External 37 R/W 

38 Ext38 Measured data on External 38 R/W 

39 Ext39 Measured data on External 39 R/W 

40 Ext40 Measured data on External 40 R/W 

41 Ext41 Measured data on External 41 R/W 

42 Ext42 Measured data on External 42 R/W 

43 Ext43 Measured data on External 43 R/W 

44 Ext44 Measured data on External 44 R/W 

45 Ext45 Measured data on External 45 R/W 

46 Ext46 Measured data on External 46 R/W 

47 Ext47 Measured data on External 47 R/W 

48 Ext48 Measured data on External 48 R/W 
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Modbus 
Address 

Notation Register Name Access 

49 Ext49 Measured data on External 49 R/W 

50 Ext50 Measured data on External 50 R/W 

51 Ext51 Measured data on External 51 R/W 

52 Ext52 Measured data on External 52 R/W 

53 Ext53 Measured data on External 53 R/W 

54 Ext54 Measured data on External 54 R/W 

55 Ext55 Measured data on External 55 R/W 

56 Ext56 Measured data on External 56 R/W 

57 Ext57 Measured data on External 57 R/W 

58 Ext58 Measured data on External 58 R/W 

59 Ext59 Measured data on External 59 R/W 

60 Ext60 Measured data on External 60 R/W 

61 Ext61 Measured data on External 61 R/W 

62 Ext62 Measured data on External 62 R/W 

63 Ext63 Measured data on External 63 R/W 

64 Ext64 Measured data on External 64 R/W 

65 Ext65 Measured data on External 65 R/W 

66 Ext66 Measured data on External 66 R/W 

67 Ext67 Measured data on External 67 R/W 

68 Ext68 Measured data on External 68 R/W 

69 Ext69 Measured data on External 69 R/W 

70 Ext70 Measured data on External 70 R/W 

71 Ext71 Measured data on External 71 R/W 

72 Ext72 Measured data on External 72 R/W 

73 Ext73 Measured data on External 73 R/W 

74 Ext74 Measured data on External 74 R/W 

75 Ext75 Measured data on External 75 R/W 

76 Ext76 Measured data on External 76 R/W 

77 Ext77 Measured data on External 77 R/W 

78 Ext78 Measured data on External 78 R/W 

79 Ext79 Measured data on External 79 R/W 

80 Ext80 Measured data on External 80 R/W 

81 Ext81 Measured data on External 81 R/W 

82 Ext82 Measured data on External 82 R/W 

83 Ext83 Measured data on External 83 R/W 

84 Ext84 Measured data on External 84 R/W 

85 Ext85 Measured data on External 85 R/W 

86 Ext86 Measured data on External 86 R/W 

87 Ext87 Measured data on External 87 R/W 

88 Ext88 Measured data on External 88 R/W 

89 Ext89 Measured data on External 89 R/W 

90 Ext90 Measured data on External 90 R/W 

91 Ext91 Measured data on External 91 R/W 

92 Ext92 Measured data on External 92 R/W 

93 Ext93 Measured data on External 93 R/W 

94 Ext94 Measured data on External 94 R/W 

95 Ext95 Measured data on External 95 R/W 

96 Ext96 Measured data on External 96 R/W 

 
Note: If the register value is 65534, then there is a communication error. 
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8.1.2.2 External Channels 4 Bytes Data (Integer Type)   

Modbus 
Address 

Notation Register Name Access 

201 Ext1 The high word of measured data is on External 1 R/W 

202 Ext1 The low word of measured data is on External 1 R/W 

203 Ext2 The high word of measured data is on External 2 R/W 

204 Ext2 The low word of measured data is on External 2 R/W 

205 Ext3 The high word of measured data is on External 3 R/W 

206 Ext3 The low word of measured data is on External 3 R/W 

207 Ext4 The high word of measured data is on External 4 R/W 

208 Ext4 The low word of measured data is on External 4 R/W 

209 Ext5 The high word of measured data is on External 5 R/W 

210 Ext5 The low word of measured data is on External 5 R/W 

211 Ext6 The high word of measured data is on External 6 R/W 

212 Ext6 The low word of measured data is on External 6 R/W 

213 Ext7 The high word of measured data is on External 7 R/W 

214 Ext7 The low word of measured data is on External 7 R/W 

215 Ext8 The high word of measured data is on External 8 R/W 

216 Ext8 The low word of measured data is on External 8 R/W 

217 Ext9 The high word of measured data is on External 9 R/W 

218 Ext9 The low word of measured data is on External 9 R/W 

219 Ext10 The high word of measured data is on External 10 R/W 

220 Ext10 The low word of measured data is on External 10 R/W 

221 Ext11 The high word of measured data is on External 11 R/W 

222 Ext11 The low word of measured data is on External 11 R/W 

223 Ext12 The high word of measured data is on External 12 R/W 

224 Ext12 The low word of measured data is on External 12 R/W 

225 Ext13 The high word of measured data is on External 13 R/W 

226 Ext13 The low word of measured data is on External 13 R/W 

227 Ext14 The high word of measured data is on External 14 R/W 

228 Ext14 The low word of measured data is on External 14 R/W 

229 Ext15 The high word of measured data is on External 15 R/W 

230 Ext15 The low word of measured data is on External 15 R/W 

231 Ext16 The high word of measured data is on External 16 R/W 

232 Ext16 The low word of measured data is on External 16 R/W 

233 Ext17 The high word of measured data is on External 17 R/W 

234 Ext17 The low word of measured data is on External 17 R/W 

235 Ext18 The high word of measured data is on External 18 R/W 

236 Ext18 The low word of measured data is on External 18 R/W 

237 Ext19 The high word of measured data is on External 19 R/W 

238 Ext19 The low word of measured data is on External 19 R/W 

239 Ext20 The high word of measured data is on External 20 R/W 

240 Ext20 The low word of measured data is on External 20 R/W 

241 Ext21 The high word of measured data is on External 21 R/W 

242 Ext21 The low word of measured data is on External 21 R/W 

243 Ext22 The high word of measured data is on External 22 R/W 

244 Ext22 The low word of measured data is on External 22 R/W 

245 Ext23 The high word of measured data is on External 23 R/W 

246 Ext23 The low word of measured data is on External 23 R/W 

247 Ext24 The high word of measured data is on External 24 R/W 

248 Ext24 The low word of measured data is on External 24 R/W 

249 Ext25 The high word of measured data is on External 25 R/W 

250 Ext25 The low word of measured data is on External 25 R/W 
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Modbus 
Address 

Notation Register Name Access 

251 Ext26 The high word of measured data is on External 26 R/W 

252 Ext26 The low word of measured data is on External 26 R/W 

253 Ext27 The high word of measured data is on External 27 R/W 

254 Ext27 The low word of measured data is on External 27 R/W 

255 Ext28 The high word of measured data is on External 28 R/W 

256 Ext28 The low word of measured data is on External 28 R/W 

257 Ext29 The high word of measured data is on External 29 R/W 

258 Ext29 The low word of measured data is on External 29 R/W 

259 Ext30 The high word of measured data is on External 30 R/W 

260 Ext30 The low word of measured data is on External 30 R/W 

261 Ext31 The high word of measured data is on External 31 R/W 

262 Ext31 The low word of measured data is on External 31 R/W 

263 Ext32 The high word of measured data is on External 32 R/W 

264 Ext32 The low word of measured data is on External 32 R/W 

265 Ext33 The high word of measured data is on External 33 R/W 

266 Ext33 The low word of measured data is on External 33 R/W 

267 Ext34 The high word of measured data is on External 34 R/W 

268 Ext34 The low word of measured data is on External 34 R/W 

269 Ext35 The high word of measured data is on External 35 R/W 

270 Ext35 The high word of measured data is on External 35 R/W 

271 Ext36 The high word of measured data is on External 36 R/W 

272 Ext36 The low word of measured data is on External 36 R/W 

273 Ext37 The high word of measured data is on External 37 R/W 

274 Ext37 The low word of measured data is on External 37 R/W 

275 Ext38 The high word of measured data is on External 38 R/W 

276 Ext38 The low word of measured data is on External 38 R/W 

277 Ext39 The high word of measured data is on External 39 R/W 

278 Ext39 The low word of measured data is on External 39 R/W 

279 Ext40 The high word of measured data is on External 40 R/W 

280 Ext40 The low word of measured data is on External 40 R/W 

281 Ext41 The high word of measured data is on External 41 R/W 

282 Ext41 The low word of measured data is on External 41 R/W 

283 Ext42 The high word of measured data is on External 42 R/W 

284 Ext42 The low word of measured data is on External 42 R/W 

285 Ext43 The high word of measured data is on External 43 R/W 

286 Ext43 The low word of measured data is on External 43 R/W 

287 Ext44 The high word of measured data is on External 44 R/W 

288 Ext44 The low word of measured data is on External 44 R/W 

289 Ext45 The high word of measured data is on External 45 R/W 

290 Ext45 The low word of measured data is on External 45 R/W 

291 Ext46 The high word of measured data is on External 46 R/W 

292 Ext46 The low word of measured data is on External 46 R/W 

293 Ext47 The high word of measured data is on External 47 R/W 

294 Ext47 The low word of measured data is on External 47 R/W 

295 Ext48 The high word of measured data is on External 48 R/W 

296 Ext48 The low word of measured data is on External 48 R/W 

297 Ext49 The high word of measured data is on External 49 R/W 

298 Ext49 The low word of measured data is on External 49 R/W 

299 Ext50 The high word of measured data is on External 50 R/W 

300 Ext50 The low word of measured data is on External 50 R/W 

301 Ext51 The high word of measured data is on External 51 R/W 

302 Ext51 The low word of measured data is on External 51 R/W 
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Modbus 
Address 

Notation Register Name Access 

303 Ext52 The high word of measured data is on External 52 R/W 

304 Ext52 The low word of measured data is on External 52 R/W 

305 Ext53 The high word of measured data is on External 53 R/W 

306 Ext53 The low word of measured data is on External 53 R/W 

307 Ext54 The high word of measured data is on External 54 R/W 

308 Ext54 The low word of measured data is on External 54 R/W 

309 Ext55 The high word of measured data is on External 55 R/W 

310 Ext55 The low word of measured data is on External 55 R/W 

311 Ext56 The high word of measured data is on External 56 R/W 

312 Ext56 The low word of measured data is on External 56 R/W 

313 Ext57 The high word of measured data is on External 57 R/W 

314 Ext57 The low word of measured data is on External 57 R/W 

315 Ext58 The high word of measured data is on External 58 R/W 

316 Ext58 The low word of measured data is on External 58 R/W 

317 Ext59 The high word of measured data is on External 59 R/W 

318 Ext59 The low word of measured data is on External 59 R/W 

319 Ext60 The high word of measured data is on External 60 R/W 

320 Ext60 The low word of measured data is on External 60 R/W 

321 Ext61 The high word of measured data is on External 61 R/W 

322 Ext61 The low word of measured data is on External 61 R/W 

323 Ext62 The high word of measured data is on External 62 R/W 

324 Ext62 The low word of measured data is on External 62 R/W 

325 Ext63 The high word of measured data is on External 63 R/W 

326 Ext63 The low word of measured data is on External 63 R/W 

327 Ext64 The high word of measured data is on External 64 R/W 

328 Ext64 The low word of measured data is on External 64 R/W 

329 Ext65 The high word of measured data is on External 65 R/W 

330 Ext65 The low word of measured data is on External 65 R/W 

331 Ext66 The high word of measured data is on External 66 R/W 

332 Ext66 The low word of measured data is on External 66 R/W 

333 Ext67 The high word of measured data is on External 67 R/W 

334 Ext67 The low word of measured data is on External 67 R/W 

335 Ext68 The high word of measured data is on External 68 R/W 

336 Ext68 The low word of measured data is on External 68 R/W 

337 Ext69 The high word of measured data is on External 69 R/W 

338 Ext69 The low word of measured data is on External 69 R/W 

339 Ext70 The high word of measured data is on External 70 R/W 

340 Ext70 The low word of measured data is on External 70 R/W 

341 Ext71 The high word of measured data is on External 71 R/W 

342 Ext71 The low word of measured data is on External 71 R/W 

343 Ext72 The high word of measured data is on External 72 R/W 

344 Ext72 The low word of measured data is on External 72 R/W 

345 Ext73 The high word of measured data is on External 73 R/W 

346 Ext73 The low word of measured data is on External 73 R/W 

347 Ext74 The high word of measured data is on External 74 R/W 

348 Ext74 The low word of measured data is on External 74 R/W 

349 Ext75 The high word of measured data is on External 75 R/W 

350 Ext75 The low word of measured data is on External 75 R/W 

351 Ext76 The high word of measured data is on External 76 R/W 

352 Ext76 The low word of measured data is on External 76 R/W 

353 Ext77 The high word of measured data is on External 77 R/W 

354 Ext77 The low word of measured data is on External 77 R/W 
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Modbus 
Address 

Notation Register Name Access 

355 Ext78 The high word of measured data is on External 78 R/W 

356 Ext78 The low word of measured data is on External 78 R/W 

357 Ext79 The high word of measured data is on External 79 R/W 

358 Ext79 The low word of measured data is on External 79 R/W 

359 Ext80 The high word of measured data is on External 80 R/W 

360 Ext80 The low word of measured data is on External 80 R/W 

361 Ext81 The high word of measured data is on External 81 R/W 

362 Ext81 The low word of measured data is on External 81 R/W 

363 Ext82 The high word of measured data is on External 82 R/W 

364 Ext82 The low word of measured data is on External 82 R/W 

365 Ext83 The high word of measured data is on External 83 R/W 

366 Ext83 The low word of measured data is on External 83 R/W 

367 Ext84 The high word of measured data is on External 84 R/W 

368 Ext84 The low word of measured data is on External 84 R/W 

369 Ext85 The high word of measured data is on External 85 R/W 

370 Ext85 The low word of measured data is on External 85 R/W 

371 Ext86 The high word of measured data is on External 86 R/W 

372 Ext86 The low word of measured data is on External 86 R/W 

373 Ext87 The high word of measured data is on External 87 R/W 

374 Ext87 The low word of measured data is on External 87 R/W 

375 Ext88 The high word of measured data is on External 88 R/W 

376 Ext88 The low word of measured data is on External 88 R/W 

377 Ext89 The high word of measured data is on External 89 R/W 

378 Ext89 The low word of measured data is on External 89 R/W 

379 Ext90 The high word of measured data is on External 90 R/W 

380 Ext90 The low word of measured data is on External 90 R/W 

381 Ext91 The high word of measured data is on External 91 R/W 

382 Ext91 The low word of measured data is on External 91 R/W 

383 Ext92 The high word of measured data is on External 92 R/W 

384 Ext92 The low word of measured data is on External 92 R/W 

385 Ext93 The high word of measured data is on External 93 R/W 

386 Ext93 The low word of measured data is on External 93 R/W 

387 Ext94 The high word of measured data is on External 94 R/W 

388 Ext94 The low word of measured data is on External 94 R/W 

389 Ext95 The high word of measured data is on External 95 R/W 

390 Ext95 The low word of measured data is on External 95 R/W 

391 Ext96 The high word of measured data is on External 96 R/W 

392 Ext96 The low word of measured data is on External 96 R/W 

 
Note: If the register value is 4294967294, then there is a communication error. 
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8.1.2.3 External Channels 4 Bytes Data (Float Type)   

Modbus 
Address 

Notation Register Name Access 

1001 Ext1 Measured data on External 1 R/W 

1003 Ext2 Measured data on External 2 R/W 

1005 Ext3 Measured data on External 3 R/W 

1007 Ext4 Measured data on External 4 R/W 

1009 Ext5 Measured data on External 5 R/W 

1011 Ext6 Measured data on External 6 R/W 

1013 Ext7 Measured data on External 7 R/W 

1015 Ext8 Measured data on External 8 R/W 

1017 Ext9 Measured data on External 9 R/W 

1019 Ext10 Measured data on External 10 R/W 

1021 Ext11 Measured data on External 11 R/W 

1023 Ext12 Measured data on External 12 R/W 

1025 Ext13 Measured data on External 13 R/W 

1027 Ext14 Measured data on External 14 R/W 

1029 Ext15 Measured data on External 15 R/W 

1031 Ext16 Measured data on External 16 R/W 

1033 Ext17 Measured data on External 17 R/W 

1035 Ext18 Measured data on External 18 R/W 

1037 Ext19 Measured data on External 19 R/W 

1039 Ext20 Measured data on External 20 R/W 

1041 Ext21 Measured data on External 21 R/W 

1043 Ext22 Measured data on External 22 R/W 

1045 Ext23 Measured data on External 23 R/W 

1047 Ext24 Measured data on External 24 R/W 

1049 Ext25 Measured data on External 25 R/W 

1051 Ext26 Measured data on External 26 R/W 

1053 Ext27 Measured data on External 27 R/W 

1055 Ext28 Measured data on External 28 R/W 

1057 Ext29 Measured data on External 29 R/W 

1059 Ext30 Measured data on External 30 R/W 

1061 Ext31 Measured data on External 31 R/W 

1063 Ext32 Measured data on External 32 R/W 

1065 Ext33 Measured data on External 33 R/W 

1067 Ext34 Measured data on External 34 R/W 

1069 Ext35 Measured data on External 35 R/W 

1071 Ext36 Measured data on External 36 R/W 

1073 Ext37 Measured data on External 37 R/W 

1075 Ext38 Measured data on External 38 R/W 

1077 Ext39 Measured data on External 39 R/W 

1079 Ext40 Measured data on External 40 R/W 

1081 Ext41 Measured data on External 41 R/W 

1083 Ext42 Measured data on External 42 R/W 

1085 Ext43 Measured data on External 43 R/W 

1087 Ext44 Measured data on External 44 R/W 

1089 Ext45 Measured data on External 45 R/W 

1091 Ext46 Measured data on External 46 R/W 

1093 Ext47 Measured data on External 47 R/W 

1095 Ext48 Measured data on External 48 R/W 

1097 Ext49 Measured data on External 49 R/W 

1099 Ext50 Measured data on External 50 R/W 
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Modbus 
Address 

Notation Register Name Access 

1101 Ext51 Measured data on External 51 R/W 

1103 Ext52 Measured data on External 52 R/W 

1105 Ext53 Measured data on External 53 R/W 

1107 Ext54 Measured data on External 54 R/W 

1109 Ext55 Measured data on External 55 R/W 

1111 Ext56 Measured data on External 56 R/W 

1113 Ext57 Measured data on External 57 R/W 

1115 Ext58 Measured data on External 58 R/W 

1117 Ext59 Measured data on External 59 R/W 

1119 Ext60 Measured data on External 60 R/W 

1121 Ext61 Measured data on External 61 R/W 

1123 Ext62 Measured data on External 62 R/W 

1125 Ext63 Measured data on External 63 R/W 

1127 Ext64 Measured data on External 64 R/W 

1129 Ext65 Measured data on External 65 R/W 

1131 Ext66 Measured data on External 66 R/W 

1133 Ext67 Measured data on External 67 R/W 

1135 Ext68 Measured data on External 68 R/W 

1137 Ext69 Measured data on External 69 R/W 

1139 Ext70 Measured data on External 70 R/W 

1141 Ext71 Measured data on External 71 R/W 

1143 Ext72 Measured data on External 72 R/W 

1145 Ext73 Measured data on External 73 R/W 

1147 Ext74 Measured data on External 74 R/W 

1149 Ext75 Measured data on External 75 R/W 

1151 Ext76 Measured data on External 76 R/W 

1153 Ext77 Measured data on External 77 R/W 

1155 Ext78 Measured data on External 78 R/W 

1157 Ext79 Measured data on External 79 R/W 

1159 Ext80 Measured data on External 80 R/W 

1161 Ext81 Measured data on External 81 R/W 

1163 Ext82 Measured data on External 82 R/W 

1165 Ext83 Measured data on External 83 R/W 

1167 Ext84 Measured data on External 84 R/W 

1169 Ext85 Measured data on External 85 R/W 

1171 Ext86 Measured data on External 86 R/W 

1173 Ext87 Measured data on External 87 R/W 

1175 Ext88 Measured data on External 88 R/W 

1177 Ext89 Measured data on External 89 R/W 

1179 Ext90 Measured data on External 90 R/W 

1181 Ext91 Measured data on External 91 R/W 

1183 Ext92 Measured data on External 92 R/W 

1185 Ext93 Measured data on External 93 R/W 

1187 Ext94 Measured data on External 94 R/W 

1189 Ext95 Measured data on External 95 R/W 

1191 Ext96 Measured data on External 96 R/W 

 
Note: If the register value is 3.0+E38, then there is a communication error. 
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8.1.3 Holding Register Parameter Table for Remote Command 

8.1.3.1 Command Data 

Modbus 
Address 

Register Name Note Access 

10002 Start / Stop data log 
0 : Stop 
1 : Start 

R/W 

10003 Year 2000 ~ 2030 W 

10004 Month 1 ~ 12 W 

10005 Day 1 ~ 31 W 

10006 Hour 0 ~ 23 W 

10007 Minute 0 ~ 59 W 

10008 Second 0 ~ 59 W 

10102 Batch Name 
Include 2 characters for each 

register○1 
R/W 

10103 Batch Name  R/W 

10104 Batch Name  R/W 

10105 Batch Name  R/W 

10106 Batch Name  R/W 

10107 Batch Name  R/W 

10108 Batch Name  R/W 

10109 Batch Name  R/W 

10110 Batch Name  R/W 

10111 Batch Name  R/W 

10112 Batch Name  R/W 

10113 Batch Name  R/W 

10114 Batch Name  R/W 

10115 Batch Name  R/W 

10116 Batch Name  R/W 

10117 Batch Name  R/W 

10118 Batch Name  R/W 

10119 Batch Name  R/W 

10120 Lot NO. 1 ~ 65535 R/W 

10121 Comment1 
Include 2 characters for each 

register○1 
R/W 

10122 Comment1  R/W 

10123 Comment1  R/W 

10124 Comment1  R/W 

10125 Comment1  R/W 

10126 Comment1  R/W 

10127 Comment1  R/W 

10128 Comment1  R/W 

10129 Comment1  R/W 

10130 Comment1  R/W 

10131 Comment1  R/W 

10132 Comment1  R/W 

10133 Comment1  R/W 

10134 Comment1  R/W 

10135 Comment1  R/W 

10136 Comment1  R/W 

10137 Comment1  R/W 

10138 Comment1  R/W 

10139 Comment1  R/W 

10140 Comment1  R/W 
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10141 Comment1  R/W 

10142 Comment1  R/W 

10143 Comment1  R/W 

10144 Comment1  R/W 

10145 Comment1  R/W 

10146 Comment1  R/W 

10147 Comment1  R/W 

10148 Comment1  R/W 

10149 Comment1  R/W 

10150 Comment1  R/W 

10151 Comment1  R/W 

10152 Comment1  R/W 

10153 Comment1  R/W 

10154 Comment1  R/W 

10155 Comment1  R/W 

10156 Comment1  R/W 

10157 Comment2  R/W 

10158 Comment2  R/W 

10159 Comment2  R/W 

10160 Comment2  R/W 

10161 Comment2  R/W 

10162 Comment2  R/W 

10163 Comment2  R/W 

10164 Comment2  R/W 

10165 Comment2  R/W 

10166 Comment2  R/W 

10167 Comment2  R/W 

10168 Comment2  R/W 

10169 Comment2  R/W 

10170 Comment2  R/W 

10171 Comment2  R/W 

10172 Comment2  R/W 

10173 Comment2  R/W 

10174 Comment2  R/W 

10175 Comment2  R/W 

10176 Comment2  R/W 

10177 Comment2  R/W 

10178 Comment2  R/W 

10179 Comment2  R/W 

10180 Comment2  R/W 

10181 Comment2  R/W 

10182 Comment2  R/W 

10183 Comment2  R/W 

10184 Comment2  R/W 

10185 Comment2  R/W 

10186 Comment2  R/W 

10187 Comment2  R/W 

10188 Comment2  R/W 

10189 Comment2  R/W 

10190 Comment2  R/W 

10191 Comment2  R/W 

10192 Comment2  R/W 
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10193 Comment3  R/W 

10194 Comment3  R/W 

10195 Comment3  R/W 

10196 Comment3  R/W 

10197 Comment3  R/W 

10198 Comment3  R/W 

10199 Comment3  R/W 

10200 Comment3  R/W 

10201 Comment3  R/W 

10202 Comment3  R/W 

10203 Comment3  R/W 

10204 Comment3  R/W 

10205 Comment3  R/W 

10206 Comment3  R/W 

10207 Comment3  R/W 

10208 Comment3  R/W 

10209 Comment3  R/W 

10210 Comment3  R/W 

10211 Comment3  R/W 

10212 Comment3  R/W 

10213 Comment3  R/W 

10214 Comment3  R/W 

10215 Comment3  R/W 

10216 Comment3  R/W 

10217 Comment3  R/W 

10218 Comment3  R/W 

10219 Comment3  R/W 

10220 Comment3  R/W 

10221 Comment3  R/W 

10222 Comment3  R/W 

10223 Comment3  R/W 

10224 Comment3  R/W 

10225 Comment3  R/W 

10226 Comment3  R/W 

10227 Comment3  R/W 

10228 Comment3  R/W 

10229 Comment4  R/W 

10230 Comment4  R/W 

10231 Comment4  R/W 

10232 Comment4  R/W 

10233 Comment4  R/W 

10234 Comment4  R/W 

10235 Comment4  R/W 

10236 Comment4  R/W 

10237 Comment4  R/W 

10238 Comment4  R/W 

10239 Comment4  R/W 

10240 Comment4  R/W 

10241 Comment4  R/W 

10242 Comment4  R/W 

10243 Comment4  R/W 

10244 Comment4  R/W 
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10245 Comment4  R/W 

10246 Comment4  R/W 

10247 Comment4  R/W 

10248 Comment4  R/W 

10249 Comment4  R/W 

10250 Comment4  R/W 

10251 Comment4  R/W 

10252 Comment4  R/W 

10253 Comment4  R/W 

10254 Comment4  R/W 

10255 Comment4  R/W 

10256 Comment4  R/W 

10257 Comment4  R/W 

10258 Comment4  R/W 

10259 Comment4  R/W 

10260 Comment4  R/W 

10261 Comment4  R/W 

10262 Comment4  R/W 

10263 Comment4  R/W 

10264 Comment4  R/W 

10265 Comment5  R/W 

10266 Comment5  R/W 

10267 Comment5  R/W 

10268 Comment5  R/W 

10269 Comment5  R/W 

10270 Comment5  R/W 

10271 Comment5  R/W 

10272 Comment5  R/W 

10273 Comment5  R/W 

10274 Comment5  R/W 

10275 Comment5  R/W 

10276 Comment5  R/W 

10277 Comment5  R/W 

10278 Comment5  R/W 

10279 Comment5  R/W 

10280 Comment5  R/W 

10281 Comment5  R/W 

10282 Comment5  R/W 

10283 Comment5  R/W 

10284 Comment5  R/W 

10285 Comment5  R/W 

10286 Comment5  R/W 

10287 Comment5  R/W 

10288 Comment5  R/W 

10289 Comment5  R/W 

10290 Comment5  R/W 

10291 Comment5  R/W 

10292 Comment5  R/W 

10293 Comment5  R/W 

10294 Comment5  R/W 

10295 Comment5  R/W 

10296 Comment5  R/W 
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10297 Comment5  R/W 

10298 Comment5  R/W 

10299 Comment5  R/W 

10300 Comment5  R/W 

10301 Comment6  R/W 

10302 Comment6  R/W 

10303 Comment6  R/W 

10304 Comment6  R/W 

10305 Comment6  R/W 

10306 Comment6  R/W 

10307 Comment6  R/W 

10308 Comment6  R/W 

10309 Comment6  R/W 

10310 Comment6  R/W 

10311 Comment6  R/W 

10312 Comment6  R/W 

10313 Comment6  R/W 

10314 Comment6  R/W 

10315 Comment6  R/W 

10316 Comment6  R/W 

10317 Comment6  R/W 

10318 Comment6  R/W 

10319 Comment6  R/W 

10320 Comment6  R/W 

10321 Comment6  R/W 

10322 Comment6  R/W 

10323 Comment6  R/W 

10324 Comment6  R/W 

10325 Comment6  R/W 

10326 Comment6  R/W 

10327 Comment6  R/W 

10328 Comment6  R/W 

10329 Comment6  R/W 

10330 Comment6  R/W 

10331 Comment6  R/W 

10332 Comment6  R/W 

10333 Comment6  R/W 

10334 Comment6  R/W 

10335 Comment6  R/W 

10336 Comment6  R/W 

10337 Comment7  R/W 

10338 Comment7  R/W 

10339 Comment7  R/W 

10340 Comment7  R/W 

10341 Comment7  R/W 

10342 Comment7  R/W 

10343 Comment7  R/W 

10344 Comment7  R/W 

10345 Comment7  R/W 

10346 Comment7  R/W 

10347 Comment7  R/W 

10348 Comment7  R/W 
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10349 Comment7  R/W 

10350 Comment7  R/W 

10351 Comment7  R/W 

10352 Comment7  R/W 

10353 Comment7  R/W 

10354 Comment7  R/W 

10355 Comment7  R/W 

10356 Comment7  R/W 

10357 Comment7  R/W 

10358 Comment7  R/W 

10359 Comment7  R/W 

10360 Comment7  R/W 

10361 Comment7  R/W 

10362 Comment7  R/W 

10363 Comment7  R/W 

10364 Comment7  R/W 

10365 Comment7  R/W 

10366 Comment7  R/W 

10367 Comment7  R/W 

10368 Comment7  R/W 

10369 Comment7  R/W 

10370 Comment7  R/W 

10371 Comment7  R/W 

10372 Comment7  R/W 

10373 Comment8  R/W 

10374 Comment8  R/W 

10375 Comment8  R/W 

10376 Comment8  R/W 

10377 Comment8  R/W 

10378 Comment8  R/W 

10379 Comment8  R/W 

10380 Comment8  R/W 

10381 Comment8  R/W 

10382 Comment8  R/W 

10383 Comment8  R/W 

10384 Comment8  R/W 

10385 Comment8  R/W 

10386 Comment8  R/W 

10387 Comment8  R/W 

10388 Comment8  R/W 

10389 Comment8  R/W 

10390 Comment8  R/W 

10391 Comment8  R/W 

10392 Comment8  R/W 

10393 Comment8  R/W 

10394 Comment8  R/W 

10395 Comment8  R/W 

10396 Comment8  R/W 

10397 Comment8  R/W 

10398 Comment8  R/W 

10399 Comment8  R/W 

10400 Comment8  R/W 
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10401 Comment8  R/W 

10402 Comment8  R/W 

10403 Comment8  R/W 

10404 Comment8  R/W 

10405 Comment8  R/W 

10406 Comment8  R/W 

10407 Comment8  R/W 

10408 Comment8  R/W 

10409 Comment9  R/W 

10410 Comment9  R/W 

10411 Comment9  R/W 

10412 Comment9  R/W 

10413 Comment9  R/W 

10414 Comment9  R/W 

10415 Comment9  R/W 

10416 Comment9  R/W 

10417 Comment9  R/W 

10418 Comment9  R/W 

10419 Comment9  R/W 

10420 Comment9  R/W 

10421 Comment9  R/W 

10422 Comment9  R/W 

10423 Comment9  R/W 

10424 Comment9  R/W 

10425 Comment9  R/W 

10426 Comment9  R/W 

10427 Comment9  R/W 

10428 Comment9  R/W 

10429 Comment9  R/W 

10430 Comment9  R/W 

10431 Comment9  R/W 

10432 Comment9  R/W 

10433 Comment9  R/W 

10434 Comment9  R/W 

10435 Comment9  R/W 

10436 Comment9  R/W 

10437 Comment9  R/W 

10438 Comment9  R/W 

10439 Comment9  R/W 

10440 Comment9  R/W 

10441 Comment9  R/W 

10442 Comment9  R/W 

10443 Comment9  R/W 

10444 Comment9  R/W 

10445 Comment10  R/W 

10446 Comment10  R/W 

10447 Comment10  R/W 

10448 Comment10  R/W 

10449 Comment10  R/W 

10450 Comment10  R/W 

10451 Comment10  R/W 

10452 Comment10  R/W 
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10453 Comment10  R/W 

10454 Comment10  R/W 

10455 Comment10  R/W 

10456 Comment10  R/W 

10457 Comment10  R/W 

10458 Comment10  R/W 

10459 Comment10  R/W 

10460 Comment10  R/W 

10461 Comment10  R/W 

10462 Comment10  R/W 

10463 Comment10  R/W 

10464 Comment10  R/W 

10465 Comment10  R/W 

10466 Comment10  R/W 

10467 Comment10  R/W 

10468 Comment10  R/W 

10469 Comment10  R/W 

10470 Comment10  R/W 

10471 Comment10  R/W 

10472 Comment10  R/W 

10473 Comment10  R/W 

10474 Comment10  R/W 

10475 Comment10  R/W 

10476 Comment10  R/W 

10477 Comment10  R/W 

10478 Comment10  R/W 

10479 Comment10  R/W 

10480 Comment10  R/W 

10481 Description  R/W 

10482 Description  R/W 

10483 Description  R/W 

10484 Description  R/W 

10485 Description  R/W 

10486 Description  R/W 

10487 Description  R/W 

10488 Description  R/W 

10489 Description  R/W 

10490 Description  R/W 

10491 Description  R/W 

10492 Description  R/W 

10493 Description  R/W 

10494 Description  R/W 

10495 Description  R/W 

10496 Description  R/W 

10497 Description  R/W 

10498 Description  R/W 

10499 Description  R/W 

10500 Description  R/W 

10501 Description  R/W 

10502 Description  R/W 

10503 Description  R/W 

10504 Description  R/W 
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10505 Description  R/W 

10506 Description  R/W 

10507 Description  R/W 

10508 Description  R/W 

10509 Description  R/W 

10510 Description  R/W 

10511 Description  R/W 

10512 Description  R/W 

10513 Description  R/W 

10514 Description  R/W 

10515 Description  R/W 

10516 Description  R/W 

10517 Description  R/W 

10518 Description  R/W 

10519 Description  R/W 

10520 Description  R/W 

10521 Description  R/W 

10522 Description  R/W 

10523 Description  R/W 

10524 Description  R/W 

10525 Description  R/W 

10526 Description  R/W 

10527 Description  R/W 

10528 Description  R/W 

10529 Description  R/W 

10530 Description  R/W 

8.1.3.2 Scale Low (DWord Type) 

Modbus Address Register Name Note Access 

4001 The low word of Scale Low data is on AI1  R/W 

4002 The high word of Scale Low data is on AI1  R/W 

4003 The low word of Scale Low data is on AI2  R/W 

4004 The high word of Scale Low data is on AI2  R/W 

4005 The low word of Scale Low data is on AI3  R/W 

4006 The high word of Scale Low data is on AI3  R/W 

4007 The low word of Scale Low data is on AI4  R/W 

4008 The high word of Scale Low data is on AI4  R/W 

4009 The low word of Scale Low data is on AI5  R/W 

4010 The high word of Scale Low data is on AI5  R/W 

4011 The low word of Scale Low data is on AI6  R/W 

4012 The high word of Scale Low data is on AI6  R/W 

4013 The low word of Scale Low data is on AI7  R/W 

4014 The high word of Scale Low data is on AI7  R/W 

4015 The low word of Scale Low data is on AI8  R/W 

4016 The high word of Scale Low data is on AI8  R/W 

4017 The low word of Scale Low data is on AI9  R/W 

4018 The high word of Scale Low data is on AI9  R/W 

4019 The low word of Scale Low data is on AI10  R/W 

4020 The high word of Scale Low data is on AI10  R/W 

4021 The low word of Scale Low data is on AI11  R/W 

4022 The high word of Scale Low data is on AI11  R/W 

4023 The low word of Scale Low data is on AI12  R/W 
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4024 The high word of Scale Low data is on AI12  R/W 

4025 The low word of Scale Low data is on AI13  R/W 

4026 The high word of Scale Low data is on AI13  R/W 

4027 The low word of Scale Low data is on AI14  R/W 

4028 The high word of Scale Low data is on AI14  R/W 

4029 The low word of Scale Low data is on AI15  R/W 

4030 The high word of Scale Low data is on AI15  R/W 

4031 The low word of Scale Low data is on AI16  R/W 

4032 The high word of Scale Low data is on AI16  R/W 

4033 The low word of Scale Low data is on AI17  R/W 

4034 The high word of Scale Low data is on AI17  R/W 

4035 The low word of Scale Low data is on AI18  R/W 

4036 The high word of Scale Low data is on AI18  R/W 

4037 The low word of Scale Low data is on AI19  R/W 

4038 The high word of Scale Low data is on AI19  R/W 

4039 The low word of Scale Low data is on AI20  R/W 

4040 The high word of Scale Low data is on AI20  R/W 

4041 The low word of Scale Low data is on AI21  R/W 

4042 The high word of Scale Low data is on AI21  R/W 

4043 The low word of Scale Low data is on AI22  R/W 

4044 The high word of Scale Low data is on AI22  R/W 

4045 The low word of Scale Low data is on AI23  R/W 

4046 The high word of Scale Low data is on AI23  R/W 

4047 The low word of Scale Low data is on AI24  R/W 

4048 The high word of Scale Low data is on AI24  R/W 

4049 The low word of Scale Low data is on AI25  R/W 

4050 The high word of Scale Low data is on AI25  R/W 

4051 The low word of Scale Low data is on AI26  R/W 

4052 The high word of Scale Low data is on AI26  R/W 

4053 The low word of Scale Low data is on AI27  R/W 

4054 The high word of Scale Low data is on AI27  R/W 

4055 The low word of Scale Low data is on AI28  R/W 

4056 The high word of Scale Low data is on AI28  R/W 

4057 The low word of Scale Low data is on AI29  R/W 

4058 The high word of Scale Low data is on AI29  R/W 

4059 The low word of Scale Low data is on AI30  R/W 

4060 The high word of Scale Low data is on AI30  R/W 

4061 The low word of Scale Low data is on AI31  R/W 

4062 The high word of Scale Low data is on AI31  R/W 

4063 The low word of Scale Low data is on AI32  R/W 

4064 The high word of Scale Low data is on AI32  R/W 

4065 The low word of Scale Low data is on AI33  R/W 

4066 The high word of Scale Low data is on AI33  R/W 

4067 The low word of Scale Low data is on AI34  R/W 

4068 The high word of Scale Low data is on AI34  R/W 

4069 The low word of Scale Low data is on AI35  R/W 

4070 The high word of Scale Low data is on AI35  R/W 

4071 The low word of Scale Low data is on AI36  R/W 

4072 The high word of Scale Low data is on AI36  R/W 

4073 The low word of Scale Low data is on AI37  R/W 

4074 The high word of Scale Low data is on AI37  R/W 

4075 The low word of Scale Low data is on AI38  R/W 

4076 The high word of Scale Low data is on AI38  R/W 
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4077 The low word of Scale Low data is on AI39  R/W 

4078 The high word of Scale Low data is on AI39  R/W 

4079 The low word of Scale Low data is on AI40  R/W 

4080 The high word of Scale Low data is on AI40  R/W 

4081 The low word of Scale Low data is on AI41  R/W 

4082 The high word of Scale Low data is on AI41  R/W 

4083 The low word of Scale Low data is on AI42  R/W 

4084 The high word of Scale Low data is on AI42  R/W 

4085 The low word of Scale Low data is on AI43  R/W 

4086 The high word of Scale Low data is on AI43  R/W 

4087 The low word of Scale Low data is on AI44  R/W 

4088 The high word of Scale Low data is on AI44  R/W 

4089 The low word of Scale Low data is on AI45  R/W 

4090 The high word of Scale Low data is on AI45  R/W 

4091 The low word of Scale Low data is on AI46  R/W 

4492 The high word of Scale Low data is on AI46  R/W 

4093 The low word of Scale Low data is on AI47  R/W 

4094 The high word of Scale Low data is on AI47  R/W 

4095 The low word of Scale Low data is on AI48  R/W 

4096 The high word of Scale Low data is on AI48  R/W 

4097 The low word of Scale Low data is on DI1  R 

4098 The high word of Scale Low data is on DI1  R 

4099 The low word of Scale Low data is on DI2  R 

4100 The high word of Scale Low data is on DI2  R 

4101 The low word of Scale Low data is on DI3  R 

4102 The high word of Scale Low data is on DI3  R 

4103 The low word of Scale Low data is on DI4  R 

4104 The high word of Scale Low data is on DI4  R 

4105 The low word of Scale Low data is on DI5  R 

4106 The high word of Scale Low data is on DI5  R 

4107 The low word of Scale Low data is on DI6  R 

4108 The high word of Scale Low data is on DI6  R 

4109 The low word of Scale Low data is on DI7  R 

4110 The high word of Scale Low data is on DI7  R 

4111 The low word of Scale Low data is on DI8  R 

4112 The high word of Scale Low data is on DI8  R 

4113 The low word of Scale Low data is on DI9  R 

4114 The high word of Scale Low data is on DI9  R 

4115 The low word of Scale Low data is on DI10  R 

4116 The high word of Scale Low data is on DI10  R 

4117 The low word of Scale Low data is on DI11  R 

4118 The high word of Scale Low data is on DI11  R 

4119 The low word of Scale Low data is on DI12  R 

4120 The high word of Scale Low data is on DI12  R 

4121 The low word of Scale Low data is on DI13  R 

4122 The high word of Scale Low data is on DI13  R 

4123 The low word of Scale Low data is on DI14  R 

4124 The high word of Scale Low data is on DI14  R 

4125 The low word of Scale Low data is on DI15  R 

4126 The high word of Scale Low data is on DI15  R 

4127 The low word of Scale Low data is on DI16  R 

4128 The high word of Scale Low data is on DI16  R 

4129 The low word of Scale Low data is on DI17  R 
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4130 The high word of Scale Low data is on DI17  R 

4131 The low word of Scale Low data is on DI18  R 

4132 The high word of Scale Low data is on DI18  R 

4133 The low word of Scale Low data is on DI19  R 

4134 The high word of Scale Low data is on DI19  R 

4135 The low word of Scale Low data is on DI20  R 

4136 The high word of Scale Low data is on DI20  R 

4137 The low word of Scale Low data is on DI21  R 

4138 The high word of Scale Low data is on DI21  R 

4139 The low word of Scale Low data is on DI22  R 

4140 The high word of Scale Low data is on DI22  R 

4141 The low word of Scale Low data is on DI23  R 

4142 The high word of Scale Low data is on DI23  R 

4143 The low word of Scale Low data is on DI24  R 

4144 The high word of Scale Low data is on DI24  R 

4145 The low word of Scale Low data is on DO1  R 

4146 The high word of Scale Low data is on DO1  R 

4147 The low word of Scale Low data is on DO2  R 

4148 The high word of Scale Low data is on DO2  R 

4149 The low word of Scale Low data is on DO3  R 

4150 The high word of Scale Low data is on DO3  R 

4151 The low word of Scale Low data is on DO4  R 

4152 The high word of Scale Low data is on DO4  R 

4153 The low word of Scale Low data is on DO5  R 

4154 The high word of Scale Low data is on DO5  R 

4155 The low word of Scale Low data is on DO6  R 

4156 The high word of Scale Low data is on DO6  R 

4157 The low word of Scale Low data is on DO7  R 

4158 The high word of Scale Low data is on DO7  R 

4159 The low word of Scale Low data is on DO8  R 

4160 The high word of Scale Low data is on DO8  R 

4161 The low word of Scale Low data is on DO9  R 

4162 The high word of Scale Low data is on DO9  R 

4163 The low word of Scale Low data is on DO10  R 

4164 The high word of Scale Low data is on DO10  R 

4165 The low word of Scale Low data is on DO11  R 

4166 The high word of Scale Low data is on DO11  R 

4167 The low word of Scale Low data is on DO12  R 

4168 The high word of Scale Low data is on DO12  R 

4169 The low word of Scale Low data is on DO13  R 

4170 The high word of Scale Low data is on DO13  R 

4171 The low word of Scale Low data is on DO14  R 

4172 The high word of Scale Low data is on DO14  R 

4173 The low word of Scale Low data is on DO15  R 

4174 The high word of Scale Low data is on DO15  R 

4175 The low word of Scale Low data is on DO16  R 

4176 The high word of Scale Low data is on DO16  R 

4177 The low word of Scale Low data is on DO17  R 

4178 The high word of Scale Low data is on DO17  R 

4179 The low word of Scale Low data is on DO18  R 

4180 The high word of Scale Low data is on DO18  R 

4181 The low word of Scale Low data is on DO19  R 

4182 The high word of Scale Low data is on DO19  R 
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4183 The low word of Scale Low data is on DO20  R 

4184 The high word of Scale Low data is on DO20  R 

4185 The low word of Scale Low data is on DO21  R 

4186 The high word of Scale Low data is on DO21  R 

4187 The low word of Scale Low data is on DO22  R 

4188 The high word of Scale Low data is on DO22  R 

4189 The low word of Scale Low data is on DO23  R 

4190 The high word of Scale Low data is on DO23  R 

4191 The low word of Scale Low data is on DO24  R 

4192 The high word of Scale Low data is on DO24  R 

4193 The low word of Scale Low data is on AO1  R 

4194 The high word of Scale Low data is on AO1  R 

4195 The low word of Scale Low data is on AO2  R 

4196 The high word of Scale Low data is on AO2  R 

4197 The low word of Scale Low data is on AO3  R 

4198 The high word of Scale Low data is on AO3  R 

4199 The low word of Scale Low data is on AO4  R 

4200 The high word of Scale Low data is on AO4  R 

4201 The low word of Scale Low data is on AO5  R 

4202 The high word of Scale Low data is on AO5  R 

4203 The low word of Scale Low data is on AO6  R 

4204 The high word of Scale Low data is on AO6  R 

4205 The low word of Scale Low data is on AO7  R 

4206 The high word of Scale Low data is on AO7  R 

4207 The low word of Scale Low data is on AO8  R 

4208 The high word of Scale Low data is on AO8  R 

4209 The low word of Scale Low data is on AO9  R 

4210 The high word of Scale Low data is on AO9  R 

4211 The low word of Scale Low data is on AO10  R 

4212 The high word of Scale Low data is on AO10  R 

4213 The low word of Scale Low data is on AO11  R 

4214 The high word of Scale Low data is on AO11  R 

4215 The low word of Scale Low data is on AO12  R 

4216 The high word of Scale Low data is on AO12  R 

4217 The low word of Scale Low data is on Math1  R 

4218 The high word of Scale Low data is on Math1  R 

4219 The low word of Scale Low data is on Math2  R 

4220 The high word of Scale Low data is on Math2  R 

4221 The low word of Scale Low data is on Math3  R 

4222 The high word of Scale Low data is on Math3  R 

4223 The low word of Scale Low data is on Math4  R 

4224 The high word of Scale Low data is on Math4  R 

4225 The low word of Scale Low data is on Math5  R 

4226 The high word of Scale Low data is on Math5  R 

4227 The low word of Scale Low data is on Math6  R 

4228 The high word of Scale Low data is on Math6  R 

4229 The low word of Scale Low data is on Math7  R 

4230 The high word of Scale Low data is on Math7  R 

4231 The low word of Scale Low data is on Math8  R 

4232 The high word of Scale Low data is on Math8  R 

4233 The low word of Scale Low data is on Math9  R 

4234 The high word of Scale Low data is on Math9  R 

4235 The low word of Scale Low data is on Math10  R 
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4236 The high word of Scale Low data is on Math10  R 

4237 The low word of Scale Low data is on Math11  R 

4238 The high word of Scale Low data is on Math11  R 

4239 The low word of Scale Low data is on Math12  R 

4240 The high word of Scale Low data is on Math12  R 

4241 The low word of Scale Low data is on Math13  R 

4242 The high word of Scale Low data is on Math13  R 

4243 The low word of Scale Low data is on Math14  R 

4244 The high word of Scale Low data is on Math14  R 

4245 The low word of Scale Low data is on Math15  R 

4246 The high word of Scale Low data is on Math15  R 

4247 The low word of Scale Low data is on Math16  R 

4248 The high word of Scale Low data is on Math16  R 

4249 The low word of Scale Low data is on Math17  R 

4250 The high word of Scale Low data is on Math17  R 

4251 The low word of Scale Low data is on Math18  R 

4252 The high word of Scale Low data is on Math18  R 

4253 The low word of Scale Low data is on Math19  R 

4254 The high word of Scale Low data is on Math19  R 

4255 The low word of Scale Low data is on Math20  R 

4256 The high word of Scale Low data is on Math20  R 

4257 The low word of Scale Low data is on Math21  R 

4258 The high word of Scale Low data is on Math21  R 

4259 The low word of Scale Low data is on Math22  R 

4260 The high word of Scale Low data is on Math22  R 

4261 The low word of Scale Low data is on Math23  R 

4262 The high word of Scale Low data is on Math23  R 

4263 The low word of Scale Low data is on Math24  R 

4264 The high word of Scale Low data is on Math24  R 

4265 The low word of Scale Low data is on Math25 Maximum: 5 R 

4266 The high word of Scale Low data is on Math25  R 

4267 The low word of Scale Low data is on Math26  R 

4268 The high word of Scale Low data is on Math26  R 

4269 The low word of Scale Low data is on Math27  R 

4270 The high word of Scale Low data is on Math27  R 

4271 The low word of Scale Low data is on Math28  R 

4272 The high word of Scale Low data is on Math28  R 

4273 The low word of Scale Low data is on Math29  R 

4274 The high word of Scale Low data is on Math29  R 

4275 The low word of Scale Low data is on Math30  R 

4276 The high word of Scale Low data is on Math30  R 

4277 The low word of Scale Low data is on Math31  R 

4278 The high word of Scale Low data is on Math31  R 

4279 The low word of Scale Low data is on Math32  R 

4280 The high word of Scale Low data is on Math32  R 

4281 The low word of Scale Low data is on Math33  R 

4282 The high word of Scale Low data is on Math33  R 

4283 The low word of Scale Low data is on Math34  R 

4284 The high word of Scale Low data is on Math34  R 

4285 The low word of Scale Low data is on Math35  R 

4286 The high word of Scale Low data is on Math35  R 

4287 The low word of Scale Low data is on Math36  R 

4288 The high word of Scale Low data is on Math36  R 
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4289 The low word of Scale Low data is on Math37  R 

4290 The high word of Scale Low data is on Math37  R 

4291 The low word of Scale Low data is on Math38  R 

4292 The high word of Scale Low data is on Math38  R 

4293 The low word of Scale Low data is on Math39  R 

4294 The high word of Scale Low data is on Math39  R 

4295 The low word of Scale Low data is on Math40  R 

4296 The high word of Scale Low data is on Math40  R 

4297 The low word of Scale Low data is on Math41  R 

4298 The high word of Scale Low data is on Math41  R 

4299 The low word of Scale Low data is on Math42  R 

4300 The high word of Scale Low data is on Math42  R 

4301 The low word of Scale Low data is on Math43  R 

4302 The high word of Scale Low data is on Math43  R 

4303 The low word of Scale Low data is on Math44  R 

4304 The high word of Scale Low data is on Math44  R 

4305 The low word of Scale Low data is on Math45  R 

4306 The high word of Scale Low data is on Math45  R 

4307 The low word of Scale Low data is on Math46  R 

4308 The high word of Scale Low data is on Math46  R 

4309 The low word of Scale Low data is on Math47  R 

4310 The high word of Scale Low data is on Math47  R 

4311 The low word of Scale Low data is on Math48  R 

4312 The high word of Scale Low data is on Math48  R 

4313 The low word of Scale Low data is on Math49  R 

4314 The high word of Scale Low data is on Math49  R 

4315 The low word of Scale Low data is on Math50  R 

4316 The high word of Scale Low data is on Math50  R 

4317 The low word of Scale Low data is on Math51  R 

4318 The high word of Scale Low data is on Math51  R 

4319 The low word of Scale Low data is on Math52  R 

4320 The high word of Scale Low data is on Math52  R 

4321 The low word of Scale Low data is on Math53  R 

4322 The high word of Scale Low data is on Math53  R 

4323 The low word of Scale Low data is on Math54  R 

4324 The high word of Scale Low data is on Math54  R 

4325 The low word of Scale Low data is on Math55  R 

4326 The high word of Scale Low data is on Math55  R 

4327 The low word of Scale Low data is on Math56  R 

4328 The high word of Scale Low data is on Math56  R 

4329 The low word of Scale Low data is on Math57  R 

4330 The high word of Scale Low data is on Math57  R 

4331 The low word of Scale Low data is on Math58  R 

4332 The high word of Scale Low data is on Math58  R 

4333 The low word of Scale Low data is on Math59  R 

4334 The high word of Scale Low data is on Math59  R 

4335 The low word of Scale Low data is on Math60  R 

4336 The high word of Scale Low data is on Math60  R 

4337 The low word of Scale Low data is on Ext1  R 

4338 The high word of Scale Low data is on Ext1  R 

4339 The low word of Scale Low data is on Ext2  R 

4340 The high word of Scale Low data is on Ext2  R 

4341 The low word of Scale Low data is on Ext3  R 
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4342 The high word of Scale Low data is on Ext3  R 

4343 The low word of Scale Low data is on Ext4  R 

4344 The high word of Scale Low data is on Ext4  R 

4345 The low word of Scale Low data is on Ext5  R 

4346 The high word of Scale Low data is on Ext5  R 

4347 The low word of Scale Low data is on Ext6  R 

4348 The high word of Scale Low data is on Ext6  R 

4349 The low word of Scale Low data is on Ext7  R 

4350 The high word of Scale Low data is on Ext7  R 

4351 The low word of Scale Low data is on Ext8  R 

4352 The high word of Scale Low data is on Ext8  R 

4353 The low word of Scale Low data is on Ext9  R 

4354 The high word of Scale Low data is on Ext9  R 

4355 The low word of Scale Low data is on Ext10  R 

4356 The high word of Scale Low data is on Ext10  R 

4357 The low word of Scale Low data is on Ext11  R 

4358 The high word of Scale Low data is on Ext11  R 

4359 The low word of Scale Low data is on Ext12  R 

4360 The high word of Scale Low data is on Ext12  R 

4361 The low word of Scale Low data is on Ext13  R 

4362 The high word of Scale Low data is on Ext13  R 

4363 The low word of Scale Low data is on Ext14  R 

4364 The high word of Scale Low data is on Ext14  R 

4365 The low word of Scale Low data is on Ext15  R 

4366 The high word of Scale Low data is on Ext15  R 

4367 The low word of Scale Low data is on Ext16  R 

4368 The high word of Scale Low data is on Ext16  R 

4369 The low word of Scale Low data is on Ext17  R 

4370 The high word of Scale Low data is on Ext17  R 

4371 The low word of Scale Low data is on Ext18  R 

4372 The high word of Scale Low data is on Ext18  R 

4373 The low word of Scale Low data is on Ext19  R 

4374 The high word of Scale Low data is on Ext19  R 

4375 The low word of Scale Low data is on Ext20  R 

4376 The high word of Scale Low data is on Ext20  R 

4377 The low word of Scale Low data is on Ext21  R 

4378 The high word of Scale Low data is on Ext21  R 

4379 The low word of Scale Low data is on Ext22  R 

4380 The high word of Scale Low data is on Ext22  R 

4381 The low word of Scale Low data is on Ext23  R 

4382 The high word of Scale Low data is on Ext23  R 

4383 The low word of Scale Low data is on Ext24  R 

4384 The high word of Scale Low data is on Ext24  R 

4385 The low word of Scale Low data is on Ext25  R 

4386 The high word of Scale Low data is on Ext25  R 

4387 The low word of Scale Low data is on Ext26  R 

4388 The high word of Scale Low data is on Ext26  R 

4389 The low word of Scale Low data is on Ext27  R 

4390 The high word of Scale Low data is on Ext27  R 

4391 The low word of Scale Low data is on Ext28  R 

4392 The high word of Scale Low data is on Ext28  R 

4393 The low word of Scale Low data is on Ext29  R 

4394 The high word of Scale Low data is on Ext29  R 
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4395 The low word of Scale Low data is on Ext30  R 

4396 The high word of Scale Low data is on Ext30  R 

4397 The low word of Scale Low data is on Ext31  R 

4398 The high word of Scale Low data is on Ext31  R 

4399 The low word of Scale Low data is on Ext32  R 

4400 The high word of Scale Low data is on Ext32  R 

4401 The low word of Scale Low data is on Ext33  R 

4402 The high word of Scale Low data is on Ext33  R 

4403 The low word of Scale Low data is on Ext34  R 

4404 The high word of Scale Low data is on Ext34  R 

4405 The low word of Scale Low data is on Ext35  R 

4406 The high word of Scale Low data is on Ext35  R 

4407 The low word of Scale Low data is on Ext36  R 

4408 The high word of Scale Low data is on Ext36  R 

4409 The low word of Scale Low data is on Ext37  R 

4410 The high word of Scale Low data is on Ext37  R 

4411 The low word of Scale Low data is on Ext38  R 

4412 The high word of Scale Low data is on Ext38  R 

4413 The low word of Scale Low data is on Ext39  R 

4414 The high word of Scale Low data is on Ext39  R 

4415 The low word of Scale Low data is on Ext40  R 

4416 The high word of Scale Low data is on Ext40  R 

4417 The low word of Scale Low data is on Ext41  R 

4418 The high word of Scale Low data is on Ext41  R 

4419 The low word of Scale Low data is on Ext42  R 

4420 The high word of Scale Low data is on Ext42  R 

4421 The low word of Scale Low data is on Ext43  R 

4422 The high word of Scale Low data is on Ext43  R 

4423 The low word of Scale Low data is on Ext44  R 

4424 The high word of Scale Low data is on Ext44  R 

4425 The low word of Scale Low data is on Ext45  R 

4426 The high word of Scale Low data is on Ext45  R 

4427 The low word of Scale Low data is on Ext46  R 

4428 The high word of Scale Low data is on Ext46  R 

4429 The low word of Scale Low data is on Ext47  R 

4430 The high word of Scale Low data is on Ext47  R 

4431 The low word of Scale Low data is on Ext48  R 

4432 The high word of Scale Low data is on Ext48  R 

4433 The low word of Scale Low data is on Ext49  R 

4434 The high word of Scale Low data is on Ext49  R 

4435 The low word of Scale Low data is on Ext50  R 

4436 The high word of Scale Low data is on Ext50  R 

4437 The low word of Scale Low data is on Ext51  R 

4438 The high word of Scale Low data is on Ext51  R 

4439 The low word of Scale Low data is on Ext52  R 

4440 The high word of Scale Low data is on Ext52  R 

4441 The low word of Scale Low data is on Ext53  R 

4442 The high word of Scale Low data is on Ext53  R 

4443 The low word of Scale Low data is on Ext54  R 

4444 The high word of Scale Low data is on Ext54  R 

4445 The low word of Scale Low data is on Ext55  R 

4446 The high word of Scale Low data is on Ext55  R 

4447 The low word of Scale Low data is on Ext56  R 
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4448 The high word of Scale Low data is on Ext56  R 

4449 The low word of Scale Low data is on Ext57  R 

4450 The high word of Scale Low data is on Ext57  R 

4451 The low word of Scale Low data is on Ext58  R 

4452 The high word of Scale Low data is on Ext58  R 

4453 The low word of Scale Low data is on Ext59  R 

4454 The high word of Scale Low data is on Ext59  R 

4455 The low word of Scale Low data is on Ext60  R 

4456 The high word of Scale Low data is on Ext60  R 

4457 The low word of Scale Low data is on Ext61  R 

4458 The high word of Scale Low data is on Ext61  R 

4459 The low word of Scale Low data is on Ext62  R 

4460 The high word of Scale Low data is on Ext62  R 

4461 The low word of Scale Low data is on Ext63  R 

4462 The high word of Scale Low data is on Ext63  R 

4463 The low word of Scale Low data is on Ext64  R 

4464 The high word of Scale Low data is on Ext64  R 

4465 The low word of Scale Low data is on Ext65  R 

4466 The high word of Scale Low data is on Ext65  R 

4467 The low word of Scale Low data is on Ext66  R 

4468 The high word of Scale Low data is on Ext66  R 

4469 The low word of Scale Low data is on Ext67  R 

4470 The high word of Scale Low data is on Ext67  R 

4471 The low word of Scale Low data is on Ext68  R 

4472 The high word of Scale Low data is on Ext68  R 

4473 The low word of Scale Low data is on Ext69  R 

4474 The high word of Scale Low data is on Ext69  R 

4475 The low word of Scale Low data is on Ext70  R 

4476 The high word of Scale Low data is on Ext70  R 

4477 The low word of Scale Low data is on Ext71  R 

4478 The high word of Scale Low data is on Ext71  R 

4479 The low word of Scale Low data is on Ext72  R 

4480 The high word of Scale Low data is on Ext72  R 

4481 The low word of Scale Low data is on Ext73  R 

4482 The high word of Scale Low data is on Ext73  R 

4483 The low word of Scale Low data is on Ext74  R 

4484 The high word of Scale Low data is on Ext74  R 

4485 The low word of Scale Low data is on Ext75  R 

4486 The high word of Scale Low data is on Ext75  R 

4487 The low word of Scale Low data is on Ext76  R 

4488 The high word of Scale Low data is on Ext76  R 

4489 The low word of Scale Low data is on Ext77  R 

4490 The high word of Scale Low data is on Ext77  R 

4491 The low word of Scale Low data is on Ext78  R 

4492 The high word of Scale Low data is on Ext78  R 

4493 The low word of Scale Low data is on Ext79  R 

4494 The high word of Scale Low data is on Ext79  R 

4495 The low word of Scale Low data is on Ext80  R 

4496 The high word of Scale Low data is on Ext80  R 

4497 The low word of Scale Low data is on Ext81  R 

4498 The high word of Scale Low data is on Ext81  R 

4499 The low word of Scale Low data is on Ext82  R 

4500 The high word of Scale Low data is on Ext82  R 
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4501 The low word of Scale Low data is on Ext83  R 

4502 The high word of Scale Low data is on Ext83  R 

4503 The low word of Scale Low data is on Ext84  R 

4504 The high word of Scale Low data is on Ext84  R 

4505 The low word of Scale Low data is on Ext85  R 

4506 The high word of Scale Low data is on Ext85  R 

4507 The low word of Scale Low data is on Ext86  R 

4508 The high word of Scale Low data is on Ext86  R 

4509 The low word of Scale Low data is on Ext87  R 

4510 The high word of Scale Low data is on Ext87  R 

4511 The low word of Scale Low data is on Ext88  R 

4512 The high word of Scale Low data is on Ext88  R 

4513 The low word of Scale Low data is on Ext89  R 

4514 The high word of Scale Low data is on Ext89  R 

4515 The low word of Scale Low data is on Ext90  R 

4516 The high word of Scale Low data is on Ext90  R 

4517 The low word of Scale Low data is on Ext91  R 

4518 The high word of Scale Low data is on Ext91  R 

4519 The low word of Scale Low data is on Ext92  R 

4520 The high word of Scale Low data is on Ext92  R 

4521 The low word of Scale Low data is on Ext93  R 

4522 The high word of Scale Low data is on Ext93  R 

4523 The low word of Scale Low data is on Ext94  R 

4524 The high word of Scale Low data is on Ext94  R 

4525 The low word of Scale Low data is on Ext95  R 

4526 The high word of Scale Low data is on Ext95  R 

4527 The low word of Scale Low data is on Ext96  R 

4528 The high word of Scale Low data is on Ext96  R 

 

8.1.3.3 Scale High (DWord Type) 

Modbus 
Address 

Register Name Note Access 

6001 The low word of Scale High data is on AI1  R/W 

6002 The high word of Scale High data is on AI1  R/W 

6003 The low word of Scale High data is on AI2  R/W 

6004 The high word of Scale High data is on AI2  R/W 

6005 The low word of Scale High data is on AI3  R/W 

6006 The high word of Scale High data is on AI3  R/W 

6007 The low word of Scale High data is on AI4  R/W 

6008 The high word of Scale High data is on AI4  R/W 

6009 The low word of Scale High data is on AI5  R/W 

6010 The high word of Scale High data is on AI5  R/W 

6011 The low word of Scale High data is on AI6  R/W 

6012 The high word of Scale High data is on AI6  R/W 

6013 The low word of Scale High data is on AI7  R/W 

6014 The high word of Scale High data is on AI7  R/W 

6015 The low word of Scale High data is on AI8  R/W 

6016 The high word of Scale High data is on AI8  R/W 

6017 The low word of Scale High data is on AI9  R/W 

6018 The high word of Scale High data is on AI9  R/W 

6019 The low word of Scale High data is on AI10  R/W 

6020 The high word of Scale High data is on AI10  R/W 
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6021 The low word of Scale High data is on AI11  R/W 

6022 The high word of Scale High data is on AI11  R/W 

6023 The low word of Scale High data is on AI12  R/W 

6024 The high word of Scale High data is on AI12  R/W 

6025 The low word of Scale High data is on AI13  R/W 

6026 The high word of Scale Low data is on AI13  R/W 

6027 The low word of Scale High data is on AI14  R/W 

6028 The high word of Scale High data is on AI14  R/W 

6029 The low word of Scale High data is on AI15  R/W 

6030 The high word of Scale High data is on AI15  R/W 

6031 The low word of Scale High data is on AI16  R/W 

6032 The high word of Scale High data is on AI16  R/W 

6033 The low word of Scale High data is on AI17  R/W 

6034 The high word of Scale High data is on AI17  R/W 

6035 The low word of Scale High data is on AI18  R/W 

6036 The high word of Scale High data is on AI18  R/W 

6037 The low word of Scale High data is on AI19  R/W 

6038 The high word of Scale High data is on AI19  R/W 

6039 The low word of Scale High data is on AI20  R/W 

6040 The high word of Scale High data is on AI20  R/W 

6041 The low word of Scale High data is on AI21  R/W 

6042 The high word of Scale High data is on AI21  R/W 

6043 The low word of Scale High data is on AI22  R/W 

6044 The high word of Scale High data is on AI22  R/W 

6045 The low word of Scale High data is on AI23  R/W 

6046 The high word of Scale High data is on AI23  R/W 

6047 The low word of Scale High data is on AI24  R/W 

6048 The high word of Scale High data is on AI24  R/W 

6049 The low word of Scale High data is on AI25  R/W 

6050 The high word of Scale High data is on AI25  R/W 

6051 The low word of Scale High data is on AI26  R/W 

6052 The high word of Scale High data is on AI26  R/W 

6053 The low word of Scale High data is on AI27  R/W 

6054 The high word of Scale High data is on AI27  R/W 

6055 The low word of Scale High data is on AI28  R/W 

6056 The high word of Scale High data is on AI28  R/W 

6057 The low word of Scale High data is on AI29  R/W 

6058 The high word of Scale High data is on AI29  R/W 

6059 The low word of Scale High data is on AI30  R/W 

6060 The high word of Scale High data is on AI30  R/W 

6061 The low word of Scale High data is on AI31  R/W 

6062 The high word of Scale High data is on AI31  R/W 

6063 The low word of Scale High data is on AI32  R/W 

6064 The high word of Scale High data is on AI32  R/W 

6065 The low word of Scale High data is on AI33  R/W 

6066 The high word of Scale High data is on AI33  R/W 

6067 The low word of Scale High data is on AI34  R/W 

6068 The high word of Scale High data is on AI34  R/W 

6069 The low word of Scale High data is on AI35  R/W 

6070 The high word of Scale High data is on AI35  R/W 

6071 The low word of Scale High data is on AI36  R/W 

6072 The high word of Scale High data is on AI36  R/W 
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6073 The low word of Scale High data is on AI37  R/W 

6074 The high word of Scale High data is on AI37  R/W 

6075 The low word of Scale High data is on AI38  R/W 

6076 The high word of Scale High data is on AI38  R/W 

6077 The low word of Scale High data is on AI39  R/W 

6078 The high word of Scale High data is on AI39  R/W 

6079 The low word of Scale High data is on AI40  R/W 

6080 The high word of Scale High data is on AI40  R/W 

6081 The low word of Scale High data is on AI41  R/W 

6082 The high word of Scale High data is on AI41  R/W 

6083 The low word of Scale High data is on AI42  R/W 

6084 The high word of Scale High data is on AI42  R/W 

6085 The low word of Scale High data is on AI43  R/W 

6086 The high word of Scale High data is on AI43  R/W 

6087 The low word of Scale High data is on AI44  R/W 

6088 The high word of Scale High data is on AI44  R/W 

6089 The low word of Scale High data is on AI45  R/W 

6090 The high word of Scale High data is on AI45  R/W 

6091 The low word of Scale High data is on AI46  R/W 

6492 The high word of Scale High data is on AI46  R/W 

6093 The low word of Scale High data is on AI47  R/W 

6094 The high word of Scale High data is on AI47  R/W 

6095 The low word of Scale High data is on AI48  R/W 

6096 The high word of Scale High data is on AI48  R/W 

6097 The low word of Scale High data is on DI1  R 

6098 The high word of Scale High data is on DI1  R 

6099 The low word of Scale High data is on DI2  R 

6100 The high word of Scale High data is on DI2  R 

6101 The low word of Scale High data is on DI3  R 

6102 The high word of Scale High data is on DI3  R 

6103 The low word of Scale High data is on DI4  R 

6104 The high word of Scale High data is on DI4  R 

6105 The low word of Scale High data is on DI5  R 

6106 The high word of Scale High data is on DI5  R 

6107 The low word of Scale High data is on DI6  R 

6108 The high word of Scale High data is on DI6  R 

6109 The low word of Scale High data is on DI7  R 

6110 The high word of Scale High data is on DI7  R 

6111 The low word of Scale High data is on DI8  R 

6112 The high word of Scale High data is on DI8  R 

6113 The low word of Scale High data is on DI9  R 

6114 The high word of Scale High data is on DI9  R 

6115 The low word of Scale High data is on DI10  R 

6116 The high word of Scale High data is on DI10  R 

6117 The low word of Scale High data is on DI11  R 

6118 The high word of Scale High data is on DI11  R 

6119 The low word of Scale High data is on DI12  R 

6120 The high word of Scale High data is on DI12  R 

6121 The low word of Scale High data is on DI13  R 

6122 The high word of Scale High data is on DI13  R 

6123 The low word of Scale High data is on DI14  R 

6124 The high word of Scale High data is on DI14  R 
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6125 The low word of Scale High data is on DI15  R 

6126 The high word of Scale High data is on DI15  R 

6127 The low word of Scale High data is on DI16  R 

6128 The high word of Scale High data is on DI16  R 

6129 The low word of Scale High data is on DI17  R 

6130 The high word of Scale High data is on DI17  R 

6131 The low word of Scale High data is on DI18  R 

6132 The high word of Scale High data is on DI18  R 

6133 The low word of Scale High data is on DI19  R 

6134 The high word of Scale High data is on DI19  R 

6135 The low word of Scale High data is on DI20  R 

6136 The high word of Scale High data is on DI20  R 

6137 The low word of Scale High data is on DI21  R 

6138 The high word of Scale High data is on DI21  R 

6139 The low word of Scale High data is on DI22  R 

6140 The high word of Scale High data is on DI22  R 

6141 The low word of Scale High data is on DI23  R 

6142 The high word of Scale High data is on DI23  R 

6143 The low word of Scale High data is on DI24  R 

6144 The high word of Scale High data is on DI24  R 

6145 The low word of Scale High data is on DO1  R 

6146 The high word of Scale High data is on DO1  R 

6147 The low word of Scale High data is on DO2  R 

6148 The high word of Scale High data is on DO2  R 

6149 The low word of Scale High data is on DO3  R 

6150 The high word of Scale High data is on DO3  R 

6151 The low word of Scale High data is on DO4  R 

6152 The high word of Scale High data is on DO4  R 

6153 The low word of Scale High data is on DO5  R 

6154 The high word of Scale High data is on DO5  R 

6155 The low word of Scale High data is on DO6  R 

6156 The high word of Scale High data is on DO6  R 

6157 The low word of Scale High data is on DO7  R 

6158 The high word of Scale High data is on DO7  R 

6159 The low word of Scale High data is on DO8  R 

6160 The high word of Scale High data is on DO8  R 

6161 The low word of Scale High data is on DO9  R 

6162 The high word of Scale High data is on DO9  R 

6163 The low word of Scale High data is on DO10  R 

6164 The high word of Scale High data is on DO10  R 

6165 The low word of Scale High data is on DO11  R 

6166 The high word of Scale High data is on DO11  R 

6167 The low word of Scale High data is on DO12  R 

6168 The high word of Scale High data is on DO12  R 

6169 The low word of Scale High data is on DO13  R 

6170 The high word of Scale High data is on DO13  R 

6171 The low word of Scale High data is on DO14  R 

6172 The high word of Scale High data is on DO14  R 

6173 The low word of Scale High data is on DO15  R 

6174 The high word of Scale High data is on DO15  R 

6175 The low word of Scale High data is on DO16  R 

6176 The high word of Scale High data is on DO16  R 
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6177 The low word of Scale High data is on DO17  R 

6178 The high word of Scale High data is on DO17  R 

6179 The low word of Scale High data is on DO18  R 

6180 The high word of Scale High data is on DO18  R 

6181 The low word of Scale High data is on DO19  R 

6182 The high word of Scale High data is on DO19  R 

6183 The low word of Scale High data is on DO20  R 

6184 The high word of Scale High data is on DO20  R 

6185 The low word of Scale High data is on DO21  R 

6186 The high word of Scale High data is on DO21  R 

6187 The low word of Scale High data is on DO22  R 

6188 The high word of Scale High data is on DO22  R 

6189 The low word of Scale High data is on DO23  R 

6190 The high word of Scale High data is on DO23  R 

6191 The low word of Scale High data is on DO24  R 

6192 The high word of Scale High data is on DO24  R 

6193 The low word of Scale High data is on AO1  R 

6194 The high word of Scale High data is on AO1  R 

6195 The low word of Scale High data is on AO2  R 

6196 The high word of Scale High data is on AO2  R 

6197 The low word of Scale High data is on AO3  R 

6198 The high word of Scale High data is on AO3  R 

6199 The low word of Scale High data is on AO4  R 

6200 The high word of Scale High data is on AO4  R 

6201 The low word of Scale High data is on AO5  R 

6202 The high word of Scale High data is on AO5  R 

6203 The low word of Scale High data is on AO6  R 

6204 The high word of Scale High data is on AO6  R 

6205 The low word of Scale High data is on AO7  R 

6206 The high word of Scale High data is on AO7  R 

6207 The low word of Scale High data is on AO8  R 

6208 The high word of Scale High data is on AO8  R 

6209 The low word of Scale High data is on AO9  R 

6210 The high word of Scale High data is on AO9  R 

6211 The low word of Scale High data is on AO10  R 

6212 The high word of Scale High data is on AO10  R 

6213 The low word of Scale High data is on AO11  R 

6214 The high word of Scale High data is on AO11  R 

6215 The low word of Scale High data is on AO12  R 

6216 The high word of Scale High data is on AO12  R 

6217 The low word of Scale High data is on Math1  R 

6218 The high word of Scale High data is on Math1  R 

6219 The low word of Scale High data is on Math2  R 

6220 The high word of Scale High data is on Math2  R 

6221 The low word of Scale High data is on Math3  R 

6222 The high word of Scale High data is on Math3  R 

6223 The low word of Scale High data is on Math4  R 

6224 The high word of Scale High data is on Math4  R 

6225 The low word of Scale High data is on Math5  R 

6226 The high word of Scale High data is on Math5  R 

6227 The low word of Scale High data is on Math6  R 

6228 The high word of Scale High data is on Math6  R 
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6229 The low word of Scale High data is on Math7  R 

6230 The high word of Scale High data is on Math7  R 

6231 The low word of Scale High data is on Math8  R 

6232 The high word of Scale High data is on Math8  R 

6233 The low word of Scale High data is on Math9  R 

6234 The high word of Scale High data is on Math9  R 

6235 The low word of Scale High data is on Math10  R 

6236 The high word of Scale High data is on Math10  R 

6237 The low word of Scale High data is on Math11  R 

6238 The high word of Scale High data is on Math11  R 

6239 The low word of Scale High data is on Math12  R 

6240 The high word of Scale High data is on Math12  R 

6241 The low word of Scale High data is on Math13  R 

6242 The high word of Scale High data is on Math13  R 

6243 The low word of Scale High data is on Math14  R 

6244 The high word of Scale High data is on Math14  R 

6245 The low word of Scale High data is on Math15  R 

6246 The high word of Scale High data is on Math15  R 

6247 The low word of Scale High data is on Math16  R 

6248 The high word of Scale High data is on Math16  R 

6249 The low word of Scale High data is on Math17  R 

6250 The high word of Scale High data is on Math17  R 

6251 The low word of Scale High data is on Math18  R 

6252 The high word of Scale High data is on Math18  R 

6253 The low word of Scale High data is on Math19  R 

6254 The high word of Scale High data is on Math19  R 

6255 The low word of Scale High data is on Math20  R 

6256 The high word of Scale High data is on Math20  R 

6257 The low word of Scale High data is on Math21  R 

6258 The high word of Scale High data is on Math21  R 

6259 The low word of Scale High data is on Math22  R 

6260 The high word of Scale High data is on Math22  R 

6261 The low word of Scale High data is on Math23  R 

6262 The high word of Scale High data is on Math23  R 

6263 The low word of Scale High data is on Math24  R 

6264 The high word of Scale High data is on Math24  R 

6265 The low word of Scale High data is on Math25 Maximum: 5 R 

6266 The high word of Scale High data is on Math25  R 

6267 The low word of Scale High data is on Math26  R 

6268 The high word of Scale High data is on Math26  R 

6269 The low word of Scale High data is on Math27  R 

6270 The high word of Scale High data is on Math27  R 

6271 The low word of Scale High data is on Math28  R 

6272 The high word of Scale High data is on Math28  R 

6273 The low word of Scale High data is on Math29  R 

6274 The high word of Scale High data is on Math29  R 

6275 The low word of Scale High data is on Math30  R 

6276 The high word of Scale High data is on Math30  R 

6277 The low word of Scale High data is on Math31  R 

6278 The high word of Scale High data is on Math31  R 

6279 The low word of Scale High data is on Math32  R 

6280 The high word of Scale High data is on Math32  R 



 
 

 
 

Page 518 of 550 

Modbus 
Address 

Register Name Note Access 

6281 The low word of Scale High data is on Math33  R 

6282 The high word of Scale High data is on Math33  R 

6283 The low word of Scale High data is on Math34  R 

6284 The high word of Scale High data is on Math34  R 

6285 The low word of Scale High data is on Math35  R 

6286 The high word of Scale High data is on Math35  R 

6287 The low word of Scale High data is on Math36  R 

6288 The high word of Scale High data is on Math36  R 

6289 The low word of Scale High data is on Math37  R 

6290 The high word of Scale High data is on Math37  R 

6291 The low word of Scale High data is on Math38  R 

6292 The high word of Scale High data is on Math38  R 

6293 The low word of Scale High data is on Math39  R 

6294 The high word of Scale High data is on Math39  R 

6295 The low word of Scale High data is on Math40  R 

6296 The high word of Scale High data is on Math40  R 

6297 The low word of Scale High data is on Math41  R 

6298 The high word of Scale High data is on Math41  R 

6299 The low word of Scale High data is on Math42  R 

6300 The high word of Scale High data is on Math42  R 

6301 The low word of Scale High data is on Math43  R 

6302 The high word of Scale High data is on Math43  R 

6303 The low word of Scale High data is on Math44  R 

6304 The high word of Scale High data is on Math44  R 

6305 The low word of Scale High data is on Math45  R 

6306 The high word of Scale High data is on Math45  R 

6307 The low word of Scale High data is on Math46  R 

6308 The high word of Scale High data is on Math46  R 

6309 The low word of Scale High data is on Math47  R 

6310 The high word of Scale High data is on Math47  R 

6311 The low word of Scale High data is on Math48  R 

6312 The high word of Scale High data is on Math48  R 

6313 The low word of Scale High data is on Math49  R 

6314 The high word of Scale High data is on Math49  R 

6315 The low word of Scale High data is on Math50  R 

6316 The high word of Scale High data is on Math50  R 

6317 The low word of Scale High data is on Math51  R 

6318 The high word of Scale High data is on Math51  R 

6319 The low word of Scale High data is on Math52  R 

6320 The high word of Scale High data is on Math52  R 

6321 The low word of Scale High data is on Math53  R 

6322 The high word of Scale High data is on Math53  R 

6323 The low word of Scale High data is on Math54  R 

6324 The high word of Scale High data is on Math54  R 

6325 The low word of Scale High data is on Math55  R 

6326 The high word of Scale High data is on Math55  R 

6327 The low word of Scale High data is on Math56  R 

6328 The high word of Scale High data is on Math56  R 

6329 The low word of Scale High data is on Math57  R 

6330 The high word of Scale High data is on Math57  R 

6331 The low word of Scale High data is on Math58  R 

6332 The high word of Scale High data is on Math58  R 
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6333 The low word of Scale High data is on Math59  R 

6334 The high word of Scale High data is on Math59  R 

6335 The low word of Scale High data is on Math60  R 

6336 The high word of Scale High data is on Math60  R 

6337 The low word of Scale High data is on Ext1  R 

6338 The high word of Scale High data is on Ext1  R 

6339 The low word of Scale High data is on Ext2  R 

6340 The high word of Scale High data is on Ext2  R 

6341 The low word of Scale High data is on Ext3  R 

6342 The high word of Scale High data is on Ext3  R 

6343 The low word of Scale High data is on Ext4  R 

6344 The high word of Scale High data is on Ext4  R 

6345 The low word of Scale High data is on Ext5  R 

6346 The high word of Scale High data is on Ext5  R 

6347 The low word of Scale High data is on Ext6  R 

6348 The high word of Scale High data is on Ext6  R 

6349 The low word of Scale High data is on Ext7  R 

6350 The high word of Scale High data is on Ext7  R 

6351 The low word of Scale High data is on Ext8  R 

6352 The high word of Scale High data is on Ext8  R 

6353 The low word of Scale High data is on Ext9  R 

6354 The high word of Scale High data is on Ext9  R 

6355 The low word of Scale High data is on Ext10  R 

6356 The high word of Scale High data is on Ext10  R 

6357 The low word of Scale High data is on Ext11  R 

6358 The high word of Scale High data is on Ext11  R 

6359 The low word of Scale High data is on Ext12  R 

6360 The high word of Scale High data is on Ext12  R 

6361 The low word of Scale High data is on Ext13  R 

6362 The high word of Scale High data is on Ext13  R 

6363 The low word of Scale High data is on Ext14  R 

6364 The high word of Scale High data is on Ext14  R 

6365 The low word of Scale High data is on Ext15  R 

6366 The high word of Scale High data is on Ext15  R 

6367 The low word of Scale High data is on Ext16  R 

6368 The high word of Scale High data is on Ext16  R 

6369 The low word of Scale High data is on Ext17  R 

6370 The high word of Scale High data is on Ext17  R 

6371 The low word of Scale High data is on Ext18  R 

6372 The high word of Scale High data is on Ext18  R 

6373 The low word of Scale High data is on Ext19  R 

6374 The high word of Scale High data is on Ext19  R 

6375 The low word of Scale High data is on Ext20  R 

6376 The high word of Scale High data is on Ext20  R 

6377 The low word of Scale High data is on Ext21  R 

6378 The high word of Scale High data is on Ext21  R 

6379 The low word of Scale High data is on Ext22  R 

6380 The high word of Scale High data is on Ext22  R 

6381 The low word of Scale High data is on Ext23  R 

6382 The high word of Scale High data is on Ext23  R 

6383 The low word of Scale High data is on Ext24  R 

6384 The high word of Scale High data is on Ext24  R 
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6385 The low word of Scale High data is on Ext25  R 

6386 The high word of Scale High data is on Ext25  R 

6387 The low word of Scale High data is on Ext26  R 

6388 The high word of Scale High data is on Ext26  R 

6389 The low word of Scale High data is on Ext27  R 

6390 The high word of Scale High data is on Ext27  R 

6391 The low word of Scale High data is on Ext28  R 

6392 The high word of Scale High data is on Ext28  R 

6393 The low word of Scale High data is on Ext29  R 

6394 The high word of Scale High data is on Ext29  R 

6395 The low word of Scale High data is on Ext30  R 

6396 The high word of Scale High data is on Ext30  R 

6397 The low word of Scale High data is on Ext31  R 

6398 The high word of Scale High data is on Ext31  R 

6399 The low word of Scale High data is on Ext32  R 

6400 The high word of Scale High data is on Ext32  R 

6401 The low word of Scale High data is on Ext33  R 

6402 The high word of Scale High data is on Ext33  R 

6403 The low word of Scale High data is on Ext34  R 

6404 The high word of Scale High data is on Ext34  R 

6405 The low word of Scale High data is on Ext35  R 

6406 The high word of Scale High data is on Ext35  R 

6407 The low word of Scale High data is on Ext36  R 

6408 The high word of Scale High data is on Ext36  R 

6409 The low word of Scale High data is on Ext37  R 

6410 The high word of Scale High data is on Ext37  R 

6411 The low word of Scale High data is on Ext38  R 

6412 The high word of Scale High data is on Ext38  R 

6413 The low word of Scale High data is on Ext39  R 

6414 The high word of Scale High data is on Ext39  R 

6415 The low word of Scale High data is on Ext40  R 

6416 The high word of Scale High data is on Ext40  R 

6417 The low word of Scale High data is on Ext41  R 

6418 The high word of Scale High data is on Ext41  R 

6419 The low word of Scale High data is on Ext42  R 

6420 The high word of Scale High data is on Ext42  R 

6421 The low word of Scale High data is on Ext43  R 

6422 The high word of Scale High data is on Ext43  R 

6423 The low word of Scale High data is on Ext44  R 

6424 The high word of Scale High data is on Ext44  R 

6425 The low word of Scale High data is on Ext45  R 

6426 The high word of Scale High data is on Ext45  R 

6427 The low word of Scale High data is on Ext46  R 

6428 The high word of Scale High data is on Ext46  R 

6429 The low word of Scale High data is on Ext47  R 

6430 The high word of Scale High data is on Ext47  R 

6431 The low word of Scale High data is on Ext48  R 

6432 The high word of Scale High data is on Ext48  R 

6433 The low word of Scale High data is on Ext49  R 

6434 The high word of Scale High data is on Ext49  R 

6435 The low word of Scale High data is on Ext50  R 

6436 The high word of Scale High data is on Ext50  R 
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6437 The low word of Scale High data is on Ext51  R 

6438 The high word of Scale High data is on Ext51  R 

6439 The low word of Scale High data is on Ext52  R 

6440 The high word of Scale High data is on Ext52  R 

6441 The low word of Scale High data is on Ext53  R 

6442 The high word of Scale High data is on Ext53  R 

6443 The low word of Scale High data is on Ext54  R 

6444 The high word of Scale High data is on Ext54  R 

6445 The low word of Scale High data is on Ext55  R 

6446 The high word of Scale High data is on Ext55  R 

6447 The low word of Scale High data is on Ext56  R 

6448 The high word of Scale High data is on Ext56  R 

6449 The low word of Scale High data is on Ext57  R 

6450 The high word of Scale High data is on Ext57  R 

6451 The low word of Scale High data is on Ext58  R 

6452 The high word of Scale High data is on Ext58  R 

6453 The low word of Scale High data is on Ext59  R 

6454 The high word of Scale High data is on Ext59  R 

6455 The low word of Scale High data is on Ext60  R 

6456 The high word of Scale High data is on Ext60  R 

6457 The low word of Scale High data is on Ext61  R 

6458 The high word of Scale High data is on Ext61  R 

6459 The low word of Scale High data is on Ext62  R 

6460 The high word of Scale High data is on Ext62  R 

6461 The low word of Scale High data is on Ext63  R 

6462 The high word of Scale High data is on Ext63  R 

6463 The low word of Scale High data is on Ext64  R 

6464 The high word of Scale High data is on Ext64  R 

6465 The low word of Scale High data is on Ext65  R 

6466 The high word of Scale High data is on Ext65  R 

6467 The low word of Scale High data is on Ext66  R 

6468 The high word of Scale High data is on Ext66  R 

6469 The low word of Scale High data is on Ext67  R 

6470 The high word of Scale High data is on Ext67  R 

6471 The low word of Scale High data is on Ext68  R 

6472 The high word of Scale High data is on Ext68  R 

6473 The low word of Scale High data is on Ext69  R 

6474 The high word of Scale High data is on Ext69  R 

6475 The low word of Scale High data is on Ext70  R 

6476 The high word of Scale High data is on Ext70  R 

6477 The low word of Scale High data is on Ext71  R 

6478 The high word of Scale High data is on Ext71  R 

6479 The low word of Scale High data is on Ext72  R 

6480 The high word of Scale High data is on Ext72  R 

6481 The low word of Scale High data is on Ext73  R 

6482 The high word of Scale High data is on Ext73  R 

6483 The low word of Scale High data is on Ext74  R 

6484 The high word of Scale High data is on Ext74  R 

6485 The low word of Scale High data is on Ext75  R 

6486 The high word of Scale High data is on Ext75  R 

6487 The low word of Scale High data is on Ext76  R 

6488 The high word of Scale High data is on Ext76  R 
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6489 The low word of Scale High data is on Ext77  R 

6490 The high word of Scale High data is on Ext77  R 

6491 The low word of Scale High data is on Ext78  R 

6492 The high word of Scale High data is on Ext78  R 

6493 The low word of Scale High data is on Ext79  R 

6494 The high word of Scale High data is on Ext79  R 

6495 The low word of Scale High data is on Ext80  R 

6496 The high word of Scale High data is on Ext80  R 

6497 The low word of Scale High data is on Ext81  R 

6498 The high word of Scale High data is on Ext81  R 

6499 The low word of Scale High data is on Ext82  R 

6500 The high word of Scale High data is on Ext82  R 

6501 The low word of Scale High data is on Ext83  R 

6502 The high word of Scale High data is on Ext83  R 

6503 The low word of Scale High data is on Ext84  R 

6504 The high word of Scale High data is on Ext84  R 

6505 The low word of Scale High data is on Ext85  R 

6506 The high word of Scale High data is on Ext85  R 

6507 The low word of Scale High data is on Ext86  R 

6508 The high word of Scale High data is on Ext86  R 

6509 The low word of Scale High data is on Ext87  R 

6510 The high word of Scale High data is on Ext87  R 

6511 The low word of Scale High data is on Ext88  R 

6512 The high word of Scale High data is on Ext88  R 

6513 The low word of Scale High data is on Ext89  R 

6514 The high word of Scale High data is on Ext89  R 

6515 The low word of Scale High data is on Ext90  R 

6516 The high word of Scale High data is onExt90  R 

6517 The low word of Scale High data is on Ext91  R 

6518 The high word of Scale High data is on Ext91  R 

6519 The low word of Scale High data is on Ext92  R 

6520 The high word of Scale High data is on Ext92  R 

6521 The low word of Scale High data is on Ext93  R 

6522 The high word of Scale High data is on Ext93  R 

6523 The low word of Scale High data is on Ext94  R 

6524 The high word of Scale High data is on Ext94  R 

6525 The low word of Scale High data is on Ext95  R 

6526 The high word of Scale High data is on Ext95  R 

6527 The low word of Scale High data is on Ext96  R 

6528 The high word of Scale High data is on Ext96  R 

 
Note: 
 The Scale Low / High can be modified only when the input type is Linear. 

8.1.3.3.1    How to calculate Modbus Scale Low / High 

 Get Scale low and Scale High from Recorder AI Configuration 
 Calculate ΔScale Range, 

  Δ Scale Range = Scale High - Scale Low 
 Calculate Modbus Range 

 Modbus ΔScale Range = ΔScale Range * 1.2 
 Calculate Modbus Scale Low = Scale Low - (Modbus ΔScale Range - ΔScale Range) 
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 Calculate Modbus Scale High = Scale High + (Modbus ΔScale Range - ΔScale Range) 
 Convert the Modbus Scale Low / High value to DWord value using the below formulae. 

 
 

DP DP Value 

0 1 

1 10 

2 100 

3 1000 

4 10000 

5 100000 

 
For example: 
 Scale Low is 500, Scale High is 1000 
 ΔScale Range = Scale High - Scale Low = 1000 -500 = 500 
 Modbus ΔScale Range = ΔScale Range * 1.2 = 500*1.2= 600 
Modbus Scale Low = Scale Low - (Modbus ΔScale Range - ΔScale Range)  

= 500 - (600 -500) = 500 -100 = 400 
Modbus Scale High = Scale High + (Modbus ΔScale Range -ΔScale Range) 

= 1000 + (600 - 500) = 1000 + 100 = 1100 
Convert the Modbus Scale Low value to DWord value: 
    (((400 * DP Value) - (-2147483648)) / (2147483647-(-2147483648))) * 4294967295 
          The DP value is 1 when the DP is 0 => 
             ((400 - (-2147483648)) / 4294967295) *4294967295  
   = (2147484048/4294967295)* 4294967295  
   = 2147484048 
 Convert the Modbus Scale High value to DWord value: 
    (((1100 * DP Value) - (-2147483648)) / (2147483647- (-2147483648))) * 294967295 
          The DP value is 1 when the DP is 0 => 
             (1100 - (-2147483648)) / (2147483647 - (-2147483648)) *4294967295 
   = (2147484748/4294967295)* 4294967295 
   =2147484748 
 

Convert DWord value to Real Scale Value: 
 Modbus Scale High = ((((DWord Value - 0) * 4294967295) / 4294967295) + (-2147483648)) / DP Value 

             =((((2147484748-0)* 4294967295) / 4294967295) + (-2147483648))/1 
             =(((2147484748*4294967295)/ 4294967295)- 2147483648)/1 
             =2147484748-2147483648 
             =1100 
Modbus Scale Low = ((((DWord Value - 0) * 4294967295) / 4294967295) + (-2147483648)) / DP Value 

       = ((((2147484048-0) * 4294967295) / 4294967295) + (-2147483648))/1 
       = (((2147484048* 4294967295) / 4294967295) -2147483648)/1 
      =2147484048-2147483648 
      =400 
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8.1.3.3.2 How to calculate Scale Low / High 

 Let’s say Scale Low is ‘A’ and Scale High is ‘B’. 
Modbus Scale Low = Scale Low - (Modbus ΔScale Range - ΔScale Range)  
       = Scale Low-(Scale High-Scale Low) *1.2- (Scale High-Scale Low) 
       =A-(B-A) *1.2-(B-A) 
       =A-(1.2B-1.2A-B+A) 
       =A-(0.2B-0.2A) 
Modbus Scale Low =1.2A-0.2B-----------------------------------Equation 1 
 
Modbus Scale High = Scale High + (Modbus ΔScale Range -ΔScale Range) 
        = Scale High + ((Scale High-Scale Low) *1.2 – (Scale High- Scale Low)) 
        =B+((B-A) *1.2-(B-A)) 
        =B+(1.2B-1.2A-B+A) 
        =B+(0.2B-0.2A) 
Modbus Scale High =1.2B-0.2A--------------------------------- Equation 2 
Multiply by 6  
6*Modbus Scale High =7.2B-1.2A 
1.2A=7.2B-(6*Modbus Scale High) ------------------------------Equation 3 
Replace 1.2A in Equation 1 with the value in Equation 3 
Modbus Scale Low =1.2A-0.2B 
Modbus Scale Low=7.2B-(6*Modbus Scale High)-0.2B 
Modbus Scale Low=7B-(6*Modbus Scale High) 
Modbus Scale Low+(6*Modbus Scale High) =7B 
(Modbus Scale Low+(6*Modbus Scale High))/7 =B--------------------------Equation 4 
Replace B Value in Equation 2 to find A Value 
Modbus Scale High =1.2B-0.2A 
Modbus Scale High =1.2*((Modbus Scale Low+(6*Modbus Scale High))/7)-0.2A 
0.2A=1.2*((Modbus Scale Low+(6*Modbus Scale High))/7)-Modbus Scale High 
A=(1.2*((Modbus Scale Low+(6*Modbus Scale High))/7)-Modbus Scale High)/0.2--------------Equation 5 
 

8.1.3.4 Others (Word Type) 
Modbus Address Register Name Note Access 

11001 PR Version  R 

11002 Plus NO. ○1  R 
 

Note: 
Value Description 

0 Standard 

1 Plus 1 

2 Plus 2 

3 Plus 3 
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8.2 Modbus Communication 

8.2.1 Read Input Registers (Function 0x04) 

 The function code is used to read from 1 to 120 contiguous input registers in the remote device. 
Query 
 The query message specifies the starting register and quantity of registers to be read. Registers are 
addressed starting at zero: register 1 – 16 are addressed as 0 – 15. 
Here is an example of a request to read register 0 (register type is Input Register, the address is 1) 
from slave device 1: 

Field Name RTU example (Hex) 

Slave Address 01 

Function 04 

Starting Address Hi 00 

Starting Address Lo 00 

Quantity of Registers Hi 00 

Quantity of Registers Lo 01 

Error Check Lo 31 

Error Check Hi CA 

Total Bytes 8 

 
Response 
 The register data in the response message are packed as two bytes per registers, with the binary 
contents right justified within each byte. For each register, the first byte contains the high order bits 
and the second contains the low order bits. 
 The response is return when the data is completely assembled. Here is an example of a response to 
the query on the opposite page: 
 

Field Name RTU example (Hex) 

Slave Address 01 

Function 04 

Byte Count 02 

Data Hi 00 

Data Lo 0A 

Error Check Lo 39 

Error Check Hi 37 

Total Bytes 7 

 

8.2.2 Preset (Write) Multiple Registers (Function 0x10) 

 The function code is used to write a block of contiguous registers (1 to 120 registers) in a remote 
device. 
Query 
The query message specified the register references to be preset. Registers are addressed starting at 
zero: register 1 is addressed as 0. The requested preset values are specified in the query data field. 
Data is packed as two bytes per register. 
Here is an example of a request to preset two registers starting at 40001 to 00 0A and 01 02 hex in 
slave device 1: 
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Field Name RTU example (Hex) 

Slave Address 01 

Function 10 

Starting Address Hi 00 

Starting Address Lo 00 

Quantity of Registers Hi 00 

Quantity of Registers Lo 02 

Byte Count 04 

Data Hi 00 

Data Lo 0A 

Data Hi 01 

Data Lo 02 

Error Check Lo 53 

Error Check Hi FC 

Total Bytes 13 

Response 
The normal response returns the slave address, function code, starting address and quantity of 
registers preset. Here is an example of a response to the query shown above: 
 

Field Name RTU example (Hex) 

Slave Address 01 

Function 10 

Starting Address Hi 00 

Starting Address Lo 00 

Quantity of Registers Hi 00 

Quantity of Registers Lo 02 

Error Check Lo 41 

Error Check Hi C8 

Total Bytes 13 

8.2.3 Placing the CRC into a Message 

When the 16 bit CRC (two 8 bit bytes) is transmitted in the message, the low order byte will be 
transmitted first, followed by the high order byte. 
 For example, if the CRC value is 1241 hex: 
 

Slave Address Function Data CRC Lo CRC Hi 

-- -- -- 41 12 

 
Note: Broadcast mode is not supported. 
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8.3 Sample Code 

8.3.1 CRC Generation Function 

An example of a C language function performing CRC generation is shown on the following pages. All 
of the possible CRC values are preloaded into two arrays, which are simply indexed as the function 
increments through the message buffer. One array contains all of the 256 possible CRC values for the 
high byte of the 16 bit CRC field, and the other array contains all of the values for the low byte. 
Indexing the CRC in this way provides faster execution than would be achieved by calculating a new 
CRC value with each new character from the message buffer. 

    /****************************************************************/ 
// Parameter: 
//    puchMsg -> unsigned char* puchMsg: message to calculate CRC upon 
// usDataLne -> unsigned short usDataLen: quantity of bytes in message 
/****************************************************************/ 
unsigned short CRC16(puchMsg, usDataLen) 
{ 
unsigned char uchCRCHi=0xFF; /* high byte of CRC initialized */ 
unsigned char uchCRCLo=0xFF; /* low byte of CRC initialized */ 
unsigned uIndex; /* will index into CRC lookup table */ 
while (usDataLen––) /* pass through message buffer */ 
{ 
uIndex = uchCRCHi ^ *puchMsgg++; /* calculate the CRC */ 
uchCRCHi = uchCRCLo ^ auchCRCHi[uIndex]; 
uchCRCLo = auchCRCLo[uIndex]; 
} 
return (uchCRCHi << 8 | uchCRCLo); 
} 
High-Order Byte Table 
/* Table of CRC values for high–order byte */ 
static unsigned char auchCRCHi[] = { 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 
0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40  
} ; 
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Low-Order Byte Table 
/* Table of CRC values for low–order byte */ 
static char auchCRCLo[] = { 
0x00, 0xC0, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 0x07, 0xC7, 0x05, 0xC5, 0xC4, 
0x04, 0xCC, 0x0C, 0x0D, 0xCD, 0x0F, 0xCF, 0xCE, 0x0E, 0x0A, 0xCA, 0xCB, 0x0B, 0xC9, 0x09, 
0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, 0xDB, 0xDA, 0x1A, 0x1E, 0xDE, 0xDF, 0x1F, 0xDD, 
0x1D, 0x1C, 0xDC, 0x14, 0xD4, 0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 0xD2, 0x12, 0x13, 0xD3, 
0x11, 0xD1, 0xD0, 0x10, 0xF0, 0x30, 0x31, 0xF1, 0x33, 0xF3, 0xF2, 0x32, 0x36, 0xF6, 0xF7, 
0x37, 0xF5, 0x35, 0x34, 0xF4, 0x3C, 0xFC, 0xFD, 0x3D, 0xFF, 0x3F, 0x3E, 0xFE, 0xFA, 0x3A, 
0x3B, 0xFB, 0x39, 0xF9, 0xF8, 0x38, 0x28, 0xE8, 0xE9, 0x29, 0xEB, 0x2B, 0x2A, 0xEA, 0xEE, 
0x2E, 0x2F, 0xEF, 0x2D, 0xED, 0xEC, 0x2C, 0xE4, 0x24, 0x25, 0xE5, 0x27, 0xE7, 0xE6, 0x26, 
0x22, 0xE2, 0xE3, 0x23, 0xE1, 0x21, 0x20, 0xE0, 0xA0, 0x60, 0x61, 0xA1, 0x63, 0xA3, 0xA2, 
0x62, 0x66, 0xA6, 0xA7, 0x67, 0xA5, 0x65, 0x64, 0xA4, 0x6C, 0xAC, 0xAD, 0x6D, 0xAF, 0x6F, 
0x6E, 0xAE, 0xAA, 0x6A, 0x6B, 0xAB, 0x69, 0xA9, 0xA8, 0x68, 0x78, 0xB8, 0xB9, 0x79, 0xBB, 
0x7B, 0x7A, 0xBA, 0xBE, 0x7E, 0x7F, 0xBF, 0x7D, 0xBD, 0xBC, 0x7C, 0xB4, 0x74, 0x75, 0xB5, 
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 0x70, 0xB0, 0x50, 0x90, 0x91, 
0x51, 0x93, 0x53, 0x52, 0x92, 0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 0x94, 0x54, 0x9C, 0x5C, 
0x5D, 0x9D, 0x5F, 0x9F, 0x9E, 0x5E, 0x5A, 0x9A, 0x9B, 0x5B, 0x99, 0x59, 0x58, 0x98, 0x88, 
0x48, 0x49, 0x89, 0x4B, 0x8B, 0x8A, 0x4A, 0x4E, 0x8E, 0x8F, 0x4F, 0x8D, 0x4D, 0x4C, 0x8C, 
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 0x43, 0x83, 0x41, 0x81, 0x80, 
0x40 
} ; 

8.3.2 Read Data Function 

/****************************************************************/ 
// Parameter: 
//    Addr -> Slave ID 
// StReg -> Starting Register Address 
// RegQuantities -> Register Quantities 
// MbsBuf -> Receive Data Buffer 
/****************************************************************/ 
bool ReadData(unsigned char Addr, unsigned short StReg,  
unsigned short RegQuantities, unsigned char* MbsBuf) 
{ 
unsigned char msg[8]; 
unsigned char Func = 0x04; 
unsigned short Crc; 
 
msg[0] = Addr; 
msg[1] = Func; 
msg[2] = HIBYTE(StReg); 
msg[3] = LOBYTE(StReg); 
msg[4] = HIBYTE(RegQuantities); 
msg[5] = LOBYTE(RegQuantities); 
Crc = CRC16(msg,6); 
msg[6] = HIBYTE(Crc); 
msg[7] = LOBYTE(Crc); 
int snd = 8; /* byte number of buffer msg */ 
int rcv = (5+(RegQuantities*2)); 
/* Send snd bytes content of msg to COMM port */ 
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/* Receive rcv bytes of response from COMM port to MbsBuf */ 
if (receiving data length is same as rcv) 
return true; 
else 
return false; 
} 

8.3.3 Convert Data Function 

 
/****************************************************************/ 
// Parameter: 
//    ValueRangeLo -> Minimum value of the value range 
// ValueRangeHi -> Maximum value of the value range 
// ScaleLo -> Minimum value of the scale value 
// ScaleHi -> Maximum value of the scale value 
// RegData -> Current register data from remote device 
/****************************************************************/ 
double ConvertData(double ValueRangeLo, 
double ValueRangeHi, 
double ScaleLo, 
double ScaleHi, 
double RegData) 
{ 
    double ConvertValue; 
    ConvertValue = (((RegData*(ScaleHi - ScaleLo))/ (ValueRangeHi - ValueRangeLo)) + ScaleLo); 
   return ConvertValue; 
} 

8.3.4 Read AI Function 

bool ReadAIData(void) 
{ 
    unsigned char MsgBuf[40]; 
    unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 2; 
unsigned short RegQuantities = 5; 
int ScaleLo, ScaleHi,  
ValueRangeLo, ValueRangeHi, 
AiData; 
unsigned short RegData; 
 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Step 1: Parsing data for AI1 
RegData = MAKEWORD(MsgBuf[4], MsgBuf[3]); 
 
// Step 2: Set value range 
//Because AI data type was set as 2 bytes, the value range would be 
// showing between -32768 to 32767 
ValueRangeLo = -32768; 
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ValueRangeHi = 32767; 
 
// Step 3: Set value range for scale 

//The default of Sensor type in AI1 is set as『Thermocouple K Type』. 

// Scale low value is showing “-120”, scale high value is showing “1000” 
//Please refer to AI configuration for Modbus Scale  
ScaleLo = -120; 
ScaleHi = 1000; 
 
// Step 4: Execute converted function 
AiData = (int)ConvertData(ValueRangeLo, 
ValueRangeHi, 
ScaleLo, 
ScaleHi, 
RegData); 
// Step 5: Repeat Step 1 to Step 4 for getting another AI data 
} 

8.3.5 Read Math Function 

 
bool ReadMathData(void) 
{ 
    unsigned char MsgBuf[120]; 
    unsigned char i, j; 
 unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 201; 
unsigned short RegQuantities = (10*2); // Math data is float type, so each Math value take two 
registers 
double ScaleLo, ScaleHi, ValueRangeLo, ValueRangeHi; 
double RegData, MathData; 
 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Step 1: Set value range 
//The default of Math data type was set as 4 bytes, the value range will be showing between 0 to 
//4294967295 
ValueRangeLo = 0; 
ValueRangeHi = 4294967295; 
 
// Step 2: Set value range for scale  
// When the property of “Transformation” in scale was set as disable, the range will be showing 
 //-2147483648 to 2147483647 
// If the property of “Transformation” in Scale was set as “Value” or  “Math Channel”, please refer to 
//Appendix D 
 
ScaleLo = -2147483648; 
ScaleHi = 2147483647; 
 
// Step 3: Please refer to the decimal value for the conversion of each 
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Math 
        switch(decimal value) 
        { 
           case 1: 
                ScaleLo = ScaleLo / 10; 
    ScaleHi = ScaleHi / 10; 
                break; 
           case 2: 
                ScaleLo = ScaleLo / 100; 
ScaleHi = ScaleHi / 100; 
                break; 
           case 3: 
                ScaleLo = ScaleLo / 1000; 
    ScaleHi = ScaleHi / 1000; 
                break; 
           case 4: 
                ScaleLo = ScaleLo / 10000; 
    ScaleHi = ScaleHi / 10000; 
                break; 
           case 5: 
                ScaleLo = ScaleLo / 100000; 
    ScaleHi = ScaleHi / 100000; 
                break; 
           default: 
                break; 
        } 
 
// Step 4: Parsing data for Math1 
RegData = (UINT)MAKELONG(MAKEWORD(MsgBuf[j+1],  
MsgBuf[j]), 
MAKEWORD(MsgBuf[j+3], 
MsgBuf[j+2])); 
 
// Step 5: Execute converted function 
MathData = ConvertData(ValueRangeLo, 
ValueRangeHi, 
ScaleLo, 
ScaleHi, 
RegData); 
   
// Step 6: Repeat Step 1 to Step 5 for getting another data of Math 
 
} 
 



 
 

 
 

Page 532 of 550 

8.3.6 Read DI Function 

 
bool ReadDIData(void) 
{ 
 unsigned char MsgBuf[96]; 
 unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 50; 
unsigned short RegQuantities = 5; 
bool DiData; 
 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Step 1: Parsing data for DI1 
DiData = (bool)MAKEWORD(MsgBuf[4], MsgBuf[3]); 
 
// Step 2: Repeat Step 1 for getting another DI data 
} 

8.3.7 Read AO Function 

bool ReadAOData(void) 
{ 
 unsigned char MsgBuf[48]; 
 unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 601; 
unsigned short RegQuantities = 5; 
unsigned short RegData; 
float AoData; 
 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Because the AO expression is specific, so we need using specific // expression to convert the value 
//as following: 
// Step 1: Parsing data for AO1 
RegData = MAKEWORD(MsgBuf[4], MsgBuf[3]); 
 
// Step2: To do converted expression for AO1 
AoData = ((RegData * 65.535)/65535)-32.768; 
 
// Step 3: Repeat Step 1 to Step 2 for getting another AO data 
 
} 
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8.3.8 Read DO Function 

 
bool ReadDOData(void) 
{ 
 unsigned char MsgBuf[48]; 
 unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 74; 
unsigned short RegQuantities = 5; 
bool DoData; 
 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Step 1: Parsing data for DO1 
DiData = (bool)MAKEWORD(MsgBuf[4], MsgBuf[3]); 
 
// Step 2: Repeat Step 1 for getting another DO data 
} 

8.3.9 Read External Function 

bool ReadExtData(void) 
{ 
 unsigned char MsgBuf[128]; 
 unsigned char Addr = 1; /* Slave Id */ 
    unsigned short StartRegAdd = 401; 
unsigned short RegQuantities = 20; 
unsigned short ExtData; 
// Read register data from remote device 
ReadData(Addr, StartRegAdd, RegQuantities, MsgBuf); 
 
// Step 1: Parsing data for Ext1 
DiData = MAKEWORD(MsgBuf[4], MsgBuf[3]); 
 
// Step 2: Repeat Step 1 for getting another Ext data 
 
Note:  
*1: Above sample code is according to the PR20 setting if the user needs changing the MsgBuf size 
and RegQuantities value from PR10 or PR30, please refer to the user manual. 
 Because the Input Register Ext data is same like Holding  Register Ext data, so the data type of 
the ExtData must  according to the setting of real case, if the data type of ExtData is 4 bytes, please 
refer to “ReadMathData” function in Step 1, Step 2, Step 4 and Step 5 to convert data type of 
customer  
Requirement (Such as Int32 or UInt32 or float data type). 
} 
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8.4 Appendix 

8.4.1 Modbus RTU Slave / TCP Server Register Data Type Table 

Field Name Data Size Data Type Note 

AI 2 Bytes WORD Little Endian 

Math 4 Bytes UINT32 Little Endian 

DI 2 Bytes WORD Little Endian 

AO 2 Bytes WORD Little Endian 

DO 2 Bytes WORD Little Endian 

External 2 Bytes / 4 Bytes WORD / DWORD Little Endian 

8.4.2 Inquire AI Range 

The Modbus scale range for each AI channel is available in the channel configuration page as shown below. 
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8.4.3 AI Conversion Example 

 The below example shows the procedure to convert the raw value received in Modbus register to 
engineering value. If the floating-point type mapped register used to read then the user doesn’t need to do 
any conversion. The register itself has the engineering value. If the integer type register is used then the 
user needs to do the conversion as per the below to convert the raw value to engineering value. The 
Modbus low scale and high scale value are available on the channel configuration page as shown in the 
above picture. 
 AI Value= (Data Register Value* (AI High Scale-AI low scale)/65535) + AI low scale 
For example, the AI range is set to -200 to 1100. If the register value is 32000 then the actual AI value is as 
below. 
 AI Value = (Data Register Value* (AI High Scale-AI low scale)/65535) + AI low scale 
        = (32000*(1100-(-200))/65535) + (-200) 
        = (32000*1300)/65535-200 
        = 634.78-200 
        = 434.78 

8.4.4 Math Conversion Sample 

The below example shows the procedure to convert the raw value received in Modbus register to 
engineering value. If the floating-point type mapped register used to read then the user doesn’t need to do 
any conversion. The register itself has the engineering value. If the integer type register is used then the 
user needs to do the conversion as per the below to convert the raw value to engineering value. 

8.4.4.1 Transformation Disable 

 
 

 If the transformation is set to disable and the decimal point is ‘0’ then the value received on the register 
doesn’t need any conversion. If the decimal value is set as “1”, then the value must be divided by 10 to 
match with the value in Math of PR. If the decimal value is set as “2”, then the value must be divided by 100 
to match with the value in Math of PR. If the decimal value is set as “3” then the value must be divided by 
1000 to match the value in Math of PR. If the decimal value is set as “4” then the value must be divided by 
10000 to match the value in Math of PR. If the decimal value is set as “5” then the value must be divided by 
100000 to match the value in Math of PR. 
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8.4.4.2 Transformation as Value 

 If the transformation is set to value and the table is configured with transformation table entries then the 
below formulae to be used to convert the raw value of DWord register to actual math channel value. 

Math value = (((Register value * (ScaleHi - ScaleLo)) / 4294967295) + ScaleLo) 
 

 
 

 The scale low and scale hi of the math channel can be referenced from transformation table output values. 
For example, the transformation table configured as below. 
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The high scale of this channel is 90 and the low scale of this channel is 10. The value of math channel is 68. 
The value at the Modbus register is 3092376452.  The register value can be converted to math channel 
actual value by using the below conversion. 

Math value = (((Register value * (ScaleHi - ScaleLo)) / 4294967295) + ScaleLo) 
     = ((3092376452*(90-10))/4294967295)+10) 
     = ((3092376452*80)/ 4294967295)+10 
     = 57.6+10 
     = 58+10 (rounded to nearest integer) 
     = 68 

8.4.4.3 Transformation as Math Channel 

 If the transformation is set to value and the decimal point is ‘0’ then the value received on the register 
doesn’t need any conversion. If the decimal value is set as “1”, then the value must be divided by 10 to 
match with the value in Math of PR. If the decimal value is set as “2”, then the value must be divided by 100 
to match with the value in Math of PR. If the decimal value is set as “3” then the value must be divided by 
1000 to match the value in Math of PR. If the decimal value is set as “4” then the value must be divided by 
10000 to match the value in Math of PR. If the decimal value is set as “5” then the value must be divided by 
100000 to match the value in Math of PR. 
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8.4.5 AO Conversion Example 

The AO Value data contains the raw data which can be converted to actual AO value using the below 
conversion. 

AO value = (((Register value * 65.535) / 65535) - 32.768) 
 For example, the AO value received in the register is 52411 then the actual value is calculated as below. 

AO value = (((52411 * 65.535) / 65535) - 32.768) 
                           = 3434754.885/65535 – 32.768 
               =19.643  
 

8.4.6 External Channel Conversion for AI channel 

 Configure the data type is 2 Byte. 
 Change the Actual low and Actual high of the external channel as similar to AI Channel. 
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8.4.7 External Channel Conversion for DI and DO Channel 

 The DI and DO channels don’t need any conversion to read in the external channel. The channel data type 
needs to be configured as 2 Byte. 
 
 

 
 

8.4.8 External Channel Conversion for AO channel 

 Configure the channel as 2 Byte. 
Configure the external channel Actual Value Low as -32.768 and Actual Value High as 32.767. 
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8.4.9 External Channel Conversion for Math Channel 

Configure the channel as 4 Byte. 
Configure the Actual Value Low and high as below depends on the decimal value of Math channel 
configuration. 

If the decimal is 0, Actual Value Low as -2147483648.0 and Actual value High as 2147483647.0. 
If the decimal is 1, Actual Value Low as -214748364.8 and Actual value High as 214748364.7. 
If the decimal is 2, Actual Value Low as -21474836.48 and Actual value High as 21474836.47. 
If the decimal is 3, Actual Value Low as -2147483.648 and Actual value High as 2147483.647. 
If the decimal is 4, Actual Value Low as -214748.3648 and Actual value High as 214748.3647. 
If the decimal is 5, Actual Value Low as -21474.83648 and Actual value High as 21474.83647. 
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8.4.10 External Channel Conversion for Data-logger XH12 

 

 
 
Configure the IP address  

Configure the IP address as Static  

Configuration > Communication > Ethernet  

Connect the PR with one XH12 via the the historical viewer on PC 
 

Entering the Configuration menu, select Communication then Press the Enter key to get into 

Communication configuration menu. It displays the communication configuration menu to configure. Find 

the IP address to integrate between PR and the data logger. Configure the IP as static or reset the IP as 

static, not DHCP, and reset the IP address by inputing the address. 
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New modifications since V2.0 (2507)  
After EMS option created, go back to Config tab, and continued to configure EMS. From E1~E8, reset any 
configuration as Auto Config and select Wiring as 3-Phase. Reset single selection from Vlla ~ kWh as V or 
not. Go back to the Home, from    
 Add function: 

EMS created to the list:  
1) UI for EMS Config 

Auto-Config Channels, Commands, Pages. 
2) UI for EMS Realtime 

Go to Menu > More > Configuration, before setting EMS option, unable to display on the list. 
  

  
 

Go to Configuration > Instrument > EMS > Enable > OK 
 

  
 

Go to, Instrument > Math > Expression > Naming Mood > Channel Name > OK 
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Go to Configuration > Display > Overview > Auto > OK 
 

  
   
Power off the device and power on again  
Go to Configuration; EMS has been created to the Config list 
 

 
 
 

EMS management data summary:  
To display the EMS energy management results data, setting the EMS options, from E1~ E8 under 
EMS, set the Config as Auto Config and set Wiring as 3 Phase. Go back to Home > Realtime, select 
E#, the data will show summary data. 
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Go to Configuration > EMS > E# > Reset Config > Yes > Wiring (E#) > 3 Phase > OK >  "Vlla" ~ 

"kWh" > Back > Home > Saving Configuration > Realtime > E# > Summary/ Power/ Phase/ Volts 
 
 

  
 

 

3) Auto Config and 3-Phase 

Go to Configuration > EMS > E# > Reset Config > Yes > Wiring (E#) > 3 Phase > OK >  "Vlla" ~ 

"kWh". Reset optional items for Signal Selection, as V(Yes) or X(Not). 
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4) Realtime EMS data  
Go Back > Home > Saving Configuration > Realtime > E# > Summary/ Power/ Phase/ Volts. Select 
E1~E8 summary from Realtime sub-menu. 
 

  
 
 
 
 
 
 
 
 
 
 
 

 



 
 

 
 

Page 546 of 550 

 New modifications since V2.0 (2507)  
 Add function:  

PR enhancement for integrate XH12 to be a source for external channels 
- Integrate TCP communication for accepting connections from XH12 devices 
- Integrate TCP Server to work with current modbus Master/Server and share the same channel 

resource 
- Add UI Communication->XH12 (TCP Server)->Devices   
 
1) IP address:  

Go to Configuration > Communication > Ethernet. Find the PR device IP. Or reset one static IP 
address. 
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2) Historical Viewer:  
Open the Historical Viewer and create new project  
- Click   New > Recorder(PR) > OK 
- Go to <Create a new project> window > enter project name > select Ethernet > enter PR IP > 

OK > click Yes to receive data 
 

     
 

Create new sensor  
 

         
 

Select USB connect > OK > SSID/ Password > Next > Finish 
- Connect one XH12 with the PC via USB cable  
- Make sure your PC is equipped with WiFi function and turn it on 
- Make sure the WiFi is connected to a proper hotspot 
- Enter the SSID & password of the hotspot 
- Press button "Next" 
- Take one sensor which is new to this system 
- Inspect the below list and see if the new sensor is detected and listed 
- Repeat steps 1~3 for the remaining new sensors and then press button "Finish" 
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3) Add XH12:  
Add XH12 to Historical Viewer project successfully 
- Recorder configuration screen pop-up: Communication > XH12 > Device 
- Unplug USB cable between XH12 & PC after XH12(TCP Server) added to connect wirelessly 

 

  
 

Send configuration updated data to PR recorder on the configuration screen  

- Click the tab  <Send configuration>  
- The PR configuration has been updated with XH12 device 
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8.5 Warranty 
 
 

WARRANTY 
Brainchild Electronic Co., Ltd. is pleased to offer suggestions on the use of its various products. 
However, Brainchild makes no warranties or representations of any sort regarding the fitness for use, or the 
application of its products by the Purchaser. The selection, application or use of Brainchild products is the 
Purchaser's responsibility. No claims will be allowed for any damages or losses, whether direct, indirect, 
incidental, special or consequential. Specifications are subject to change without notice. In addition, 
Brainchild reserves the right to make changes without notification to Purchaser to materials or processing 
that do not affect compliance with any applicable specification. Brainchild products are warranted to be free 
from defects in material and workmanship for 18 months after delivery to the first purchaser for use. An 
extended period is available with extra cost upon request. Brainchild's sole responsibility under this warranty, 
at Brainchild's option, is limited to replacement or repair, free of charge, or refund of purchase price within 
the warranty period specified. This warranty does not apply to damage resulting from transportation, 
alteration, misuse or abuse. 
 
 
RETURNS 
No products return can be accepted without a completed Return Material Authorization (RMA) form. 
 
 
NOTE 
Information in this user's manual is subject to change without notice. 
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For any repair or maintenance needs, please contact us.  
 

 
 

 Electronic Co., Ltd. 
No.209, Chung Yang Rd., Nan Kang Dist., 
Taipei 11573, Taiwan 
Tel: 886-2-27861299 
Website: www.brainchildtw.com 
Email: service@brainchild.com.tw 
 

Copyright ©  2025 Brainchild, all rights reserved.  
 
 
 
 

 

-Please install 20A circuit breaker on the power supply end 
-To remove the dust please use the dry cloth 
-The installation that the safety of any system incorporating the equipment is the  
  responsibility of the assembler of the system 
-If the equipment is used in a manner not specified by the manufacturer, the  
  protection provided by the equipment may be impaired 
-Do not cover the cooling vents to maintain airflow 
-Beware not to over-tighten the terminal screws. For C22 should not exceed 0.19 N-m  
(1.74 Lb-in or 2 Kgf-cm) and C62/72/42/82/83 and R22 should not exceed 1 N-m  
( 8.9 Lb-in or 10.2 Kgf-cm ), temperature Min.60°C, use copper conductors only. 
 
-Veuillez installer un disjoncteur 20A à l'extrémité de l'alimentation 
-Pour enlever la poussière, veuillez utiliser le chiffon sec 
-L'installation que la sécurité de tout système incorporant l'équipement est la   
  responsabilité de l'assembleur du système 
-Si l'équipement est utilisé d'une manière non spécifiée par le fabricant, le la protection  
  fournie par l'équipement peut être altérée 
-Ne couvrez pas les évents de refroidissement pour maintenir le flux d'air 
-Attention à ne pas trop serrer les vis des bornes. Pour C22 ne doit pas dépasser 0,19 N-m 
(1,74 Lb-in ou 2 Kgf-cm) et C62/72/42/82/83 et R22 ne doivent pas dépasser 1 N-m 
(8,9 Lb-in ou 10,2 Kgf-cm), température Min.60°C, utiliser uniquement des conducteurs en cuivre. 


